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What is autocad?
AutoCAD is a PC-based drafting and design software package developed and marketed by 
Autodesk®, Inc. As of 2010, it has been around for approximately 28 years—several lifetimes 
in the software industry. It has grown from modest beginnings to an industry standard, often 
imitated, sometimes exceeded, but never equaled. The basic premise is simple and one of the 
reasons for AutoCAD’s success. Anything you can think of, you can draw quickly and easily. 
For many years it helped if this “anything” was 2D in nature, as AutoCAD is essentially a 
superb electronic 2D drafting board. In recent releases, however, its 3D capabilities finally 
matured, and AutoCAD is now also considered an excellent 3D visualization tool.

The software has a rather steep learning curve to become an expert but a surprisingly easy one 
to just get started. Most important, it is well worth learning. This is truly global software that 
has been adopted by millions of architects, designers, and engineers worldwide. Over the years 
Autodesk has expanded that reach by introducing add-on packages that customize AutoCAD 
for industry-specific tasks, such as electrical, civil, and mechanical engineering. However, 
underneath all these add-ons is still plain AutoCAD. This software remains hugely popular. 
Learn it well, as it is still one of the best things you can add to your resume and skill set.

About this book
This book is not like most on the market. While many authors certainly fancy their particular 
text as being unique and novel in its approach, I rarely reviewed one that was clear to a beginner 
student and distilled AutoCAD concepts down to basic, easy to understand explanations. The 
problem may be that many of the available books are written by either industry technical 
experts or teachers but rarely by someone who is actively both. One really needs to interact 
with the industry and the students, in equal measure, to bridge the gap between reality and the 
classroom.

After years of AutoCAD design work in the daytime and teaching nights and weekends, I set 
out to create a set of classroom notes that outlined, in an easy to understand manner, exactly 
how AutoCAD was used and applied, not theoretical musings or clinical descriptions of the 
commands. These notes eventually were expanded into the book that you now hold. The 
rationale was simple: I need this person to be up and running as soon as possible to do a 
job. How do we make this happen?

Teaching methods
This book has its roots in a certain philosophy developed while attending engineering school 
many years ago. While there I had sometimes been frustrated with the complex presentation 
of what in retrospect amounted to rather simple topics. My favorite quote was, “Most ideas 
in engineering are not that hard to understand but often become so upon explanation.” The 
moral of that quote was that concepts can usually be distilled to their essence and explained 
in an easy and straightforward manner. That is the job of a teacher: Not to blow away students 
with technical expertise but to use experience and top-level knowledge to sort out what is 
important and what is secondary and to explain the essentials in plain language.

Such is the approach to this AutoCAD book. I want everything here to be highly practical 
and easy to understand. There are few descriptions of procedures or commands that are 
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rarely used in practice. If we talk about it, you will likely need it. The first thing you must 
learn is how to draw a line. You will see this command on the first few pages of Chapter 1. 
It is essential to present the “core” of AutoCAD, essential knowledge common to just about 
any drafting situation, all of it meant to get you up and running quickly. This stripped down 
approach proved effective in the classroom and was carefully incorporated into this text.

Text organization
This book comes in two parts: Level 1 and Level 2:

Level 1 (Chapters 1–10) is meant to give you a wide breadth of knowledge on many 
topics, a sort of “mile wide” approach. These ten chapters comprise, in my experience, the 
complete essential knowledge set of an intermediate user. You then can work on, if not 
necessarily set up and manage, moderate to complex drawings. If your CAD requirements 
are modest or if you are not required to draft full time, then this is where you stop.
Level 2 (Chapters 11–20) is meant for advanced users who are CAD managers, full-time 
AutoCAD draftspersons, architects, or self-employed and must do everything themselves. 
The goal here is depth, as many features not deemed critically important in Level 1 are 
revisited to explore additional advanced options. Also introduced are advanced topics 
necessary to set up and manage complex drawings.

Throughout the book, the following methods are used to present material:

l	 Explain the new concept or command and why it is important.
l	 Cover the command step by step (if needed), with your input and AutoCAD responses 

shown so you can follow and learn them.
l	 Give you a chance to apply just-learned knowledge to a real-life exercise, drawing, or model.
l	 Test yourself with end-of-chapter quizzes and drawing exercises that ask questions about 

the essential knowledge.

You will not see an extensive array of distracting “learning aides” in this text. You will, 
however, see some common features throughout, such as:

Commands: These are presented 
in almost all cases in the form of 
a command matrix, such as the 
one shown here for a Line. You 
can choose any of the methods for 
entering the command.

Tips and tricks: These are seen 
mostly in the first few chapters and 
one is shown here. They are very 
specific, deliberate suggestions to 
smooth out the learning experience. 
Do take note.

TIP 1: The Esc (Escape) key in the upper left-hand 
corner of your keyboard is your new best friend 
while learning AutoCAD. It will get you out of just 
about any trouble you get yourself into. If something 
does not look right, just press the Esc key and 
repeat the command. Mine was worn out learning 
AutoCAD, so expect to use it often.

Step-by-step instructions: These 
are featured whenever practical and 
show you exactly how to execute the 
command, such as the example with 
Line here. What you type in and what 
AutoCAD says are in the default font: 
Courier New. The rest of the steps 
are in the standard print font.

Step 1. Begin the Line command via any of the 
previous methods.
  �•  AutoCAD says: Specify first point:

Step 2. Using the mouse, left-click anywhere on the 
screen.
  �•  AutoCAD says: Specify next point or [Undo]:

Step 3. Move the mouse elsewhere on the screen 
and left-click again. You can repeat Step 2 as many 
times as you wish. When you are done, click Enter or 
Esc.
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Learning objectives and time for 
completion: Each chapter begins 
with this, which builds a “roadmap” 
for you to follow while progressing 
through the chapter, as well as sets 
expectations of what you will learn if 
you put in the time to go through the 
chapter. Time for completion is based 
on classroom teaching experience but 
is only an estimate. If you are learning 
AutoCAD in school, your instructor 
may choose to cover part of a chapter 
or more than one at a time.

In this chapter we introduce AutoCAD and discuss 
the following:

Introduction and the basic commands

The Create Objects commands

The Edit and Modify Objects commands

The View Objects commands, etc.

By the end of the chapter you will 

Estimated time for completion of chapter: 3 hours.

Summary, review questions, 
exercises: Each chapter concludes 
with these. Be sure to not skip these 
pages and to review everything you 
learned.

SUMMARY
REVIEW QUESTIONS
EXERCISES

What your goal should be
Just learning commands is not enough; you need to see the big picture and truly understand 
AutoCAD and how it functions for it to become effortless and transparent. The focus after all 
is on your design. AutoCAD is just one of the tools to realize it.

A good analogy is ice hockey. Professional players do not think about skating; to them it’s 
second nature. They are focused on strategy, scoring a goal, and getting by the defenders. This 
mentality should be yours as well. You must become proficient through study and practice, 
to the point where you are working with AutoCAD, not struggling against it. It then becomes 
“transparent” and you focus only on the design, to truly perform the best architecture or 
engineering work of which you are capable.

If you are in an instructor-led class, take good notes. If you are self-studying from this text, 
pay very close attention to every topic; nothing here is unimportant. Do not skip or cut 
corners, and complete every drawing assignment. Most important, you have to practice, daily 
if possible, as there is no substitute for sitting down and using the software. Not everyone 
these days has the opportunity to learn while working and getting paid; companies want 
ready-made experts and do not want to wait. If that is the case, you have to practice on your 
own in the evening or on weekends. Just taking a class or reading this book alone is not 
enough.

It may seem like a big mountain to climb right now, but it is completely doable. Once on 
top, you will find that AutoCAD is not the frustrating program it may have seemed in the 
early days but an intuitive software package that, with proficiency of use, becomes a natural 
extension of your mind when working on a new design. That in the end is the mark of 
successful software; it helps you do your job easier and faster. You can contact me at  
Elliot.Gindis@gmail.com. Good luck!



This page intentionally left blank



Chapters 1–10

1level 



level 1  
Chapters 1–10

2

Level 1 is the very beginning of your studies. No prior knowledge of AutoCAD is assumed, 
only basic familiarity with computers and some technical aptitude. You are also at an 
advantage if you have hand-drafted before, as many AutoCAD techniques flow from the old 
paper and pencil days, a fact alluded to later in the chapters.

We begin Chapter 1 by outlining the basic commands under Create Objects and Modify 
Objects followed by an introduction to the AutoCAD environment. We then introduce basic 
accuracy tools of Ortho and OSNAP. Chapter 2 continues the basics by adding units and 
various data entry tools. These first two chapters are the most important, as success here 
ensures you will understand the rest and be able to function in the AutoCAD environment.

Chapter 3 continues on to layers, then each succeeding chapter continues to deal with one 
or more major topics per chapter: Text and Mtext in Chapter 4, hatching in Chapter 5, and 
dimensioning in Chapter 6. In these six chapters you are asked to not only practice what you 
learned but apply the knowledge to a basic architectural floor plan. Chapter 7 introduces 
Blocks and Wblocks, and Chapter 8 Arrays. At this point you are asked to draw another 
project, this time a mechanical device. Level 1 concludes with basic printing and output in 
Chapter 9, and finally advanced printing and output (Paper Space) in Chapter 10.

Be sure to dedicate as much time as possible to practicing what you learn; there really is no 
substitute.
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CHAPTER

AutoCAD Fundamentals  
Part I

LEARNING OBJECTIVES
In this chapter, we introduce AutoCAD and discuss the following:
l	 Introduction and the basic commands.
l	 The Create Objects commands.
l	 The Edit/Modify Objects commands.
l	 The View Objects commands.
l	 The AutoCAD environment.
l	 Interacting with AutoCAD.
l	 Practicing the Create Objects commands.
l	 Practicing the Edit/Modify Objects commands.
l	 Selection methods—Window and Crossing.
l	 Accuracy in drafting—Ortho.
l	 Accuracy in drafting—OSNAPs.

1
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1.1  Introduction and basic commands
AutoCAD 2011 is a very complex program. If you are taking a class or reading this 
textbook, this is something you probably already know. The commands available to you, 
along with their submenus and various options, number in the thousands. So, how do 
you get a handle on them and begin using the software? Well, you have to realize two 
important facts.

First, you must understand that on a typical workday, 95% of your AutoCAD drafting time 
is spent using only 5% of the available commands, over and over again. So getting started is 
easy; you need to learn only a handful of key commands, and as you progress and build 
confidence, you can add depth to your knowledge by learning new ones.

Second, you must understand that even the most complex drawing is essentially made up of 
only a few basic fundamental objects that appear over and over again in various combinations 
on the screen. Once you learn how to create them and edit them, you will be able to draw 
surprisingly quickly. Understanding these facts is the key to learning the software. We are 
going to strip away the perceived complexities of AutoCAD and reduce it to its essential core. 
Let us go ahead now and develop the list of the basic commands.

For a moment, view AutoCAD as a fancy electronic hand-drafting board. In the old days of 
pencil, eraser, and T-square, what was the simplest thing that you could draft on a blank 
sheet of paper? That of course is a line. In your notes, write the following header, “Create 
Objects,” and below it add “line.”

So what other geometric object can we draw? Think of basic building blocks, those that 
cannot be broken down any further. A circle qualifies and so does an arc. Because it is so 
common and useful, throw in a rectangle as well (even though you should note that it is a 
compound object, made up of four lines). So, here is the final list of fundamental objects the 
way you should have them written down in your notes:

Create Objects
m	 Line
m	 Arc
m	 Circle
m	 Rectangle

As surprising as it may sound, these four objects, in large quantities, make up the vast 
majority of a typical design, so already you have the basic tools. We create these on the 
AutoCAD screen in a bit. For now, let us keep going and get the rest of the list down on 
paper.

So now that you have the objects, what can you do with them? You can erase them, which 
is probably the most obvious. You can also move them around your screen and, in a similar 
manner, copy them. The objects can rotate, and you can also scale them up or down in size. 
With lines, if they are too long, you can trim them and, if they are too short, extend them. 
Offset is a sort of precise copy and is one of the most useful commands in AutoCAD. Then 
there is mirror, used as the name implies to make a mirror-image copy of an object. Finally 
there is fillet, used to put a radius on two intersecting lines, among other things. We will 

By the end of the chapter, you will have learned the essential basics of creating, modifying, 
and viewing objects; the AutoCAD environment; and accuracy in the form of straight lines 
and precise alignment of geometric objects via OSNAP points.

Estimated time for completion of chapter: 3 hours.
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learn a few more useful commands a bit later. But, for now, under the header “Edit/Modify 
Objects,” list the commands just mentioned.

Edit/Modify Objects
m	 Erase
m	 Move
m	 Copy
m	 Rotate
m	 Scale
m	 Trim
m	 Extend
m	 Offset
m	 Mirror
m	 Fillet

Once again, as surprising as it may sound, this short list represents almost the entire set 
of basic Edit/Modify Objects commands that you will need once you begin to draft. Start 
memorizing them.

To finish up, let us add several View Objects commands. With AutoCAD, unlike paper  
hand-drafting, you do not always see your whole design in front of you. You may need to 
zoom in for a closeup or out to see the big picture. You may also need to pan around to view 
other parts of the drawing. With a wheeled mouse, so common on computers these days, it is 
very easy to do both, as we soon see. To this list we will add the regen command. It stands for 
regenerate, and it simply refreshes your screen, something you may find useful later. So here is 
the list for View Objects:

View Objects
m	 Zoom
m	 Pan
m	 Regen

So, this is it for now, just 17 commands making up the basic set. Here is what you need to do:

1.	 As mentioned before, memorize them so you know what you have available.
2.	 Understand the basic idea, if not the details, behind each command. This should be easy 

to do, because (except for maybe offset and fillet) the commands are intuitive and not 
cryptic in any way; erase means erase, whether it is AutoCAD, a marker on a whiteboard, 
or a pencil line.

We are ready now to start AutoCAD, discuss how to interact with the program, and try them 
all out.

1.2  The autocad environment
It is assumed that your computer, whether at home, school, or training class, is loaded with 
AutoCAD 2011. It is also assumed that AutoCAD starts up just fine (via the AutoCAD icon 
or Start menu) and everything is configured right. If not, ask your instructor, as there are just 
too many things that can go wrong on a particular PC or laptop, and it is beyond the scope 
of this book to cover these situations. If all is well, start up AutoCAD, and you should see 
the screen depicted in Figure 1.1 (your particular screen may vary slightly, which we discuss 
soon).

This is your basic “out of the box” AutoCAD screen for the Initial Setup Workspace. From 
both the learning and teaching points of view, the new screen layout is a big improvement 
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over older versions of AutoCAD, and Autodesk has done an admirable job in continuing to 
keep things clean and simple.

Part of that success is due to AutoCAD’s major facelift, which began with Release 2009 a few years 
ago. If you caught a glimpse of earlier versions, you may have noticed toolbars present. They are 
still around, but what we have now, dominating the upper part of the screen, is called the Ribbon. 
It is a new way of interacting with AutoCAD, and we discuss it in detail soon. Other screen 
layouts or workspaces are available to you, including one with toolbars. They can be accessed 
through the menu seen in Figure 1.2, which is located at the bottom right (or top left) of the 
screen, depending on migrated settings. If you click on that menu, you will see the Workspace 
Switching Menu, shown in Figure 1.3. Here, you can also switch to AutoCAD Classic, which 
removes the Ribbon and loads the screen with toolbars and a palette, as seen in Figure 1.4.

So which workspace to use? Well, for now switch back to the Initial Setup Workspace with 
the Ribbon. We will shortly discuss how to interact with AutoCAD and give you some 
choices. Just before we do that though, let us go over the other features of the screen as seen 
in Figure 1.5. Here is a brief description of what is labeled there.

l	 Drawing area. Takes up most of the screen and is usually colored black (white in this 
text). It is where you work and your design appears. If you wish to change it to black 

Figure 1.1 
AutoCAD 2011.

Figure 1.2 
Workspace switching.
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to ease eye strain, you will need to right-click into Options then choose Display 
and Colors. We cover this in advanced chapters, so you should ask your instructor for 
assistance in the meantime, if necessary.

l	 Command line. Right below the drawing area, usually colored white. It is where the 
commands may be entered and also where AutoCAD tells you what it needs to continue. 
You need to always keep an eye on what appears here, as this is one of the main ways that 
AutoCAD communicates with you.

l	 UCS icon. A basic X-Y-Z (Z is not visible) grid symbol. Not important for now but will be 
later in advanced studies and 3D. It can be turned off, as will be shown later.

Figure 1.3 
Workspace switching menu.

Figure 1.4 
AutoCAD 2011, classic layout.
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l	 Model Space/Paper Space tabs. Not important for now, but will be in Chapter 10, 
“Advanced Output—Paper Space.”

l	 Toolbar. Toolbars contain icons that can be pressed to activate commands. They are an 
alternative to typing and the Ribbon, and most commands can be accessed this way. 
AutoCAD has dozens of them.

l	 Crosshairs. The mouse cursor. It can be full-size and span the entire screen, or a small 
(flyspeck) size. You can change the size of the crosshairs if you wish, and full-screen is 
recommended in some cases.

l	 Drawing and construction aids. These various settings assist you in drafting and 
modeling. We introduce them as necessary. An additional set of advanced drawing aids 
are on the far right of the screen.

l	 Ribbon. A new way of interacting with AutoCAD’s commands, to be discussed soon.
l	 Tool palette. One of many in AutoCAD; they add more functionality, to be discussed later.
l	 Cascading drop-down menus. Another way to access commands in AutoCAD.

1.3  Interacting with autocad
OK, so you have the basic commands in hand and ideally also a good idea of what you 
are looking at on the AutoCAD screen. We are ready to try out the basic commands and 
eventually draft something. So, how do we interact with AutoCAD and tell it what we want 
drawn? There are six overall and four primary ways. The four primary ways (Methods 1–4) 
follow, roughly in the order they appeared over the years. After them are the two outdated 
methods that are mentioned only in passing as a historical side note.

Method 1: Type in the commands on the command line (AutoCAD v1.0–current).
Method 2: Select the commands from the drop-down cascading menus (AutoCAD v1.0–current).

Figure 1.5 
AutoCAD 2011 screen elements.
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Method 3: Use toolbar icons to activate the commands (AutoCAD 12/13–current).
Method 4: Use the Ribbon tabs, icons, and menus (AutoCAD 2009–current).
Method 5: Use the screen side menu (outdated).
Method 6: Use a tablet (outdated).

Details of each method including the pros and cons follow. Most commands are presented 
in all four primary ways, and you can experiment with each method to determine what you 
prefer. Eventually you will settle on one particular way of interacting with AutoCAD or a 
hybrid of several.

Method 1: Type in the Commands on the Command Line
This was the original method of interacting with AutoCAD and, to this day, remains the most 
foolproof way to enter a command: good old-fashioned typing. AutoCAD is unique among 
leading CAD software in that it has retained this method while almost everyone else moved 
to graphic icons, toolbars, and Ribbons. If you hate typing, this will probably not be your 
preferred choice.

However, do not discount keyboard entry entirely; AutoCAD has kept it for a reason. When 
the commands are abbreviated to one or two letters (Line  L, Arc  A, etc.), input can be 
incredibly fast. Just watch a professional typist for proof of the speed with which one can 
enter data via a keyboard. Other advantages to typing are that you no longer have toolbars or 
a Ribbon cluttering up precious screen space (there is never enough of it) and you no longer 
have to take your eyes off the design to find an icon; instead, the command is actually at 
your fingertips. Finally, this method is the only way to enter a few of the commands (mostly 
in 3D). The disadvantage is of course that you have to type.

To use this method, simply type in the desired command (spelling counts) at the command 
line, as seen in Figure 1.6, and press Enter. The sequence initiates and you can proceed. 
A number of shortcuts are built into AutoCAD (try using just the first letter or two of a 
command), and we will learn how to make our own shortcuts in advanced chapters. This 
method is still preferred by many “legacy” users (a kind way to say they have been using 
AutoCAD forever).

Method 2: Select the Commands from the Drop-Down Cascading 
Menus
This method has also been around since the beginning. It presents a way to access virtually 
every AutoCAD command, and indeed many students start out by checking out every one 
of them as a crash course on what is available—a fun but not very effective way of learning 
AutoCAD. The cascading menus (so named because they drop out like a waterfall) may be 
hidden initially, but you can easily make them visible via the down arrow at the top left of 
the screen (next to the printer symbol). Select Show Menu Bar and they will appear. Go ahead 
and examine the cascading menus; these are similar in basic arrangement to other software 
and you should be able to navigate through them easily. We refer to them on occasion in the 

Figure 1.6 
AutoCAD 2011 command line (circle typed in).
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following format: Menu→Command. So, for the sequence shown in Figure 1.7, you would 
read Draw→Circle→3 Points.

Method 3: Use Toolbar Icons to Activate the Commands
This method has been around since AutoCAD switched from DOS to Windows in the  
mid-1990s and is a favorite of a whole generation of users; toolbars are a familiar sight with 
virtually any software these days. Toolbars contain sets of icons, organized by categories 
(example, Draw toolbar, Modify toolbar, etc.). You press the icon you want and a command is 
initiated. One disadvantage to toolbars, and the reason the Ribbon was developed, is that they 
take up a lot of space and, arguably, are not the most effective way of organizing commands 
on the screen. You can access toolbars by activating the AutoCAD Classic Workspace, or to have 
the Ribbon and toolbars, do the following while in the Initial Setup Workspace:

1.	 Type in toolbar and press Enter.
m	 AutoCAD says: Enter toolbar name or [ALL]:

2.	 Type in draw and press Enter.
m	 AutoCAD says: �Enter an option [Show/Hide/Left/Right/Top/Bottom/Float] 

<Show >:
3.	 Type in s for Show and press Enter. The Draw toolbar appears, as seen in Figure 1.8.

To get more toolbars, you need not go through that procedure again. Simply right-click on 
the new toolbar and a menu appears, as seen in Figure 1.9. Then, just select the additional 
toolbars you want to see. Bring up Modify and Standard; those are the other two we will need 
in the beginning. Dock them all off to the side or next to the Ribbon on top.

Method 4: Use the Ribbon Tabs, Icons, and Menus
This is the most recently introduced method of interacting with AutoCAD and follows a  
new trend in software user interface design started by Microsoft and Office 2007 (seen in 
Figure 1.10 with Word®).

Figure 1.8 
Draw toolbar.

Figure 1.7 
AutoCAD 2011 cascading drop-down menus.
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Notice how toolbars have been displaced by “tabbed” categories, where information is 
grouped together by a common theme.

So it goes with the new AutoCAD. The Ribbon was introduced with AutoCAD 2009 and it is 
here to stay. It is shown again in Figure 1.11.

Notice what we have here. A collection of tabs, indicating a subject category, is found at 
the top (Home, Insert, Annotate, etc.) and each tab reveals an extensive set of tools (Draw, 
Modify, Annotation, etc.). At the bottom of the Ribbon, additional options can be found 
by using the drop arrows. In this manner the toolbars have been rearranged in what is, in 
principle, a more logical and space saving manner. Additionally tool tips appear if you place 
your mouse over any particular tool for more than a second. Another second will yield 
an even more detailed tool tip. In Figure 1.12, you see the Home tab selected, followed 
by additional options via the drop arrow, and finally the mouse placed over the Polygon 
command. A few moments of waiting reveals the full tool tip for that command; pressing the 
icon activates the command.

Figure 1.9 
Toolbar menu.

Figure 1.10 
MS Word® Ribbon example.
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Familiarize yourself with the Ribbon by exploring it. It presents some layout advantages, 
and specialized Ribbons can be displayed via other workspaces. The disadvantage of this 
new method is that it is a relatively advanced tool that presents many advanced features 
right away and some confusion is liable to come up for a brand-new user. It is also not ideal 
for longtime users who type, and some veterans in my update classes turn the feature off. 
The Ribbon is the single biggest change to AutoCAD’s user interface and represents a jump 
forward in designer/software interaction, but the ultimate decision to use it is up to you.

Methods 5 and 6: Use the Screen Side Menu and Use a Tablet
These last two methods are rather archaic. Practically no one uses tablets or the screen side 
menu, and some younger users do not even know what they are, since both fell out of favor 
in the 1990s. If you are curious, ask your instructor what a screen side menu is (accessed 
through Options, Display tab). A tablet was a piece of digital input hardware with an 
overlaid command template. It disappeared a long time ago.

Before we try out our basic commands, let us begin a 
list of tips. These are a mix of good ideas, essential 
habits, and time-saving tricks passed along to 
you every once in a while (mostly in the first 
few chapters). Make a note of them as they are 
important. Here is the first, most urgently  
needed one.

Finally in the interest of trying out the Ribbon, 
cascading menus, toolbars, and typing all at once, go 

into the AutoCAD Classic Workspace and remove all toolbars except the three mentioned 
(Draw, Modify, and Standard). Then, using the cascading menus, bring up the Ribbon via 

Figure 1.11 
AutoCAD 2011 Ribbon.

Figure 1.12 
Polygon command and tool tip.

TIP 1:  The Esc (Escape) key in the 
upper left-hand corner of your keyboard is your 

new best friend while learning AutoCAD. It will get 
you out of just about any trouble you get yourself 

into. If something does not look right, just press the 
Esc key and repeat the command. Mine was worn out 

learning AutoCAD, so expect to use it often.
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Tools→Palettes→Ribbon. You should then see the screen in Figure 1.13, with toolbars 
docked, no palettes, and even scroll bars removed (ask your instructor how—we will use far 
more effective pan and zoom methods soon). Review everything learned thus far and proceed 
to the first commands.

1.4  Practicing the create objects commands
Let us try the commands now, one by one. Though it may not be all that exciting, it is 
extremely important that you memorize the sequence of prompts for each command, as 
these are really the ABCs of AutoCAD. Remember: If a command is not working right, or 
you see little blue squares (they are called grips, and we cover them very soon), just press 
Esc to get back to the Command: status line, at which point you can try it over again. All four 
methods of command entry will be presented: typing, cascading menus, toolbar icons, and 
the Ribbon. Alternate each method until you decide which one you prefer. It is perfectly OK 
to use a hybrid of methods.

➤➤ Line

Figure 1.13 
Modified AutoCAD 2011 screen.

Step 1. Begin the Line command via any of the preceding methods.
m AutoCAD says: Specify first point:
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m	 AutoCAD says: Specify next point or [Undo]:

Step 3.	 Move the mouse elsewhere on the screen and left-click again. You can repeat Step 2 as 
many times as you wish. When you are done, click Enter or Esc. You should have a bunch 
of lines on your screen, either separate or connected together, as shown in Figure 1.14.

You need not worry about several things at this point. The first is accuracy; we will introduce 
a tremendous amount of accuracy later in the learning process. The second is the options 
available in the brackets, such as [Undo]; we will cover those as necessary. What is important 
is that you understand how you got those lines and how to do it again. In a similar manner, 
we move on to the other commands.

➤➤ Circle

Figure 1.14 
Lines drawn.

Step 1. Begin the Circle command via any of the preceding methods.
m	 AutoCAD says: Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]:
Step 2. Using the mouse, left-click anywhere on the screen and move the mouse out away 

from that point.
m	 AutoCAD says: Specify radius of circle or [Diameter] <1.9801>:
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Step 3. Notice the circle that forms; it varies in size with the movement of your mouse. The 
value in brackets in the previous step may also be different; left-click again to finish 
the Circle command. Repeat Steps 1 through 3 several times, and your screen should 
look like Figure 1.15.

The method just used to create the circle was called Center, Radius, and you could have 
specified an exact radius size if you wished, by just typing in a value after the first click (try 
it). As you may imagine, there are other ways to create circles—six ways to be precise, as seen 
with the Ribbon and cascading menus (Figures 1.16 and 1.17).

Special attention should be paid to the Center, Diameter option. Often students are asked to 
create a circle of a certain diameter, and they inadvertently use radius. This is less of a problem 
when using the Ribbon or the cascading menus, but you need to watch out if typing or using 
toolbars, as you will need to press d for [Diameter] before entering a value, otherwise guess 
what it will be. We will focus much more on these bracketed options as the course progresses. You 
will get a chance to practice the other circle options as part of the end of chapter exercises.

➤➤ Arc

Figure 1.15 
Circles drawn.
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Step 2.	m AutoCAD says: Specify start point of arc or [Center]:

Take the mouse and left-click anywhere on the screen. This is the first of three points 
necessary for the arc.

Step 3.	m AutoCAD says: Specify second point of arc or [Center/End]:
Click somewhere else on the screen to place the second point.

Step 4.	m Finally AutoCAD says: Specify end point of arc:
Left-click a third, final time, somewhere else on the screen, to finish the arc.

Practice this sequence several more times to fully understand the way AutoCAD places the 
arc. Your screen should look something like Figure 1.18.

The method just used to create the arcs is called 3 Point and, without invoking other 
options, is a rather arbitrary (eyeball) method of creating them, which is just fine for some 
applications. Just as with circles, there are, of course, other ways to create arcs—11 ways to be 
precise, as seen with the Ribbon and cascading menus (Figures 1.19 and 1.20).

Not all of these options are used, and some you will probably never need, but it is worth 
going over them to know what is available. You will get a chance to practice the other arc options 
as part of the end of chapter exercises.

➤➤ Rectangle

Figure 1.16 
Additional circle options 
(Ribbon).

Figure 1.17 
Additional circle options (cascading 
menus).
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Figure 1.18 
Arcs drawn.

Figure 1.19 
Additional arc options 
(Ribbon).

Figure 1.20 
Additional arc options (cascading 
menus).
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Step 1. Begin the Rectangle command via any of the preceding methods.
m	 AutoCAD says: Specify first corner point or [Chamfer/Elevation/

Fillet /Thickness/Width]:
Step 2. Left-click, and move the mouse diagonally somewhere else on the screen.
Step 3.	m AutoCAD says: Specify other corner point or [Area/Dimensions/

Rotation]:
Left-click one more time to finish the command.

You screen should look more or less like Figure 1.21.

There are of course more precise ways to draw a 
rectangle. In Step 3, you can press d for Dimensions 
and follow the prompts to assign length, width, and 
a corner point (where you want it) to your rectangle. 
Try it out, but as with all basic shapes drawn so far, 
do not worry too much about sizing and accuracy, 
just be sure to understand and memorize the 
sequences for the basic command—that is what is 
important for now.

So now you have created the four basic shapes used 
in AutoCAD drawings (and ended up with a lot of 
junk). Let us erase all of them, and get back to a 
blank screen. To do this, we need to introduce Tip 
2, which is quite easy to just type. Notice the use of 
the e abbreviation; we will see more of this as we 
progress.

Figure 1.21 
Rectangles added.

TIP 2:  To quickly erase everything on 
the screen, type in e for “erase,” press Enter, then 
type in all. Then press Enter twice. After the first 

Enter, all the objects are dashed, indicating they were 
selected successfully. The second Enter finishes the 

command by deleting everything. Needless to say, this 
command sequence is useful only in the early stages 

of learning AutoCAD, when you do not intend to  
save what you are drawing. You may want to 

conveniently forget this particular tip when you  
begin to work on a company project. For now  

it is very useful, but we will learn far more selective 
erase methods later.



CHAPTER 1  
AutoCAD Fundamentals Part I 

19

So let us put all of this to good use. Create the drawing shown in Figure 1.22. Use the 
Rectangle, Line, Circle, and Arc commands. Do not get caught up trying to make everything 
line up perfectly, just do a quick sketch. Then you can tell everyone that you learned how to 
draw a house in AutoCAD within the first half hour. Well, sort of.

At this point it is necessary to mention the Zoom and Pan commands. These are very easy if 
you have a mouse with a center wheel (as most PCs do these days).

1.5  View objects
Zoom
Put your finger on the mouse wheel and turn it back and forth without pressing down. The 
house you just created will get smaller (roll back) or larger (roll forward) on the screen. 
Remember though, the object remains the same; you are just zooming in and out.

Pan
Put your finger on the mouse wheel, but this time press and hold. A hand symbol will 
appear. Now move the mouse around while keeping the wheel depressed. You will be able 
to pan around your drawing. Remember again, the drawing is not moving, you are moving 
around it.

Regen
This is the easiest command you will learn. Just type in regen and press Enter. The screen 
will refresh. One use for this is if you are panning over and AutoCAD does not let you go 
further, as if you hit a wall. Simply regen and proceed.

While the mouse method is easiest, there are other ways to zoom and pan. One alternative is 
using toolbars, and part of the Standard toolbar (which you should have on your screen) has 
some Zoom (magnifying glass) and Pan (hand) icons for this purpose, as seen in Figure 1.23.

Figure 1.22 
Simple house sketch.

Figure 1.23 
Zoom and Pan icons.
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Explore the icon options on your own, but one 
particular Zoom option is critically important, 
Zoom, Extents. If you managed to pan your little 
house right off the screen and cannot find it, this 
will come in handy, and a full tip on Zoom, Extents 
is presented next.

What if you did something that you did not want 
to do and wished you could go back a step or two? 
Well, like most programs, AutoCAD has an Undo 
command, which brings us to the fourth tip.

Now that you have drawn your house, leave it on your 
screen and let us move on. We now have to go through 
all the Edit/Modify Objects commands, one by one. 
Each of them is critical to creating even the most basic 
drawings, so go through each carefully, paying close 
attention to the steps involved. Along the way, the 
occasional tip will be added as the need arises.

Just to remind you: The Esc key will get you out of 
any mistakes you make and return you to the basic 
command line. Be sure to perform each sequence 
several times to really memorize it. As you learn the 
first command, Erase, you will also be introduced to 
the picking objects selection method, which will be 
similar throughout the rest of the commands. Also, 
keep a close eye on the command line, as it is where 
you and AutoCAD communicate, and it is a two-way 
conversation.

Finally before you get started, here is another useful 
tip that students usually appreciate early on to save 
some time and effort.

Figure 1.24 
Multiple object selection.

TIP 3:  Type in z for “zoom,” press Enter, 
then type in the letter e, then press  

Enter again. This is called Zoom to Extents and  
makes AutoCAD display everything you sketched, filling 

up the available screen space. If you have a middle-
button wheel on your mouse, then double-click it for 
the same effect. This technique is very important to fit 

everything on your screen.

TIP 4:  To perform the Undo command 
in AutoCAD just type in u and press Enter. Do  
not type the entire command—if you do that,  

more options pop up, which we do not really need  
at this point, so a simple u suffices. You can do  
this as many times as you want to (even to the 

beginning of the drawing session). You can also  
use the standard Undo and Redo arrows shown in 
Figure 1.24. Yes, AutoCAD has a Redo; it was once 
called the Oops command. Oops still exists, but its 
complexity has grown and we do not explore it at 

the moment.

TIP 5:  Hate to keep having to type, 
pull a menu, or click an icon each time you 

practice the same command? Well, no problem. 
Simply press the space bar or Enter, and this will 

repeat the last command you used. There, saved you 
a few minutes per day for that coffee break.
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1.6  Practicing the edit/modify objects commands
➤➤ Erase

Step 1. Begin the Erase command via any of the preceding methods.
m	 AutoCAD says: Select objects:

Step 2. Select any object from the house in the previous drawing assignment (Figure 1.22) 
by taking the mouse, positioning it over that object (not in the empty space), and 
left-clicking once.

Step 3.	m AutoCAD says: Select objects: 1 found
The object becomes dashed. You saw this before when we erased everything in Tip 2. 
It means the objects were selected.

Step 4.	m AutoCAD asks you again: Select objects:
Watch out for this step. AutoCAD always asks this, in case you want to select more objects, 
so get used to it. You are done, however, so press Enter and the object will disappear.

Practice this several times, using the Undo command to bring the object back. Make sure you 
keep it there, since you will need it to practice the next few commands on. You can of course 
select more than one object, as this is the whole point of being asked to select again. As you 
click on each one, it becomes dashed as seen in Figure 1.24. You can do this until you run 
out of objects to select; there is no limit. To deselect any objects, hold down the Shift key and 
click on them.

➤➤ Move

Step 1. Begin the Move command via any of the preceding methods.
m	 AutoCAD says: Select objects:

Step 2. Select an object by positioning the mouse over that object and left-clicking once.
m	 AutoCAD says: Select objects: 1 found
The object becomes dashed.
m	 AutoCAD then asks you again: Select objects:
Unless you have more than one object to move, you are done, so press Enter.

Step 3.	m AutoCAD says: Specify base point or [Displacement] <Displacement>:
That means left-click anywhere on or near the object to “pick it up”; this is where 
you will be moving it from.

Step 4.	m AutoCAD says: Specify second point or <use first point as 
displacement>:
Move the mouse somewhere else on the screen and left-click to place the object in 
the new location. This is where you will be moving it to. Notice that a dashed copy 
of the object remains in its original location until you complete the command.
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Figure 1.25 
Move command in progress.

Undo what you just did and practice it again. Figure 1.25 shows the Move command in progress. 
The dashed circle remains there as a “shadow” until you place your circle in its new location.

➤➤ Copy

Step 1. Begin the Copy command via any of the preceding methods.
m	 AutoCAD says: Select objects:

Step 2. Select an object by positioning the mouse over that object and left-clicking once.
m	 AutoCAD says: Select objects: 1 found
The object becomes dashed.
m	 AutoCAD then asks you again: Select objects:
Unless you have more than one object to copy, you are done, so press Enter.

Step 3.	m AutoCAD says: Specify base point or [Displacement/mOde]
 <Displacement>:
That means left-click anywhere on or near the object to “pick it up”; this is where 
you will be copying it from.

Step 4.	 m AutoCAD says: Specify second point or <use first point as displacement>:
Move the mouse somewhere else on the screen and left-click to copy the object to 
the new location. This is where you will be copying it to. Notice that a dashed copy 
of the object remains in its original location until you complete the command. You 
can copy as many times as you want.

Undo what you just did and practice it again. Figure 1.26 shows the Copy command in 
progress. The dashed circle remains there as a “shadow” until you copy your new circles into 
their new locations.
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➤➤ Rotate

Figure 1.26 
Copy command in progress.

Step 1. Begin the Rotate command via any of the preceding methods.
m	 AutoCAD says: Current positive angle in UCS: ANGDIR = counterclockwise 

ANGBASE = 0, and on the next line: Select objects:
Step 2. Select any object as before, remembering to press Enter again after the selection. So 

far, it is quite similar to Erase, Move, and Copy.
m	 AutoCAD says: Specify base point:
This means select the pivot point of the object’s rotation (the point about which 
it will rotate). If you selected a circle for your object, try to stay away from the 
center point, as your rotation efforts may be less than spectacular. Otherwise, click 
anywhere on or near the object.

Step 3.	m AutoCAD says: Specify rotation angle or [Copy/Reference] <0>:
Move the mouse around in a wide circle and the object also rotates. Notice how the 
motion gets smoother as you move the mouse farther away. You can click anywhere 
for a random rotation angle or you can type in a specific numerical degree value.

Figure 1.27 shows the Rotate command in progress.

➤➤ Scale
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Figure 1.27 
Rotate command in progress.

Step 1. Begin the Scale command via any of the preceding methods.
m	 AutoCAD says: Select objects:

Step 2. Select any object as before, remembering to press Enter again after the first selection.
Step 3.	m AutoCAD says: Specify base point:

This means select the point from which the scaling of the object (up or down) will 
occur. For now, click somewhere on or near the object or directly in the middle of it.

Step 4.	m AutoCAD says: Specify scale factor or [Copy/Reference] <1.000>:
Move the mouse around the screen. The object will get bigger or smaller. You can 
randomly scale it or enter a numerical value. For example, if you want it twice as big, 
enter 2; half size will be .5.

Figure 1.28 shows the Scale command in progress.

➤➤ Trim

To practice this command you first need to draw two intersecting lines, one horizontal and 
one vertical, similar to a plus sign. Once this is done, go ahead and perform the sequence 
that follows.
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Step 1. Begin the Trim command via any of the preceding methods.
m	 AutoCAD says:
Current settings: Projection = UCS, Edge = None
Select cutting edges...
Select objects or <select all>:

Step 2. Using the mouse, left-click on one of the lines. You can choose the vertical or 
horizontal, it does not matter. This is your cutting edge. The other line, the one you 
did not pick, will be trimmed at the intersection point of the two lines. The cutting 
edge line becomes dashed.
m	 AutoCAD says: Select objects or <select all>: 1 found
Press Enter.

Step 3.	m AutoCAD says: Select object to trim or shift-select to extend 
or[Fence/Crossing/Project/Edge/eRase/Undo]:
Go ahead and pick anywhere on the line that you did not yet select and it will be 
trimmed.

You can repeat Step 3 as many times as you want, but we are done, so press Enter. Practice 
this several times by pressing u then Enter and repeating Steps 1 through 3. Remember two 
things to avoid mistakes: Pick the cutting edge first, and do not forget to press Enter before 
picking the line to be chopped.

You can also do a trim between two or more lines, as shown in Figure 1.29. This is 
something we need in the first major project, so practice both types of trims. In both cases, 
the lines selected as cutting edges are now dashed, and the lines about to be trimmed have 
the cursor (small box) over them.

➤➤ Extend

Figure 1.28 
Scale command in progress.

To practice this command, we first need to draw two intersecting lines, just as for trim, 
but then use the Move command to relocate the vertical line directly to the right of the 
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horizontal line, a short distance away, so we can extend the horizontal line into the vertical. 
Once this is done, go ahead and perform the Extend command.

Step 1. Begin the Extend command via any of the preceding methods.
m	 AutoCAD says:
Current settings: Projection = UCS, Edge = None
Select boundary edges...
Select objects or <select all>:

Step 2. At this point, left-click the vertical line. This is the target into which you will extend 
the horizontal line. It becomes dashed.
m	 AutoCAD says: Select objects: 1 found
Press Enter.

Step 3.	m AutoCAD says: Select object to extend or shift-select to trim or 
[Fence/Crossing/Project/Edge/Undo]:
Go ahead and pick the end of the horizontal line that is closest to the vertical line. It 
is the arrow that will extend into the vertical line target.

Figure 1.29 
Trim commands in progress.

Figure 1.30 
Extend command in progress.
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Step 4. You can repeat Step 3 as many times as you want, but we are done, so press Enter. Practice 
this several times by pressing u then Enter and repeating Steps 1 through 3. In Figure 1.30, 
the dashed vertical line is the “target” and the solid horizontal line is the “arrow.” The 
cursor (box) is positioned to extend the arrow into the target by clicking once.

➤➤ Offset

This command is one of the more important ones you will learn. Its power lies in its 
simplicity. This command creates new lines by the directional parallel offset concept, where 
if you have a line on your screen, you can create a new one that is a certain distance away 
but parallel to the original. To illustrate it, first draw a random vertical or horizontal line 
anywhere on your screen.

Step 1. Begin the Offset command via any of the preceding methods.
m	 AutoCAD says: Specify offset distance or [Through/Erase/Layer] 

<Through>:
Step 2. Enter an offset value (use a small number for now, 2 or 3). Then press Enter.
Step 3.	m AutoCAD say: Select object to offset or [Exit/Undo] <Exit >:

Pick the line by left-clicking on it; the line becomes dashed.
m	 AutoCAD says: Specify point on side to offset or [Exit/Multiple/

Undo] <Exit>:
Step 4. Pick a direction for the line to go, which will be one of the two sides of the original 

line. You can keep doing this over and over by selecting the new line and then the 
direction (see Figure 1.31). If you want to change the offset distance, you must repeat 
Steps 1 through 3.

The significance of the Offset command may not be readily apparent. Many students, 
especially ones that may have done some hand-drafting, come into learning AutoCAD with 
the preconceived notion that it is just a computerized version of pencil and paper. While 

Figure 1.31 
Offset command in progress.
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this is true in many cases, in others, AutoCAD represents a radical departure. When you 
begin a new drawing on paper, you literally draw line after line. With AutoCAD, surprisingly 
little line drawing occurs. A few are drawn, and then the Offset command is employed 
throughout. Learn this command well, you will need it.

➤➤ Mirror

Figure 1.32 
Mirror command in progress.

This command, much as the name implies, creates a mirror copy of an object over some 
plane. It is surprisingly useful because often just copying and rotating is not sufficient or 
takes too many steps. To learn this command, you have to think of a real-life mirror, with 
you standing in front of it. The original object is you, the plane is the door with the mirror 
attached (which can swing on a hinge), and the new object is your mirrored reflection. To 
practice this command, draw a triangle by joining three lines together, as seen in Figure 1.32.

Step 1. Begin the Mirror command via any of the preceding methods.
m	 AutoCAD says: Select objects:

Step 2. Select all three lines of the triangle and press Enter.
m	 AutoCAD says: Specify first point of mirror line:

Step 3. Click anywhere near the triangle and move the mouse around. You will notice the new 
object appears to be anchored by one point. This is the swinging mirror reflection.
m	 AutoCAD says: Specify second point of mirror line:

Step 4. Click again near the object (make the second click follow an imaginary straight 
line). You will notice the new object disappear. Do not panic; rather check what the 
command line says.
m	 AutoCAD says: Delete source objects? [Yes/No] <N>:

Step 5. The response in Step 4 just asked you if you want to keep the original object. If you 
do (the most common response), then just press Enter and you are done. Figure 1.32 
illustrates Step 3.
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➤➤ Fillet

Fillets are all around us. This is not just an AutoCAD concept but rather an engineering 
description for a rounded edge on a corner of an object or at an intersection of two objects. 
These edges are added to avoid sharp corners for safety or other technical reasons (such as a 
weld). By definition, a fillet needs to have a radius greater than zero, but in AutoCAD a fillet 
can have a radius of zero, allowing for some useful editing, as we see soon. To illustrate this 
command, first draw two perpendicular lines that intersect.

Step 1. Begin the Fillet command via any of the preceding methods.
m	 AutoCAD says:
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]:

Step 2. Let us put a radius on the fillet. Type in r for “radius” and press Enter.
m	 AutoCAD says: Specify fillet radius <0.0000>:
Enter a small value, perhaps 0.5 or 1. Press Enter.

Step 3.	m AutoCAD says: Select first object or [Undo/Polyline/Radius/Trim/
Multiple]:
Select the first (horizontal) line, somewhere near the intersection. It becomes 
dashed.

Step 4.	m AutoCAD says: Select second object or shift-select to apply corner:
Select the second (vertical) line, somewhere near the intersection. The lines have a 
fillet added to them of the radius you specified.

These are the steps involved in adding a fillet with a radius. You can also do a fillet with a 
radius of zero, so repeat Steps 1 through 4, entering 0 for the radius value. This is very useful 
to speed up trimming and extending. Intersecting lines can be filleted to terminate at one 
point, and if they are some distance apart, they can be filleted to meet together. All this is 
possible with a radius of zero. Try it. Figure 1.33 summarizes everything described so far. The 
1 and 2 indicate a suggested order of clicking the lines for the desired effect.

Well, this is it for now. We covered the basic commands. These commands form the basis 
of what we call basic CAD theory. All 2D computer-aided design programs need to be 
able to perform these functions in order to work, though other software may refer to them 
differently, such as Displace instead of Move or Join instead of Extend. Be sure to memorize 

Figure 1.33 
Fillet command summary.
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these commands and practice them until they become second nature. They are truly the 
ABCs of basic computer drafting, their importance cannot be overstated, and you need to 
master them to move on.

1.7  Selection methods
Before we talk about the accuracy tools available to you, we need to briefly cover a more 
advanced type of selection method called Window/Crossing. You may have already seen 
this by accident: When you click randomly on the screen without selecting any objects and 
drag your mouse to the right or left, a rectangular shape forms. It is either dashed or solid 
(depending on settings, these shapes may have a green or blue fill) and goes away once you 
click the mouse button again or press Esc. This happens to be a powerful selection tool.

l	 Crossing: A crossing appears when you click and drag to the left of an imaginary vertical 
line (up or down) and is a dashed rectangle. Any object it touches will be selected.

l	 Window: A window appears when you click and drag to the right of an imaginary vertical 
line (up or down) and is a solid rectangle. Any object falling completely inside it will be 
selected.

Figure 1.34 shows what both the Crossing and the Window look like. Practice selecting 
objects in conjunction with the Erase command. Draw several random objects, start up the 
Erase command, and instead of picking each one individually (or doing “erase, all”), select 
them with either the Crossing or Window and make a note of how each functions. This is a 
very important and useful selection method.

1.8  Drawing accuracy—Part 1
Ortho (F8)
So far, when you created lines, they were not perfectly straight. Rather, you may have lined 
them up by eye. This of course is not accurate enough for most designs, so we need a better 
method. Ortho (which stands for “orthographic”) is a new concept we now introduce that 
allows you to draw perfectly straight vertical or horizontal lines. It is not a command but 
rather a condition you impose upon your lines prior to starting to draw them. To turn on 
the Ortho feature just press the F8 key at the top of your keyboard, or click to depress the 
ORTHO button at the bottom of the screen. Then begin drawing lines. You will see your 
mouse cursor constrained to only vertical and horizontal motion. Ortho is usually not 
something you just set and forget about, as your design may call for a varied mix of straight 
and angled lines, so do not be shy about turning the feature on and off as often as necessary, 
and sometimes right in the middle of drawing a line.

Figure 1.34 
Crossing/Window.
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1.9  Drawing accuracy—Part 2
OSNAPs
While drawing straight lines, we generally like those lines to connect to each other in a very 
precise way. So far we have been eyeballing their position relative to each other, but that is 
not accurate and is more reminiscent of sketching, not serious drafting. Lines (or for that 
matter all fundamental objects in AutoCAD) connect to each other in very distinct and 
specific locations (two lines are joined end to end, for example). Let us develop these points 
for a collection of objects.

ENDpoint
These are the two locations at the ends of any line. Another object can be precisely attached 
to an endpoint. The symbol for it is a square, as illustrated in Figure 1.35.

Figure 1.35 
Endpoints.

MIDpoint
This is the middle of any line. Another object can be precisely attached to a midpoint. The 
symbol for it is a triangle, as illustrated in Figure 1.36.

Figure 1.36 
Midpoint.

CENter
This is the center of any circle. Another object can be precisely attached to a center point. The 
symbol for it is a circle, as illustrated in Figure 1.37.

Figure 1.37 
Center.
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QUADrant
These are the four points at the North (90°), West (180°), South (270°), and East (0°, 
360°) quadrants of any circle. Another object can be precisely attached to a quadrant point. 
The symbol for it is a diamond, as illustrated in Figure 1.38.

Figure 1.38 
Quadrants.

Figure 1.39 
Intersection.

Figure 1.40 
Perpendicular.

INTersection
This is a point that is located at the intersection of any two objects. You may begin a line or 
attach any object to that point. The symbol for it is an X, as illustrated in Figure 1.39.

PERPendicular
This is an OSNAP point that allows you to begin or end a line perpendicular to another line. 
The symbol for it is the standard mathematical symbol for a perpendicular (90°) angle, as 
illustrated in Figure 1.40.

These are the six fundamental OSNAP points we mention for now. There are others of 
course, such as Node, Extension, Insertion, Tangent, Nearest, Apparent Intersection, and 
Parallel, but those are used far less often, and with the exception of Near and Node, they are 
not discussed in detail.
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So how do you use the OSNAPs that we developed so far? There are two methods. The first 
is to type in the OSNAP point as you need it. For example, draw a line. Then, begin drawing 
another line, but before clicking to place it, type in end and press Enter. AutoCAD adds the 
word of, at which point you need to move the cursor to roughly the end of the first line. The 
snap marker for endpoint (a square) appears, along with a tool tip stating what it is. Click to 
place the line; now your new line is precisely attached to the first line.

In the same manner, try out all the other snap points mentioned (draw a few circles to practice 
Quad and Center). In all cases, begin by typing line, then one of the snap points, followed by 
Enter. Then bring the mouse cursor to the approximate location of that point and click.

1.10  Osnap drafting settings
As you may imagine, there is a faster way to use OSNAP. The idea is to have these settings 
always running in the background so you need not type them in anymore. To set them up, 
you need to type in osnap or select Tools→Drafting Settings… from the cascading overhead 
menu. The OSNAP dialog box appears. First, make sure the Object Snap tab is selected 
from the four available, then select the Clear All button, finally check off the six settings 
mentioned previously, and press OK.

So now you have set the appropriate settings, but you still need to turn them on. For that 
we need to mention another F key. If you press F3 or press the OSNAP toggle button at the 
bottom of the screen, the OSNAP settings become active. Go ahead and do this, then begin 
the same line drawing exercise; see how much easier it is now as the snap settings appear on 
their own. This is the preferred way to draw, with them running in the background. Feel free 
to press F3 anytime you do not need them anymore; OSNAP is also not something that you 
may want all the time. Figure 1.41 shows the Drafting Settings dialog box, with the discussed 
OSNAP points checked.

Figure 1.41 
OSNAP dialog box.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 2:

l	 Create Objects
m	 Line
m	 Arc
m	 Circle
m	 Rectangle

l	 Edit/Modify Objects
m	 Erase
m	 Move
m	 Copy
m	 Rotate
m	 Scale
m	 Trim
m	 Extend
m	 Offset
m	 Mirror
m	 Fillet

l	 View Objects
m	 Zoom
m	 Pan
m	 Regen

l	 AutoCAD drawing environment
m	 Drawing Area, Command Line, Cascading Menus, Toolbars, Ribbon

l	 Selection methods
m	 Direct Object Selection
m	 Select: All
m	 Crossing
m	 Window

l	 Ortho (F8)
l	 Osnap (F3)

m	 ENDpoint
m	 MIDpoint
m	 CENter
m	 QUADrant
m	 INTersection
m	 PERPendicular

Additionally, you should understand and know how to use the following tips introduced in 
this chapter before moving on to Chapter 2:

TIP 1: The Esc (Escape) key in the upper left-hand corner of your keyboard is your new  
best friend while learning AutoCAD. It will get you out of just about any trouble  
you get yourself into. Mine was worn out learning AutoCAD, so expect to use it  
often.

TIP 2: To quickly erase everything on the screen, type in e for “erase,” press Enter, then type 
in all. Then press Enter twice. After the first Enter, all the objects will be dashed, 
indicating they were selected successfully. The second Enter finishes the command by 
deleting everything.

TIP 3: Type in z for “zoom,” press Enter, then type in the letter e, then press Enter again. This 
is called Zoom to Extents and makes AutoCAD display everything you sketched, filling 
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up the available screen space. If you have a middle-button wheel on your mouse, then 
double-click it for the same effect. This technique is very important to fit everything 
on your screen.

TIP 4: To perform the Undo command in AutoCAD just type in u and press Enter. Do not 
type the entire command—if you do that, more options pop up, which we do not 
really need at this point, so a simple u suffices. You can do this as many times as you 
want to (even to the beginning of the drawing session). You can also use the standard 
Undo and Redo arrows shown in Figure 1.24.

TIP 5: Hate to keep having to type, pull a menu, or click an icon each time you practice the 
same command? Well, no problem. Simply press the space bar or Enter, and this will 
repeat the last command you used.

Review Questions
Answer the following based on what you learned in Chapter 1.

1.	 List the four Create Objects commands covered.

2.	 List the ten Edit/Modify Objects commands covered.

3.	 List the three View Objects commands covered.

4.	 What four main methods are used to issue a command in AutoCAD?

5.	 What is the difference between a selection Window and Crossing?

6.	 What is the name of the command that forces lines to be drawn perfectly straight horizontally and 
vertically? Which F key activates it?

7.	 What six main OSNAP points are covered? Draw the snap point’s symbol next to your answer.

8.	 What command brings up the OSNAP dialog box?

9.	 Which F key turns the OSNAP feature on and off?

Exercises
1.	 Draw the following sets of lines (in bold on left) and practice the 2-Point, 3-Point, and the Tan, Tan, 

Tan circle options. You may use the Ribbon, cascading menus, or typing. In all cases use OSNAPs to 
connect the circle precisely to the drawn lines. The result you should get is shown in dashes on the 
right. (Difficulty level: Easy; Time to completion: 5 minutes)
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2.	 Draw an arc using the Start, Center, End option (a commonly used one) as follows. First draw the 
three lines shown in bold on the left, then the arc. Be sure to use OSNAPs. The result you should get 
is shown in dashes on the right. (Difficulty level: Easy; Time to completion: 5 minutes)

3.	 Draw a simple door using the 3-Point arc method. First draw, copy, rotate, and position the lines as 
seen in Steps 1 through 3, then add the arc as shown in Step 4 (use Ortho and OSNAPs throughout). 
You may have to try it a few times to get it to look right. Finally, erase the bottom line. (Difficulty level: 
Easy; Time to completion: 5 minutes)

4.	 Draw the following sets of electrical connection shapes. You will need only the basic Create and 
Modify commands, including Rectangle, Circle, Line, Offset, Fillet, and Mirror, as well as OSNAPs 
and Ortho. Specific sizes are not important, but make your drawing look similar, and use accuracy in 
connecting all the pieces. (Difficulty level: Easy; Time to completion: 15 minutes)
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5.	 Draw the following house elevation using what you learned. You will need only the basic Create and Modify 
commands. The overall sizing can be approximated; however, use Ortho (no crooked lines) and make sure 
all lines connect using OSNAPs. (Difficulty level: Intermediate; Time to completion: 15 minutes)

6.	 Draw the following sets of shapes. You will need only the basic Create and Modify commands, but 
you will use almost every one of them, including multiple cutting edges trim. The overall sizing is 
completely arbitrary, and your design may not look exactly like this one, but be sure to draw all the 
elements you see here and use OSNAP precision throughout. (Difficulty level: Intermediate; Time to 
completion: 15 minutes)
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7.	 Draw the following side view of a car using what you learned. You will need only the basic Create 
and Modify commands. The overall sizing (including multiple fillets needed on most corners) can be 
approximated; however, use accuracy and make sure all lines connect using OSNAPs. (Difficulty level: 
Intermediate; Time to completion: 20 minutes)
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CHAPTER

AutoCAD Fundamentals  
Part II

LEARNING OBJECTIVES
You learned a great deal in the first chapter, in fact almost everything you need to get 
started drafting a design. This chapter serves as a “clean up” and concludes the basic 
introduction to AutoCAD, as there are just a few more topics to get to. Here, we discuss 
the following:
l	 Using grips
l	 Setting units
l	 Using Snap and Grid
l	 Understanding the Cartesian coordinate system
l	 Distance entry tools:

m	 Direct Distance Entry
m	 Relative Distance Entry
m	 Dynamic Distance Entry

2
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By the end of the chapter you will have learned the necessary basics to begin drafting  
an architectural floor plan; after an introduction to layers in Chapter 3, you will begin  
to do so.

Estimated time for completion of chapter: 2 hours.

2.1  Grips
Let us begin Chapter 2 with grips, a natural progression from learning the OSNAP points. 
These are relatively advanced editing tools, but chances are you already made them appear 
by accident by clicking an object without selecting a command first. That is OK; just press 
Esc and they go away. But what are these mysterious blue squares? Take a close look; after 
learning OSNAPs, these should look familiar.

Grips are control points, or locations on objects where you can modify that object’s size, 
shape, or location. (They are quite similar to the “handles” that you find in Photoshop® or 
Illustrator® if you ever used those applications.) Try them out by clicking on any line, circle, 
arc, or rectangle (as in Figure 2.1). The form becomes dashed and the grips pop up. When 
your mouse hovers over one of them, the grip turns pink. If you click on it, it becomes red, 
meaning it is active (or hot). Now move the mouse around. The object changes in one of 
several ways. A line or circle can be moved around if the center grip is selected. A circle can 
be scaled up or down in size if the outer quadrants are selected. Arcs can be made larger or 
their length increased. Other grips, such as the endpoints of a line or corners of a rectangle, 
change (or stretch) the shape of that object if activated and moved.

2.2  Units and scale
We have not yet talked about any sort of drawing units such as feet, inches, or centimeters. 
When you practiced the Offset command, you entered a value, such as 2 or 3, but what did 
it mean? Well, as you inadvertently discovered, the default unit system in AutoCAD (until 

l	 Inquiry commands:
m	 Area
m	 Dist
m	 List
m	 ID

l	 Explode command
l	 Polygon command
l	 Ellipse command
l	 Chamfer command
l	 Templates
l	 Setting limits
l	 Save
l	 Help files
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you change it) is a simple decimal system of the type we use in everyday life. However it 
is unitless, meaning that the 2 or 3 you entered could have been anything, including feet, 
inches, yards, meters, miles, or millimeters. Think about it; it is an easy and powerful idea, 
but it is up to you to set the frame of reference and stick to it. So if you are designing a city 
and 1 is equal to a mile, then 2 is two miles and 0.5 is half a mile. AutoCAD does not care; 
it gives you a system and lets you adapt it to any situation or design. Then you just draw in 
real-life units or, as we say in CAD, 1-to-1 units. This is the Golden Rule of AutoCAD. Always 
draw everything to real-life size. Do not scale objects up or down.

A decimal system of units is OK for many engineering applications, but what about 
architecture? Architects prefer their distances broken down to feet and inches, because it 
is always easier to understand and visualize a distance of 22-6 than 270. To switch to 
architectural units, type in units and press Enter, or select Format→Units… from the 
cascading menus, and the dialog box in Figure 2.2 appears.

Simply select Architectural from the drop-down menu at the upper left and ignore the rest of 
the options in the dialog box; there is no need to change anything else at this point. Now, as 
you draw and enter in units, they will be recognized as feet or inches. To enter in 5 feet (such 
as when using the Offset command), type 5. To enter in 5 inches, there is no need for an 
inch sign, just type in the number 5; AutoCAD will understand. To mix feet and inches, type 
in 56, which is of course 5-6; there is no need for a dash either.

Figure 2.1 
Grips on circles, rectangles, arcs, and lines.
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2.3  Snap and grid
These two concepts go hand in hand. The idea here is to set up a framework pattern on the 
screen that restricts the movement of the crosshairs to predetermined intervals. That way, 
drawing simple shapes is easy because you know that each jump of the mouse on the screen 
is equal to some preset unit. Snap is the feature that sets that interval, but you need the  
grid to make it visible. One without the other does not make sense, and usually they are set 
equal to each other. Snap and Grid are not used that often in the industry, but it is a great 
learning tool and we will do some drawings at the end of this chapter using them. It also 
helps knowing about this feature, as it is often inadvertently activated by pressing the Snap 
or Grid buttons at the bottom of the screen.

To Set Snap
Type in snap.

m	 AutoCAD say: Specify snap spacing or [ON/OFF/Aspect/Style/Type] <0−0 
1/2>:

Type in 1, setting the Snap to 1 inch.

Figure 2.2 
The Drawing Units dialog box.
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TO Set Grid
Type in grid.

m	 AutoCAD say: Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/ 
Limits/Follow/Aspect] < 0−0 1/2>:>:

Type in 1, setting the grid to 1 inch.

The Snap and Grid are now set, though you may have to Zoom to Extents (Tip 3) to see 
everything. In previous versions of AutoCAD, the grid was hard-to-see dots. In AutoCAD 
2011, it is reminiscent of graph paper, as seen in Figure 2.3. Try drawing a line; you will 
notice right away that the cursor “jumps” according to the intervals you set. F9 turns Snap 
on and off, while F7 takes care of Grid, and you can always toggle back and forth using the 
drawing aids buttons at the bottom of the screen. Figure 2.3 is a screen shot of Snap and 
Grid in use while drawing a simple shape.

2.4  Cartesian coordinate system
AutoCAD, and really all CAD programs, rely on the concepts of axes and planes to orient 
the drawings in space. In 2D drafting, you are always drawing somewhere on AutoCAD’s X-Y 
plane, which is made up of the intersections of the X and Y axes. When you switch to 3D, 
the Z axis is made visible to allow drawing into the third dimension. The X, Y, and Z axes are 
part of the Cartesian coordinate system, and we need to briefly review this bit of basic math, 
then illustrate exactly why it is helpful to know it. Figure 2.4 illustrates the 2D coordinate 
system, made up of the X and Y axis and numbered as shown.

Figure 2.3 
Figure drawn with Snap and Grid.
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This system is important not only because you may want to know where in space your 
drawing is, but so you can create objects of a given size by entering their X and Y values. 
Moreover, we refer to this system often for a variety of other construction needs and distance 
entries, including inserting drawings into the point 0,0, so review it to familiarize yourself 
with it again, as likely you may not have seen this in a while. Next, we introduce the various 
distance entry tools. Whether you choose to use manual distance inputs or the newer 
“dynamic” methods, knowing the Cartesian coordinate system will help you understand 
what is going on.

2.5  Distance entry techniques
AutoCAD has a number of precise ways to enter distances and angles and thereby create 
initial layouts. These techniques come in two flavors: the older “manual” method, where you 
enter data via keyboard, and the newer “dynamic” method, where you enter the values on 
the screen via what is known as a heads-up display. Most students probably gravitate toward 
the newer method, and indeed it offers many advantages, not the least of which is faster data 
input. We consider this the primary method in this text, and present the manual method 
only as an alternate, though in at least one case, it is a bit more straightforward.

Direct Distance and Angle Entry
Erase anything that may be on your screen and turn off all drawing aids, including Snap, 
Grid, and anything else you may have on. Now press the DYN drawing aid, as seen in 
Figure 2.5.

This dynamic input allows you to specify distances and angles directly on the screen. 
Begin drawing a line and you will see the display in Figure 2.6, though of course your values 
may be different.

Notice what AutoCAD is allowing you to do. The 7.9361 value in Figure 2.6 is surrounded 
by a box, meaning it is editable. All you have to do is enter a desired value, so enter a small 

Figure 2.4 
The Cartesian coordinate system.
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value such as 5, but do not press Enter yet. What if you wanted to change the angle of the 
line? Simply press the Tab key and tab over to the 32 degree value, and enter something else, 
perhaps a 45. Then, finally press Enter; your line 5 units long at 45 degrees is done. The line 
command continues of course and you can repeat this as much as needed.

Using the manual method, you can do the same exact thing without the DYN input. Simply 
click the line anywhere, point the mouse in the direction you want the line to go, and enter 
a value on the keyboard. If all lines are at right angles (90°) to each other, then leave Ortho 
on and “stitch” your way around by just pointing and clicking. This is a very useful method 
after you do a basic room or building survey and return to the office to enter the data into 
AutoCAD. You can also enter data one click at a time by following the coordinate points. 
Begin the line command, then instead of clicking, type in the following values, pressing 
Enter after each one:

0, 0 0, 2 2, 2 2, 4 4, 4 4, 2 6, 2 6, 0 then c for “close”

These are the X and Y values for the lines to follow; and if you typed correctly, then the shape 
in Figure 2.7 should emerge on your screen.

This is a rather slow method of entering data, but it is good for practice and to really 
understand the Cartesian points. We do not use this regularly in actual design work.

Relative Distance and Angle Entry
Relative distance frees you from the 0,0 point and allows you to draw any rectangular shape 
of any size, anywhere on the screen. With dynamic input, this makes little difference, 
as seen next. To draw a 5  3 rectangle, make sure DYN is on, begin the command, and 
click anywhere to start the rectangle. You will see fields to enter the values for the height 

Figure 2.5 
Dynamic input.

Figure 2.6 
Dynamic input while drawing a line.
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and width (Figure 2.8). The upper right corner of the rectangle is not visible because the 
crosshairs obscure part of it.

As before, enter a new value in the first text field (5) and Tab over to the next field, entering 
the other value (3). As you press Enter, the 5  3 rectangle is set.

Using the manual method, you can do the same exact thing without the DYN input, and 
it may even be a bit faster, but you do have to learn a new trick. The @ sign is what frees 
you from 0,0 so you need to enter it prior to the values. Turn off the DYN, and begin the 
Rectangle command as before by clicking anywhere. Then type in the following: @5,3 and 
press Enter. The same 5  3 rectangle appears. The manual method is sometimes preferred in 
this one type of shape creation.

Now that you know about the @ symbol and what it does, you can also draw lines at an angle 
using the manual method, something that was briefly ignored in the manual Direct Distance 
Entry discussion. You will however need to add a new symbol, <, to indicate the angle. The 
format is as follows: @Distance<Angle. Therefore, to create a line that is 10 units long at 
45°, you start the Line command and type in: @10<45.

As you can see, the dynamic input is preferred and recommended, but it is still good to 
know about the manual methods if you just need a quick shape drawn or if you are stuck on 
a computer with an older version of AutoCAD—still very much a possibility.

Figure 2.8 
Dynamic input while drawing a rectangle.

Figure 2.7 
Point-by-point distance entry.
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Dynamic input, meanwhile, can be used for just about anything, including the basic 
commands you have learned thus far, as described next.

Other Uses of DYN
While most users turn on DYN when they need to enter data for basic line work and shapes, 
its use extends out to just about any shape on which you work. Figure 2.9 shows DYN with 
an arc (a) and a circle (b).

You may have noticed also that some of the “heads up” menus show a down arrow. You 
can use the down arrow on your keyboard to drop down the menu and reveal other menu 
choices, which of course mimic what is available in the parentheses on the command line. 
Figure 2.10 is one example with the Offset command.

Figure 2.9 
Dynamic input while drawing an arc (a) or a circle (b).

Figure 2.10 
Dynamic input with extra menus on offset.
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Figure 2.11 
Inquiry toolbar.

It is up to you if you would like to use the DYN feature throughout your lessons in AutoCAD; 
in fact, it is recommended in some situations. However, it is not good for getting a point 
across in a textbook, as this information tends to add clutter and lessen clarity in screen 
shots, obscuring the main message, so you will not see it much from here on.

2.6  Inquiry commands
Our next topic in AutoCAD fundamentals is the Inquiry commands set. These were upgraded 
in AutoCAD 2010, but the fundamental Inquiry tools remain area, distance, list, and ID. 
You can also now measure the radius, angle, volume, and mass properties, but the last two 
are not covered. All these commands provide information in one form or another and 
are indispensable in a sophisticated drawing. The Area command is particularly useful to 
architects and interior designers, to get areas of rooms and spaces, and we start with it. All 
commands, as before, can be accessed through the usual four ways: typing, cascading menus, 
toolbars, and the Ribbon. The toolbar used is the Inquiry toolbar, as seen in Figure 2.11, and 
should be brought up on screen using the right-click method described in Chapter 1.

➤➤ Area

Area calculations are performed in two ways: either on an object or, more commonly, point 
by point (such as the area of a room). Draw a rectangle of any size, and we will go over both 
methods, although with a rectangle, you would use only the Object method, saving the 
point-by-point method for a more complex floor plan.

Point by point
This is used when measuring an area defined by individual lines (not an object).

Step 1. Make sure your units are set to Architectural, and you have a rectangle on your screen.
Step 2. Begin the Area command via any of the methods described in Chapter 1.

m  AutoCAD says: Specify first corner point or [Object/Add area/
Subtract area] <Object>:

Step 3. Activate your OSNAPs (F3), and click your way around the corners of the rectangle 
until the green shading covers the entire area to be measured (four clicks total).
m  AutoCAD says several lines to you:
Specify next point or [Arc/Length/Undo]:
Specify next point or [Arc/Length/Undo]:
Specify next point or [Arc/Length/Undo/Total] <Total>:
Specify next point or [Arc/Length/Undo/Total] <Total>:
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Figure 2.12 
Angle (a) and Radius (b) measurements.

Step 4. When done, press Enter, and you get a total for area and perimeter. Mine said:
Area = 67.9680, Perimeter = 34.2044
Yours almost certainly says something different.

Object
This is used when you have an object (not an area defined by individual lines) to measure.

Step 1. Begin the Area command via any of the previous methods.
m  AutoCAD says: Specify first corner point or [Object/Add area/
Subtract area] <Object>:

Step 2. Press the letter o for object.
m  AutoCAD says: Select objects:

Step 3. Select the square and you get the same area and perimeter measurements.

Practice the radius and angle measurements on your own. They are quite straightforward 
in process: start up the command, select the lines of the rectangle for the angle, getting the 
information seen in Figure 2.12(a), or select a circle you have drawn and get the information 
seen in Figure 2.12(b). DYN activates as you do this (even if you do not have it on).

➤➤ Distance

The Distance command gets you the distance between any two points. Although we practice 
on the corners of a rectangle, the command works on any two points, as selected by a mouse 
click, even an empty space.

Step 1. Make sure your units are set to Architectural, a rectangle is on your screen, and your 
OSNAPs are activated.
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Figure 2.13 
Distance command results via toolbar or Ribbon.

Step 2. Begin the Distance command via any of the previous methods. (See the note that 
follows Step 4.)
m  AutoCAD says: Specify first point:

Step 3. Select a corner of the rectangle.
m  AutoCAD says: Specify second point or [Multiple points]:

Step 4. Select the other corner across the rectangle. AutoCAD then gives you some 
information. Mine said:
Distance = 13.5521, Angle in XY Plane = 0, Angle from XY Plane = 0
Delta X = 13.5521, Delta Y = 0.0000, Delta Z = 0.0000
Yours will say something different.

Note: There is an important difference in procedures if you use the icons or the Ribbon. In 
those cases, DYN activates and you get a graphical representation of the distance, as seen in 
Figure 2.13. If you type or use cascading menus, then you get the command line results seen 
in Steps 1 through 4.

➤➤ List

The List command gives you information about not just the geometric properties of the 
object but also its CAD properties, such as what layer it is on, the subject of the next chapter. 
It is an extremely useful command that clues you in on what you are looking at (whether a 
beginner or an expert, you will sometimes ask yourself this question).

Step 1. Make sure you have something on your screen to investigate.
Step 2. Begin the List command via any of the previous methods.

m  AutoCAD says: Select objects:
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Figure 2.14 
List command.

Select your object (it becomes dashed) and press Enter. The command line pops up 
in mid-screen. Look it over and close it (X, upper right) when done. What mine said 
about the rectangle is shown in Figure 2.14.

➤➤ ID

This command is the simplest of all. It tells you the coordinates of a point in space, such as 
the intersection of two lines. This is useful for inserting blocks (to be covered later) and just 
plain old figuring out the general location of a design, something needed for Xrefs way ahead 
in advanced chapters.

Step 1. Make sure you have something on your screen to ID.
Step 2. Begin the ID command via any of the previous methods.

m  AutoCAD says: Specify point:
Step 3. Using OSNAPs select a point, such as the corner of a rectangle. AutoCAD gives you 

the X, Y, and Z coordinates. Here is what I got; you will get different values:

X = 11.1504 Y = 6.7753 Z = 0.0000

This concludes the section on Inquiry commands. We are now in the home stretch and will 
explore some commands that do not quite fit in anywhere else.
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Figure 2.15 
Unexploded and exploded rectangles, side  
by side.

Explode is used to make complex objects simpler. That means a rectangle becomes four 
separate lines, and other objects we have yet to study (blocks, Mtext, dimensions, hatch) are 
simplified into their respective components. This command is mentioned in almost every 
chapter, as virtually all AutoCAD entities can be exploded and many should never be. To try 
it out, we yet again need a rectangle of any size. Make sure you are using the actual Rectangle 
command, not just four lines.

Step 1. Begin the Explode command via any of the previous methods.
m  AutoCAD says: Select objects:

Step 2. Pick the rectangle and it becomes dashed.
m  AutoCAD says: 1 found
Press Enter and the rectangle will be exploded. Click any of its lines and you will 
notice the line is independent, as seen in Figure 2.15. Keep in mind that you cannot 
explode circles, arcs, and lines, as those are already the simplest objects possible. 
There is a way to reverse Explode (besides an immediate Undo), but it applies to 
only simple compound objects, such as a rectangle. If you explode a hatch pattern 
and save your work, that is it, no going back. This is why you will see appropriate 
warnings when we get to those chapters.

➤➤ Polygon

2.7 Miscellaneous  topics
➤➤ Explode

The Polygon command is useful, and we need it in later chapters for a project. It is also easy to do 
and can be introduced early on, though it is not nearly as important as the primary four objects 
(line, arc, circle, and rectangle); and due to that, it was not introduced in the first chapter.
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A polygon, strictly speaking, is any shape with three or more sides to it. Of course, in those 
cases when it has three sides (triangle), you can draw it with existing techniques. Same 
thing with four sides (square or rectangle). However, what about five sides or more, such as 
pentagon or hexagon? Here, a Polygon command is needed, as it is a real chore to draw these 
shapes using just the Line command (just try figuring out all the correct angles).

However, drawing polygons presents a complication you may not have with simpler shapes. 
With a rectangle, you specify the height and width and that is it, but how do you do that 
with, let us say, a pentagon? Figure 2.16 is a picture of one. What is the height? What is the 
width? It is not an easily measured shape.

The solution that drafters came up with a long time ago (many of AutoCAD’s techniques are 
just adaptations of pencil and paper board-drafting methods used for decades) is to enclose 
the shape in a circle of a known radius or diameter.

You can also enclose the circle inside the polygon. With this technique it is easier to specify a 
size—you just say “I need a pentagon that fits inside a circle of 10 in. diameter.” This is where 
the terms inscribed and circumscribed come from. Figure 2.17 is a diagram of two pentagons, 
both inscribed in and circumscribed about a circle—note the tangencies. In one case, the 
points of the polygon touch the circle; in the other case, its sides touch it.

Let us go through the steps in making this polygon.

Step 1. On a blank screen draw a circle with a radius of 5. Note that we do not need this step 
to create a polygon, but for your first try, it is a great help in visualizing what you are 
doing.

Step 2. Begin the polygon command via any of the previous methods.
m  AutoCAD says: Enter number of sides <4>:

Step 3. Enter the number 5 for five sides (making it a pentagon), and press Enter.
Step 4.	m AutoCAD says: Specify center of polygon or [Edge]:

With your OSNAPs on, click to select the center of the circle.
Step 5.	m AutoCAD says: Enter an option [Inscribed in circle/Circumscribed 

about circle] <I>:
Step 6. Now that you know what these terms mean, go ahead and press Enter to select I for 

“Inscribed in circle” (the default value). You can just as easily select C as well.
Step 7.	m AutoCAD says: Specify radius of circle:

Enter the value 5. A screen shot of the result is in Figure 2.18.

Figure 2.16 
Basic pentagon.

Figure 2.17 
Inscribed and circumscribed 
pentagon.
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Figure 2.19 
Drawing challenge star.

You can now erase the circle, since it was just a guide. In the future you will not need it; just 
click to place the polygon anywhere on the screen. Go ahead and practice this command 
again, but this time selecting a different number of sides (six or more) and also using the 
circumscribed option. This new command leads us into the first challenge exercise.

 

 Drawing challenge—star
Try this exercise based on what you learned. Draw a perfect five-sided star such as the one 
shown in Figure 2.19.

Think about everything we talked about up to this point. Only four commands are needed to 
create the star. Take a few minutes to try to draw it. If you cannot get it, do not despair, about 
a third of my students through the years typically did not get it right away either. The answer 
is at the end of Chapter 8.

➤➤ Ellipse
The Ellipse command is easy to do and is needed when we draw furniture in Chapter 4, so 
we include it here. The command can be executed in one of two ways: Center and Axis, End. 
You can also create a partial ellipse by defining just a section of it.

Step 1. Begin the Ellipse command via any of the previous methods.
m  AutoCAD says: Specify axis endpoint of ellipse or [Arc/Center]:]:
Click anywhere on the screen.

Step 2.	m AutoCAD says: Specify other endpoint of axis:
With Ortho on (not required but good to have), click again somewhere off to the left 
or right of the first point. Then move the mouse back toward the center as the ellipse 
is formed, as seen in Figure 2.20.

Step 3.	m AutoCAD says: Specify distance to other axis or [Rotation]:
Click anywhere again to complete the ellipse. You can also specify a rotation angle 
along the major axis (the line between click 1 and 2). This would be as if the ellipse 
were rotating away (or toward) you.

Figure 2.18 
Step 7 results.
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Figure 2.20 
Ellipse after Step 2.

Figure 2.21 
Ellipse, arc variation.

For a variation on this, try the Arc submenu of the ellipse, which is essentially similar in 
execution until the final step, when you trace how much of the ellipse you want to see, as 
shown in Figure 2.21.

➤➤ Chamfer

You may have already seen or tried the Chamfer command, as it sits right next to Fillet in 
the cascading menus and the Modify toolbar. It is not as critical as Fillet and not used as 
frequently, so it was not included in the main set of commands, but we introduce it now. A 
chamfer is a beveled edge connecting two surfaces. Think of it as a fillet that is angled instead 
of round. Chamfers may have a 45° corner, but this is not required; AutoCAD allows for 
asymmetrical chamfers.

To try out the command, draw two perpendicular lines similar to the fillet exercise in 
Chapter 1, as shown in Figure 2.22.

Step 1. Begin the Chamfer command via any of the previous methods.
m  AutoCAD says:
(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]:
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No distance has been entered yet, and any attempt at chamfer results in a chamfer 
radius zero. Press d for Distance.

Step 2.	m AutoCAD says: Specify first chamfer distance <0.0000>:
Enter a small value, such as 1.

Step 3.	m AutoCAD says: Specify second chamfer distance <1.0000>:
Here the 1 is not needed again, so just press Enter.

Step 4.	m AutoCAD says: Select first line or [Undo/Polyline/Distance/Angle/
Trim/mEthod/ Multiple]:
Select the first line.

Step 5.	m AutoCAD says: Select second line or shift-select to apply corner:
Select the second line.

The chamfer is created, as seen in Figure 2.23. Zoom in if needed to see it. If the chamfer 
fails, it is possible that you selected values too large for the available lines. Another way to 
create a chamfer is using the length of one line segment together with an angle, using the 
Angle option. Experiment with both.

Templates
Templates are something of a mystery for a beginner AutoCAD student. What exactly are they? 
While templates can get complicated in what they contain, all a template really is, is a file 
with some information embedded in it and all the proper settings set but no actual design. So 
it is a blank page with some intelligence built in and everything set up and ready for you to 
draw. These templates can be saved under a *.dwt extension, but you really need not concern 
yourself with this. What is important is being able to open a new file and know what you are 
looking at. Using the cascading menu File→New…, you will default to the screen in Figure 
2.24. Open up the highlighted acad.dwt and you have a blank file, end of story.

Limits
This is yet another topic that causes confusion. Limits are not technically necessary, but many 
textbooks persist in having you set them up. All they are is an indication of the size to which 
your drawing area is preset. Remember, however, that it is limitless, so all limits refer to is the 
area you can work on without a regen. If you draw a shape that is way beyond your limits, 
you simply regenerate the screen (Zoom→Extents) and the limits move to just beyond this 
new shape, so setting them is rather redundant. If you would like to set them anyway, just 

Figure 2.23 
Chamfer.

Figure 2.22 
Chamfer setup.
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type in limits, press Enter, and set the lower left corner to 0,0, then the upper right corner 
to perhaps 100, 50, or anything else you wish.

Save
Needless to say, you need to save your work; AutoCAD will eventually lock up, crash, and 
die. If not, Windows will, or there will be a power failure, and there is never a guarantee of a 
Save, so it is just a good habit to get into. Starting in the next chapter, you need to start saving 
your work. To do so, you can type in save and press Enter or press the graphic of a disk at 
the top of the screen. Another way is to drop down the arrow located next to the big red A at 
the upper left of the screen (Figure 2.25) and choose Save or Save As. You then get the usual 
Save dialog box (Figure 2.26) from which you should know how to proceed.

Figure 2.24 
acad.dwt template.

Figure 2.25 
AutoCAD main menu with Save As selected.
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Help Files
Finally we get to our last topic, the Help files. AutoCAD, like any software, has extensive 
Help files, and indeed that is one way (though not recommended) to attempt to learn the 
software. A better application of Help is to explore it once you know how to use AutoCAD 
and need assistance with a particular aspect of a command. Tool tips that appear with every 
command (unless you turn them off) in various levels of detail also can be considered a part 
of the Help files.

Generally, as with any software, you get to the Help files via the F1 key. There is a bit of 
a twist here though. By default (this is new to AutoCAD 2011), pressing F1 gets you to 
Autodesk’s online help. This is OK if you have an internet connection at your terminal, and 
the online Help will be more up to date and have more features. However, AutoCAD has 
extensive Help files built into the software and they are already installed, so there may not 
be a need to go online. This default setting can be deactivated in Options System tab. Ask 
your instructor for assistance if needed. If accessed locally, the Help files are still viewed 
through a browser (they are *.html files) and the home page looks like Figure 2.27.

As you can see, a tremendous amount of useful information is found here, with tutorials 
and reference material covering a good deal of the software, including advanced topics such 
as 3D and AutoLISP. Pressing Index at the top left takes you to a comprehensive AutoCAD 
command listing (Figure 2.28), where you can browse for a command. Once you type it in, 
all occurrences of it will be highlighted. Then you can click the relevant one and be able to 
read about the commands operation. Figure 2.29 shows how to create an arc via the Help 
files. The index is context sensitive.

Review everything presented so far; in Chapter 3, we introduce the layers concept and put 
all the preceding together to begin drawing a floor plan. Remember that learning AutoCAD 
is cumulative, and you need everything we have covered so far, no more and no less, to 
successfully deal with the upcoming material, so make sure you understand it all before 
moving on.

Figure 2.26 
Save As.
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Figure 2.27 
AutoCAD 2011 Help files.

Figure 2.28 
AutoCAD 2011 Help files Index.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 3:

l	U sing grips
m	 Activating them, using Esc to get out

l	 Setting units
m	 Architectural and Engineering (Decimal) units

l	U sing Snap and Grid
m	 Setting both, turning them on and off

l	U nderstanding the Cartesian coordinate system
m	 X and Y axes, ordered pair (X,Y)

l	 Distance entry tools
m	 Direct Distance Entry
m	 Relative Distance Entry
m	 Dynamic Distance Entry

l	 Inquiry commands
m	 Area
m	 Dist
m	 List
m	 ID

l	 Explode command
l	 Polygon command

m	 Circumscribed and inscribed
l	 Ellipse command
l	 Chamfer command
l	 Templates

m	 acad.dwt
l	 Setting limits
l	 Save
l	 Help files (F1)

Figure 2.29 
Index, Arc command.
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Review Questions
Answer the following based on what you learned in Chapter 2.

  1.	 How do you activate grips on AutoCAD’s geometry?

  2.	 How do you make grips disappear?

  3.	 What are grips used for?

  4.	 What is the command to bring up the Units dialog box?

  5.	 The Snap command is always used with what other command?

  6.	 �Correctly draw a Cartesian coordinate system grid. Label and number each axis appropriately, with 
values ranging from 5 to 5.

  7.	 �On the preceding Cartesian coordinate system grid, locate and label the following points: (3,2) (4,4) 
(2,5) (5,2) (3,1) (2,4) (1,5) (2,2).

  8.	 What are the two main types of distance entry?

  9.	 How do you use Dynamic Input?

10.	 List the four primary Inquiry commands covered.

11.	 What command simplifies a rectangle into four separate lines?

12.	 What is the difference between an inscribed and a circumscribed circle in the Polygon  
command?

13.	 What is a chamfer as opposed to a fillet?

14.	 What template should you pick if you want a new file to open?

15.	 What is the idea behind limits?

16.	 Why should you save often?

17.	 What is the graphic symbol for Save?

18.	 How do you get to the Help files in AutoCAD?

Exercises
1.	 Open a new file, set units to Architectural, and set both your Snap and Grid to 1. Then draw the 

following shape. Keep in mind the spacing between each dot is now 1. You would be wise to use the 
mirror command to complete this faster. The linework in this example has been darkened slightly for 
clarity. (Difficulty level: Easy; Time to completion: 5 minutes)
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2.	 Open a new file and set units to Architectural. Then draw the following figure using the Dynamic 
Input (DYN) drawing aid. When done, use the Area command to find its area. (Difficulty level: Easy; 
Time to completion: 5 minutes)

3.	 Open a new file and set units to Architectural. Draw the following shapes using the manual Relative 

Distance Entry (the @ sign) method. The first number is always the X; the second is the Y. Repeat the 
exercise using the DYN method instead. Sizes: 24  36, 17.5  3, 12  12, 3  40 (Difficulty 
level: Easy; Time to completion: 5 minutes)
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4.	 Open a new file and set units to Architectural. Draw the following figure using basic Circle, Line, 
Offset, and Fillet commands. (Difficulty level: Easy; Time to completion: 5 minutes)

5.	 Open a new file and set units to Architectural. Draw the following mechanical piece. All dimensions 
and centerlines are for reference only; we have not yet covered how to create them. (Difficulty level: 
Easy; Time to completion: 10 minutes)
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6.	 Open a new file and set units to Architectural. Draw the following mechanical piece. All dimensions 
and centerlines are for reference only; we have not yet covered how to create them. (Difficulty level: 
Intermediate; Time to completion: 20 minutes)

7.	 Open a new file and leave the units as Decimal. Draw the following simplified nut and bolt diagram. 
You have all the needed information but may have to carefully project some parts of the side view. You 
need the Polygon, Circle, Line, Trim, Chamfer, and other commands. (Difficulty level: Intermediate; 
Time to completion: 10–15 minutes)
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8.	 Open a new file and set units to Architectural. Draw the following bookshelf. The spacing of the 
shelves and the size and rotation of the books can be anything you want. All dimensions are for 
reference only. (Difficulty level: Intermediate; Time to completion: 15 minutes)
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CHAPTER

Layers, Colors, Linetypes, 
and Properties

LEARNING OBJECTIVES
Layers are an essential concept and need to be introduced before a serious drawing is 
attempted. In this chapter, we introduce layers and discuss the following:
	 What are layers?
	 Why use them?
	 Creating and deleting layers
	 Making a layer current
	 Assigning layer colors
	 Index color
	 True color
	 Color Books
	 Layer Freeze/Thaw
	 Layer On/Off
	 Layer Lock/Unlock
	 Loading and setting linetypes
	 Properties Palette
	 Match Properties
	 Layers toolbar

3
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Here, you learn all the remaining tools to begin creating a floor plan, which we start at the 
end of the chapter.

Estimated time for completion of chapter: 3 hours (lesson and project).

3.1  Introduction to layers
Layers are our first major topic after the previous chapters of basics. It is a very important 
concept in AutoCAD, and no designer or draftsperson would ever consider drawing anything 
more complex than a few lines without using them.

What Are Layers?
“Layers” is a concept that allows you to group drawn geometry in distinct and separate 
categories according to similar features or a common theme. This allows you to exercise 
control over your drawing by (among other things) applying properties to those groups,  
such as assigning colors or making them visible or invisible for clarity.

So, for example, all the walls of a floor plan will exist on the Walls layer, all the doors on 
the Doors layer, windows on the Windows layer, and so on. You can think of layers as 
transparency sheets in an anatomy textbook, with each sheet showing a unique and distinct 
category of data (skeleton, muscle, circulatory system, etc.), but when viewed all at once they 
show the complete picture of a person. Similarly in AutoCAD, there can be any number of 
layers (often the problem is using too many), with all of them holding their respective data 
and combining into the complete design.

Why Use Them?
As just stated, the key word here is control. Each layer can be assigned certain properties, such 
as color or linetype, or it can be manipulated to make it visible or invisible, as well as locked 
or unlocked to prevent editing. If all your geometry were lumped together on one layer, as 
some beginners do, then whatever you do to one set of objects, you do to all; certainly not 
what you want.

Let us take a look at the Layers Properties Manager. Open a new file and type in layer or just 
la, and what you see is shown in Figure 3.1.

Let us take a look at all the layer features one by one.

Figure 3.1 
AutoCAD 2011 Layer Properties Manager.
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Creating and Deleting Layers
Each new layer needs to be initially typed in according to what you need or the company 
standard. To do that, you need to highlight (click on) the layer 0 gray band. When it turns blue, 
simply press Enter once; the blue ribbon bar will jump to another line and create Layer 1.  
Another way to get a new layer is to press a button at the top of the layer box (two icons to the 
left of the red X) that looks like a sheet of paper with a sparkle next to it. Either way, once you 
do that, just type in the layer name followed by Enter. Some helpful tips:

l	 If you notice that you made a spelling mistake after you already pressed Enter, you can 
just click back into the layer name once or twice until the cursor enters Edit mode and 
retype.

l	 Do not attempt to change the 0 layer’s name. It is the default layer and cannot be deleted 
or renamed.

l	 If you want to delete a layer (perhaps an accidentally made one), simply highlight the 
layer, and click the red X and then Apply at the bottom right of the layer box. If the layer 
contains nothing it will be deleted.

Following this procedure create three layers:

l	 A-Doors
l	 A-Walls
l	 A-Windows

What you should see is in Figure 3.2.

Making a Layer Current
This is simply the active layer on which you can draw at any given moment. You are always 
on some layer (even if you are not immediately sure which one exactly). So, logically, if you 
are about to draw a wall, you should be in the A-Walls layer and so on. To specify what layer 
to have as current either click on the green check mark button (to the right of the red X) or 
double-click the layer name itself. Go ahead and make A-Walls current.

Figure 3.2 
Layer Properties Manager with three new layers.
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Assigning colors to layers is very important and should be done as you create them or soon 
after. The reasons to have color are twofold. On the most basic level, a colorful drawing is 
more pleasant to look at on the screen, but more important, it is easier to interpret and work 
with. If, for example, your walls are green and you keep this in mind, then your eye is able to 
quickly see and assess the design. Likewise, yellow doors are easy to spot. This color separation 
greatly aids in drafting. Imagine a scenario where your building floor plan is made up of all 
white lines; you would be unable to tell one line from another. As that drawing grew more 
complex, all the lines would melt into one monochrome mess. Finally, colors are assigned 
pen thicknesses (an advanced topic) and contribute to more professional-looking output. We 
address this in Level 2.

To assign colors, let us turn our attention back to the Layer dialog box. Highlight, by clicking 
once, layer A-Walls. Now follow the blue ribbon across until you see a box with the word 
white next to it. It will be under the Color column. Click on it, and the Select Color dialog 
box pops up, as seen in Figure 3.3.

Index color
Let us take a tour of this Index Color tab. The two large 24  5 stripes of colors you 
immediately see at the top make up the AutoCAD Color Index (ACI), and it contains 240 
colors. Do not be too quick in selecting one of those right away. Take a look below; there are 
two smaller color stripes. The rainbow-like stripes 1 through 9 are the ones in which we are 
most interested. If you take a close look, they are the primary colors and the 240 colors above 
them are just different shades of the primaries. You should always use up those nine colors 
first—they are very distinct from each other—and only then move on to the others. Also this 
makes setting pen weights easier later down the road, as you need not scroll through dozens 
of colors to find the ones you used.

Figure 3.3 
Select Color, Index Color.
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The colors from left to right are Red→Yellow→Green→Cyan (not Aqua)→Blue→Magenta 
(not Maroon), then white and two shades of gray, 8 and 9. The color stripe below that 
contains just additional shades of gray, and we do not need them for now. So, finally, pick 
a color for the A-Walls layer (green is what many architects use for walls), click on it, then 
press Enter; you are taken back to the Layer dialog box to assign more colors to more layers. 
Yellow is recommended for A-Doors and red for A-Windows.

True color
There is more to colors, of course. Go back to the Select Color dialog box. Now click the 
second tab called True Color. Here is where some experience in graphic design may come 
in handy. The main color window you are looking at now contains over 16 million colors 
and should be familiar to you if you used Photoshop, Illustrator, PaintShop®, or any of those 
types of design programs. You can now move your mouse around, selecting colors based on 
the HSL method. That is hue (the actual colors, moving across), saturation (moving up or 
down), and luminance (brighter or darker, moving the slider up or down next to the main 
window). You may also use the RGB (red, green, blue) model of color selection by using the 
drop-down selector at the upper right. Whichever color you settle on will be shown by both 
color models. Play around with all the buttons to get a feel for them. Designers rarely use 
these colors for 2D work (where you want objects to be bright and visible), but do pick these 
more subtle colors for realistic-looking 3D models. Figure 3.4 is a screen shot of what this 
tab looks like.

Color books
Here is where things get even fancier. Color Books are Pantone colors. If you are an architect 
or an interior designer, you already know what these are. If you are shaking your head and 
have never heard of Pantone, then do not worry about it, chances are you will not need to 
use them. Simply scroll through the palettes and select a color. Figure 3.5 is a screen shot of 
the Color Books tab.

Figure 3.4 
Select Color, True Color.
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Layer Freeze/Thaw and On/Off
Here we come to a very important part of the Layers dialog box. Freeze and Thaw are 
opposites of the same command, one that will make a layer disappear from view. The 
command freezes or thaws the layer for the entire drawing. Pick a layer, highlight it, follow 
the band across to the Freeze column and underneath you will find a yellow “sun” icon. If 
you click on it, that layer “freezes” and the icon becomes a blue “snowflake.” Clicking again 
undoes the action. So what does freeze mean? It makes the layer (or rather all the objects  
on that layer) disappear from view, but remember, they are not deleted, only invisible.  
You will use this feature routinely in drawings to control what is displayed. The On/Off 
feature represented by the light bulb (yellow to blue and back) is essentially the same as 
Freeze/Thaw, with some subtle (and minor) details, so we do not go into them. You can use 
either method, though stay with Freeze/Thaw just to keep things consistent.

Layer Lock/Unlock
This layer command, represented by the padlock, does exactly that; it locks the layer so you 
cannot edit or erase it. The layer remains visible but untouchable. The unlocked layer’s icon 
is blue and looks “unlocked,” while a locked layer’s padlock turns yellow and changes to a 
“locked” position. Play around with all the buttons we mentioned thus far to get a feel for 
them. When done, make sure everything is reset (not locked or frozen) and click on the X in 
the upper corner of the Layer box to close it.

3.2  Introduction to linetypes
Linetypes are the different lines that come with AutoCAD. As a designer, architect, or 
engineer, you may need a variety of lines to convey different ideas in your design. Just like in 
hand-drafting, where you created Dashed, Hidden, Phantom, and other line types to show 
cabinets, demolition work, or hidden geometry in part design, in AutoCAD you load the 
lines and use them as necessary.

Figure 3.5 
Select Color, Color Books.
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The idea here is to load them all in the beginning then assign the linetypes to either a layer 
or sometimes just a few items. You can also load them as needed, but it is recommended 
getting this out of the way so you have them at your fingertips.

Step 1. Type in linetype and press Enter or choose Format→Linetype. . .  from the 
cascading menu. The Linetype Manager pops up.

Step 2. Press Load. . . . The Load or Reload Linetypes box comes up. Figure 3.6 is a screen 
shot of both dialog boxes.

Step 3. Position your mouse in the white empty space between the two columns (Linetype 
and Description) of the Load/Reload Linetypes box and right-click. The Select All/
Clear All menu pops up.

Step 4. Press Select All and every linetype in the left column turns blue (selected).
Step 5. Press OK (and possibly a Yes to All as well) and the dialog box disappears. All the 

linetypes are loaded now, so press OK again in the Linetype Manager and that is it.

We now use the loaded linetypes and assign a linetype to a layer.

Step 1. Go back to the Layers dialog box.
Step 2. Create a new layer called Hidden and assign a linetype to it (the “hidden” linetype, 

naturally).
Step 3. Make sure the Hidden layer is highlighted with the blue bar and move your mouse 

to the right until it matches up with the header category Linetype. It should say 
Continuous right now.

Step 4. Click on the word Continuous and the Select Linetype (Figure 3.7) dialog box comes 
up with all your linetypes preloaded. If we did not load them earlier, the box would 
have been practically empty and we would have had to do the loading at that point.

Step 5. So, now all we have to do is scroll up and down the list to find the appropriate 
linetype (Hidden in this case), select it, and press OK.

Make a note of the important linetypes for future reference: Center, Dashed, Divide, Hidden, 
and Phantom are some of the key ones. Ignore the ones named ACAD_ISO for the simple 
reason that their names are not descriptive enough to recognize at a glance. Also make a 
note of why there are three types of the same linetype (such as DASHED, DASHED2, and 

Figure 3.6 
Linetype Manager and Load/Reload Linetypes.
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DASHEDX2). By checking the appearance carefully, you will see that the scale is different. 
Finally let us get back to the Layers dialog box. If you set your Hidden layer to Current, then 
everything you draw will be a dashed line.

We conclude with one final important note on linetypes. If you cannot see the linetype, and 
it appears as a solid line when it should be something else, chances are the scale is too small. 
Type in ltscale (linetype scale) and enter a larger number. This is mentioned again as a 
reminder in a future tip.

3.3  Introduction to properties
Sometimes, you need to change objects from one layer to another (perhaps because of an 
error in originally placing it on the correct layer or a later decision to change to another 
layer). Also, you may need to change the color, linetype, or other properties of objects. 
AutoCAD has a collection of tools to change the properties of objects, with the three most 
common methods being the Properties palette, the Match Properties tool, and the Layer 
toolbar. We explore each in order.

➤➤ Properties Palette

There are two other ways to bring up the Properties palette:

l	 Double-click on any geometry object (line, arc, etc.) or
l	 Press Ctrl1.

Once you do any of these, the Properties box in Figure 3.8 appears.

Look at the palette in detail from top to bottom. There are a number of categories (General, 
View, etc.) and a number of features that can be modified in those categories (Color, Layer, 

Figure 3.7 
Select Linetype.
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Linetype, etc.). Also there are two columns, a gray one on the left and a mix of gray (inactive) 
and white (active) fields on the right. To use this palette first draw several lines on your 
screen, each of which is on a different layer. Then follow these steps:

Step 1. First, make sure you have selected one or more items to change. They become 
dashed. If you selected two items, only those properties common to both that can  
be changed are available.

Step 2. In the Properties box, find the category you want changed, color, for example.
Step 3. Click on the right-hand column directly across from that property.
Step 4. An arrow drops down. Click on it and view the choices within that category.
Step 5. Select the different property that you want the new objects to have, such as a new 

color.
Step 6. Close the Properties box (the X in the upper corner) and press Esc once or twice; the 

objects have that property. The Properties toolbar is a quick, easy way to change a 
number of properties but there is another way, shown next.

➤➤ Match Properties
This is a really great way to very quickly match up the properties of one object with the 
properties of another. The procedure is simple. Start the command (methods in the table 
that follows), select the first object whose properties you like, and then click on another 
object that you want to have those properties.

Figure 3.8 
Properties palette.
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Match Properties matches almost anything: layers, colors, linetypes, linetype scales, text sizes, 
hatch patterns, and many more factors. Finally, we have the Layers toolbar, which has its own 
method of layer changes and deserves its own separate discussion.

Layers Toolbar
The Layers toolbar is shown in Figure 3.9. Add it to your visible toolbars on the screen, and 
use it throughout the remainder of the chapters.

To change layers using this toolbar, simply select whatever you would like to change to 
another layer (what you selected becomes dashed), then drop down the Layer menu in the 
toolbar and pick the new layer on which you want the highlighted geometry to go, and it 
changes. You may have to press Esc to deselect the layer(s) afterward.

This toolbar is also useful for freezing, turning off, and locking layers, as seen in Figure 3.10. 
And, it is a great visual reference to determine what layer is current, which of course is the 
layer being shown. The toolbar has some useful icons, though the only one we covered so far 
was the one all the way to the left that brings up the Layer Properties Manager.

This is it for basic layers and associated topics. You should know the following:

l	 What layers are and why they are needed.
l	 How to open the Layer dialog box.
l	 How to enter a new layer, delete it, and change its name.
l	 How to make a layer current.
l	 How to assign a color to a layer and all the color options.
l	 How to Freeze/Thaw, turn Off/On, and Lock/Unlock the layers.
l	 How to select and set linetypes.
l	 How to use the Properties dialog box.
l	 How to use Match Properties.
l	 How to use the Layers toolbar.

Figure 3.9 
Layers toolbar.

Figure 3.10 
Layers toolbar in use.
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What we have not covered yet:

l	 The left side of the Layer Properties Manager (Filters and Layer States)—to be covered in 
Level 2.

l	 Several other Layer features—Lineweights, Plot Style, Plot, and the like.

For now, it is time to put everything to good use and draw a full apartment floor plan. 
Review everything thus far and begin the assignment in the next section.

3.4  In class drawing project: floor plan layout
This is your first major drawing assignment. You now get a chance to put together everything 
you learned so far and apply it to a realistic drawing situation. Although this floor plan is 
very simple compared to major architectural or engineering projects created in the industry, 
it still features components of a professional drawing, just fewer of them, so you do not get 
overwhelmed right away. Follow all instructions carefully and proceed slowly. Speed comes 
later, when all the commands become second nature. Our goal is to draw the floor plan 
shown in Figure 3.11.

This is a simple one-bedroom apartment. The kitchen is on the upper left, bedroom on the 
upper right, bathroom on the lower right, and the living room right in the middle. There are 
two closets, six windows, and six doors (kitchen has no door). The dimensions are only for 
you to look at and use, not draw in yet, as we still have not learned them. The numbers in 
the boxes are the door opening sizes. All walls are 5 in. thick.

Outlined next is a complete discussion on how to start drawing the floor plan, intended for 
those students studying AutoCAD by themselves without an instructor. If you are taking a 
class, your instructor will assist you but should essentially follow the same format. Once 
you learn all the steps involved and build confidence, aim to draw it again in less than 60, 
then 30, and finally less than 10 minutes, starting from a blank screen. This may sound 
unreasonable now, but that is the required industry speed and you will be able to get to that 
quite soon with some practice. An outline of steps with additional information (if needed) 
follows.

Basic file preparation

1.	 Open a brand-new AutoCAD file using the acad.dwt template. Save it as YourName_
AptProject1.dwg. We start from the very beginning for practice purposes.

2.	 Set your units to Architectural using the Units command.
3.	 Set up layers: A-Walls (green), A-Windows (red), and A-Doors (yellow).
4.	 Load all your linetypes (we need them later). If you were to save and close this file 

right now and use it later for another project, then it would be called a template, as first 
explained in Chapter 2.

Starting the floor plan
Now that the basic file is set up, how would you start a drawing from the very beginning? 
Well, there are a few ways. We could certainly draw line by line, but that is not too efficient. 
Think back to your set of tools learned thus far. The best approach is to draw two rectangles. 
One represents the outer walls and the other represents the inner walls.

5.	 Draw a rectangle that is 25–1 wide and 24–10 tall. Be careful. Use the correct method 
of manual Relative Distance Entry or Dynamic Input, your choice. You can even just 
use the Rectangle command, indicating the dimensions as allowed by one of the sub-
options. If you do it manually, you will start a rectangle, press Enter, left-click anywhere 
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in the screen, and then type in @251,2410 exactly as written. If you use DYN, start the 
rectangle and enter the values on screen, using the Tab key to hop between the first and 
second values. If you use the Rectangle Dimension option, start the Rectangle, press d, 
and enter its length and width when prompted. Once again, make sure the units are 
Architectural or you will immediately run into problems.

6.	 Offset the rectangle 5 to the inside to create the inner walls (Offset command).
7.	 Explode both wall rectangles. This is needed to break apart the rectangles for use as the 

basis for the interior walls. You should now have a total of eight individual lines, as seen 
in Figure 3.12.

Figure 3.11 
Floor plan layout.
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Drawing the inner wall geometry
As mentioned in Chapter 1, one of the biggest misconceptions beginners have about drafting 
in AutoCAD is that they will spend lots of time drawing line after line. That expectation is 
natural; after all, in hand-drafting that is exactly what you would do—pick up the pencil 
and T-square and draw lines connecting them in intricate ways to create a design. Not so 
in AutoCAD. You still draw lines occasionally, but most of the time, you use the Offset 
command to create new geometry, such as in this case. For example, we use the inner main 
walls as a basis for the room walls and offset as needed.

  8.	 Offset the inner left vertical wall 11–10 to the right to create part of the kitchen 
wall. Then right away offset 5 for the thickness of the wall. Repeat with the inner top 
horizontal wall (offset 7–10) to get the lower part of the kitchen. Offset 5 to the right 
for thickness. Figure 3.13 illustrates this graphically.

  9.	 Fillet the two sets of walls to create a sharp corner. This is where the Fillet command’s 
advantage really shows. Follow it carefully, and select the two inner wall lines first, then 
the outer.

10.	 Create a 2–10 opening for the kitchen door. Once again use the Offset command. 
Offset the inner wall 4–8 to the right as shown on the plan. Then offset again 2–10 
to frame the opening. Next trim it out by selecting all the lines using a crossing, pressing 
Enter, and clicking on the lines you do not need. You will use this technique to create 
the windows the same way.

11.	 Trim out the extra line where each inner wall meets the main wall. Figure 3.14 shows 
you what you should see so far (be sure to ask your instructor if something is not 
working out).

Figure 3.12 
Floor plan, Step 7.
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Figure 3.13 
Floor plan, Step 8.

Figure 3.14 
Floor plan, Step 11.
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Drawing the rest of the inner walls
If you understood the previous steps, then you should have a basic idea of what is needed to 
draw the rest of the floor plan. It really is mostly similar. You of course have to get creative 
on occasion, but just stop and think of the basic tools you have available. If it seems overly 
complicated, you are doing it wrong. After the kitchen, go on to do the bathroom in the 
lower right corner, then the bedroom and entrance. Here are some additional tips to help 
you along:

l	 Create the openings for the doors and windows, but do the actual doors and windows 
last. Be sure to use the correct layers.

l	 To create a door, first redo Exercise 3 of Chapter 1. Further instructions follow.
l	 To create windows, draw a rectangle with a line through it. Position into the window 

opening. Both a door and a window are shown in Figure 3.15.

Some additional information on how to create the doors and windows is presented next.

The easiest way to create a door is to draw a rectangle of the needed size. The door sizes 
vary somewhat throughout the floor plan, but the thickness is always 2. Start the Rectangle 
command and click once where the door will go (use OSNAP accuracy). Then, relative to 
that point, determine what to type in using Relative Distance Entry or Dynamic Input. Be 
careful, as negative numbers may be involved.

So, in this example (Figure 3.16), a 36 door is created by placing a rectangle at the upper 
right corner of the wall and typing in @-2,36. Make a note of why it is a negative 2. If you 
are using Dynamic Input, you still have to use negative numbers; you just type on the screen 
and do not need the @ sign, but the rest still applies.

Figure 3.15 
Door and window symbols.

Figure 3.16 
Creating the door symbol.



level 1  
Chapters 1–10

82

To create the door swing, you can carefully position a three-point arc (as in the Chapter 1 
exercise) or, as an alternative, create a circle based at the hinge point and with a radius of 36, 
as seen in Figure 3.17.

Then, just trim the unneeded three quarters of the circle by using the top of the door and the 
left wall as cutting edges.

The window is much easier to do. As stated before, just draw a rectangle in the window 
opening and add a straight line across, then insert into the opening (Figure 3.18). Once 
again it bears repeating, for both the doors and the windows, be sure to be on the correct 
layer for each.

Figure 3.17 
Creating a door swing.

Figure 3.18 
Creating a simple window.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 4:

l	 Layers
m	 Basic concept and purpose
m	 Creating and deleting
m	 Current layer

l	 Layer colors
m	 Setting and changing colors
m	 Index color
m	 True color
m	 Color Books

l	 Layer Freeze/Thaw
l	 Layer On/Off
l	 Layer Lock/Unlock
l	 Linetypes

m	 Loading and selecting
l	 Properties palette
l	 Match Properties
l	 Layers toolbar

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 3.

  1.	 What is a layer?

  2.	 What are some of the main reasons for using layers in AutoCAD (list at least two)?

  3.	 What typed command brings up the Layers dialog box?

  4.	 List two ways to create a new layer.

  5.	 How do you delete a layer?

  6.	 How do you make a layer current?

  7.	 What are the three available Color tabs?

  8.	 What does freezing a layer do?

  9.	 What does locking a layer do?

10.	 What are some of the linetypes mentioned in the text?

11.	 What are three ways to bring up the Properties toolbar?

12.	 What two other ways to change properties or layers were discussed?

EXERCISES
1.	 In a new file, load all linetypes, then open the Layer dialog box, and set up the following layers, colors, 

and linetypes. Then lock all E-layers, make A-Walls-New current, and freeze A-Text. (Difficulty level: 
Easy; Time to completion: 7–10 minutes)

A-Walls-Demo, Gray, Hidden
A-Walls-New, Green, Continuous
A-Windows-New, Red, Continuous
A-Doors-Demo, Gray, Hidden
A-Doors-New, Yellow, Continuous
A-Shelves, Blue, Hidden
A-Furniture, Magenta, Continuous
A-Text, Cyan, Continuous
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A-Dims, Cyan, Continuous
A-Carpeting, Gray, Continuous
E-Outlets-Duplex, Red, Continuous
E-Switches, Red, Continuous
E-Switches-3way, Red, Continuous

2.	 In a new file, leave units as Decimal; load all linetypes; set up layers M-Bracket, Hidden, and Center; 
and assign them proper linetypes and colors of your choosing. Then draw the following mechanical 
object. All dimensions are for your reference only; we will learn how to create them in Chapter 6. 
(Difficulty level: Easy; Time to completion: 12–15 minutes)

3.	 In a new file, leave units as Decimal; load all linetypes; set up layers M-Part, Hidden, and Center; and 
assign them proper linetypes and colors of your choosing. Then draw the following mechanical object. 
All dimensions are for your reference only; we will learn how to create them in Chapter 6. (Difficulty 
level: Intermediate; Time to completion: 20–25 minutes)
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4.	 In a new file, leave units as Decimal; load all linetypes; set up layers M-Part, Hidden, and Center; and 
assign them proper linetypes and colors of your choosing. Then draw the following pipe assembly. All 
dimensions are for your reference only; we will learn how to create them in Chapter 6. (Difficulty level: 
Intermediate; Time to completion: 20 minutes)

5.	 Often in design work you need to draw standard parts, because no CAD files are available. Such is 
the case with the following electrical termination blocks, breakers, and thermostat equipment. In a 
new file, leave units as Decimal and set up layer E-Part, assigning it any color you wish. Then draw 
the electrical hardware. All dimensions are for your reference only; we will learn how to create them in 
Chapter 6. Most of the internal geometry you will have to estimate. Be sure to use the Copy command 
wisely to avoid duplication of drawing effort. (Difficulty level: Intermediate; Time to completion: 
45 minutes)
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6.	 Valves are an important part of piping and instrumentation diagrams (P&IDs). In a new file, set up the 
units as Architectural and set up layers M-Part, Hidden, and Center, assigning them proper linetypes 
and colors of your choosing. Then draw the valve shown. All dimensions are for your reference only; 
we will learn how to create them in Chapter 6. Be sure to use the Mirror command wisely to avoid 
duplication of drawing effort. (Difficulty level: Intermediate; Time to completion: 60 minutes)
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7.	 In a new file, set up Architectural units, the correct layers (only A-Walls and A-Doors are needed), 
and draw the following floor plan. Dimensions, text, and the solid hatch pattern are for clarity and 
construction purposes only. We will learn them in an upcoming chapter. (Difficulty level: Intermediate/
Advanced; Time to completion: 60 minutes)
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AutoCAD is the undisputed CAD software of choice among most architects, and indeed the 
software finds its widest application in architecture and related fields. Therefore, it makes 
sense to feature architecture in our first Spotlight On feature.

Architecture is the art and science of designing and constructing buildings and other physical 
structures for human shelter or use. It is a far-reaching field that encompasses not only 
construction and layout of structures but also some civil engineering, landscape design, 
interior design, and project management.

Architects are often described as a cross between engineers and artists. They not only 
need extensive knowledge of statics, strength of materials, and construction methods and 
codes but also artistic flair and well-developed aesthetics. Although architects often work 
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with specialists to complete projects, many are well versed in electrical, plumbing, HVAC, 
landscape, and lighting design. Add to that the necessary ability to manage projects and 
deal with clients as well as financial and legal matters, and one can see that architecture is a 
demanding and multifaceted profession.

It is also not an easy profession in which to get started. In the United States, a student needs 
to complete a Bachelors of Architecture followed by a Masters of Architecture. Depending on 
individual programs and how they are structured, this can take anywhere from five to seven 
years. The student then has to gain work experience, often while earning a relatively low salary, 
before being eligible to sit for the Architect Registration Examination (ARE), to be licensed 
in the state of his or her residence. While earnings for partners and senior architects can be 
substantial, it does take quite a while to get established and build a reputation and client base.

Virtually all architects today have switched to computer-aided drafting, and a group of 
CAD drafters is a common site in most offices. Drafting is time consuming, so most senior 
architects focus on bringing in new business and creating top level concepts and designs, 
leaving the details and drafting to junior architects and CAD designers (sometimes the 
same person). This works out well, as junior architects have an opportunity to learn by 
doing actual useful work while “learning the ropes” of the business. Acquiring cutting-edge 
AutoCAD skills is therefore a great way to get your foot in the door of the profession.

According to the 2006–2007 Occupation Outlook Handbook, published by the U.S. Department 
of Labor, the median salary of architects in the United States was $62,960, with the middle 
50% earning between $46,690 and $79,770. For 10 years’ experience, the base compensation 
level increases significantly to an average range of $62,608–$79,919; that range reaches 
$72,678–$96,928 for architects with 15 years’ experience.

Senior architects and partners typically have earnings that exceed $100,000 annually. It is not 
unusual for an officer or equity partner to earn a base salary of $235,000, with a bonus of 
$200,000. Due to the major stake in ownership that equity partners may have, they can earn 
incomes approaching, and occasionally surpassing, seven figures.

So how do architects use AutoCAD, and what can you expect? A typical medium-sized project, such 
as a residential home, will feature a set of plans that may include

l	 A-1 Site Plan: The property surrounding the structure.
l	 A-2 Demo Plan: What needs to be demolished to make room for the new design, if 

applicable.
l	 A-3 Construction Plan: The actual design, which may have multiple floors.
l	 A-4 RCP: The reflected ceiling plan, which may include lighting.
l	 A-5 Electrical Plan: The outlets, switches, panels, and lighting, if not on the RCP or a 

separate plan.
l	 A-6 Kitchen Elevations: Shows cabinets and appliances.
l	 A-7 Bathroom Elevations: Shows bath, shower, sink, and other features.
l	 A-8 Window and Door Schedule: Lists all doors/windows, and sizing, quantity, and the like.
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Figure 1 
AIA layers.

l	 A-9 Cellar: Shows basement or cellar plan, if needed.
l	 A-10 Roof: Shows construction of roof beams, rafters, braces, joists, and other elements.
l	 A-11 Wall Sections: Shows the various walls used, and their internal structure.
l	 GN-1 General Notes: Describes the overall job and any special instructions to the contractor.
l	 GN-2 Plumbing Riser Diagram: Describes flow of pipes and plumbing features.
l	 S-1 Framing Plan: Describes the construction of the house frame.
l	 S-2 Structural Details: Additional details of design; may be multiple pages.

Extensive use of AIA layering, or an in-house system based on it, is employed, as seen in 
Figure 1. Figures 2 and 3 go into more detail.

Figure 2 
Architectural details. (Images courtesy of RM Architect, PC www.rma-nyc.com)
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You should also expect to see extensive use of advanced Level 1 and Level 2 concepts, such as

l	 Xrefs: The main plan is externally referenced to the electrical and RCP plans, Chapter 17.
l	 Paper Space: Each of the plans is a separate Layout tab, Chapter 10.
l	 Attributes: Found in the titleblocks, door and window schedules, and other elements, 

Chapter 18.

Architectural drafting is a demanding and skill-intensive endeavor. Many jobs are started 
with a survey of existing structures, if any exist. If the project calls for a brand-new building, 
not a renovation, then only a site plan is needed and the design may be created right away. 
Typically a building core is laid out (which then becomes the Xref), and the architect then 
works on designing the internal details of the building. When the overall design is set, other 
systems are added, such as electrical, plumbing, HVAC, security, fire protection, mechanical, 
and much more. Corporate and commercial jobs are typically more involved than residential 
ones, and some of the previously mentioned subsystems are applicable mostly to those. 
Finally, extensive construction notes, details, and schedules need to be developed. The final 
document set may feature 20–30 sheets, or more.

Several factors make architectural drafting challenging:

l	 A complex building design may use virtually all of AutoCAD’s tools and concepts; you 
need to be well versed in all of them. This means mastering every topic in Levels 1 and 2 
of this book.

l	 There is a need for extreme accuracy, as the original design plans of the building structure are 
the anchor for the rest of the design. Mistakes made early on will come back to haunt you.

Figure 3 
Residential architectural floor plan. (Images courtesy of RM Architect, PC www.rma-nyc.com)
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l	 There is rarely a luxury of excess time. Architects bid on a job and must work within a set 
budget. A slow draftsperson who is not proficient (or efficient) takes too long to create 
the drawings and diminishes profits. Working fast and accurately is a must. Rarely do you 
learn the basics and are allowed to mature “on the job” anymore; it is just too expensive 
for a small architecture office.

In spite of these challenges, or maybe because of them, architectural drafting is enjoyable 
and rewarding, especially if you are a new graduate and picking up knowledge in your 
profession along the way. Even if you just do non-design drafting, the pay is good (salaries 
vary from $35,000 to $55,000 and up), and you will acquire some frightening AutoCAD 
skills very quickly in this fast-paced environment. Most of today’s AutoCAD experts 
(including the author) can trace their roots to using AutoCAD in architecture; it is the cutting 
edge of computer-aided drafting.
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CHAPTER

Text, Mtext, Editing,  
and Style

LEARNING OBJECTIVES
Text allows your design to communicate beyond what just a line drawing can. In this 
chapter, we introduce Text, Mtext, Style, and Editing and discuss the following topics:
l	 Text
l	 Properties and applications of Text
l	 Editing all types of text
l	 Mtext
l	 Properties and applications of Mtext
l	 Mtext formatting
l	 Mtext symbols
l	 Style
l	 Spell Check

4
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At the end of this chapter you will be able to annotate your floor plan as well as add 
additional features, such as furniture and stairs.

Estimated time for completion of chapter: 2 hours (lesson  project).

4.1  Introduction to text and mtext
Adding text to your AutoCAD drawing is the next logical step once you learn how to create 
and edit basic designs. After all, the purpose of most drawings is to describe how to build 
something or show what a design looks like. Text goes a long way in assisting in this and, 
along with dimensions, is usually the next item to be added to a new design.

Text in AutoCAD comes in two versions: regular Text (single line text) and Mtext (multiline 
text). We look at how to create and edit both types. We then look at how to choose and set 
fonts and conclude the chapter by adding text to the previously designed floor plan.

4.2  Text
The first type of Text command we cover is regular Text. This is your basic text creation 
command, and it creates a text field anywhere you click on the screen, into which you can 
type whatever you need to. It does have a carriage return that goes to another line upon 
pressing Enter, so you need to press Enter twice to get out of the field. While an unlimited 
number of lines of text can be typed, typically regular text is used for only a single line as 
multiple lines of text are not joined together in paragraph form and cannot be formatted to 
any extent. Let us summarize:

l	 Text is used mostly when only one or several lines are needed.
l	 The text cannot be formatted or any effects added, beyond underlining and few other 

minor effects.
l	 Multiple lines of text are not in paragraph form, rather they remain individual lines.

Open a new file, bring up the Text toolbar (Figure 4.1), and let us create a few sample lines.

Step 1. Begin the text command via any of the previous methods.
m  AutoCAD says:
Current text style: “Standard” Text height: 0.2000 Annotative: No
Specify start point of text or [Justify/Style]:

Step 2. Left-click anywhere on the screen.
m  AutoCAD says: Specify height <0.2000>:

Step 3. Enter a new height if desired, say 1.0, and press Enter.
m  AutoCAD says: Specify rotation angle of text <0>:
You can rotate the text, but there really is no need to, so just type in 0 for now, and 
press Enter.

Figure 4.1 
Text toolbar.
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Step 4. A text field opens up with a blinking cursor. Go ahead and type something, pressing 
Enter once to go to the next line or twice to finish. Figure 4.2 shows what the basic 
text looks like. If yours is a different size, you may have to zoom in or out to fit it 
nicely on the screen.

The text is still rather simple; we have not yet addressed font, sizing, or any effects. Notice 
that the text is on three separate lines. You can move, copy, or erase any of the two lines 
without affecting the other. So how would you edit this text?

Editing Text
Editing, or changing, what the text says is very simple and is the same procedure for both Text 
and Mtext, so we go over it right away and you can apply it from now on. The easiest way to 
edit the text is to double-click on it, which opens the text field. This is such an overriding and 
best method that we do not present a command matrix, as the only other way is to type in 
ddedit (or use the appropriate Edit icon; see Figure 4.3), but this method is rarely used. 
However, remember ddedit for Chapter 6. It is the only way to change dimension text values, 
so you will need it eventually, just not yet. When you are done editing, just press Enter again.

Here is a trick with regular text that you will not hear about much anymore. If you want to 
underline it, type in %%u just before the text string you want underlined. This old code dates 

Figure 4.2 
Basic text.

Figure 4.3 
Edit icon.
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back to DOS days, and it will automatically and immediately add an underline to your basic 
text. You can also experiment with %%c, %%p, and %%d. See what those three do. None of this 
is needed with Mtext, as discussed next.

4.3  Mtext
Mtext is multiline text. In other words, this is the command you use when you anticipate 
typing in a paragraph as opposed to one or two lines, and more important, you require some 
advanced formatting and effects. As of AutoCAD 2010, it even has Spell Checker built in. 
Many designers use Mtext for all their text needs, just in case formatting needs to be applied 
to even just one word. The only downside is that it takes a few seconds longer to set up and 
the features make it a more complex command. The idea here is to define an area where your 
text will go. Once you do that, the new paragraph fits into that area.

Let us summarize the Mtext features and try the command:

l	 Used primarily for writing paragraphs.
l	 Has extensive formatting and editing features.
l	 Has an extensive symbol library and Spell Check.
l	 Can accept extensive text importing

Step 1. Begin the Mtext command via any of the previous methods
m  AutoCAD says: Current text style: “Standard” Text height: 0.2000
Annotative: No
Specify first corner

Step 2. Left-click anywhere on the screen, noticing the abc next to the crosshairs. A rectangle 
with an arrow appears, as shown in Figure 4.4. Continue to move your mouse down 
and across to the right, making the rectangle bigger. This is your text field; make it as 
large or small as you need it to be to hold all the text. As you do this,
m � AutoCAD says: Specify opposite corner or [Height/Justify/Line 
spacing/Rotation/ Style/Width/Columns]:

Click again when you have defined the field.

Figure 4.4 
Mtext field.
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Here AutoCAD 2011 throws you a bit of a twist. If you are not using the Ribbon, you will 
see the text field with a toolset just above it (but not attached to it), as seen in Figure 4.5, 
where you can type in your text, pressing Enter to go to the next line. To finish up, press 
OK in the upper right of the toolset or just click anywhere outside the field. We will go over 
some of the tools in a moment, but what if you have the Ribbon up?

If you are using the Ribbon, the formatting duties are transferred completely to the Text 
Editor tab, and all you see below it is the text field, no toolset, as seen in Figure 4.6 (though 
you can bring it back, as shown later). The functionality is essentially the same, only the 
presentation differs. We cover Mtext’s extensive formatting tools in the next section.

Formatting Mtext
First of all, notice something: If you click on Mtext, it remains a paragraph, a big difference 
from a few lines of regular text. To edit Mtext, as already mentioned, you do the same thing 
as for regular text; that is, double-click on it, use the icon, or type in ddedit. Now, on to 
formatting. Mtext has a lot of additional features, and once you input the text, you can 
modify it significantly. There is some intent here to mimic MS Word’s text editing abilities, 
and although AutoCAD cannot really come close to a dedicated word processing program, 
the available tools are still quite extensive. We take a look at the non-Ribbon toolset first and 
cover the tools again (in less detail, since you already will know them) using the Ribbon’s 
Text Editor.

Figure 4.5 
Text formatting (no Ribbon).

Figure 4.6 
Text formatting (with Ribbon).
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Looking at the Text Formatting toolbar from left to right, as shown in Figure 4.7, we have the 
following groups:

Group 1.	� This is where you set name, font, and size, although this is generally done using 
style, to be discussed later. You can also make the text annotative, to be covered in 
Level 2.

Group 2. �These are the standard Bold, Italic, Underline, Overline, and Undo/Redo buttons. This 
is also where you set color, though that is usually done by layer. The Ruler icon 
turns off the Ruler grid, the OK button closes the field, and the down arrow brings 
up additional options, to be covered soon.

Group 3. Here you find a tool for making columns and some of the associated settings, 
paragraph justification tools, as well as tools to change line spacing, numbering, and 
fields.

Group 4. Here you find tools to change from upper to lower case (and vice versa), symbols (to 
be discussed soon), oblique, width factor, and tracking tools.

You may be familiar with most of these if you ever typed a document in MS Word®. Just like in 
Word, you can highlight the text to which you want the changes to apply. Experiment with the 
buttons to see what they all do. Notice also how Arial is the default font in AutoCAD 2011.

There is more to the Mtext command than just the main toolbar seen in Figure 4.8, although 
it does contain most of the often used commands. Two additional menus are accessed by 
either right-clicking while inside the Mtext box or pressing the @ symbol icon in Group 4. We 
cover this @ menu first; it introduces a vast array of available symbols.

Here is what the menu looks like (Figure 4.9). Look at it closely; it has interesting and useful 
options. In engineering and science, one typically encounters many industry- or trade-specific 

Figure 4.8 
Mtext sample.

Figure 4.7 
Text formatting groups.
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symbols. AutoCAD provides a significant database of them for your use. Browse through and 
try them all by clicking and making them appear in your text field.

In case none of those symbols is what you are looking for, there are more. At the bottom of 
the menu, click on Other. A character map appears, as shown in Figure 4.10.

Figure 4.9 
Mtext symbols.

Figure 4.10 
Character map.
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It is similar to the character map used by MS Word and functions the same way. This is 
basically a database of available letters (in English and several other languages) as well as 
symbols and characters. The choices change somewhat from font to font. To use this tool, 
simply click on a symbol you want (it will temporarily increase in size so you can examine it 
closer), and press the Select button. Then, minimize the Character Map box (or close it if you 
do not need it any more), and right-click to paste back into your Mtext field.

Character maps are generally for symbols not found in the main list of the drop-down table 
(Figure 4.9). If you see the symbol you want there first, use it.

To introduce the final menu, right-click in the Mtext field and you will see the menu in 
Figure 4.11.

Some of these menu choices duplicate what is already seen in the main Mtext menu bar, and 
you can access all the symbols through here as well. Aside from some Cut and Paste choices, 
this menu just presents an alternate way of making option selections.

As mentioned before, Ribbon users are presented with essentially the same formatting tools 
but in a rearranged manner. Figure 4.12 is the Ribbon’s Text Editor again with the various 
drop-down menus “thumbtacked” (by clicking the tack symbol) on the drawing canvas:

l	 Style: Annotative and size can be changed here.
l	 Formatting: Bold, italics, underline, overline, font, color, background mask (color), 

oblique, spacing, and width factor can be changed here.

Figure 4.11 
Mtext right-click menu.
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l	 Paragraph: Justification, line spacing, bullets, and numbering can be changed here.
l	 Insert: Columns, symbols, and fields can be changed here.
l	 Spell Check: You can run the Spell Checker and set dictionaries and settings here.
l	 Tools: Find and Replace, Import Text, and AutoCAPS are found here.
l	 Options: Here you can make the Editor toolbar come back (AutoCAD never really gets 

rid of anything), add the Ruler grid, and use the Undo/Redo. You can also change the 
background of the Editor to opaque.

l	 Close: Closes the Editor, similar to the OK button.

4.4  Style
The idea behind the Style command is very straightforward. Pick a font, give it a name and a 
size, and use it throughout your drawing. Drawings typically use only one font throughout 
the main design, and perhaps another fancier one in the title block area for logos and other 
designations, so it makes sense to set one style and stick to it. You have already perhaps 
changed the font while learning the Mtext command, but it was only for that instance. You 
need to make sure that font is set globally, meaning for the entire drawing.

Prior to AutoCAD 2009, changing the font right away was a necessity, as the default font 
(Simplex) was unattractive and rarely used in practice. With AutoCAD 2011 and the previous 
two releases, the default font is Arial (though the default size is still 0.2), so you may want to 
stay with this popular font and not change it. If you need to, however, here is the procedure.

Whichever method you use, the Text Style dialog box of Figure 4.13 appears.

Taking a look at this dialog box, let us say Arial is not what we want here; we would like to 
set a RomanS font that is 6 high instead. To do this, we need to go through the following 
three steps:

Step 1. Press the New button and type in the name and size of the font: RomanS_6.
Step 2. Pick romans.shx from the Font Name: drop-down menu.
Step 3. Highlight the 0.0000 in the Height field and type in 6 (no need for the inch 

symbol). Press Apply and Close.

All text that you type from now on will be RomanS 6 font. To create another font just repeat 
these steps. To size your font up and down, you can also create new font styles, but in this 
case it may be more practical to just use the Scale command.

Figure 4.12 
Ribbon Text Editor, thumbtacked.
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The additional options in the Style dialog box are not used that often but review them just in 
case. A list follows. All effects can be previewed in real time in the Preview box in the lower right.

l	 Upside down: Flips the text upside down.
l	 Backwards: Flips the text backwards.
l	 Vertical: Stacks the text vertically.
l	 Width Factor: Widens the text if (1), narrows text if (1).
l	 Oblique Angle: Leans the text to the right if positive () and to the left if negative (–).
l	 Annotative: An advanced topic for Level 2.

4.5  Spell check
This section briefly describes AutoCAD’s in-place, stand-alone spell checking abilities. Yes, 
AutoCAD does have a Spell Checker, and why not? For the price the software costs, it better. 
It is very easy to use, so let us try it out on the misspelled phrase shown in Figure 4.14.

The first thing you notice is that the misspelled word (jumped) is underlined by a dotted red 
line. If you right-click on the word while in Editing mode, you get the in-place spell check with 
suggestions (Figure 4.15). Simply select the word you want to correct to and AutoCAD obliges.

Now what if you already have a significant amount of text (perhaps from an import) and 
need to spell check it? Then you can use the stand-alone utility, as described next.

Using any of these methods, the Check Spelling dialog box appears, as seen in Figure 4.16.

Figure 4.13 
Text Style dialog box.
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Figure 4.14 
Misspelled word.

Figure 4.15 
In-place Spell Checker.

Figure 4.16 
Check Spelling.
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Using the drop-down menu of the Check Spelling dialog box, you can select specific 
paragraphs or lines of text, or just press Start to initiate Spell Checker for all the text in the 
drawing. In any case, Check Spelling appears as in Figure 4.17.

Much like with the MS Word spell checker, you can run through some options, such as 
ignoring the word, changing it, or adding it to the dictionary so it is not flagged again (good 
for names and acronyms). There is even a variety of languages available. When done, Spell 
Checker tells you, and you can close it.

4.6  In class drawing project: adding text and 
furniture to floor plan layout
Let us now apply what you learned to our floor plan. Shown in Figure 4.21 is the same floor 
plan you have worked on in Chapter 3, with the addition of text in the rooms and closets 
(with dashed lines indicating closet shelves) as well as new furniture and appliances.

Some general tips:

l	 Make up your own layers and colors for each set of data, making sure the names are logical. 
For example, call kitchen appliances something along the lines of A-Appliances and so on.

l	 None of the furniture is drawn to scale, so approximate but draft everything correctly, 
connecting all lines with OSNAP and using Ortho for straight lines. Most shapes are 
based on rectangles.

l	 Save your work often.

Also some specific drawing tips:

l	 All kitchen furniture on the left is formed using basic rectangles, drawn to no particular 
size. To create the range top burners with the four even circles, you need to draw one as 
shown in the following sequence using two circles and two lines, then mirror it using 
midpoints of the range itself, as seen in Figure 4.18.

l	 To create the table you could use a rectangle with a small guideline sticking out of the left 
vertical side. That could be the anchor for the second point of the arc. Then a Mirror and 
an Explode command allows you to erase the unneeded parts, as seen in Figure 4.19.

l	 You may occasionally need a new OSNAP point called nearest. It creates shapes (usually 
new lines) along random spots of previous geometry. In a sense near is the exact opposite 
of the precise end, mid, and other points you learned. Near simply shadows a line or any 
object and allows you to begin a new object anywhere along that perimeter. We do not 

Figure 4.17 
Check Spelling initiated.
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generally leave near running along with the other 
OSNAP points, as it makes using them more difficult; 
rather, just type it in (NEA) or use the toolbar as 
needed. An hourglass figure appears; just click on 
wherever you want to start the stair line. Figure 4.20 
is a screen shot of NEAr in action.

l	 Draw rectangles around each of the room text fields; 
we need this later for hatch.

l	 The bathtub is done using the basic Ellipse 
command, introduced in Chapter 2.

Finally we have two more tips. Tip 6 has to do with ltscale, something briefly mentioned in Chapter 3. Tip 7 
shows you how to get rid of the UCS icon, something many students ask about. Figure 4.21 shows the floor plan 
with furniture and appliances.

Tip 6:  If you draw your hidden lines 
for the closet shelving and they look solid not 

dashed, then the problem may be incorrect linetype 
scaling, a common error to watch out for. Type in 

ltscale, press Enter, and input a new value (a larger 
one, since your floor plan is bigger than the default 

original space of 8.5  11). Do this a few times 
until you get it to look just right.

Figure 4.18 
Constructing the range top.

Figure 4.19 
Constructing the table.

Figure 4.20 
Near OSNAP.
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Figure 4.21 
Floor plan layout 2.

Tip 7:  Want to get rid of that pesky 
Universal Coordinate System icon hanging out 

in the drawing area? It is somewhere near the lower 
left-hand corner of your screen, looks like a big L, and 
has a Y and an X on its tips. To make it go away, type 
UCSICON, press Enter and then type in OFF. Of course, 
if it does not bother you and you actually like it there, 

then ignore this whole tip.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 5:

l	 Text
m	 Creating basic text

l	 Mtext
m	 Creating basic Mtext

l	 Mtext formatting options
m	 Bold
m	 Underline
m	 Italics
m	 Justification
m	 Symbols
m	 Other

l	 Editing text
m	 Double-click
m	 ddedit

l	 Style
m	 Font name
m	 Font type
m	 Font size
m	 Width factor
m	 Oblique angle

l	 Spell Checker

Tips

Tip 6: If you draw your Hidden lines for the closet shelving and they look solid not dashed, 
then the problem may be incorrect linetype scaling, a common error to watch out for. 
Type in LTSCALE, press Enter, and input a new value (a larger one, since your floor 
plan is bigger than the default original space of 8.5  11). Do this a few times until 
you get it to look just right.

Tip 7: Want to get rid of that pesky Universal Coordinate System icon hanging out in the 
drawing area? It is somewhere near the lower left-hand corner of your screen, looks 
like a big L, and has a Y and an X on its tips. To make it go away, type UCSICON, press 
Enter and then type in OFF. Of course, if it does not bother you and you actually like it 
there, then ignore this whole tip.

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 4.

  1.	 What are the two types of text in AutoCAD? State some properties of each, and describe when you 
would likely use each type.

  2.	 What are the two methods to edit text in AutoCAD?

  3.	 What feature allows you to add extensive symbols to your Mtext?

  4.	 What are the three essential features to input when using Style?

  5.	 What is the width factor?

  6.	 What is an oblique angle?

  7.	 How do you initiate Spell Check?

  8.	 What new OSNAP is introduced in this chapter?

  9.	 How do you get rid of the UCS icon?

10.	 What can you do if you cannot see the dashes in a Hidden linetype?



level 1  
Chapters 1–10

110

2.	 Draw the following set of P&ID (piping and instrumentation diagram) symbols. They are not to scale 
and are approximated. Then enter the legend as shown next to the symbols. Use the Arial font of 
appropriate size. (Difficulty level: Intermediate; Time to completion: 40–60 minutes)

EXERCISES
1.	 Open a blank file and create a new style called RomanS_2; choose font: RomanS, height: 2, and 

width factor: 0.88. Then create the following table using basic linework (distances between horizontal 
lines are 4). Finally, fill it in with the data shown using your choice of Text or Mtext commands. 
(Difficulty level: Easy; Time to completion: 20 minutes)
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3.	 Open a new file, set up Architectural units, create the proper layers and colors, and draw the following 
floor plan. The dimensions are only for construction purposes and the solid hatch is for clarity. 

(Difficulty level: Intermediate; Time to completion: 60–90 minutes)
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CHAPTER

Hatch Patterns

Learning objectives
Hatch patterns allow you to indicate a variety of surfaces, from wood to concrete, on  
your design. In engineering, they are also used to indicate cross section surfaces.  
In this chapter we introduce the Boundary Hatch and discuss the following:
l	 Hatch fundamentals
l	 Picking patterns
l	 Picking area or objects to hatch
l	 Adjusting scale and orientation
l	 Working with hatch patterns
l	 Gap tolerance
l	 Gradients and solid fills

5
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 At the end of this chapter, you will be able to add hatch patterns to your floor plan.

Estimated time for completion of chapter: 2 hours (lesson  project).

5.1 I ntroduction to hatch
This is a chapter on the concept of Boundary Hatch or just Hatch for short. This is simply 
a tool for creating patterns and adding fills to your design. These are not merely decorative, 
rather they serve an important function of indicating types of materials, ground and floor 
coverings, and cross sections. As such, this topic is quite important and is the next logical 
concept to master in AutoCAD.

We cover hatch patterns in two sections. The first is with the Ribbon turned off, which 
makes the Hatch command default to the classic dialog box seen in Figure 5.1. It is easier 
for a beginner to visualize hatch concepts via this method. It was also the only way to access 
Hatch up until AutoCAD 2011, good to know if you are using an older version of AutoCAD. 
With the 2011 release, Hatch can be accessed with the Ribbon only (if it is turned on). 
The Ribbon essentially duplicates the Hatch dialog box, with maybe a few more bells and 
whistles; we cover this approach as well.

Hatch patterns are not an AutoCAD invention. In the days of hand-drafting, there was also a 
need to visually indicate what sort of material one was looking at. Architects and engineers 

Figure 5.1 
Hatch and Gradient dialog box.
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created easy to understand repeating patterns that somewhat, if not closely, resembled the 
actual material or at least gave you a very good idea of what it was. Just a few of the uses of 
hatch patterns follow:

Architecture

l	 Brick: An important and popular pattern to render the exterior and (sometimes) interior 
of buildings. AutoCAD has numerous brick patterns available.

l	 Herringbone, parquet: Important for flooring designations.
l	 Honeycomb: Insulation designation.

Civil Engineering

l	 Concrete, sand, clay, earth, gravel: All used in designating surfaces in civil and site plan 
design.

Mechanical Engineering

l	 Various ANSI diagonal patterns: Used to designate the visible inside of an object cut in 
cross section.

With AutoCAD, creating these patterns is easy, as they are all pre-drawn and saved in a 
library that is called up anytime you use the command. Often a designer can purchase or 
download additional patterns, if the basic ones are inadequate. You can even make your own 
and save them for future use, although this is a tedious process and is only briefly covered in 
Appendix D.

5.2  Hatch procedures
At the most basic level, AutoCAD’s Hatch command requires only four steps:

Step 1. Pick the hatch pattern you want to use.
Step 2. Indicate where you want the pattern to go.
Step 3. Fine-tune the pattern by adjusting scale and angle (if necessary).
Step 4. Preview the pattern and accept it if OK.

Memorize the four steps and their sequence; this will help you when looking at the Hatch 
command dialog box.

Before we get into the details, it goes without saying that you first need something to hatch. 
The command will not work on a blank screen or a bunch of unconnected lines. You need 
a closed area (although later on we violate that rule), and the easiest to do is a circle or 
rectangle. Open a new file and draw either of the two shapes. Follow the steps carefully as 
described next. All advanced Hatch functions flow from these basics.

Step 1. Pick the Hatch Pattern you Want to use

With the Ribbon turned off (Tools→Palettes→Ribbon), begin the Hatch command using 
any of the previous methods. The Hatch and Gradient dialog box appears (Figure 5.1). At 
the bottom right of the dialog box is an arrow that expands or collapses additional options. 
Make sure it is expanded, as seen in the figure.
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Now select a pattern. The choices are listed in the upper left of the dialog box under the 
heading Type and pattern. Below that are three fields called Type, Pattern:, and 
Swatch:. Leave Type as predefined and move down to the next one. If you use Pattern:, 
then you select the pattern by name; if you pick Swatch:, patterns are selected visually, a 

Figure 5.2 
Hatch Pattern Palette.

Figure 5.3 
Other Predefined tab.
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much better option. Click on the diagonal lines to the right of Swatch: (or the little box 
with the three dots to the right of Pattern:) and a new box, called the Hatch Pattern Palette, 
appears (Figure 5.2).

Take a look through the tabs: ANSI, ISO, Other Predefined, and Custom. We have a use for 
some of the ANSI patterns, not so much for the ISO ones, and Custom is where the custom-
defined patterns go if you are inclined to create them. Click on the Other Predefined tab, and 
Figure 5.3 is what you see.

Scroll up and down the patterns. You will notice some of the ones mentioned at the start of 
this chapter. Go ahead and pick one that you like, preferably one that is distinct and stands 
out; AR-HBONE is a good choice and is used in this example. When you click on it, the 
pattern is highlighted blue. Go ahead and click on OK. We are done with Step 1. The new 
pattern choice is reflected in the Swatch area, as seen in Figure 5.4.

Step 2. Indicate Where You Want the Pattern to Go
There are two ways to indicate where to put the pattern, either by directly picking the object 
that will contain the pattern or by picking a point inside that object. The difference is very 
simple. If the object actually is an object made of joined-together lines and is one piece (such 
as your rectangle or circle), then it can be picked directly. If not, and the “object” is really just 
a collection of connected lines defining an area, then the best way is to pick a point in the 

Figure 5.4 
Step 1 completed.
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middle of that area; and indeed this is the more common situation. The pattern then behaves 
like a bucket of paint spilled in the middle of the room. It flows outward evenly and stops 
only when it hits a wall. Once again, no holes or gaps are allowed yet; that is addressed later.

In the Boundaries section of the dialog box (top middle), observe the two choices just 
discussed and pick either one. The AutoCAD procedure is outlined next.

Add: pick points
If you pick this option AutoCAD says:

Pick internal point or [Select objects/remove Boundaries]:

Click somewhere inside the object and AutoCAD says:

Selecting everything...
Selecting everything visible...
Analyzing the selected data...
Analyzing internal islands...

Press Enter and you will return to the Hatch dialog box with Step 2 completed.

Add: select objects
Alternatively, if you pick this option AutoCAD says:

Select objects or [picK internal point/remove Boundaries]:

Click on the object itself (not the empty space) and press Enter. You will return to the Hatch 
dialog box with Step 2 completed.

Successfully picking a boundary can sometimes be tricky business. The existence of gaps, 
no matter how small, can be a source of occasional frustration to designers; and until just 
recently, it used to be difficult to tell where those gaps were hiding in order to fix them. As 
of AutoCAD 2010, red circles now appear where the gaps are, aiding you in locating them, 
but this all can be avoided in the first place by not doing sloppy drafting (i.e., not connecting 
lines together properly). It is a sign of advanced AutoCAD skills when a complex area 
hatches right the first time.

In cases where boundary selection is not successful, complex areas can often be broken down 
to smaller ones by using lines to divide the area into smaller pieces and the non-problematic 
portions hatched first, though this is a last resort. A few releases ago, AutoCAD added the Gap 
Tolerance command that ignores gaps up to a preset limit. This is a great tool, which we cover 
shortly, along with the entire gap issue in general, but it is somewhat of a “band-aid” and still 
does not address the underlying sloppy drafting, but merely allows you to get away with it.

Remember “Garbage in  Garbage out”; it is essential to master the fundamentals of 
AutoCAD drafting early on. The Hatch command is an “early warning” to students. If they 
are having problems using it smoothly, they need to go back and refine their basic drafting 
(linework and accuracy) skills.

Step 3. “Fine-Tune” the Pattern by Adjusting Scale and  
Angle (if Necessary)
You are almost done and, at this point, could probably just press OK and finish the hatch 
pattern; however, press Preview instead. It is found at the bottom left of the dialog box and 
is generally a good habit to get into. What you see is your hatch pattern (if it is the right size) 
with the object’s border in dashed lines (Figure 5.5).

If everything looks right (as it does in this example), AutoCAD says what to do next:

Pick or press Esc to return to dialog or <Right-click to accept hatch> 
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Go ahead and right-click or press Enter.

Sometimes, however, the pattern is too big or too small. You can usually tell it is too big 
by either not being able to see it or seeing a small part of it. If it is too small the problem is 
worse, because you may not be able to finish the pattern at all. Instead, AutoCAD tells you 
the following:

Hatch spacing too dense, or dash size too small. Pick or press Esc to 
return to dialog or <Right-click to accept hatch>:

Nothing appears. In either case, press Esc once and you return to the dialog box. Under the 
Angle and scale, change the scale to a larger or smaller number (by typing it in) and preview 
it again. You may need to do this several times until the hatch pattern is just right. In the 
same manner, you may adjust the angle of the entire pattern if desired. Angle and scale is 
shown in Figure 5.6.

Step 4. Preview the Pattern and Accept it if OK
Finally you are done. Do one more preview and press OK. The sample hatch pattern should 
look like Figure 5.7. Yours may or may not be similar depending of course on what pattern 
and scale you selected, as well as what shape you used.

5.3  Working with hatch patterns
In this section, we mention some of the additional tools and concepts that pertain to hatch 
patterns. First of all, the most basic question at this point is, how do you edit a hatch pattern 
after you’ve created it? It is very easy: To edit a hatch pattern, simply double-click on it. Make 
sure you get one of the lines of the pattern, not just empty space. You will see grips and the 

Figure 5.5 
Hatch preview.

Figure 5.6 
Angle and scale.
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standard Properties Palette (Figure 5.8); here you can change whatever you need to. This is 
different from previous releases of AutoCAD, where you were taken to the Hatch dialog box 
(Figure 5.1). If you are using the Ribbon (to be discussed shortly), you need to click only 
once to edit the pattern.

Figure 5.8 
Editing the hatch pattern.

Figure 5.7 
Final hatch pattern.
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Exploding Hatch Patterns
This may be one of the worst things you can do. Never explode hatch patterns; depending 
on the size, they turn into hundreds of pieces that cannot be put back together again in the 
same editable form. All the reasons designers give for exploding hatch patterns (making 
them fit, trimming them, moving the containment border, etc.) can be addressed with 
additional hatch tools.

Hatch Pattern Layers and Colors
Hatch patterns should be on a generic A-Hatch layer or whatever layer name best describes 
what the pattern represents (A-Carpet, M-Cross-Sec, C-Gravel, etc.). Choose any color you 
want for the hatch patterns, though you should not go with anything too bright, as it may 
overwhelm the design. Shades of gray are common for cross sections in mechanical design, 
as are various shades of rusty orange for brick. As a side note, hatch patterns can be easily 
erased by the usual erasing methods. The patterns can also be moved, copied, rotated, and 
mirrored, though there is rarely a reason to do so.

In AutoCAD 2011, you can now assign a color directly to a hatch pattern regardless of what 
layer (and associated color) it is on. You can also assign a background color (solid, not a 
gradient). To do this you can select both the hatch color and the background color (Figure 
5.9) from two drop-down menus at the top left of the Hatch dialog box. The same steps can 
be performed with the Ribbon. The result of the steps shown in Figure 5.9 is shown in  
Figure 5.10.

Advanced Hatch Topics
Except for Gap Tolerance, we do not cover the rest of the options in much detail but 
summarize some of them in an overview. Feel free to explore on your own; this is an 
important part of learning AutoCAD and greatly enhances your confidence with the  
software.

Hatch origin
This allows you to begin hatch patterns from a precise location (origin) as opposed to a 
random fill-in. AutoCAD chooses the origin on the pattern itself, and you get to choose to 
what point on the object that origin is aligned. Try it out.

Figure 5.9 
Hatch (blue) and background (yellow) color selection.
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Options
l	 Annotative: Will not be covered until Level 2.
l	 Associative: Keep this checked. This simply means that if you move the border, the hatch 

moves with it; very useful in case of future updates.
l	 Create separate hatches: If there are multiple separate areas to hatch, this option keeps 

them separate; sometimes useful, sometimes not.
l	 Draw order: This is exactly what it sounds like; it gives you options on how you want to 

stack the hatch and its boundary. Check out the options in the drop-down menu.
l	 Inherit Properties: This option lets you borrow the features of another hatch pattern and 

use them in a new pattern you are creating, saving you some effort and time in picking 
out a pattern from scratch.

Islands
This gives AutoCAD guidance in how to interpret boundaries inside boundaries (e.g., a chair 
in the middle of your floor). It simply tells AutoCAD to ignore them or, if not, how to deal 
with them. Try drawing another rectangle inside your first one and running through the 
options represented by the pentagon shapes.

Gap tolerance
This is a simple and popular new tool that was mentioned earlier. Simply set the tolerance to a 
value big enough to span anticipated holes or gaps in your design and hatch as usual. Initially, 
if your tolerance is set to 0 units and you try to hatch an area with a gap, you get Figure 5.11.

Figure 5.11 
Boundary Not Closed alert.

Figure 5.10 
Hatch pattern with background.
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Close the alert and press Esc to continue. Then, returning to the main dialog box, set a value 
for the gap tolerance (you can use 10 for starters) and re-hatch the area. You get another 
warning (which can be eliminated from future occurrence by checking off Always perform 
my current choice), as seen in Figure 5.12.

Select Continue hatching this area and AutoCAD temporarily closes the gap to 
continue the Hatch command. After successful completion, the gap shows again but the 
hatch remains, as seen in Figure 5.13. Some designers have used the command to ignore 
door openings when hatching carpeting in floor plans. You can try this as well on your floor 
plan later.

5.4 Gra dient and solid fill
At the top left of the Hatch and Gradient dialog box, click on the Gradient tab. The left side 
of the box changes while the right-hand side stays essentially the same, as shown in Figure 
5.14. The gradient option is just a solid fill with some flair. You can choose the desired 
pattern, in one or two colors, and adjust the Shade, Tint, Orientation, and Angle of the 
gradient. The rest of the steps are similar; Pick point or Select object, Preview, and done.

Shown in Figure 5.15 is a possible use for gradient in rendering a brick wall. A brick pattern 
was created and a brick-colored fill on top of each other. Note that you may need to use 
Tools→Draw Order→Bring to Front from the cascading menu to position the brick above 
the gradient fill (or the gradient fill behind the brick, depending on what you pick first). Try it.

Solid Fill
This fill is the first choice in Other Predefined (shown in Figure 5.16) and deserves special 
mention as our final topic.

This solid fill is similar to a gradient but with no fancy color mixing, just one color. It is very 
handy as a fill for walls, some types of cross sections, or any location where you want a dark 
area. It becomes even more useful when paired up with a lineweight feature called screening, 

Figure 5.12 
Open Boundary Warning.

Figure 5.13 
Hatch with gap tolerance.
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which is discussed in detail in Chapter 19. It has to do with being able to fade out (or 
screen) the intensity of any color (typically down to 30%) and is perfect for indicating “area 
of work” on key plans, some types of carpeting, and even pavement on civil engineering 
drawings.

A way to mimic this now without screening is to change the solid fill’s color to Gray 9; a soft 
gray haze is then seen that is distinct and visible, yet not overwhelming. If you are wondering 
how the walls were filled in on the apartment drawing, this is how.

Figure 5.14 
Gradient tab.

Figure 5.15 
Brick wall using hatch and gradient.
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The previous steps using the Hatch dialog box are essentially duplicated using the Ribbon. 
Bring it back by typing in Ribbon (or Tools→Palettes→Ribbon via the cascading menus). 
Draw a shape to hatch and begin the command in the same manner as before (typing, 
Ribbon, toolbars, or drop-down menus); you will see the Ribbon switch to Figure 5.17. Here 
you still have to pick the pattern by dropping down the menu, as seen in Figure 5.18. Note 
how all the hatch patterns are present and you have no tabs anymore.

Figure 5.16 
Solid fill.

Figure 5.17 
Ribbon hatch.

Figure 5.18 
Selecting patterns.
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You can then hover your mouse over the area and get an “instant preview” of the pattern 
to get an idea of what you have. When you move the mouse away, the pattern disappears. 
Selection of boundaries is all the way on the left, under Boundaries, and the fine-tuning is 
in the middle of the Ribbon under Properties. Here, you can select the Scale, Angle (with 
instant rotation via a slider), and Background Colors. The rest of the features, such as Gap 
Tolerance, Origin, and others, are found under Origin and Options on the right.

Which method you use is entirely up to you, though if you have the Ribbon up all the time, 
it makes more sense to continue using it for the Hatch command as well.

5.5  In class drawing project: adding hatch to  
floor plan layout
Go ahead and add hatch to the rooms of your floor plan, including the walls. Some tips follow.

To add hatch to rooms, freeze the A-Doors layer and instead draw temporary lines closing 
off the door entrances. After hatching, remove the lines. You may also be able to use gap 
tolerance set to at least 3 feet, but that is not recommended.

Make sure the hatch patterns are on the proper layers, whatever they may be (carpeting or 
just hatch_1, hatch_2; you decide). You do not have to pick the hatch patterns shown, but 
make sure they are reasonable and at the proper scale.

To fill in the apartment walls, freeze everything except the A-Walls and the hatch layer. 
Then use the solid fill, color 9 as described earlier. If you created everything properly, there 
should be no gaps or breaks in the wall islands. Check to make sure the windows are drawn 
correctly, meaning the wall has to have an actual closed gap, into which the window is 
inserted. Figure 5.19 shows what everything should look like prior to wall hatching (1) and 
right after (2). The apartment is shown in Figure 5.20.

Figure 5.19 
Wall hatching.
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Figure 5.20 
Floor plan with hatch.

Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 6.

l	 Hatch
l	 Picking pattern
l	 Selecting area or object
l	 Scale and orientation adjustments
l	 Preview
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l	 Editing a hatch
m	 Double-click

l	 Additional options
m	 Islands
m	 Inherit properties
m	 Associative
m	 Draw order

l	 Gap tolerance
l	 Gradients and fill

Review questions
Answer the following based on what you learned in Chapter 5.

1.	 List the four steps in creating a basic hatch pattern.
2.	 What two methods are used to select where to put the hatch pattern?
3.	 What commonly occurring problem can prevent a hatch being created?
4.	 What is the name of a tool recently added to AutoCAD to address this problem?
5.	 How do you edit an existing hatch pattern?
6.	 What is the effect of exploding hatch patterns? Is it recommended?
7.	 What especially useful pattern to fill in walls is mentioned in the chapter?

Exercises
1.	 In a new file, create the following shapes and hatch patterns. Sizing and patterns are arbitrary, but 

do try to duplicate what is shown as closely as possible. (Difficulty level: Easy; Time to completion: 
3–5 minutes)
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2.	 In a new file, create the following shapes and hatch patterns. Sizing and patterns are arbitrary, but 
do try to duplicate what is shown as closely as possible. (Difficulty level: Easy; Time to completion: 
3–5 minutes)

3.	 Open a new file and set units to Architectural. Create the following stair layout and hatch patterns. Any 
sizes and dimensions that are not given can be estimated, as can the scale of the patterns. (Difficulty 
level: Intermediate; Time to completion: 20–30 minutes)
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4.	 Open a new file and set units to Architectural. Create the following layout of a set of cylinders. 
Dimensions are provided, but sizing is of secondary importance to creating the hatch patterns. Notice 
how gradients are used to depict curvature inside the pipe cross sections; a good trick to add realism 
to 2D drawings. (Difficulty level: Intermediate; Time to completion: 20 minutes)
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LEARNING OBJECTIVES
In this chapter we will introduce the first part of AutoCAD’s extensive dimensioning 
capabilities and discuss the following:
l	 Linear (horizontal and vertical) dimensions
l	 Aligned dimensions
l	 Diameter dimensions
l	 Radius dimensions
l	 Angular dimensions
l	 Continuous dimensions

CHAPTER

Dimensions

6
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l	 Baseline dimensions
l	 Leader and Multileader
l	 Arc Length dimensions
l	 Ordinate dimensions
l	 Jogged dimensions

m	 ddedit
m	 ddim

l	 Dimension units
l	 Dimension font
l	 Dimension arrowheads
l	 Dimension overall size

At the end of this chapter you will be able to add dimensions to your floor plan.

Estimated time for completion of chapter: 3 hours (lesson  project).

6.1  Introduction to dimensions
Dimensioning in AutoCAD is a major topic, one that is so extensive that it is split into two 
separate discussions. Here, we address the basics of what dimensions are, which ones are 
available, and how to use and edit them. In Chapter 13, we look at extensive customization 
and additional options. AutoCAD permits significant sophistication with dimensioning; 
here, we cover only what is used most often to get you going quickly. In Chapter 13, we also 
introduce a brand-new addition to the dimensioning family: parametric dimensioning and 
the concept of constraints and dimension-driven design.

So what are dimensions? They are simply visible measurements of something for the 
purposes of conveying information to the audience that will be looking at your design. 
It is how you describe the size of the design and where it is in relation to everything else. 
Dimensions can be “natural,” meaning they display the actual value, or “forced,” when they 
display an altered value, such as when you dimension an object with a break line. The break 
line indicates that a chunk was taken out to conserve space, yet the dimension still needs to 
state the true value, which is entered manually.

6.2  Types of dimensions
The first step in learning dimensions is to know what is available, so you can use the 
appropriate type in any situation. The primary and secondary dimensions available to you 
are shown next. Commit them to memory, as you may need many, if not most of them, on a 
complex project.

Primary dimensions are the dimensions used most often by the typical architectural or 
engineering designer:

l	 Linear (horizontal and vertical)
l	 Aligned
l	 Diameter
l	 Radius
l	 Angular
l	 Continuous
l	 Baseline
l	 Leader.
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Figure 6.1 
Dimension toolbar.

Secondary dimensions are used less often or are quite specialized but still need to be 
mentioned:

l	 Arc Length
l	 Ordinate
l	 Jogged

Let us take the primary list, one by one. Look them over and understand for what each is 
used. Then draw the appropriate shape to practice with, and add the new dimension by 
following the step-by-step instructions. We will, as always, use typing, toolbars, cascading 
menus, and the Ribbon. Open a new file and bring up the Dimension toolbar (Figure 6.1), 
adding it to the toolbars already on your screen.

Note an important point if typing dimensions: You need to type in dim and press Enter. This 
gets you into the dimension subset. The command line then says Dim: and you can type in 
whatever dimension you want to create (usually abbreviating by typing only the first few 
letters, as shown) and press Enter again. The command then executes normally. So there is 
an advantage to using other input methods here rather than typing, though the differences in 
effort and speed are rather small. Remember also that you need to press Esc to get out of this 
subset and back to the regular command line.

Linear Dimensions
These are any dimensions that are strictly horizontal or vertical (Figure 6.2).

Step 1. Create a small to medium size rectangle or square, as seen in Figure 6.2, and begin 
the Linear Dimension command via any of the previous methods.

Step 2. m � AutoCAD says: Specify first extension line origin or <select 
object>:

		�  Turn on your OSNAPs, and using ENDpoint, select the left corner of the rectangle/
square.

Step 3. m  AutoCAD says: Specify second extension line origin:
		�  Again, using ENDpoint, select the right corner of the rectangle/square (we are 

doing the horizontal one first).
Step 4. The Dimension appears.

m	� AutoCAD says: Specify dimension line location or [Mtext/Text/Angle/
Horizontal/Vertical/Rotated]:

		�  Move the mouse up and down and click where you want the dimension to 
go, usually a short distance from the object. It sets and the value is shown by 
AutoCAD saying Dimension text = 4.4681 (your value will likely be different 
of course).
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Note an important distinction with typing. Instead of setting the value in Step 4, AutoCAD 
throws in one more step, allowing you to alter the dimension on the spot (forcing it). You 
can enter a new value or press Enter to accept the natural one.

The previous linear dimensions are by far the most common in most drawings and are also 
the basis for the continuous and baseline dimensions, to be covered later on. Be sure to also 
run through the vertical version of the linear dimension, selecting the upper and lower right 
(or left) corners of the rectangle/square. Next is the aligned dimension, which gives a true 
distance of a slanted surface.

Aligned Dimension
This is a dimension that measures a slanted line or object (Figure 6.3).

Step 1.	Create a small to medium size rectangle or square and chop off a corner, as seen in 
Figure 6.3. Then begin the Aligned Dimension command via any of the previous 
methods.

Figure 6.3 
Aligned dimension.

Figure 6.2 
Linear dimensions.
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Figure 6.4 
Diameter dimension.

Step 2. m � AutoCAD says: Specify first extension line origin or <select 
object>:

		�  Turn on your OSNAPs and using ENDpoint, select the upper left start of the 
slanted line.

Step 3. m  AutoCAD says: Specify second extension line origin:
	 Again, using ENDpoint, select the lower right end of the slanted line.

Step 4. The Dimension appears.
m	� AutoCAD says: Specify dimension line location or [Mtext/Text/
Angle]:

	� Move the mouse up and down and click where you want the dimension to 
go, usually a short distance from the object. It sets and the value is shown by 
AutoCAD saying Dimension text = 2.9255 (your value will likely be different 
of course).

Again, note an important distinction with typing. Instead of setting the value in Step 4, 
AutoCAD throws in one more step, allowing you to alter the dimension on the spot (forcing 
it). You can enter a new value or press Enter to accept the natural one.

The next two dimensions, diameter and radius, are essentially similar, though we cover them 
separately for clarity. Note the primary difference: the symbol indicating diameter (Ø) and the 
symbol for radius (R) prior to the value. Although you can set this up, by default there is no 
line crossing the circle half-way (for radius) or all the way (for diameter), so you have to read 
the values carefully and look for the appropriate symbol to know what you are looking at. 
Also note the location of the values: They are at roughly the 10, 2, 4, and 8 o’clock positions 
relative to the circle. Do not just stick them anywhere; hand-drafting rules still apply in CAD.

Diameter Dimension
This is a dimension that measures the diameter of a circle or an arc (Figure 6.4).
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Figure 6.5 
Radius dimension.

Step 1. Create a small to medium size circle, as seen in Figure 6.4. Then begin the Diameter 
Dimension command via any of the previous methods.

Step 2. m � AutoCAD says: Select arc or circle:
	 Pick the circle and the Dimension appears attached to your mouse.

Step 3. m � AutoCAD says: Dimension text = 3.1357 (your value will likely be different of 
course)

	 Specify dimension line location or [Mtext/Text/Angle]:
	� Position your mouse somewhere to the upper right of the circle (rarely inside, 

usually outside) at 2 o’clock or at any of the other accepted positions and click. 
The value and dimension set.

Again, note an important distinction with typing. Instead of setting the value in Step 3, 
AutoCAD throws in one more step, allowing you to alter the dimension on the spot (forcing 
it). You can enter a new value or press Enter to accept the natural one.

Radius Dimension
This is a dimension that measures the radius of a circle or an arc (Figure 6.5).

Step 1. Create a small to medium size circle, as seen in Figure 6.5. Then begin the Radius 
Dimension command via any of the previous methods.

Step 2. m  AutoCAD says: Select arc or circle:
Pick the circle and the dimension appears attached to your mouse.

Step 3. m � AutoCAD says: Dimension text = 1.5679 (your value will likely be different of 
course).

	 Specify dimension line location or [Mtext/Text/Angle]:
	 �Position your mouse somewhere at the upper right of the circle (rarely inside, 

usually outside) at 2 o’clock or at any of the other accepted positions and click. 
The value and dimension set.
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Again, note an important distinction with typing. Instead of setting the value in Step 3, 
AutoCAD throws in one more step, allowing you to alter the dimension on the spot (forcing 
it). You can enter a new value or press Enter to accept the natural one.

Angular Dimension
This is a dimension for angles between two lines or objects (Figure 6.6).

Figure 6.6 
Angular dimension.

Step 1. Create two lines spread out at a random angle, as seen in Figure 6.6. Then begin the 
Angular Dimension command via any of the previous methods.

Step 2. m  AutoCAD says: Select arc, circle, line, or <specify vertex>:
	 Pick both lines, one after the other.

Step 3. m � AutoCAD says: Specify dimension arc line location or[Mtext/Text/
Angle/Quadrant]:

	� Drag the mouse out and move it around, selecting the best position for the new 
dimension, and click when you find a spot you like. Be careful, as the supplement 
of the degree value shows if you move behind the lines.

m	 AutoCAD says: Dimension text = 60 (your value may of course be different).

Again, note an important distinction with typing. Instead of setting the value in Step 3, 
AutoCAD throws in one more step, allowing you to alter the dimension on the spot  
(forcing it). You can enter a new value or press Enter to accept the natural one and position 
the text.

Angular completes the basic set of new fundamental dimensions. Next we have continuous and 
baseline, which are not really new, as we will see, but rather an extension (or automation) of the 
linear dimension learned earlier. We then conclude with a leader—not so much a dimension 
but a useful member of that family.
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Figure 6.8 
Setup for Continuous Dimensions.

Continuous dimensions
These are a continuous string of dimensions (Figure 6.7).

A short explanation is in order, as continuous and baseline dimensions give new students 
some initial problems. Continuous dimensions are nothing more than a string of familiar 
horizontal or vertical ones. The idea here is to create one of those two types of linear 
dimensions, then start up Continuous where you left off and let AutoCAD quickly fill them 
in as you pick contact points. It is really the same as using Linear over and over again, but 
faster and more accurate since it is automated.

The easiest way to practice the Continuous Dimensions is to draw a set of squares attached 
to each other. These represent a simplified view of building and room walls. Basically draw 
one random-sized square and copy it, endpoint (lower left corner) to endpoint, until you 
have what is shown in Figure 6.8.

The next step is to draw one horizontal (it can also be vertical) linear dimension as you 
already have done. Locate it about where you would like the entire string to go, as seen in 
Figure 6.9.

This is the essential first step in creating both continuous and baseline dimensions. Now you 
can practice Continuous as outlined next.

Figure 6.7 
Continuous dimensions.
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Figure 6.9 
First step of Continuous Dimensions.

Figure 6.10 
Continuous Dimensions result.

Step 1.	Once you have the squares and one linear dimension, start up the Continuous 
command via any of the previous methods.
m	� AutoCAD says: Specify a second extension line origin or [Undo/
Select]

	 <Select>:
Step 2.	A new Dimension appears. Pick the next point (corner) along the string of rectangles 

and click on it (always using OSNAP points, no eyeballing).
m	� AutoCAD says: Dimension text = 1.9709 (your value may of course be 

different).
	� You can continue this until you run out of objects to dimension; at that point, just 

press Esc. Your result is shown in Figure 6.10.

As you are already aware, the difference between typing and the other methods once again is 
the opportunity to enter a value other than what is given (force the dimension) when typing. 
You then have to repeat the Continuous command (in other words, retype cont) to carry on.

Baseline Dimensions
These are continuous stacks of dimensions (Figure 6.11).

The Baseline Dimension, as mentioned before, is very similar. The goal is to make a neat 
stack of evenly spaced dimensions that all start at one point (the base in baseline). To begin, 
erase the previous continuous dimensions (leaving the squares), and once again draw one 
linear dimension, as seen in Figure 6.12.
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Step 1.	Once you have the squares and one linear dimension, start up the Baseline 
command via any of the previous methods.
m	� AutoCAD says: Specify a second extension line origin or [Undo/
Select]

	 <Select>:
Step 2. A new Dimension appears. Pick the next point (corner) along the string of rectangles 

and click on it (always using OSNAP points, no eyeballing).
m	� AutoCAD says: Dimension text = 3.9417 (your value may of course be 

different).
You can continue this until you run out of objects to dimension; at that point just 
press Esc. Your result is shown in Figure 6.13.

Figure 6.13 
Baseline Dimensions result.

Figure 6.11 
Baseline dimensions.

Figure 6.12 
First step of Baseline Dimensions.
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Leader and Multileader
This is an arrow and label combination pointing at something (Figure 6.14).

While a leader is not a true dimension by definition, it is still a very common and necessary 
member of the dimension family. The values shown by the leader can be not only numerical 
but also text comments from the designer, concerning the part or object to which it is pointing.

Leaders are so important that AutoCAD has given them a major rework in recent releases. 
We go over the two main options in increasing order of complexity, starting with the basic 
Leader command, followed by the more feature-rich Multileader, with its Add, Remove, 
Align, and Collect options.

Leader command
Step 1. Draw a small box on your screen, making sure Ortho is off. Type in the command 

leader and press Enter.
m	 AutoCAD says: Specify leader start point:

Step 2. Click with OSNAP precision on your shape, perhaps a midpoint on the top side, as 
seen in Figure 6.14.
m	 AutoCAD says: Specify next point:

Step 3. Move your mouse at a 45° angle away from the first point and click again at a 
reasonable distance away. You created the leader line and arrowhead seen in Figure 6.15.
m	� AutoCAD says: Specify next point or [Annotation/Format/Undo] 
<Annotation>:

Step 4. Turn Ortho back on and draw a short line to the right, clicking when done; this is 
your horizontal landing, as seen in Figure 6.16.
m	� AutoCAD says: Specify next point or [Annotation/Format/Undo] 
<Annotation>:

Step 5. You are done, so press Enter.
m	 AutoCAD says: Enter first line of annotation text or <options>:
Type something in, pressing Enter if you wish to do another line, and Enter again if 
you are done, as seen in Figure 6.17.

Figure 6.14 
Leader.

Figure 6.15 
Leader Step 3.
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Multileader
This method is relatively new and is meant to add more flexibility and usefulness (and 
inadvertently some complexity) to the Leader command. You need to bring up the 
Multileader toolbar, seen in Figure 6.18.

There is something new to Multileader that you did not have with the basic one. You can set 
up a multileader style, so all leaders have the exact look you want. In our sample case, we 
give our multileader a bubble in which to add text. Press the very last button on the right 
(mleader with a paint brush) and the dialog box in Figure 6.19 appears.

Press New and give the multileader a name, such as Sample Style, and press Continue. You 
are taken to the Modify Multileader Style dialog box (Figure 6.20). Examine the three tabs, 
Leader Format, Leader Structure, and Content, carefully. Most of the options are reasonably 
self-explanatory, and you will see some of them again later on. Under the Content tab, select 
Multileader type: as Block and Source block: as Detail Callout. Finally press OK, Set Current, 
and Close.

Now let us try out our new multileader style.

Step 1. Start the Multileader command via any of the previous methods.
m	 AutoCAD says: Specify leader arrowhead location or [leader Landing 
first/Content first/Options] <Options>:

Step 2. Click anywhere and extend your mouse (Ortho off) at 45° to the right.

Figure 6.16 
Leader Step 4.

Figure 6.17 
Leader Step 5.

Figure 6.18 
Multileader toolbar.
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m	 AutoCAD says: Specify leader landing location:
Click again to place the multileader and bubble. You will see something like Figure 6.21.

Step 3. m  AutoCAD says: Enter view number <VIEWNUMBER>:
Enter in some value.
m	 AutoCAD says: Enter sheet number <SHEETNUMBER>:
Enter in another value.

Once you do this, you will see the final result (Figure 6.22), the appearance of which can of 
course be fine-tuned.

Now that you have one leader on the screen, it is easy to experiment with other interesting 
options. Move across the toolbar, starting first with the Add Leader (Figure 6.23), and get rid 
of it via Remove Leader. Then, after adding it back in, create a new set of leaders and line them 
up using the Align Multileaders (Figure 6.24), which aligns the leaders with one that you pick 
as the primary. Finally, Collect Multileader (Figure 6.25) combines them into one string.

Figure 6.19 
Multileader Style Manager.

Figure 6.20 
Modify Multileader Style.
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Figure 6.21 
Leader.

Figure 6.22 
Multileader with Block.

Figure 6.23 
Add Leader.

Figure 6.24 
Align Multileaders.
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Secondary Dimensions
It was mentioned that there are some secondary dimensions, meaning they are not used as 
often. We briefly mention them here, and you may want to go over them on your own in 
detail, especially if you feel one or more of them may be extremely useful to you:

l	 Arc Length
l	 Ordinate
l	 Jogged

Arc Length, as you may have guessed, measures the length of an arc. Simply select the toolbar 
icon and click the arc you want to measure (Figure 6.26).

Ordinate dimensions (Figure 6.27) measure horizontal or vertical distances from a datum 
point (0,0 in this case). They are used in manufacturing to prevent accumulation of errors 
that can occur using continuous measurements. Draw the shapes shown in Figure 6.27, 
positioning the lower left corner of the rectangle at 0,0, and begin the Ordinate Dimension. 
Then click major points along the way in either horizontal or vertical directions to get precise 
values at that location from the origin.

Jogged dimensions are useful when the radius or diameter dimension’s center is off the sheet 
of paper and cannot be shown directly, so a “break line” of sorts is used. You simply select the 
arc or circle then the center location override and a jogged dimension appears (Figure 6.28).

There are other dimension options we have not yet explored. We come back to some of them 
in Level 2. For now we must move on and learn how to do editing.

6.3  Editing dimensions
You should now be quite familiar with the types of dimensions available and how to apply 
them to basic shapes. The next step is to be able to edit them or change their values, if 
needed. This is a very simple and short topic.

Figure 6.26 
Arc Length.

Figure 6.25 
Collect Multileaders.
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You already learned that you can edit text and mtext by double-clicking on it. The text in the 
dimensions is essentially editable mtext, so you would be tempted to double-click on the 
text to edit it. Not so fast though. If you do that, then the Properties dialog box pops up. You 
saw it in Chapter 3. Figure 6.29 shows what it looks like again when the dimension text is 
double-clicked.

While this is useful later on, in advanced topics, it does not let you edit the dimensions. 
However, in Chapter 4, we covered ddedit and mentioned it was also useful for editing. Go 
ahead and create a horizontal dimension again on your square, type in ddedit, and press 
Enter. The mtext editing box pops up (Figure 6.30) and you can now type in any value you 
need. Edit as usual and click on OK when done.

Here is a useful tip. If you want to reset your forced dimension value back to its natural value 
and you forgot what it was, just type in  <   >. These two “alligator teeth” brackets restore 
the natural value. Type them in instead of the forced value and click on OK. Try it yourself.

Figure 6.28 
Jogged.

Figure 6.27 
Ordinate.
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6.4  Customizing dimensions
We have one more topic to cover on our way to basic proficiency in dimensioning.  
It is customization, and as mentioned at the start of the chapter, it is an extensive subject, 
also necessitating it being split into the fundamentals here and advanced customization  
in Chapter 13. The goal here is to learn what experience has shown to be the most important 
four customization tools. This allows you to be productive in most of the drafting situations 

Figure 6.29 
Dimension Properties.

Figure 6.30 
Mtext edit of dimensions.
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you are likely to encounter. Later, you will add to this knowledge by learning tools used by 
CAD administrators and senior designers. So what customization is necessary at this level?

We need to learn how to

l	 Change the units of the dimensions.
l	 Change the font of the dimensions.
l	 Change the arrowheads of the dimensions.
l	 Change the fit (size) of the dimensions.

To be able to change any of these we need to introduce a new tool, the Dynamic Style dialog 
box or dimstyle for short. It is a “one-stop-shopping” dialog box for dimension modification 
that you eventually need to learn well.

➤➤ ddim

Use any of the previous methods to bring up the Dimension Style Manager, as seen in  
Figure 6.31.

In Chapter 13, we create a brand-new dimension style and heavily modify it. For now, we 
just go ahead and change the current one to reflect the changes suggested in the previous 
list. Go ahead and press Modify from the menu on the right. You will see the Modify 
Dimension Style: Standard dialog box (Figure 6.32).

The dialog box may or may not open to the Lines tab as seen in Figure 6.25, but regardless 
take a look at the available tabs at the top. As noted before, we cover every command and 
option under those tabs in Chapter 13 and return to them again when we learn Paper Space. 
Let us focus right now on what we need to change.

Figure 6.31 
Dimension Style Manager.
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Step 1. Change the units of the dimensions
Pick the Primary Units tab and simply select the drop-down menu at the very top left, where 
it says Unit format. The default value is Decimal; change it to Architectural and select the 
appropriate Precision in the menu just below it. That is all we need from that tab for now. Notice 
how the preview window on the upper right reflects your choice of units, as seen in Figure 6.33.

Figure 6.33 
Selecting Architectural units.

Figure 6.32 
Modify Dimension (Lines tab).
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Step 2. Change the font of the dimensions
To do this you need to click on the Text tab. You then see Text style: on the upper left. If you 
just opened a new AutoCAD file to practice dimensions, you probably do not have a font set 
and get only Standard as your choice if you click the down arrow. Fortunately, Standard is 
now an attractive Arial font, not the ugly Simplex it used to be, so changing fonts is optional 
but still useful to know. For example, the RomanS font is a popular alternative.

Something else to keep in mind is that, in a real working drawing, you would likely set your 
text style (using style) before you work on any dimensions (an important point, take note). 
Then you would just select the font from the list. The idea here is to match up your regular 
font used in text and mtext with the font used in dimensioning (another important point). 
In general, you should stick to one font in a given drawing and just vary the size as needed. 
The titleblock is exempt from this, as that may have special fonts, logos, and the like.

AutoCAD of course anticipates that you may not have set a font style when you first set 
up dimensions and allows you to do this from the Text tab by bringing up the Style box 
when you click the button just to the right of the Text style menu (with the three dots, ). 
Go ahead and set a different font if you wish, RomanS 0.25 perhaps, and the new setting 
appears, as seen in Figure 6.34.

Step 3. Change the arrowheads of the dimensions
The default for all dimensioning is the standard arrowhead. You can easily change that to 
any other type, including the Architectural tick, popular with architects. You can even create a 
custom arrowhead (not something we try to do here).

Click over to the Symbols and Arrows tab. In the upper left corner under the Arrowheads 
section, you will see First:. That is the first arrowhead type, and if you change it, AutoCAD 
assumes you want the second one to be the same and changes it as well. Simply click the 
down arrow and select the Architectural tick. Leave everything else the same. The result is 
shown in Figure 6.35.

Figure 6.34 
Setting a new font.
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Step 4. Change the fit (size) of the dimensions
This function is quite deceptive. Located in the Fit tab, just underneath the preview window, 
it features only a few lines and is shown in Figure 6.36.

The idea here is to increase the size of the dimensions proportionately so everything scales 
up evenly and smoothly in step with the size and scale of your overall drawing. This concept, 
however, opens up a number of questions (chief among them, what value do you enter 
into there and why?), which we are not ready to discuss yet but will in Chapter 18 (“Paper 
Space”). So for now do not enter anything, just be aware of how to do it when needed. When 
you get to dimensioning the floor plan, just enter 15 in that space.

This is it for now; just click on OK and AutoCAD returns you to the Dimension Style 
Manager, where you can just press Close. Try creating a dimension and see what it looks 
like now. Figure 6.37 shows a set of horizontal dimensions before the changes we just went 
through and another one afterward. The difference is obvious. For now, this is all you need 
to make professional-looking dimensions. Review and memorize everything you learned and 
go on to the floor plan in Figure 6.38, adding dimensions to complete the drawing.

Figure 6.36 
Use overall scale of:.

Figure 6.35 
Changing the arrowheads.
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6.5 In class drawing project: adding dimensions  
to floor plan layout
Let us now apply what we learned to the floor plan. Open the file and freeze all the layers 
except the walls and windows. If you really want to get fancy, put the wall solid hatch on its 
own (visible) layer and freeze the regular floor hatch layer so the carpeting and floors do not 
show. Next create a new layer for the dimensions, A-Dim. Finally set up the dimensions: Use 
Architectural units, Arial 6 font, leave the arrowheads as they are, and change the fit to 15. 
Dimension the floor plan any way you want; what is shown in Figure 6.38 is a guide but not 
the only way.

Figure 6.37 
Dimensions before and after.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 7:

l	 Dimensions
m	 Linear (horizontal and vertical)
m	 Aligned
m	 Diameter

Figure 6.38 
Adding dimensions to floor plan.
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m	 Radius
m	 Angular
m	 Continuous
m	 Baseline
m	 Leader and Multileader
m	 Arc Length
m	 Ordinate
m	 Jogged

l	 Editing dimension values
m	 ddedit
m	 The effect of    

l	 ddim command
m	 Dimension units
m	 Dimension font
m	 Dimension arrowheads
m	 Dimension overall size

Review questions
Answer the following based on what you learned in Chapter 6.

1.	 List the 13 types of dimensions discussed.

2.	 What command is best for editing dimension values?

3.	 What is the difference between forced and natural dimensions?

4.	 How do you restore a natural dimension value when you forgot what it was?

5.	 List the four items that needed to be customized in our dimensions.

6.	 What command brings up the Dimension Style Manager?

7.	 What type of arrowhead do architects usually prefer?
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Exercises
1.	 In a new file draw and dimension the following mechanical part. (Difficulty level: Easy/Moderate; Time 

to completion: 20–25 minutes)

2.	 In a new file draw and dimension the following mechanical part. Any dimensions not given can be 
estimated. (Difficulty level: Moderate; Time to completion: 30–35 minutes)
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CHAPTER

Blocks, Wblocks, Dynamic 
Blocks, and Purge

LEARNING OBJECTIVES
In this chapter we introduce the concept of Blocks and discuss the following:
l	 Creating Blocks
l	 Retain, Convert, and Delete options
l	 Redefining Blocks
l	 Inserting Blocks
l	 Purge
l	 Creating Wblocks
l	 Creating Dynamic Blocks

7
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At the end of this chapter you will be able to create Blocks, Wblocks, and Dynamic Blocks as 
well as insert symbol libraries and purge your drawing.

Estimated time for completion of chapter: 1–2 hours.

7.1  Introduction to blocks
This chapter is about a very useful AutoCAD concept that will greatly simplify your workload. 
Groups, Blocks, Wblocks, and Dynamic Blocks are all members of the same family. They 
exist around the idea that objects can and should be grouped together if possible, to allow 
for easier handling and storage for future reuse. We do not look at groups, as they are rarely 
used, but instead focus on Blocks and Wblocks, with an additional discussion of their more 
sophisticated cousins, Dynamic Blocks.

Let us formally define a Block. It is a collection of objects that are grouped and held together 
under some identifying name. These objects can then be copied, moved, erased, and just 
about anything else, all as one unit. Think of Blocks as electronic “glue” that binds the 
objects they contain to each other.

The benefit of this should be apparent. If you have an office table with eight chairs around 
it, and you need to move them all around many times while optimizing a room layout, it 
is a lot easier to click a Block once than attempt to select all nine pieces using Window or 
Crossing or one at a time. Imagine an engineering example involving a simple gear with all 
its intricately designed teeth. Dozens if not hundreds of lines and arcs may make up the gear. 
It would be not just wise, but mandatory, to form them all into a single Block.

There is however another very important reason. That is the concept of reuse and symbol 
libraries. Blocks can be saved and reused for future drawings that may need the same exact 
object. That way you never have to draw the same thing twice, an AutoCAD Golden Rule. A 
collection of these objects cataloged in some orderly fashion becomes a symbol library, an 
indispensable part of just about any designer’s toolset. Likely candidates for these libraries 
include door, window, and furniture symbols; bolts, standard parts, and fasteners; really just 
about anything that can be used in more than one design or drawing.

Difference between Blocks and Wblocks
Ideally you are sold on the importance of Blocks, and we can go through the specifics. The 
differences between Blocks and Wblocks are blurred; they are alike in many ways. The key 
difference is that Blocks are internal to the file you are working on and Wblocks are external. 
This means that Blocks are saved inside whatever file is open and you are working on. As 
such, their main use is for grouping things together and temporary reuse in that particular 
AutoCAD drawing. While they can certainly be moved between files (Clipboard Copy/Paste 
is a great tool), this is not really what they are for.

Wblocks (write Blocks) are intended for creating symbol libraries. Wblocks are saved externally, 
anywhere you want to put them, and become independent, stand-alone AutoCAD drawings, 
which you can open and work on if needed. Both types of Blocks can of course be easily 
inserted back into drawings, and we cover that procedure in detail.

Creating a Block
To create a Block you first need something to make a Block out of. Once you draw 
something, only three things need to be done after that. You need to

1.	 Select the objects.
2.	 Give the Block a name.
3.	 Select a base point.
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Let us try this out. Draw a chair as shown in Figure 7.1. It is made up of three rectangles and 
three lines. Use accuracy tools.

We need to now group them all together into one object.

Start the Block Creation command via any of the previous methods. The Block Definition 
dialog box appears, as seen here in Figure 7.2.

Step 1. Press the Select objects button at the top of the middle column. Select the entire 
chair and press Enter.

Step 2. Enter a name for this Block in the top left field under Name.

Figure 7.1 
Basic lounge chair.

Figure 7.2 
Block Definition.
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Step 3. Pick a base point with the Pick point button at the upper left. Select a corner or 

midpoint somewhere on the object. The significance of this becomes more apparent 
when we insert the object back into the file.

There are of course a few other items in the dialog box under Settings, Behavior, and Description, 
but they are not usually needed (though feel free to enter a description). Annotative is covered 
in advanced chapters. The one setting of importance, however, is the Retain, Convert to Block, 
Delete choices under the Select objects button. They are explained next and appear with almost 
similar wording in Wblock as well.

Retain
This means that the Block is created and stored in memory, but the original object (the chair 
you are looking at) remains in separate pieces, useful if you wish to make several Blocks of 
the chair, one after the other, each slightly different yet based on the same original.

Convert to block
This option is what you are likely to use the most. It creates the Block and stores it in 
memory and also makes a Block out of the original object. Use it when you are sure one 
Block is all you need to make out of this one object and you have a need for it right away.

Delete
Here the Block is created and stored in memory, but the original is deleted from the drawing. 
This is useful when you are making a Block for future use but have no need for it now.

The common theme with all three of these choices is that, whichever way you use, the Block 
gets created and saved to memory. The only real choice is what to do with the original.

Finally you are ready to click on OK. The Block Definition dialog box should look like  
Figure 7.3. Notice the small preview window in the upper middle of the dialog box.

Figure 7.3 
Block Definition, completed.
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The chair is now a Block, which can be proven by clicking on it once with the mouse. You 
will notice that only one blue grip point appears (wherever it is you picked the base point; 
see Figure 7.4). If you now erase it, the entire chair will disappear. Go ahead and erase it; we 
need to do this to introduce two new commands before we discuss Wblock.

7.2  Insert
As mentioned before, the process of making the Block adds it into the memory. Then you 
can insert it back into the drawing when needed.

Start up the Insert command via any of the previous methods and the Insert dialog box 
appears, as seen in Figure 7.5. Notice the chair cued up and ready to go (as it is the only 
Block so far).

Figure 7.4 
Chair as a Block.

Figure 7.5 
Insert.
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Look over the options such as Insertion Point, Scale, Rotation, and Block Unit, but at this 
point you need not really do anything extra. Go ahead and click on OK, and the chair 
appears attached at the insertion point to the mouse. The point of attachment was specified 
when you made the Block. Click anywhere on the screen and the Block becomes part of the 
drawing. This process can be repeated as often as necessary as long as the Block remains in 
memory.

There is something important to remember concerning redefining Blocks. If a Block is saved 
under a certain name and another Block is created and saved under the same name, the first 
Block is redefined, a sort of overwriting process. Sometimes this is bad, as you are destroying 
the old Block. Sometimes however this is desirable, such as when you are looking to update 
the appearance of the Block. When there are many Blocks in the drawing under the same 
name, all are updated in this manner.

7.3  Purge
Between introduction of the Block and Wblock concepts is a good time to take an 
intermission of sorts and discuss a command called Purge. Purge is a very useful tool to 
“clean up” your drawing of unwanted and often unseen geometry and data. It is especially 
useful when it comes to Blocks and Wblocks, hence its inclusion here.

Conceptually, here is the idea. A complex AutoCAD drawing often grows in size and 
becomes weighed down, similar to an iceberg floating in the ocean. Much like the (mostly 
hidden under the surface) mountain of ice, what you see on-screen may only be a small 
fraction of what actually is present in the file.

The reason why becomes apparent when you think about the drafting process for a moment. 
If you create 50 layers for anticipated future use but end up needing only 40 of them, the 
other 10 are uselessly hanging out in your Layer dialog box. Same thing with unused fonts  
or linetypes (remember loading all of them but using only a few). Layers, linetypes, and  
fonts really take up little space, but with Blocks and Wblocks it is a whole different  
story.

Wblocks are miniature drawings all to themselves, and while many are just simple doors 
or window symbols, others can be quite large (such as entire furniture sets or appliances in 
an architectural layout). Worse yet, these Blocks rarely come alone; they bring friends, lots 
of them. I have seen and worked with complex multistory sprawling building layouts that 
feature not dozens but hundreds of Blocks. They all take up room in a file, ballooning it up to 
a rather huge size.

If all these Blocks are needed, then fine; this is a necessary evil. But if not—say a type of chair 
was deleted from the specs—they need to be removed. Erasing them all is easy enough, but 
are you done? Are they all gone for good? Unfortunately, no. They may not be visible but 
they are still there weighing down your file, slowing down computer performance and just 
about everything else. This is where Purge comes into play.

Purge gets rid of items that are not actually used in the drawing file and permanently deletes 
them. You can use the command to selectively purge items or purge all at once. The two 
main points to remember are

l	 Purge will not get rid of objects that are visible and present in the drawing—it is not an 
Erase command.

l	 Purge is permanent (unless you immediately undo it), so be careful of what you purge. If 
you anticipate eventually needing something, do not purge it out.
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Let us give the command a try.

First of all, erase the chair from your screen. Then start up the Purge command via one of the 
two methods and the dialog box in Figure 7.6 appears.

As you can see from looking at the list of items in the dialog box, quite a few items are 
eligible for purging. Some were already mentioned, like Layers and Linetypes, while others 
you may not have heard of, like Materials and Shapes. Either way, what is important is 
whether or not the item has a plus sign next to it. If it does, you can click the plus sign and 
expand the folder to see what specific items are in those general categories. In our case, you 
will see the chair Block under the Blocks category. You will also see Annotative under some 
of the other categories. We look at Annotative in later chapters, so for now just ignore it and 
we purge Annotative alongside the chair Block.

The actual process of purging is easy. You can either select each item one at a time (usually 
done only when you want to selectively purge), or you can click Purge All at the bottom. Be 
sure the Purge nested items box is checked and the one above it is not, as seen in Figure 7.6. 
When all the items are purged, there are no more plus signs and the buttons gray out as well. 
Press Close after you are done and that is it.

Experienced users purge often and keep little useless junk in the file unless absolutely 
necessary. Purging is certainly something that should be done prior to saving the file for the 

Figure 7.6 
Purge.
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day, emailing it, or archiving it for storage and record keeping. Be careful though, and do not 
get rid of needed items. Always think before purging.

7.4  Wblocks
Pretty much everything said about Blocks applies to Wblocks as well, and as a result, this 
section is short, as you have seen this before. The central idea to keep in mind is that a 
Wblock is external, and as such, you need to tell AutoCAD where to put the Wblock as you 
make it. Let us try this out. Clear your screen and make sure all items are purged out from the 
previous exercise. Now go ahead and draw another furniture object, perhaps a sofa this time.

The only way to start up this command is via typing wblock and pressing Enter. Once you do 
that, the dialog box in Figure 7.7 appears.

For the screen shot in this figure, a specific path has not been selected, but you can do that by 
clicking the button with the three dots, , to the right of File name and path: and browsing 
around until you find where you want the file to go. Be sure to also change the name of the 
file at the end of the string, so it does not just say New Block. Then select the sofa and pick 
one of the three options to Retain, Convert, or Delete the original. When done press on OK 
and the Wblock is created and dropped off where you indicated in the path.

Inserting Wblocks
Go ahead and insert your sofa back in using the Insert command. The procedure is essentially 
the same, except that now you naturally have to browse for the file. The Browse button is just to 
the right of the Name field. Look around for your Block and when you find it, click on it and 
press OK. It will insert just as with the previous Block command.

7.5  Dynamic blocks
Dynamic Blocks were introduced relatively recently to AutoCAD (in Release 2006). Like 
many new features, they are not necessarily a radically new concept. Rather, they are an 

Figure 7.7 
Write Block.
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evolution of the regular Block or Wblock. The idea here is to be able to modify a Block in 
response to design conditions. A simple example is of a door. If you insert a Block of a  
3’ door, rotated at 45°, and later realize that you need a 3’-6” door, rotated to a closed 
position, you can change that in place without redefining the Block or inserting another one.

So what we are doing essentially is adding a level of intelligence and automation to the 
standard Block concept. This is especially useful when it comes to scaling, stretching, and 
otherwise modifying the sizes, as that is cumbersome to do with regular Blocks (as opposed 
to rotating them, which is easy).

To accomplish all this, the designer needs to modify a regular Block by adding Parameters 
and Actions. Three things make up a Dynamic Block: the Geometry itself, at least one 
Parameter, and at least one Action associated with that parameter. The result is a Block  
that has one or more special grip points, each defined with a certain modifying property 
(e.g., Stretch, Rotate, Scale). The Block can then be modified in place as needed. Create a 
Block called sample chair and save it. Then follow the procedures outlined.

Regardless of which method you use to start the command (you can also just double-click on 
the Block itself), you will see the dialog box in Figure 7.8. Select the Block you want to work 
with, which in this case is the only one available.

After you select the “sample chair,” you are taken to the main editing screen, called a Block 
Editor (recognizable by its yellow background), shown in Figure 7.9. This is where the 
settings are applied.

A Block Authoring Palette also appears. Sets of parameters and actions are available from 
this palette, and the Block can be set up to have any of those. When done, Close Block Editor 

Figure 7.8 
Edit Block Definition.
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is pressed (top right of screen) to return to the regular drawing space. So what can we do 
here? Well, let us add two actions and parameters to the chair that will give it some scaling and 
rotational abilities.

Open the Parameter tab on the palette and pick the Linear parameter. That after all is the way 
Scale works, by linearly scaling up an object. Pick first the upper left corner start point, then 
the upper right corner endpoint of the chair (sort of like adding a horizontal dimension). 
The result is shown in Figure 7.10.

While you are there, add a rotation as well by running through the required Base Point, 
Radius, and Angle prompts. The result is shown in Figure 7.11.

Figure 7.9 
Dynamic Block Edit mode.

Figure 7.10 
Dynamic Block 1.
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Now you can add actions associated with those parameters. Pick the Actions tab and pick 
Scale. Then select the Parameter and the Objects (the chair) as prompted. Repeat the same 
steps for the Rotation. The result is shown in Figure 7.12. Notice the new (faded) Scale and 
Rotate symbols.

Close the Block Editor (button at upper right) and you are prompted to save your work, as 
seen in Figure 7.13.

Figure 7.11 
Dynamic Block 2.

Figure 7.12 
Dynamic Block 3.

Figure 7.13 
Block—Save Parametric Changes.
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Finally you are back where you started. Click on the new Block and you will notice the 
dynamic grips, as seen in Figure 7.14. You can now use these to change the size and rotation 
of the Block, as seen in Figure 7.15 with scaling.

There are of course a few more tricks to these Dynamic Blocks, chief among them being the 
new Parametric tools, but we address those in the advanced level.

So how do dynamic Blocks fit into the big picture? Are they as useful as they seem? In my 
opinion the results are mixed. The idea is certainly a good one, but the effort involved to 
add meaningful and extensive dynamic intelligence to a large group of different Blocks 
is considerable. Existing libraries of Blocks have sufficed for most users, who diligently 
built them up over the years, and experience has sometimes shown that there has been a 
reluctance to redefine these libraries. A lack of time and money to tinker with AutoCAD (as 
opposed to using AutoCAD for billable drafting work) has always been a problem. In a sense, 
it may be a shame, as Dynamic Blocks, by allowing multiple variations on a single Block, 
may actually reduce the size of libraries. A door may just be a door, adjustable to any size on 
the go, instead of 20 doors for every conceivable situation. It is a useful, if underused, idea.

Figure 7.14 
Dynamic Block 4.

Figure 7.15 
Dynamic Block 5.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 8:

l	 Block
m	 Select objects
m	 Name the Block
m	 Select a base point

l	 Wblock
m	 Select objects
m	 Select path and enter Block name
m	 Select a base point

l	 Options
m	 Retain
m	 Convert to Block
m	 Delete

l	 Insert command
l	 Purge command
l	 Dynamic Blocks

m	 Parameters
m	 Actions

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 7.

1.	 What are Blocks and why are they useful?

2.	 What are the differences between Blocks and Wblocks?

3.	 What are the essential steps in making a Block? A Wblock?

4.	 How do you bring the Block or Wblock back into the drawing?

5.	 Explain the purpose of Purge.

6.	 Explain the basic idea behind Dynamic Blocks. What steps are involved?
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EXERCISES
1.	 In a new file, create the following architectural table, chair, keyboard, phone, and screen and make a 

Block out of the individual pieces as well as the overall “assembly.” Nested Blocks such as these are 
quite common in AutoCAD design. Insert the Block back into the file. Dimensions not given (most of 
them) can be approximated, and naming Blocks is up to you, just make them descriptive. (Difficulty 
level: Easy; Time to completion: 15–20 minutes)

2.	 In a new file, create the following set of doors and make a Wblock out of each, dropping them off in a 
folder named Doors. Insert each back into the file. Repeat the process using Dynamic Blocks and the 
Scale Action, Linear Parameters. (Difficulty level: Easy; Time to completion: 5–10 minutes) 



Spotlight On: 
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Mechanical engineering is the science of designing and manufacturing mechanical systems 
or devices. It is one of the oldest and most widespread engineering specialties, and is often 
the profession one has in mind when thinking of a typical engineer. Mechanical engineering 
is also by far the most diverse of the engineering specialties and “mechies” can be found 
working in fields as wide-ranging as aerospace, automotive, naval, rail, power, infrastructure, 
robotics, manufacturing, consumer products, and much more. It is truly a profession that 
keeps our society moving.

Mechanical engineers need a mastery of a wide variety of engineering sciences, structures, 
materials, vibrations, machine design, control systems, and electrical engineering, to name a 
few. They also need to be well versed in business practices, cost analysis, and risk assessment, 
as design and production of just about anything is closely tied to these. Mechanical engineers 
have been the driving force behind development of high-end software tools, such as Finite 
Element Analysis (FEA) for structural work.
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Education for mechanical engineers starts out similar to the other engineering disciplines. 
In the Unites States, all engineers typically have to attend a four-year ABET-accredited school 
for their entry level degree, a Bachelor of Science. While there, all students go through 
a somewhat similar program in their first two years, regardless of future specialization. 
Classes taken include extensive math, physics, and some chemistry courses, followed by 
statics, dynamics, mechanics, thermodynamics, fluid dynamics, and material science. 
In their final two years, engineers specialize by taking courses relevant to their chosen 
field. For mechanical engineering, this includes structures, controls, vibration analysis, 
thermodynamics, and machine design, among others.

Upon graduation, mechanical engineers can immediately enter the workforce or go on to 
graduate school. Though not required, some engineers choose to pursue a Professional 
Engineer (P.E.) license. The process first involves passing a Fundamentals of Engineering 
(F.E.) exam, followed by several years of work experience under a registered P.E., and finally 
sitting for the P.E. exam itself. Mechanical engineering is also an excellent undergraduate 
degree for entry into law, medicine, or business school. Just some of the careers you can 
pursue with an engineering bachelor’s followed by a J.D., M.D., or an MBA include patent 
attorney, biomedical engineer, and manager or CEO of an engineering firm. If you can 
handle the education requirements, the mechanical engineering degree may truly be one of 
the most useful ones in existence.

Mechanical engineers can generally expect starting salaries (with a bachelor’s degree) in the 
$54,000–$58,000/year range, which is somewhat toward the higher end among engineering 
specialties. This of course depends highly on market demand and location. A master’s 
degree is highly desirable and required for many management spots. The job outlook for 
mechanical engineers is excellent, as the profession is so diversified that there is always a 
strong demand in some of the sectors, even if others are in a downturn.

So how do mechanical engineers use AutoCAD and what can you expect? Industry-wide, 
AutoCAD enjoys significant amount of use, even as its share shrinks as companies switch to 
low-cost 3D solutions such as SolidWorks and Inventor.

In truly high-end design (automotive and naval, for example), the dominant software 
applications continue to be CATIA, NX, and Pro/Engineer and AutoCAD does not compete 
with these. However, this still leaves many applications where AutoCAD is appropriate, such 
as small part design, schematics, and overall layout of systems. Many companies also do not 
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manufacture but rather assemble modular pieces into new products; here, too, AutoCAD is 
the appropriate low-cost solution. Let us take a look at a few examples.

The acronym P&ID stands for piping and instrumentation diagrams, a major mechanical 
engineering field, commonly referred to as process control. Engineers use principles of fluid 
flow, material science, and hydrodynamics to design piping and valves that regulate fluid 
flow. This can be anything from a chemical plant to an electro-chlorination system to waste 
treatment. Usually systems are assembled out of standard industry parts, so AutoCAD is the 
appropriate tool to put them together into a design. Figure 1 shows a typical piping diagram.

Small device assemblies are another example of mechanical design. If the parts are standard 
and no manufacture is necessary, only assembly drawings, then AutoCAD can be used to 
depict the ideas. Figure 2 shows an AutoCAD drawing of a tuning peg assembly.

Figure 1 
Typical piping diagram.

Figure 2 
Tuning peg assembly.
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CHAPTER

Polar and Rectangular 
Arrays

Learning objectives
In this chapter we introduce the concept of an array and discuss the following:
l	 Creating a Polar Array
l	 Object, Center, Quantity, Degrees
l	 Creating a Rectangular Array
l	 Object, Rows and Columns, Distances
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At the end of this chapter you will be able to create polar and rectangular arrays. You then 
start a new in class mechanical project.

Estimated time for completion of chapter (lesson  project): 3 hours.

Arrays are a very useful tool in AutoCAD to create patterns of objects. These patterns can  
be of a circular or linear type, hence the “Polar Array” and “Rectangular Array” discussions 
that follow. In a strict sense, this tool is not something entirely new, but merely automates 
what you can do (albeit tediously) by regular commands learned in Chapter 1 and is a huge 
time-saver.

8.1  Polar array
A polar array is a collection of objects around some common point arranged in a circle (or 
part thereof). An example in architecture is a group of chairs arranged around a conference 
table. The idea is to draw the table, then one chair, and after positioning the chair exactly 
where it will be in relation to the table, use Polar Array to copy it around the table to create, 
let us say, ten of them. The Array command copies and rotates them into position and spaces 
them out evenly—a task that would have taken a while to do one chair at a time.

In mechanical engineering, an example may be teeth of a sprocket gear. You draw the circle 
representing the wheel of the gear; put in one tooth properly drawn, detailed, and centered 
on top; then Array to get the full gear. Figure 8.1 shows illustrations of what was just 
discussed. There are of course many other examples.

Figure 8.1 
Example of arrays.

Steps in Creating a Polar Array
First of all, we need to create something to array. So go ahead and draw a circle of any size 
to represent the table just discussed, and then create a convincing-looking chair. You may 
want to make a block out of it after you are done for convenience. Next position it at the top 
of the table (Figure 8.2). Be sure to line it up perfectly on the vertical axis (or else the array 
will be skewed off center) and move it back a bit from the table with Ortho on. So now what 
does AutoCAD need to know?

l	 It needs to know what object to array (that would be the chair, not the table).
l	 It needs to know the center point of the array (center of the table).
l	 It needs to know how many objects to create (let’s stick to ten or so).
l	 It needs to know if the pattern goes all the way around (that is, is it 360° or less).
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It is good to learn these steps and realize what you need to do before even starting up the 
Array command; that way you have a clear idea of what buttons to push and what data to 
enter once you have the dialog box in front of you. We used this approach when learning 
Hatch, Block, and Wblock and will continue to do so.

Step 1. Once you have the table and chair drawn, follow the steps shown to create the polar 
array. Start up the Array command via any of the methods shown.	  

Step 2. You will see the Array dialog box shown in Figure 8.3.
Step 3. Use the Select objects button (upper right) to select the chair.
Step 4. Just below to the left is the button to select the center of the table (use OSNAPs).
Step 5. Below that is where you fill in the Total number of items: (let us do 10).
Step 6. Finally, below that is Angle to f ill (we go with the full 360°).

Figure 8.2 
Chair and table—initial setup.

Figure 8.3 
Array dialog box with Steps 3–6 completed.
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Notice how one of the items we did not specify is the angle between the objects. That is 
something AutoCAD figures out for you and it spaces the objects accordingly.

Step 7. Be sure the Rotate items as copied button is checked.
Step 8. Important: Before you press OK, press Preview  , which allows you to see the 

results of what you did without committing to the final array. If you want to modify 
some feature of the array, then press Esc and return to the main dialog box, and 
if not, then press Enter, and you are done. You should see an array similar to the 
example in Figure 8.1.

Note that the entire array is not a block, just a collection of objects, and to redo the whole 
thing, you need to erase all the copies, leaving just the table and the original chair and repeat 
everything. That is why the Preview button is so important. Do not be so quick to press OK 
right away.

8.2  Rectangular array
Here the idea is basically the same. We are looking to replicate objects but this time in rows 
(horizontal) and columns (vertical). An example, as shown in Figure 8.4, may be columns 
of a warehouse. If they are spread out evenly, then this is the perfect tool for this. You simply 
draw one I-beam with furrowing and array it up and across the appropriate area.

Steps in Creating a Rectangular Array
The first thing to do is to draw a convincing-looking I-beam (everything to scale this time) 
surrounded by furrowing, as in Figure 8.4. Let us make the furrowing rectangle 200 wide by 
260 tall with the I-beam inside. What does AutoCAD need to know?

l	 It needs to know what object to array (that would be the column).
l	 It needs to know how many rows and columns to create.
l	 It needs to know the distance between the rows and the columns.

Step 1. Start up the Array command just as in the previous polar array exercise. The Array 
dialog box appears as before. Be sure to pick the other choice, Rectangular Array, this 
time (Figure 8.5).

Figure 8.4 
Rectangular array.
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Step 2. Use the Select objects button (upper right) to select the column.
Step 3. Just below you can enter the number of rows and columns. Let us do five Rows and 

five Columns.
Step 4. Below that you can enter the offset distance for the rows and columns. That is the 

distance between two similar points on two sample objects. So, for example, you 
can say it will be 10 feet centerline to centerline of two columns. That is why it was 
important to draw them to scale, so you know how much to offset. Let us enter 72 
for the Row offset: and 72 for the Column offset:. Leave the Angle of array: as is.

Step 5. Finally, preview the array (it may be partially off the screen) and press OK if all  
is well.

In general, polar arrays are used more often than the rectangular ones, though both are 
important to know.

8.3 I n class drawing project: mechanical device
Let us now put what we learned to use. We draw a mechanical gadget (a suspension strut of 
sorts), created years ago for my classes. Though what it is exactly is still debatable, the gadget 
proved to be an excellent drawing example and features quite a bit of what we covered in 
this and preceding chapters as well as a few minor nuances of AutoCAD drafting that, once 
learned, raise your skill levels considerably. The trick is to make your drawing look exactly 
like the example. If you approximate and cut corners, you miss out on some of the important 
concepts that give a more professional look to your drawings.

A full page view of the completed device is found toward the end of the chapter (in Figure 
8.15). Take a good look at it and decide on a strategy to draw it. Over the course of the next 
few pages, we develop a step-by-step process to actually do it. Follow the steps carefully, 
though do not worry about the thick border; that is a polyline, to be covered in Level 2. The 
title block is just a simple collection of lines and text.

Step 1. For starters open a new file, give it a name (Save As), and set up your layers. We 
need, at a minimum:
M-Part, Color: Green (for most of the parts of the device).
M-Text, Color: Cyan.

Figure 8.5 
Array dialog box with Steps 1–4 completed.
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M-Dims, Color: Cyan (for the dimensions).
M-Hidden, Color: Yellow, Linetype: Hidden (for all hidden lines).
M-Center, Color: Red, Linetype: Center (for the main centerlines).
M-Hatch, Color: 9 (a gray for cross section cutaways).

You may also want additional layers for the spring and the title block. You can decide on the 
exact layers and their colors; the preceding is just a guide. Also, the images in this chapter 
remain black and white, for clarity on a white page.

Step 2.	 Set up all the necessary items for smooth drafting (if desired), such as the Text Style 
(Arial, .20), the Dim Style, and Units (either Architectural or Mechanical is fine), 
and get rid of the UCS icon if you do not like it.

Step 3.	 To begin the drawing itself, we need to start with the hex bolts. Go ahead and draw 
one of them according to the information in Figure 8.6. Be very careful, all sizes 
are diameters not radiuses; you must tell AutoCAD this by pressing d for diameter 
while making a circle. This has tripped up many of my students in the past. Also do 
not forget to make layer M-Part current. If the bolt is anything but green in color, 
you missed this step. The dimensions are only for your reference for now; there’s 
no need to draw them.

Step 4.	 Now make a block out of the bolt, calling it Bolt—Top View.
Step 5.	 Complete the rest of the top view by drawing the remaining circles and positioning 

the bolt at the top, as shown in Figure 8.7. Use accuracy (OSNAPs), though the 
bolt can be any distance from the top of the circle. Be careful to use diameters as 
indicated.

Step 6.	 Array the bolt around the top view four times, as shown in Figure 8.8.
Step 7.	 You now have to project the main body of the part based on this top view. The best 

way is by drawing two horizontal guidelines, of any length, starting from the top 
and bottom quadrants of the big circle, then an arbitrary vertical line to mark the 
beginning of the part on the right, as shown in Figure 8.9.

Figure 8.6 
Bolt layout.

Figure 8.7 
Bolt array.
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Step 8.	 Trim or fillet the main vertical guideline and continue offsetting based on the given 
geometry to “sketch out” the basic outline of the shape, as seen in Figure 8.10. Do 
not yet add dimensions; they are for construction only.

Step 9.	 Continue adding the basic geometry to the side view, as well as hidden and 
centerlines, as shown in Figure 8.11. Set LTSCALE to .4.

Figure 8.9 
Projection lines.

Figure 8.10 
Body of part.

Figure 8.8 
Array completed.
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Step 10. Add the bolt projections, as seen in Figure 8.12 (the depth into the side view can 
be approximated). Finally, add hatch patterns, using the Angle option to reverse 
the hatch directions, which is a common technique in mechanical design to 
differentiate the parts from each other in a cross section.

Step 11. Now, how do you do the spring? Well, this is where the Circle/Ttr comes in. Draw 
one circle at the upper left of the area where it is supposed to go with the correct 
diameter (see the main diagram). Then, one way of proceeding is to draw a straight 
arbitrary line down from the center of that circle, rotate the line 15° about that 
center point, then offset 0.1 in each direction, erase the original line, extend the two 
new ones to the bottom (if necessary), and repeat the process, as seen in Figure 8.13. 

Figure 8.11 
Building side view.

Figure 8.13 
Drawing the spring.

Figure 8.12 
Hatching side view.
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Once a set is done, you can then mirror the rest over and trim carefully to create the 
impression of a coiled spring.

Step 12. Finally add dimensions and a title block by simple use of rectangles, as seen in 
Figures 8.14 and 8.15. The title block and its contents are typical of a mechanical 
engineering drawing.

Figure 8.14 
Completed side view.

Figure 8.15 
Mechanical project—final.
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8.4 Dra wing a star
As promised, the technique of drawing the star from Chapter 2 is as follows. Create the 
pentagon next; noticing that it is a five-point geometric shape, draw lines from endpoint to 
endpoint connecting those vertices. Then erase the pentagon and use trim to erase the inner 
lines, as shown in the progression in Figure 8.16.

The reason students do this simple exercise is to underscore a very important point. AutoCAD 
is used across a vast array of industries, each with its own symbols and unique objects. It would 
be impossible for the software to include all of them in its database. Instead AutoCAD gives 
you basic tools and leaves it up to your creativity and skill to create the shape you need. So, 
when at a loss as to how to draw something you imagined in your mind, stop and think about 
the basics that you learned and how you can put them together into something new.

Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 9:

l	 Polar array
m	 What to array
m	 Center point of array
m	 How many objects to create
m	 Angle to fill

l	 Rectangular array
m	 What to array
m	 How many rows
m	 How many columns
m	 What distance between rows
m	 What distance between columns

Review questions
Answer the following based on what you learned in Chapter 8.

1.	 List the two types of arrays available to you.

2.	 What four steps are needed to create a polar array?

3.	 To array chairs around a table, where is the center point of the array?

4.	 What three steps are needed to create a rectangular array?

Figure 8.16 
Drawing challenge.
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Exercises
1.	 In a new file, draw the image found on the opening page of Chapter 8, reproduced here with dimensions. 

You should be able to draft everything shown, including the dimensions. (Difficulty level: Moderate; Time to 
completion: 10–15 minutes)

2.	 In a new file, draw the following five row by five column rectangular array. The chairs are 200 by 200 
and the offset between them is 500. The array is also at a 45° angle. (Difficulty level: Easy; Time to 
completion: 10 minutes)
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3.	 In a new file, draw the following gear array. Begin with circles of indicated diameter. Then focus on 
creating the first tooth as seen in the detail. Make sure it is centered and aligned. Finally, array the 
tooth (24 teeth are used in the example) and clean up the design with trimming. (Difficulty level: 

Moderate; Time to completion: 20 minutes)
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CHAPTER

Basic Printing and Output

Learning objectives
In this chapter we introduce the Plot dialog box and the Page Setup Manager and go 
through all the associated options to produce a print or a plot, including the following:
l	 What printer or plotter to use
l	 What paper size to use
l	 What area to plot
l	 At what scale to plot
l	 What pen settings to use
l	 What orientation to use
l	 What offset (if any) to use
l	 The Page Setup Manager

9
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Upon the completion of this chapter you will be able to recognize and set up all the features 
needed to print or plot any type of drawing from any AutoCAD workstation.

Estimated time for completion of chapter: 1 hour.

9.1 I ntroduction to printing and plotting
In almost every situation the on-screen AutoCAD design is plotted or printed, and indeed 
the fundamental “product” of most design work is paper output. This output is then used to 
manufacture or build the design; it also may be needed for sales or archiving purposes.

Because designers and their clients want something tangible to look at and use, all design 
work in AutoCAD must be created with the ultimate goal of displaying it on a piece of paper, 
not just on-screen. This fact influences the evolution of a drawing from the outset, and a 
skilled AutoCAD designer selects paper size, output scales, and line weights early in the 
process so the inevitable output proceeds smoothly. We eventually talk about all of these  
and more.

Professional-looking output in AutoCAD is no accident and comes with its own set of 
challenges. Though you may be able to walk up to an expertly set up drawing and just select 
File→Plot...→OK, such situations result only from a thorough understanding of what 
is involved. More important, if the requirements call for a different output of the same 
drawing (e.g., for an informal check of a small section of the drawing versus a final full-size 
submission to the client), you must know what to change and by how much.

AutoCAD allows for a wide array of output, and the devil is in the minute details. Output 
spans this chapter as well as part of Chapter 10 (“Advanced Output—Paper Space”) and 
Chapter 19 (“Advanced Output and Pen Settings”). Our goal right now is only to familiarize 
you with the essentials and what AutoCAD needs to know to print or plot a drawing.

Take note as you go through this that, although some specifics (such as type of printer or 
plotter) may be unique to your particular office, home, or school, most of what you need to 
know stays constant from situation to situation and from one release of AutoCAD to another 
(even if the location of the buttons and menus change); therefore, it is important that you 
memorize and understand the essential concepts.

9.2  The essentials
You need to give AutoCAD the following information when setting up a drawing for printing 
or plotting:

l	 What printer or plotter to use.
l	 What paper size to use.
l	 What area to plot.
l	 At what scale to plot.
l	 What pen settings to use.
l	 What orientation to use.
l	 What offset (if any) to use.

There are of course some other subtleties, but we focus on these essential ones for now. Note 
that we do not look at the actual Plot dialog box until later, as you truly need to understand 
what buttons you are pushing and why before you actually do that.

What Printer or Plotter to Use
This is where you select what output device you will use. In most architecture offices, 
engineering companies, and schools, you will have a plotter (color or black and white) for 
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C-, D-, and E-sized drawings (paper sizes are discussed next), and a LaserJet printer (color 
or black and white) for A- and B-sized drawings. Your typical AutoCAD station usually is 
networked to access both, as requirements may change daily. You need to select which device 
is getting the drawing (AutoCAD does not care—it will print a floor plan of a sports stadium 
on a postcard if you let it). This choice is of course tied in with the scale and the ultimate 
destination of the printed drawing (check plot or to a client). We discuss this in more detail 
later.

What Paper Size to Use
You would think that paper sizing is a cut-and-dried, straightforward matter (somewhere a 
professional printing company manager is laughing), but this is certainly not the case. Paper 
comes in a bewildering array of international sizes and standards in both inches and metric 
(millimeter) sizing. Some common standards include ANSI, ISO, JIS, and Arch. For the 
purposes of this discussion, we need to simplify matters and present all paper as existing in 
the following basic sizes as viewed in Landscape mode, meaning the first (larger) value is the 
horizontal size:

l	 A size: 11  8.5 sheet of paper (letter).
l	 B size: 17  11 sheet of paper (ledger).
l	 C size: 22  17 sheet of paper.
l	 D size: 36  24 sheet of paper.
l	 E size: 48  36 sheet of paper.

Generally speaking, these are the maximum paper dimensions. Some standards list 
essentially the same sizes but with the border accounted for, so a D-size sheet is 34  22” 
and so on. Note that legal (14  8.5) size paper, while it certainly can be used, is not 
common in engineering or architecture.

As a side note, we can now define precisely the difference between printing and plotting.

Printing usually refers to the output of drawings on A- or B-sized paper, which is easily done 
on most office LaserJet printers. Most home printers can do only A size, but this of course 
varies with the size (and cost) of the printer.

Plotting usually refers to output of drawings on C-, D-, or E-sized paper, which has to be done 
on plotters, as a LaserJet generally cannot accept paper of this size.

Memorize the paper sizes presented here, as it is pretty much the industry standard as far 
as AutoCAD design is concerned. You will hear these sizes asked for and referred to come 
printing time, and if there is any deviation from these sizes, rest assured it will not be 
anything radical, as there is only so much flexibility in what printers and plotters can accept 
(at least among the models that small companies and schools can afford).

What Area to Plot
What “area to plot” can be taken quite literally, as in what do you want to see on the printed 
paper? The essential choices boil down to really two. Do you want to see the entire drawing 
(usually) or parts thereof (sometimes). Your choices in that regard include the following.

Extents
This option prints everything visible in the AutoCAD file. However, this means everything 
visible to AutoCAD (and not necessarily to you), so if you have a floor plan with some stray 
lines that you did not notice located some distance away, AutoCAD shrinks the important 
floor plan to make room for those unimportant stray lines. This is exactly the same as typing 
in Zoom→Extents (from Chapter 1). So it is a very good idea to Zoom to Extents prior to 
printing. Remember this acronym: WYSIWYG—what you see is what you get. If you see it 



level 1  
Chapters 1–10

190

on the screen, it will print unless prior arrangements are made (Freeze the layer, etc.) or the 
geometry is on the Defpoints layer. For a carefully drawn layout, Extents is the only choice 
when you want to see the entire drawing.

Window
As you may have guessed, this is for those situations where you want to see just a piece of the 
drawing. You simply select that choice and click the Window button that appears to the right 
of it and draw a selection window around what you want to see.

Display and limits
The remaining two choices are of little use in most situations. Limits plots the entire drawing 
from 0,0 to the preset limits (something most users do not set anyway), and Display plots 
the view in the current viewport in the Model tab or the current Paper Space view in a Layout 
tab (something we have not covered yet). One can generally use Window in those situations, 
but Display is fine as well if you want only the current viewport printed.

At What Scale to Plot
Of all options in Plot, this one causes the most confusion to a beginner AutoCAD user, 
for the simple reason that scale is closely tied in with a very important topic: Paper Space. 
The essential idea here is that while, yes, you can assign a scale from the Plot dialog box, 
in reality this is not usually done for most drawings, except simple and small mechanical 
pieces, such as bolts and brackets. What is done instead is that a title block is set up in Paper 
Space and the design (in Model Space) is scaled by means of viewports (much more on this 
in Chapter 10), so then in the Plot dialog box you can select 1:1 (one-to-one) and a properly 
set up drawing prints to scale.

What if you do not care about scale and just want a print to look over? Here, the pendulum 
swings in the other direction and things become very easy. Just check off the Fit to Paper box 
above the scale and the drawing will fit on whatever paper you are using, with no regard to 
scale whatsoever. While this technique is not for final prints of to-scale architectural layouts, 
it is used very often for non-scaled work, such as electrical wiring schematics, network 
design, conceptual layouts, and of course check plots.

What Pen Settings to Use
This is a topic that has an entire chapter all to itself (Chapter 19), and we do not go into 
detail here. Suffice it to say, if there is one thing that instantly screams “amateur,” it is lack 
of Pen Settings. The concept is simple, critically important in hand-drafting, yet sometimes 
overlooked in the computerized world of AutoCAD. It deals with the fact that linework in 
a drawing is not all the same size. Primary features (such as walls on a floor plan) should 
appear darker on a print, while secondary features (furniture, for example) should appear 
slightly lighter. This was the reason for the existence of 2H, 4H, and other pencil leads (for 
those old enough to remember), and the reason today for the existence of pen settings.

With AutoCAD, different colors represent the different pencil leads, and a strict standard 
needs to be followed as to what drawing features have what color assigned to them. In this 
manner, drawings come out with different shades of linework, something that is noticed 
by the eye, and as a result the drawings are much more readable and professional looking. 
These settings are created, customized, adjusted, and saved under the ctb extension, for all 
to use according to company standards set by management.

For now, select monochrome.ctb as your ctb file, and the entire set of customization tools 
are presented in Chapter 19 as promised.
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What Orientation to Use
This is simply a question of whether you want the drawing to be oriented Portrait or 
Landscape; in other words, do you want the longer side of the sheet of paper oriented  
up/down or across. This should be familiar to just about every computer user who has 
printed anything from a word processor or other software.

One twist here is that you can check off a box to plot upside down. A useful application for 
this option, as I noticed one day, appears when you are printing many sets of similar-looking 
(but different) drawings. If you want to know which drawing is coming out of the plotter 
without waiting until it plots completely, send it in backwards. That way the title block  
(with the identifying drawing number) comes out first and that question is instantly 
resolved.

What Offset to Use
This refers to whether or not you need to shift your drawing around to account for a border 
and stapling area on the left (or elsewhere). If you check off Center the plot, it will be 
automatically centered on the paper, and in most cases this is what you would do.

Miscellaneous
There are a number of other features in Plot. For example, you can plot to a file (*.plt) and 
take it with you to another computer; this is useful for large volume drawing duplication at 
stores that have no AutoCAD, only printers, such as Kinko’s®. You can also turn on a plot 
stamp so information such as date and time of the printing can appear in the border. Some 
plotting features are unique to 3D and solid modeling. We explore some of these topics 
as well in Chapter 19. Finally there is a Preview window and a Number of copies to print 
selection, the function of those being self-explanatory.

9.3  The plot dialog box
Let us now take a close look at the Plot dialog box and identify the locations of all the 
features described earlier. Open up the floor plan from the earlier chapters and bring up Plot 
via any of the following methods.

The Plot Model dialog box appears, as seen in Figure 9.1. If it is not full size, press the small 
arrow at the bottom right to expand it fully. The features we discussed are in Figure 9.2.

Go through all of the settings, referencing the explanations in the previous discussion until 
you completely understand what each one does. Set the final settings as shown next.

l	 What printer or plotter to use: Set whatever printer is available at your location (it will 
likely differ from what you see here). If you have a plotter, ignore it for now and use a 
printer instead, as we are using A size for this exercise.

l	 What paper size to use: Select from the drop-down list. We want any A size available; 
Letter (8.5  11 in.) or similar is fine.

l	 What area to plot: Select Extents.
l	 At what scale to plot: Check off Fit to paper for this exercise.
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Figure 9.2 
Plot features.

Figure 9.1 
Plot Model dialog box.
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l	 What pen settings to use: Select monochrome.ctb, and click on Yes if prompted to use 
this for all layouts.

l	 What orientation to use: Select Portrait.
l	 What offset (if any) to use: Check off Center the plot.

Do not press OK yet. The Plot box should look like Figure 9.3.

Preview
Much like the situation with creating an array or hatch, a Preview button is available. With 
printing and plotting drawings, it is crucially important to preview the drawing before 
sending it to Plot. Paper and ink cost money, and everyone regardless of skill level makes 
mistakes in setting up printing. This really should become a habit, as errors can be costly, 
especially on large print jobs. On an industry-wide scale, this simple Preview button actually 
saves tons of paper and gallons of ink. I caught not only printing setup errors but even 
linework drawing errors during the Preview process.

Go ahead and press Preview (lower left corner) and the Preview screen in Figure 9.4 
appears. You can zoom and pan around using standard mouse techniques, and when you are 
ready to send the drawing to the printer (or return to Plot for adjustments), right-click and 
select Exit or Plot, respectively.

Go ahead and plot. If everything was set up correctly and your computer is connected to the 
printer, the floor plan should print as seen in Figure 9.5.

Figure 9.3 
Plot features selected.
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Figure 9.5 
Final output.

Figure 9.4 
Plot Preview.
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If something does not look right anywhere in the process, review the entire set of steps, one 
by one, returning to the Preview screen to check up on the effect of the changes.

9.4  Page setup manager
There is one last topic to learn in this chapter. The settings on the print job you just sent are 
not saved in memory. Try it by typing in plot again. Unless it has been saved somehow, you 
have to reset them all again. The technique to “save” your settings involves another feature of 
Plot called Page Setup Manager.

The idea here is as follows. You need to enter all the data for a print job in another similar-
looking Print dialog box and save it under a descriptive name. Then save the drawing with 
these settings, and when you do the actual plot, the name you saved under appears under 
Page setup (upper left corner). Then, no more entering settings one item after another, just 
select the Page setup (it may already be cued up), preview, and print.

This has two advantages. The first is obvious: It speeds things up a lot by keeping all the 
drawing’s print settings ready for use. The second may not be as obvious. Because you can 
save as many setups as you want, you can have one drawing set up for multiple printers or 
multiple settings.

For example, your office may need the final output sent in color to a D-sized plotter at a 
certain scale, but in-house checks are done on 17  11 sheets, in black and white and no 
scale. You can easily set up two distinct setups and name them Client _Layout and Check _
Layout. On occasion, I have used up to a dozen setups on one drawing, each with its own 
purpose: presentation, archiving, optimized for color, check plots, and so forth.

A question usually arises when this topic is presented. Does this need to be done every time 
a new drawing is created from a blank file? The answer is yes, but it is something that needs 
to be done only once and saves you much time down the road. Obviously, using templates 
negates the need to do this at all, as all settings carry over.

The Page Setup Manager is found using the cascading drop-down menu: File→Page Setup 
Manager or the Output tab on the Ribbon and is shown in Figure 9.6.

Press the New button and the New Page Setup appears, as shown in Figure 9.7. Enter the 
name of the new setup and press OK.

You are then taken to the now familiar-looking Page Setup dialog box. Upon completion of 
the settings, a preview (yes, still needed), and a press of the OK button, you are redirected to 
the Page Setup Manager ready for another setup if needed. If not, press Close.

To see the benefit of this, go to Plot and select the name of the setup from the Page setup in 
the upper left corner; all your settings appear. Plot the drawing and save it. You never have to 
enter settings again (unless something changes, like the arrival of a new printer). So finally, 
after learning all this new material, you can now reduce printing to a pressing of the Preview 
and the OK buttons—our goal all along.

As stated before, there is still a lot we have not covered and we revisit this topic again in 
Chapters 10 and 19. Printing is something you usually receive assistance with at a new 
job, training center, or consulting gig. However, the most you should expect to be told is 
what printer is commonly used (up to ten connected to one computer is not unheard of) 
and what is the standard ctb file in use. The rest is up to you, and with the knowledge you 
gained in this chapter, you should be proficient in all printing matters just shy of the level of 
AutoCAD management and administration.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 10.

l	 What printer or plotter to use
m	 Differences between plotting and printing

Figure 9.6 
Page Setup Manager.

Figure 9.7 
New Page Setup.
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l	 What paper size to use
m	 A size
m	 B size
m	 C size
m	 D size

l	 What area to plot
m	 Extents
m	 Window
m	 Display
m	 Limits

l	 At what scale to plot
m	 1:1
m	 Fit to paper
m	 Other scale

l	 What pen settings to use
m	 ctb files

l	 What orientation to use
m	 Portrait or Landscape

l	 What offset (if any) to use
m	 Center the plot
m	 X or Y offset

l	 Preview
l	 Page Setup Manager

Review questions
Answer the following based on what you learned in Chapter 9.

1.	 List the seven essential sets of information needed for printing or plotting.

2.	 List the five paper sizes and their corresponding measurements in inches.

3.	 What is the difference between printing and plotting?

4.	 List the four plot area selection options.

5.	 What scale setting ignores scale completely?

6.	 What is the extension of the Pen Settings file?

7.	 Explain the importance of Preview before printing and plotting.

8.	 Why is the Page Setup Manager useful?

Exercise
1.	 Open the mechanical device drawing from earlier chapters and practice printing with a variety of 

scales and other settings. (Difficulty level: Easy; Time to completion: 10 minutes)

•	 Select printer.

•	 Select paper size; stay with A size.

•	 Select Extents for the area. Also try again with Window; observe the results in Preview.

•	 Try a variety of scales such as 1:1, 1:2, and so on; observe the results in Preview.

•	 Pick the monochrome.ctb file.

•	 Try both Landscape and Portrait orientation.

•	 Center the plot.
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Advanced Output  
Paper Space

LEARNING OBJECTIVES
In this chapter we introduce and thoroughly cover the concept of Paper Space.  
We specifically introduce
l	 The primary reasons for using Paper Space
l	 Entering Paper Space and setting up title blocks (Layouts)
l	 Viewports and their properties
l	 Viewport scale assignments
l	 Controlling what is visible in viewports
l	 Setting up text and dim styles based on the viewport scale
l	 The new Annotation feature that simplifies setup of Text and dims

10
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By the end of the chapter, you will be well versed in applying this critical concept to your 
design work.

Estimated time for completion of chapter: 3 hours.

10.1  Introduction to paper space
Paper Space is an extensive and critically important topic in AutoCAD. Learning it is a rite 
of passage for all AutoCAD designers, and proper setup and use of Paper Space is a mark of 
an expert user. The topic is not necessarily difficult but can be somewhat tedious, requiring 
care and attention from the designer who really has to “dot the Is and cross the Ts” to assure 
everything is done right. It is also a topic that needs to be understood well in theory, first 
and foremost. The actual “button pushing” process to set things up is much easier when you 
understand what Paper Space is and why it is used. The result of learning all this, however, 
is a professional drawing set that is accurate and easy to read, understand, and print. This is 
a necessity and a goal well worth striving for. We explore Paper Space from all angles, one 
step at a time. Read and understand each section before moving on to the next. Paper Space 
knowledge is cumulative.

What Is Paper Space?
When you create a design of a building with pencil and paper, this design needs to be drawn 
to a certain scale, as opposed to full-size, for the simple reason that it would not fit on a 
piece of paper if you did not do this. This is the reason why architects carry with them an 
architectural scale, a portion of which is shown in Figure 10.1.

Then they can simply pick the appropriate scale for the size of their intended design (1/8  
1-0 is common), and now due to the fact that 8 feet are represented by 1 inch, the building 
floor plan can fit nicely on a large sheet of paper.

In AutoCAD however, you do not draw “to scale.” Because you now have an infinite size 
canvas upon which to create your design, everything is drawn one to one or “life-size,” 
meaning that, if you were to jump into your design through the computer monitor, you 
would find yourself in proportion to (and would be able to freely walk around inside) your 
building.

This is the Golden Rule of AutoCAD, and indeed in all cases of computer-aided design, and 
marks a significant departure in philosophy and method from the previous hand-drafting 
approach. In fact, attempting to draw “to scale” results in severe complications and potential 
for error when creating, and later changing, the design and is simply not done in practice.

Figure 10.1 
Architectural scale.
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Drawing one to one, however, creates a whole new set of problems. How do you output a 
design that may be dozens or hundreds of feet across, onto a paper that is generally only 3 or 
4 feet wide? Furthermore, this design has to be framed by a title block or title page that itself 
has to be drawn one to one, so as to not violate the Golden Rule. The solution is elegant, 
simple in principle, and has stood the test of time.

The idea is as follows. Draw the design in one area of AutoCAD, called Model Space, 
then draw the title block in another unconnected and unrelated area, called Paper Space. 
Finally, connect the two together via a clever concept, called a viewport, which is simply a 
“window” looking in from Paper Space onto Model Space. This viewport is then assigned 
an appropriate scale; and if everything is drawn (and then printed) one to one from Paper 
Space, then the design comes out to scale and the problem is resolved.

This in essence is Paper Space: nothing more than a technique to separate the two worlds 
and then reconcile them in a meaningful way to get around the tricky problem of a finite size 
piece of paper holding a much larger design.

Be sure you understand the previous few paragraphs completely. The reasons behind 
everything outlined from here on will be easier to see once you have a good idea of why  
we are doing what we are doing.

10.2  Paper space concepts
The devil, as they say, is in the details, and the study of Paper Space involves a number of 
separate concepts, each of which is an important part of the complete picture and needs to 
be looked at closely:

l	 Layouts: Entering Paper Space and setting up title blocks.
l	 Viewports: Viewports and their properties.
l	 Scaling: Viewport scale assignments.
l	 Layers: Controlling what is visible in viewports.
l	 Text and dims: Setting up text and dim styles based on viewport scale.
l	 Annotation: A new feature that simplifies setup of text and dims.
l	 Summary: Putting it all together.

These topics are listed roughly in the order a designer would go through them as he or she 
sets up and does the project. As an example drawing, we continue using the architectural 
floor plan that you have been working on since the start of Level 1. It happens to fit nicely 
on a D-size (36  24) sheet of paper at ½ scale to illustrate the concepts. If you want to 
use another design, perhaps one drawn in one of the end-of-chapter exercises or one your 
instructor assigned to you, by all means use that. If you stick with the apartment floor plan, 
then thaw all the layers. It is messy, but we fix that later. Let us begin with the first topic, 
layouts.

Layouts
The first step involves switching over to Paper Space and familiarizing yourself with the 
Layout tabs. They are found at the bottom of your drawing area, resemble Microsoft Excel 
tabs, and say Model, followed by Layout 1 and Layout 2, as seen in Figure 10.2.

Go ahead and switch over into Paper Space by clicking on Layout 1. You will notice a 
different environment, as shown in Figure 10.3. For starters, the UCS icon is a triangle and 
the Layout 1 tab is highlighted. Your background color is white, and finally you have a 
variety of background features (rectangles, shadows, viewports, and others). We will modify 
this environment in a minute, but in the meantime click on the Model tab and jump back 
into Model Space. You now know how to enter and exit Paper Space.
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There really is no need for Paper Space to look any different from Model Space. There is nothing 
special about Paper Space whatsoever. Remember, it is just a technique in AutoCAD to create two 
separate worlds. You can actually draw in Paper Space as if it is your regular drawing area with no 
adverse effects, but of course that would defeat the whole purpose of what we are doing.

Based on this, it is highly recommended that the Paper Space shadow and other features are 
turned off. Indeed most experienced users prefer their Paper Space to look as close to Model 
Space as possible. It is ultimately up to you if you want to do this, but all screen shots in the 
remainder of this chapter feature the plain Paper Space environment. To do this you need to 
right-click to Options, then select the Display tab and take a look at the Layout elements 
(lower left). Go ahead and uncheck all but the very first choice, as seen in Figure 10.4, and set 
the Sheet/Layout color to black in Colors (though in the textbook the background remains 

Figure 10.3 
Paper Space.

Figure 10.2 
Layout tabs.
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white to conserve ink and for clarity). It is also a good idea to set your crosshairs to 100 for 
reasons soon to be explained. Ask your instructor for assistance if needed. Finally, click on OK.

After this modification, Paper Space should look like what is seen in Figure 10.5 (except of course 
for the screen color, which should be black, as preferred by most users). Notice that now the 
only indication that you are in Paper Space is the triangle UCS icon and the highlighted Layout 
1 tab. Also the viewport rectangle was erased. Note that some students may already have had this 
environment, or a variation of it, set up and could have skipped the previous few steps.

So what are these Layout tabs in real life? They are literally sheets of paper when the job is 
completed and ready for printing. The design (done in Model Space) is “presented” in Paper 
Space with each Layout being one sheet of the total drawing set, that is, the Architectural, 
Mechanical, Electrical, Details, and so on.

If you are thinking that we need to learn how to make title blocks at this point and perhaps 
create more Layouts, then you are correct. We create a title block from a built-in AutoCAD 

Figure 10.4 
Paper Space preference settings.

Figure 10.5 
Paper Space, modified.
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template. This may or may not be the way you will be doing it at your job. If you are in an 
architecture office, there may be a pre-drawn title block that you can just retrieve and paste 
in, but for our learning purposes we create a new one.

Select the Layout 1 tab (left-click) then right-click to bring up the menu shown in Figure 10.6.

We will work with this menu for the next few pages. Let us first of all try creating a title  
block from a template by clicking the From template… choice. You get the dialog box in 
Figure 10.7. Pick the Tutorial-iArch.dwt template and click on Open.

Figure 10.6 
Layout tab menu.

Figure 10.7 
Select Template From File.
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Another small dialog box, Insert Layout(s), appears, as shown in Figure 10.8. It is simply 
informing you that the layout is a D-size one. Click OK.

Notice what happened: You have a new tab, called D-Size Layout, positioned right after 
the other three layouts. Click on it and you see a decent title block, much improved in 
AutoCAD 2010 versus older releases (AutoCAD 2011 continues to use it). It is a reasonable 
representation, minus the fancy logos, of what a typical architectural office may use. Inside 
the title block is a blue rectangle through which you may or may not see your building; this 
is the viewport, and we cover this topic next. For now, go ahead and delete it. We will make 
our own soon. Also, explode the title block as we want to modify it.

What you have now is shown in Figure 10.9 (except that your screen background likely is 
colored black).

Figure 10.8 
Insert Layout(s).

Figure 10.9 
Basic Tutorial-iArch.dwt title block.
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The next step is to modify the Layout tabs by renaming them to something more descriptive 
and removing the unnecessary ones. Right-click on the new D-Size Layout tab to get the 
menu to appear again. Select the Rename choice and the tab’s name becomes editable; type 
in Architectural Layout. Let us now get rid of the Layout 1 and Layout 2 tabs, as they 
are empty and not needed. Begin by clicking on Layout 1, then right-click to get the menu 
up again. Select Delete and press OK when the warning box pops up. Repeat the procedure 
for Layout 2. After these steps we have only the following two tabs remaining, Model and 
Architectural Layout, as seen in Figure 10.10.

Take a moment to look over the title block in the Architectural Layout tab. As a reminder once 
again, delete the original viewport (the blue rectangle), as we will make our own from scratch. 
Then explode the title block if you have not done so yet. Modify anything you may want to 
look different (for example, delete the USER, REVDATE, and the FNAME text in the lower left 
corner and added sheet A1 in the lower right corner of the title box), but this is optional.

Now we need to create more of these title sheets, for the Mechanical and Electrical layouts. 
Go back to the menu (right-click on the Architectural Layout tab) and select the Move or 
Copy… choice. The dialog box in Figure 10.11 appears.

Figure 10.11 
Move or Copy.

Figure 10.10 
Model and Architectural Layout tabs.



207

CHAPTER 10  
Advanced Output: Paper Space 

Be sure to do two things. First of all, check off the Create a copy box at the bottom left and 
also click on the (move to end) choice, which simply places the new title sheet next in 
line after the existing Architectural Layout and may be important later when it come to the 
printing order. The order can be seen in Figure 10.12. Finally click on OK and observe what 
happens with the tabs. A new one appears, saying Architectural Layout (2), and it is a perfect 
copy of the previous existing tab. Go ahead and rename it (as outlined earlier) to Mechanical 
Layout. Repeat the whole procedure to create a third tab, called Electrical Layout, and finally a 
fourth tab, called Landscaping Layout. The final result is in Figure 10.12.

Review this entire section; it is an important first step to learning Paper Space and is a 
common procedure needed to set up a project that has multiple pages (which is pretty much 
the case every time). It should be clear as to what each sheet (tab) represents. Next we work 
on the sheets to set up viewports so the design can be viewed at the proper scale.

Viewports
Viewports, as mentioned in the Paper Space introduction, are simply windows from the Paper 
Space world looking into the Model Space world. It is as if we ripped a hole in the fabric of 
Paper Space and observed what was behind there. We assign scales to these viewports later on 
and in this manner reconcile the Paper and Model Spaces. For now we need to first learn how 
to create and modify the viewports and go over some of their properties. Your new layouts 
already have a premade viewport (the blue rectangle), but as mentioned earlier, you should 
have now erased it; we will learn to create new ones from scratch.

To go through the following steps, we need a drawing of the floor plan in Model Space. Open 
up the file of the apartment plan that you have been working on and look over the drawing, 
cleaning it up if necessary. Thaw all the layers and Copy/Paste it (using Ctrl-C and Ctrl-V, not 
the AutoCAD commands) from that file into your new file where you just set up the Paper 
Space tabs. This is important to learn to do, as you often will need to copy items out of one 
file into another when working on real projects. Finally, freeze the Dimensions layer, leaving 
only the walls, windows, doors, furniture, appliances, and the carpeting hatch, if desired. The 
sample file shown here was modified slightly to include both furniture and carpeting all at 
once. You are now ready to set up the Mview window.

Click on the Architectural Layout tab, entering Paper Space, type in mview, and press Enter. 
This is the key command for creating new viewports. Alternatively you can use the cascading 
menus View→Viewports→1 Viewport. Note here that you can create more than one viewport at 
a time, but we do only one for now.

m	 AutoCAD says:
Specify corner of viewport or
[ON/OFF/Fit/Shadeplot/Lock/Object/Polygonal/Restore/LAyer/2/3/4] <Fit> 

Figure 10.12 
All tabs.
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Then simply click and drag the mouse across your screen, effectively drawing a large rectangle 
from one side of the sheet to the other (avoiding the actual title block in the lower right corner). 
AutoCAD says: Specify opposite corner: as you are doing this and Regenerating model  
as you complete the viewport. You should now be able to see the design inside the “rectangle” 
you created, as shown in Figure 10.13.

You can create more viewports in the other layouts if you like for practice, but we focus on 
this one, in the Architectural Layout.

Floating model space
Double-click inside the viewport. Its border becomes thicker and you notice your mouse 
is “inside” the viewport, as shown in Figure 10.14. The advantage of having 100 width 
crosshairs is evident here, as the viewport “clips” the ends of the crosshairs and it becomes 
clear that you are in this mode. Pan and zoom while inside the viewport and you notice the 
design shifts around while the Paper Space title sheet stays still. This Floating Model Space 
mode is sort of a “no man’s land” between Model and Paper spaces and is critical in scaling 
the design, as we shall soon see. For now double-click anywhere outside of the viewport to 
get back to Paper Space. Be careful not to double-click on the actual viewport itself. That 
takes you to the vpmax mode (maximum viewport size), which can be used for editing  
but is not needed here. If you do accidentally double-click on it, press the button shown in 
Figure 10.15 to get back (bottom right of the screen).

Practice jumping in and out of the viewport several times; this is very important for the rest 
of the chapter. Note also the big picture discussed so far. You are in Paper Space and created 
the viewport to look onto the design in Model Space. When you are inside the viewport, 
you are technically in Model Space, but still in Paper Space as well. You need this for scaling 

Figure 10.13 
New viewport.
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purposes only. Design work on either the floor plan or the title sheet or block is done in their 
respective spaces.

Next we need to learn how to modify the viewport(s). Note that they are not static displays 
but rather dynamic tools you can and should mold and shape to your needs as outlined in 
the next section.

Modifying the viewport
First, make sure you are in Paper Space, and then click once on the viewport (not inside of 
it, but on the lines of the actual viewport rectangle). The viewport becomes dashed and grips 
appear. Using them you can resize the viewport to any size desired by clicking on any grip, 
activating it (it turns red), and adjusting the viewport’s size and shape. In general you can

l	 Scale the viewport(s) up and down to any size.
l	 Adjust the viewport(s) to any shape.
l	 Move the viewport(s) anywhere you’d like.
l	 Erase the viewport(s).
l	 Copy the viewport(s) as many times as needed.
l	 Make new ones as needed.

Take a few minutes to go through all these features. Make your viewport smaller, then copy 
it several times. Move all four around the screen, then erase one. Finally create it again with 
Mview. In the end try to have what is shown in Figure 10.16 and in general make sure you 
understand viewport manipulation, the Mview command, and getting in and out of Floating 

Figure 10.14 
Floating Model Space.

Figure 10.15 
Minimize viewport.
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Model Space. When you are inside the viewport, do not forget to also scale the drawing up or 
down and zoom to extents. We focus on a precise scale later.

Polygonal viewport
The shape of the viewport need not be rectangular or square; it can be any shape necessary 
by using the Polygonal option. To practice this, click over to the Mechanical Layout and 
create a new viewport using the Mview command; however, before clicking to draw the 
actual viewport, select P for Polygonal in the lengthy menu.

m	 AutoCAD says: Specify start point: and after the first click Specify next 
point or [Arc/Length/Undo]:

Click your way around in some random fashion (do not overlap the clicks) and press C for 
Close to close the viewport. What you get after creating a starburst sort of pattern is shown in 
Figure 10.17. You can see the design inside the oddly shaped viewport.

Of course this is not really what this tool is for. Rather it is to make viewports that weave 
their way around possible revision blocks or notes on the drawing, thereby freeing you from 
being forced to use a rectangle and wasting space. An example is shown in Figure 10.18, and 
this is often the case in real-life designs, making Polygonal viewports very important for 
creating an efficient layout.

There are a few other important items to cover with viewports, such as locking them and 
making them invisible, but we introduce these features a bit later, as the need arises. What we 
need to look at next is the “core” of Paper Space: scaling the viewports and their contents.

Scaling
Here we finally put everything together, because really what we have done so far was just 
the “setup.” We have our design in Model Space and our title block/sheet in Paper Space, 
connected together by one or more viewports. Now we need to give these viewports a scale, 
which was our goal all along.

Figure 10.16 
Four random viewports.
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To make things simple, let us just have one viewport in our Architectural Layout, so delete 
any others you may have, including polygonal ones, and leave one large viewport similar to 
Figure 10.13.

So, what is scaling? Well, you may have already guessed it has something to do with 
zooming. After all, as the design is zoomed in and out (while in Floating Model Space), the 
scale continuously changes and is always something. So scaling the design properly is just a 
matter of knowing how much to zoom it in the viewport. The big question of course is, how 
much? Another way to put it is, what scale factor do we apply?

Figure 10.17 
Polygonal Viewport 1.

Figure 10.18 
Polygonal Viewport 2.
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There are two ways to assign scale to this or any viewport. The first one is a technique used 
for just about every AutoCAD release up until the last few. It is a bit more involved but really 
gets you to understand what is going on. Then we cover the other, easier method.

Method 1: Double-click inside the viewport, type in zoom, and press Enter. You see
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real  
time>:

Here is where you used to pick E for extents and see the entire drawing fill up your screen. 
However did you notice the enter a scale factor (nX or nXP) choices? This is what we are 
interested in right now, specifically nXP.

What nXP means is that you need to enter a ratio relative to Paper Space (which is the 1:1 
“anchor,” so to speak) and then the design scales to that ratio. So what is it? Well for 1/4  
1-0 the n is 1/48 (followed by the xP). So type in 1/48xp and press Enter. The design zooms 
to precisely 1/4  1-0 scale, as shown in Figure 10.19.

Now this seems to be too small. No problem, just type in zoom and press Enter again. Then 
type in 1/24xp and press Enter again. The design will zoom to ½  1-0, as shown in 
Figure 10.20, which seems to be a better size for this design and title sheet.

So where did 1/48xp and 1/24xp come from? They are just ratios developed from the 
fact that there are 12 inches in 1 foot and the scale is 1/4 or 1/2. Therefore, for 1/4, it 
is 1/48 (1/8 inch scale  1/12 inches in a foot  1/48 relative to the 1:1 Paper Space). 
For 1/2 it is 1/24 (1/2 inch scale  1/12 inches in a foot  1/24 relative to the 1:1 Paper 
Space) and so on. There are other scales such as 1/16, 1/8, 3/8, 5/8, and others; they can 
all be derived in a similar manner. There is of course a faster and easier way to set up 
viewport scales.

Method 2: Double-click back out to Paper Space and bring up the Viewports toolbar, shown 
in Figure 10.21.

Figure 10.19 
Design zoomed to ¼  1-0 scale (1/48xp).
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Now click the viewport once (not inside of it, but on the lines of the actual viewport rectangle). 
When the viewport becomes dashed, the scale associated with that viewport is shown in the white 
field on the right side of the Viewport toolbar. Click the down arrow and you see a wide variety of 
choices. Pick the scale you want and the viewport takes on that scale, as shown in Figure 10.22.

Figure 10.20 
Design zoomed to ½  1-0 scale (1/24xp).

Figure 10.21 
Viewports toolbar.

Figure 10.22 
Viewport scaling, Method 2.
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Layers
We have done a lot already in setting up the drawing in Paper Space. We now turn our 
attention to several important details that are either new or change significantly when 
dealing with Paper Space.

One of those is Layers. While the fundamental Layer concepts do not change, a new ability is 
added to the Layers dialog box. It turns out that, when viewports are present, you can freeze 
and thaw layers in those viewports independent of each other and the main drawing. This is 
very significant, as you want to be able to display different items as you go from viewport to 
viewport.

Perhaps the most important example of that is when you jump between the Architectural, 
Mechanical, and Electrical Layouts. Each tab is a new viewport, yet all views of the design 
originate from one actual copy of that design. In each layout, you need to see only what is 
relevant to that layout, and it would be a major problem if you could turn layers on and off 
only in the main Model Space drawing. Then each tab would display the exact same thing.

Fortunately this is not the case, and in each viewport, you can turn layers on and off 
as needed to get the design points across. Therefore the Architectural Layout has only 
Architectural layers and so on. It is the same idea with multiple viewports on one layout 
(such as the case with detail sheets). Each viewport is truly a world unto itself. To see an 
example of this let us create four viewports in the Architectural Layout, as shown in  
Figure 10.23. The scales assigned are random.

Double-click into the top left viewport and bring up layers. The Layers dialog box (with some 
extra columns) appears, as shown in Figure 10.24. All relevant columns have been expanded 
for maximum visibility of the contents. Look for the VP Freeze column (circled); this is the 
only column in which we are interested.

In that column, you can freeze all the unneeded layers for that layout without affecting either 
the main layout or the other viewports. Go ahead and freeze the A-Floor-Hatch layer. The 
result is shown in Figure 10.25. Note how the neighboring viewports are not affected by 

Figure 10.23 
Four viewports for Layers demo.
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what you did in the top left one. Now click over to the top right one and freeze the A-Doors 
layer only. Click over to the bottom left viewport and freeze the A-Floor-Hatch, and the 
A-Appliances_Furniture layers. Finally, in the bottom right viewport, freeze everything except 
the walls and windows. Note the distinctly different layer settings in each viewport; they are 
completely independent.

Lock VP
We now cover two other notable features of viewports. The first is the ability to lock the 
viewport, which simply means you cannot change the viewport’s scale and all zooming 
attempts fail (the entire Paper Space drawing zooms instead). This can be useful to prevent 
accidental zooming while inside the viewport and should be set after the design is laid out 
and set up. To do this, bring up the Properties box (refer to previous chapters if you forgot 
how). Then click the viewport once, and select (under Misc.) the Display locked option, 
setting it to Yes, as shown in Figure 10.26.

Figure 10.24 
Layers dialog box with VP Freeze columns.

Figure 10.25 
VP Frozen layers.
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Freeze VP
This next feature allows you to either “freeze” the viewport or simply prevent it from 
printing. The reason for this is that generally you do not want a big fat rectangle on your 
final plots that will go to the client. This is especially true of the main layouts that feature 
just one large viewport. The visible viewport rectangle can be mistaken for part of the border 
and is unnecessary. Even with detail sheets, each of which may display many details, the 
trend is to just separate them adequately but not have any rectangles visible. If you “didn’t 
do it by hand in the old days” then there is no need to introduce it in AutoCAD.

Having said this, however, some designers prefer to see the viewports all the time and have 
them disappear only upon printing. So you have several options in this regard.

First of all, we need to put the viewports on an appropriate layer if they are not already. 
Designers generally create a _VP layer for them. Notice a trick here. The VP layer has an 
underscore in front of it. This forces the layer (or any layer that has that underscore) to rise to 
the top of the layer list, above the 0 layer. This makes it easy to find the title block and sheet 
or the VP layers (as long as you do not overdo it and stick too many up there). Go ahead 
and change the color of the layer to gray and freeze it. Then finally change all the viewports 
(using Properties) to that frozen _VP layer. If you did everything correctly, then the viewport 
boxes disappear, as shown in Figure 10.27.

There are other alternatives of course for those who want to see the viewports but not print 
them. You can put them on the Defpoints layer. This layer does not print (it is the definition 
points from dimensions). Another method is to just put a slash through the printer icon in 
the Layers dialog box corresponding to the viewport layer, which leads to the same result.

We are getting to the end of Paper Space, and two major topics are left: Text and dims and 
the Annotation tools.

Figure 10.26 
Locking the Viewport.



217

CHAPTER 10  
Advanced Output: Paper Space 

Text and dims
This topic is probably the most confusing one in Paper Space and really requires the AutoCAD 
designer to not only understand everything thoroughly but also work carefully and deliberately. 
In practice, much of this is done only once and saved as part of a template, but for educational 
purposes, we assume you are being tasked with the Text and dims setup from scratch and must 
know all the steps.

Our goal here is quite straightforward: We want all the text and dimensions to be the same 
size when printed, regardless of in what scale viewport they appear. This uniformity is a basic 
requirement of a professional drawing. Architects and engineers specify something to the 
effect of: “I want the text height to be ¼ on all drawings, both in layouts and in all details,” 
and it is up to the AutoCAD designer to ensure that this happens. With hand-drafting this 
was not an issue; the text and dims were drawn all at once using the same size template.

With AutoCAD, due to our use of Model Space and Paper Space, things are not so simple. The 
basic fact remains that all text and dimensions have a certain fixed measurable size when drawn 
in Model Space and appear as different sizes when viewed through the various scaled viewports, 
just as the design itself does. Some designers try to simplify everything by dimensioning the 
design in Paper Space to achieve uniformity (AutoCAD lets you do this), but this is not correct. 
The dimensions and all text must remain with the design in Model Space. The reasons for this are 
many, not the least of which is that any movement of the design misaligns everything.

So the text and dims need to stay where they are supposed to be, and we need to understand 
how to properly size text and dimensions based on the anticipated scale of the viewport in 
which they appear. This all really just boils down to a game of “match-up.” The basic theory 
is as follows. You already know that viewport scale is a function of zooming. Therefore, when 
you have uniform text in Model Space and view the same set of text through the ¼  1-0 
versus the ½  1-0 scale viewport in Paper Space, the text in the ½ viewport appears two 
times as large, as the viewport is a larger scale. To counter this effect, you need to make sure 
that the text that appears in that ½ viewport is drawn to be half as big, so it appears uniform 
with the ¼ text (just as an example).

Figure 10.27 
Viewports frozen.
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The trick is to be consistent and careful, so that the wrong size text does not appear with the 
wrong viewport scale. So, how is this done in practice? How do you know what size text and 
dims are appropriate for a particular scale? We have tables for this, such as the one shown in 
Figure 10.28.

To use this chart, you have to know what scale viewports you are using. With the main 
layouts, such as the Architectural or Mechanical, done earlier, it is very easy. These layouts 
typically feature only one viewport of a known scale (1/8  1-0 is commonly used); 
therefore, if the architect desires all text output to be 3/16 in height (also a common size), 
then by reading the chart from left to right until we meet the 3/16 column, we arrive at a 
height of 18 inches, which is to be used for all text in that drawing. For the 1/4  1-0 scale, 
that same text size is now 9 inches, half as big, since the new scale, 1/4  1-0 is twice as 
large. Ideally, this all makes sense to you.

With details, which may come in all the scales listed, the procedure is no different; you just 
have to be very careful in knowing ahead of time what scale viewport you will be using, to 
use the appropriate text height. All this comes with experience, and after much practice, you 
will be able to quickly assess the necessary scale of a given detail to ensure that all aspects 
of it are visible and clear to whoever is reading the plans. This will be the only factor in 
determining the appropriate text size.

The chart shows not only the text height but also the dimension sizes under the SCALE 
FACTOR column. Here, you retrieve the appropriate size (24 in the ½  1-0 example) and 
enter that value in the Use overall scale of: text field under the Fit tab of the DDIM dialog 
box. Also shown is the appropriate scale for linetypes (9 in the case of ½  1-0). You need 
this to ensure you can see a hidden line, for example, under this scale.

Most of the information contained in Figure 10.28 needs to be entered into AutoCAD in 
the form of text styles and dim styles. This is the job of the CAD manager on initially setting 
up an architectural or engineering office’s CAD standards. Yes, it is as tedious as it sounds; 
the chart is abbreviated and does not contain every scale used, so the work is substantial. 
Fortunately it needs to be done only once, and a template is formed for all users to follow 
from there on out. Enforcing this usually turns out to be the hardest part of all, as the 

Figure 10.28 
Text and scale standardization chart.
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“system” is only as good as the people who follow it. You must be careful to use the proper 
style (usually called Arial_.25, for example), and be sure to set that style as current while 
working on the relevant design or detail. The payoff comes later in the process, when you 
view the design in Paper Space. Uniformity and professionalism is the final goal.

Practice
Step 1. Go to the Style dialog box and create three new text styles, all Arial fonts. They are 

set up for a final text height of ¼ and are viewed through three viewports of the 
following scales:
m  ½  1-0 (therefore, size: 6).
m  ¼  1-0 (therefore, size: 12).
m  1⁄8  1-0 (therefore, size: 24).

Step 2. Go to the Ddim dialog box and create three new dim styles. All must use the 
appropriate text from the previous procedure (therefore, the ½  1-0 dimension 
style uses the Arial_.5 style of 6 height, etc.). Then set the fit as shown on the chart 
and reproduced here:
m  ½  1-0 (therefore, Use overall scale of: 24).
m  ¼  1-0 (therefore, Use overall scale of: 48).
m  1⁄8  1-0 (therefore, Use overall scale of: 96).

Step 3. One by one, in Model Space, set each text and dimension style as current and create 
one set of text and one set of random dimensions next to each other, as shown in 
Figure 10.29.

This may take you a few minutes to set up and execute. Be sure to work carefully, checking 
and rechecking all your settings. As expected, the three scales go up in size 2 for each jump 
from ½ to ¼ to 1⁄8. We now want to see them uniform in size in Paper Space.

Go into Paper Space and create three viewports next to each other. Use the tools learned 
previously to set the first one to the ½  1-0, the second to ¼  1-0, and the third to 
1⁄8  1-0. Pan around until the appropriate text/dims combination is in the respective 
viewport (you may have to go to Model Space and move them apart slightly). The result is 
shown in Figure 10.30.

Notice the complete uniformity of the text and dims in Paper Space (as opposed to how they 
looked in Model Space in Figure 10.29). This is the essence of what we are doing here. If you 

Figure 10.29 
½, ¼, and 1⁄8 text and dimensions.

Figure 10.30 
Paper Space text and dims uniformity.
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can set up these three viewports and all the text/dims correctly, you can do any drawing. Be 
sure to review and learn everything thus far presented. Ask your instructor for assistance if 
needed.

Annotation
This final Paper Space feature we briefly discuss is relatively new and first appeared in 
AutoCAD 2008. Called Annotation, its purpose is to present an alternate approach to the 
methods of the previous section “Text and dims.” The new approach is different in that it 
allows you to set multiple scales for the same text, so the proper scales are visible in the 
proper viewports with no further input from the user. Several items can be annotated: styles, 
dimensions, blocks, and hatches. We explore text as outlined in the following procedure, but 
it is similar with dimensions.

Open a brand-new file, type in style, and press Enter. The familiar Style dialog box comes 
up. Create a new style, calling it Arial_Anno, font Arial. Check off the Annotative box under 
Size and leave the Paper Text Height as 0. The new text has a triangular symbol next to it, as 
seen in Figure 10.31. Be sure to set it as Current.

Now switch to Model Space and create a line of text. The first time you do this a dialog 
box, such as shown in Figure 10.32, pops up. Set the scale at which you anticipate this text 
to show up in (such as inside a ¼  1-0 viewport, as done here). Go ahead and set the 
previously mentioned scale and press OK. Finish typing the text.

Now switch to Paper Space and create a viewport and set it to the ¼ scale. Expand or 
contract it to fit nicely around the text, as shown in Figure 10.33.

Now copy that viewport to the right and change its scale to 1⁄8. The text will briefly shrink to 
a smaller size then balloon back up to the same size you set (¼), as shown in Figure 10.34.

This is the essence of Annotation. The Annotation Scale is adjusted at the bottom right of 
the taskbar, as shown in Figure 10.35, so when new text is being created, you need to set its 
anticipated viewport scale right away.

Figure 10.31 
Annotative style.
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Figure 10.32 
Select Annotation Scale.

Figure 10.33 
Annotation text in sample viewport.

Figure 10.34 
Annotation text in sample viewports.

Figure 10.35 
Annotation Scale.

Figure 10.36 
Annotative text copy.
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You can also set different annotation scales to the same text if you anticipate it being visible 
in two or more viewports of different scale. Click on the text and a “double” of it pops up 
(Figure 10.36). This double is not a true copy but a temporary twin. At this point, go ahead 
and set the new annotation scale from the popup list in Figure 10.35 and move the text to a 
new position (usually right on top of where the old one was).

Everything done here with text can be done with dimensions and the other items listed 
previously. Experiment with this tool to see exactly what AutoCAD’s designers had in mind. 
It is not necessarily easier than the previous method but may be somewhat simpler—
opinions vary. Note the Annotation Visibility option (scale symbol with a light) next to 
the Annotation Scale list. This shows all objects in all scales; the symbol next to it is for 
automatic scale addition.

Summary
We have gone over a lot of information in this Paper Space chapter. Ideally you have absorbed 
all of it and are able to use this valuable and important tool. Many use it improperly or not at 
all, and being an expert in Paper Space sets you apart from the crowd and adds a true level of 
professionalism to your designs. This summary serves as a capstone to the chapter and presents 
the big picture once again, now that the details have been mastered.

Do not think of Paper Space as a rigid or fixed system, where buttons are pushed and 
results pop out. While an element of this is present, the proper way of looking at it is as a 
flexible and loose collection of tools that allow you to shape and mold the presentation of 
your design in a way that is efficient, clear, professional, and of course pleasing to the eye. 
There is no one way to do things. Rather there is a constant tug of war between (sometimes 
conflicting) requirements. For example, you have to consider

l	 The size of the design: This is the first and foremost concern. Your design takes priority 
over everything else, so focus on that in Model Space, creating your architectural layout or 
engineering device, as per client need.

l	 The size of the available plotter and paper: After the design is completed, output is 
considered. What do you have to work with? Most companies have a plotter capable of 
36  24 plots. Some have the larger 48  36 plotters. Know your paper options. The 
larger plotters take E-sized paper, the smaller only up to D size. You cannot print on what 
you do not have unless you outsource to a print shop.

l	 The scale needed to clearly see all facets of the design: This is the next important 
step. Take a look at how your design will look on the D- or E-size sheets. Can you see 
everything? Are any parts of the design not clearly visible? Generally a 25  25 building 
(such as the one used as an example in this chapter) fits nicely on a D-size sheet at ½  
1-0 scale. If it is much bigger, then you can either switch to an E-size sheet (if possible) 
or switch to another scale. Another scale, however, makes the small details of the design 
hard to see, so an option is to stay at the previous scale and “split” the drawing into 
halves or quarters and use match lines for alignment.

As you can see, many variables come into play in setting up Paper Space properly, and 
with experience all this will be in your head at the start of a project and you will know 
instinctively what paper, scale, and viewports to go with, based on the size and expected 
overall shape of the design.

As of completion of this chapter, you have graduated from a beginner to intermediate level 
of AutoCAD knowledge. Ideally, you understood everything up to now and have not skipped 
any exercises or reading. If so, then good job. If all you need AutoCAD for is basic drafting or 
just knowing enough to oversee other full-time AutoCAD designers, then you may stop here, 
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you have what you need. If your work requires expert level knowledge, you need to go on to 
Chapters 11 through 20. See you there.

Summary
You should understand and know how to use the following concepts and commands before 
moving on to Level 2 and Chapter 11.

l	 Paper Space
l	 Layouts
l	 Viewports
l	 Scaling a design inside of a viewport
l	 Working with layers in individual viewports
l	 Scaling text and dims in viewports
l	 The Annotative concept

Review questions
Answer the following based on what you learned in Chapter 10.

1.	 What is Paper Space?

2.	 What are layouts?

3.	 How do you create, delete, rename, and copy layouts?

4.	 What are viewports?

5.	 How do you create, scale, and shape viewports?

6.	 How do you scale a design inside of a viewport?

7.	 How do you turn layers on and off in individual viewports?

8.	 How do you scale text and dims in viewports?

9.	 Describe the Annotative concept.

Exercises
1.	 Set up a total of five title blocks in Paper Space using the Tutorial-iMfg.dwt template file that 

follows. Name the tabs:
•	 Front View
•	 Side View
•	 Section A-A
•	 Section B-B
•	 Section C-C
Delete any extra tabs.
(Difficulty level: Easy; Time to completion: 10 minutes)
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2.	 Bring up the floor plan you did in Chapter 4 (Exercise 3) or redraw it. Then go into Paper Space 
and create an Arch Layout tab, followed by several viewports, as in the following figure. Assign the 
viewports a scale as shown. Freeze the Dims layer in the two detail viewports. (Difficulty level: Easy; 

Time to completion: 10–15 minutes)
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Now that you have completed Level 1, beginner to intermediate, you should have the basic 
skills necessary to work on a drawing of moderate complexity with a certain amount of speed 
and accuracy. Level 2 is the second part of your journey in becoming proficient in AutoCAD. 
The goal at the end of this level is for you to know most of the practical information about 
AutoCAD 2011 in two dimensions. This will allow you to not only work on very complex 
drawings but also set up and manage them. Then, with some additional work experience, 
you will have the skills of a CAD manager or administrator, a necessity in many engineering 
or architectural firms, even if your job is not just AutoCAD.

Starting with the next chapter, this textbook does not feature any of the basic introductions 
concerning AutoCAD and what it is. It is assumed you have already read through all the 
introductory information and are familiar with all the material in Chapters 1–10. There are 
no further explanations or reviews of earlier material, so if you need to review anything from 
Level 1, do so before proceeding. With this book, we dive into the new material right away 
and do not look back, as there is much more to cover.

Level 2 consists of several parts. Chapters 11 through 13 are all about advanced features of 
basic concepts: lines, layers, and dimensions. We add significant depth to these Level 1 topics. 
Chapters 14 through 16 cover a broad set of topics that introduce a variety of advanced 
features, such as interacting with other software, the Design Center, Express tools, the CUI, and 
many shorter topics. This then clears the way for some remaining “big ideas” in AutoCAD: 
External References, Attributes, and Advanced Output and Pen Settings, which make up 
Chapters 17 through 19. These are very important topics, especially External References, as they 
are critical to many architectural designs. We complete Level 2 with isometric design, which is 
a very useful tool in its own right.

The pace of the course picks up somewhat as well, and more responsibility is placed on 
you to follow up and do your own research into additional AutoCAD functions. We also 
introduce a drawing project that spans the entire level from Chapters 11 to 20. It is a more 
in-depth floor plan that, while still greatly simplified, attempts to replicate a real-life 
architectural layout. There also are fewer generic drawings to do, in favor of more topic-
specific exercises at the end of each chapter. One constant remains: You still need to practice 
to ensure success.
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CHAPTER

Advanced Linework

LEARNING OBJECTIVES
In this chapter we revisit the line concept and expand on it by discussing the following:
l	 Polyline and Pedit
l	 Xline
l	 Ray
l	 Spline
l	 Mline, Mlstyle, and Mledit
l	 Sketch

By the end of the chapter you will learn how to use and apply these new types of lines and 
be able to incorporate them into future design work.

Estimated time for completion of chapter: 2–3 hours.

11.1  Introduction to advanced linework
We begin Level 2 where we started in Level 1, with the simple Line command. At the time 
this was enough to start with, and no mention was made of the Line command’s six relatives. 
Experience has shown that this is a sure way to scare off brand-new students. Now that you 
are more advanced and I hope have built up skill and confidence, we can come back and go 
in-depth.

11
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As it turns out, while the Line command is useful for most drawing situations, it is inadequate 
or inconvenient for a small but important number of other applications. Here we look at 
other variants of the Line including the Pline (Polyline), the Xline (Construction Line), its 
close relative the Ray, a special case of the polyline called a Spline, an Mline (Multiple Line), 
and the most unusual one of all, the Sketch command.

11.2  Pline (polyline)
A pline is a regular line with some unique properties:

l	 Property 1: A pline’s segments are joined together.
l	 Property 2: A pline can have thickness.

These two properties add tremendous importance and versatility to the old Line command, 
which created only unjoined segments that maintained a constant zero thickness. Figure 11.1 
provides an illustration of the first property. The upper case W is drawn with four line segments. 
As you can see, they are all separate, with only the left segment clicked on, and the grips reflect 
that. The W below it is drawn using the Pline command and is all one unit, as seen by clicking it 
once. Notice the slightly compressed center grips.

One example of applying this feature may include drawing lengthy runs of cabling or piping. 
Then, if the run needs to be deleted, only one click is necessary to remove all the segments. 
Let us try to draw a pline.

Figure 11.1 
Line versus Pline command (Property 1).
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Step 1. Start the Pline command via any of the previous methods.
Step 2. m  AutoCAD says: Specify start point:
Step 3. Left-click anywhere on the screen.

m � AutoCAD says: Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

Step 4. Ignoring the lengthy menus for now, click around until you get the same W shape 
seen earlier.
m � AutoCAD says: Specify next point or [Arc/Close/Halfwidth/Length/
Undo/Width]:

When done, press Enter or Esc. Then click your new pline to see that it is all one unit, not 
separate lines.

Pedit
What if you wanted to apply thickness to the pline or create a pline out of a bunch of lines? 
For this you need Pline’s companion command called Pedit or Polyline Edit. Let us try this 
out on the pline you created and give it thickness. You need to add another toolbar to your 
collection, called Modify II (Figure 11.2).

Figure 11.2 
Modify II toolbar.

Step 1. Start the Pedit command via any of the previous methods.
Step 2. m  AutoCAD says: Select polyline or [Multiple]:
Step 3. Click any of the W polyline segments.

m � AutoCAD says: Enter an option [Close/Join/Width/Edit vertex/Fit/
Spline/Decurve/Ltype]

Step 4. Press w for Width, and press Enter.
m  AutoCAD says: Specify new width for all segments:

Type in a small value, say 0.25, and press Enter. The pline adopts the new width for all 
segments, as shown in Figure 11.3. You can press Esc to completely exit out of the Pedit 
command.

Draw the W once again out of ordinary lines. The procedure to create a pline out of lines is 
as follows:

Step 1. Start the Pedit command via any of the previous methods.
Step 2. m  AutoCAD says: Select polyline or [Multiple]:
Step 3. Click any of the W line segments.

m  AutoCAD says: Do you want to turn it into one? <Y> 
Press Enter to accept “yes.”
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Step 4. m � AutoCAD says: Enter an option [Close/Join/Width/Edit vertex/Fit/
Spline/Decurve/Ltype gen/Undo]:

Select j for Join, and select all relevant lines, pressing Enter when done. The 
collection of separate lines is now a polyline and you may press w for Width as 
before. Press Esc to completely exit out of the Pedit command.

Another notable option in the Pedit command is Spline, and if you press s while in the 
Pedit command, your W will look like Figure 11.4.

To undo this you can press d for Decurve (another Pedit option). Spline is an important case 
of a polyline. We look at Spline as a separate command later in the chapter.

Exploding a Pline
Plines can be easily exploded using the Explode command. The effect is twofold:

l	 The pline loses its thickness.
l	 The pline is broken into individual lines.

To put it back together requires the Pedit command, so Explode and Pedit are inverses of 
each other. Be careful though and do not explode plines unless absolutely necessary, as there 
may be many individual lines to account for once exploded.

Additional Pline Options
A few more options are worth mentioning with the Pline command. First of all, you can start 
out drawing a pline with a preset width (or half width). Here is the command sequence for 
that, presented in a shortened “actual” format, as seen from the command line by the user.

Command: pline (typed or via any of the previous methods)

Specify start point:
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:w

Figure 11.3 
Pline with thickness (Property 2).

Figure 11.4 
Pline with the Spline option.
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Specify starting width <0.0000>:.25
Specify ending width <0.2500>:.25
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:

As you can see, the W option was chosen and a width of 0.25 was entered for both start and 
end. If those lengths are not similar, you get something akin to Figure 11.5, a zero start width 
followed by a 0.75 end width.

Another option is l for Length. This is similar to Direct Distance Entry from Level 1. Finally 
there is a for the Arc option. This creates arcs on the fly and is very useful for drawing 
organic-looking shapes for everything from landscape design to furniture to cabling and 
wiring, as shown in Figure 11.6.

Finally, AutoCAD 2011 introduces some additional tools to work with plines (including 
unexploded rectangles, which are plines by definition). These tools come in the form of a 
new menu that appears when you hover the mouse over a grip belonging to a pline or a 
rectangle (Figure 11.7).

As you can see, you can stretch, add a vertex, or even convert the line to an arc, allowing 
some new design possibilities and even saving some time.

Figure 11.5 
Pline with varying 
width.

Figure 11.6 
Pline of 0.2 width with Arc option.

Figure 11.7 
New grip menu.
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Stretch
This option, covered as a separate command in Chapter 15, allows for stretching that 
particular line and anything attached to it, in one of several ways, as seen in Figure 11.8.

Add vertex
This option allows you to “break” the line with the addition of another control point (grip), 
as seen in Figure 11.9. You can then create two angled lines out of one straight line.

Convert to arc
This somewhat similar option also adds a vertex, but one that allows an arc to be formed 
(Figure 11.10).

Figure 11.8 
Stretch option performed on the W pline 
(with Ortho on).

Figure 11.9 
Add Vertex performed on side of a rectangle (with 
Ortho on).

Figure 11.10 
Convert to Arc performed on side of a 
rectangle (with Ortho on).
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11.3  Xline (construction line)
From the relatively involved pline we swing over to the very simple xline. This is a continuous 
line that has no beginning or end. The Zoom command has no effect on it. The construction 
part of the name refers back to the days of hand-drafting, where you would draw, in light 
pencil, a guideline that stretched from one end of the paper to the other, and was used as a 
reference starting point for a string of elevations (or something else) to be drawn one after 
another.

To use it, make sure Ortho and OSNAP are not activated, and do the following:

Step 1. Start the Xline command via any of the previous methods.
Step 2. m  AutoCAD says: Specify a point or [Hor/Ver/Ang/Bisect/Offset]:
Step 3. Click anywhere and an xline appears.

m  AutoCAD says: Specify through point:
Step 4. Click randomly anywhere along the screen and multiple xlines appear. Figure 11.11 

shows one result of clicking in a circular manner.

Figure 11.11 is perhaps not the most useful of creations, but landscape designers may find 
some use for the result of placing a circle at the intersection of those lines and trimming. 
Then, by some creative scaling, rotating, and copying, you get the reasonable representation 
of trees or shrubs in Figure 11.12.

As seen in the menu that follows the xlines, you can also create perfectly horizontal, vertical, 
or angular xlines. The same can be accomplished by having Ortho on, although the options 

Figure 11.11 
Random xlines.
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allow you to create multiple xlines more easily. Clear your screen, start up Xline again, and 
when you see the following menu, try out the various options (results are in Figure 11.13):

Specify a point or [Hor/Ver/Ang/Bisect/Offset]:

11.4  Ray
A ray is simply an xline, but infinite in one direction. It is easy to use and quite similar 
to Xline, except there are no options for horizontal, vertical, or angular; to get a perfectly 
straight ray, you just turn on Ortho.

Figure 11.12 
An application of Xline.

Figure 11.13 
Hor/Ver/Ang (set to 45°) options in Xline.

Step 1. Start the Ray command via any of the previous methods.
Step 2. m  AutoCAD says: Specify start point:
Step 3. Click anywhere and a ray is created (Figure 11.14).
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11.5  Spline
Spline is a unique and valuable command. Its origins are in the mathematical field of 
numerical analysis, and it is called a piecewise polynomial parametric curve (or a NURBS curve, 
non-uniform rational B spline). While knowing the details is not necessary for using this 
command, what is important is that a spline is ideal for approximating complex shapes 
through curve fitting. What you do is create a path made out of point clicks, and AutoCAD 
interpolates a “best fit” curve through those points.

The result is a smooth, organic shape useful for a great number of applications, from contour 
gradient lines in civil engineering to landscape design to electrical wiring and many other 
shapes and objects. The term spline, by the way, comes from the flexible spline devices used 
by shipbuilders and draftspersons to draw smooth shapes in pre-computer days. To draw a 
spline, do the following.

Figure 11.14 
Ray command.

Step 1. Start up the Spline command via any of the previous methods.
Step 2. m  AutoCAD says: Current settings: Method = Fit Knots = Chord

Specify first point or [Method/Knots/Object]:
Step 3. Click anywhere and a spline appears.

m  AutoCAD says: Enter next point or [start Tangency/toLerance]:
Step 4. Click on another point somewhere on the screen, in an up and down wave pattern, 

as seen in Figure 11.15.
m  AutoCAD says: Enter next point or [end Tangency/toLerance/Undo/
Close]:
As early as this step, you can select c for Close to close the Spline tool. Instead 
though, we continue with the spline curve.

Step 5. Click on a few more points in a similar wave pattern. AutoCAD keeps saying the 
same thing as in Step 4. Continue clicking several more times (refer again to  
Figure 11.15). When done, simply press Enter.



level 2  
Chapters 11–20

238

This is your basic “out of the box” spline. Notice how, as you click points, AutoCAD fits a smooth 
curve that best approximates the path. Each grip in Figure 11.15 represents a click of the mouse, 
a control point. You can manipulate the position of these grip points in the standard manner, 
with the Spline following suit. This makes the Spline a very flexible tool, adjustable to the exact 
demands of the designer. Try activating the grips and moving them around.

The command was redesigned somewhat in AutoCAD 2011, and many of its advanced 
features are hidden away in submenus, which is a good thing, as most users need only the 
basic Spline and not extensive options for tangencies and other details.

That is not to say they are not there if needed. Click on the down-arrow on the bottom left of 
the spline (grips enabled), and select Show Control Vertices, which is another way to design 
the spline, useful for 3D work. Go over the various other options on your own with the Help 
Files; there are too many to go into here, but learning them will help you understand this 
very intriguing command.

Through the examination of Spline, you should now have a good idea of how to create and 
control it. The points of the spline do not have to be random. You can set up a framework 

Figure 11.15 
Spline command, grips enabled.

Figure 11.16 
Spline with framework, offset, and grips.



CHAPTER 11  
Advanced Linework

239

for the shape and use OSNAPs to precisely place where you want the spline to go, as shown 
in Figure 11.16. What you see here is four lines drawn, representing the framework. Then, 
using OSNAP points, a spline was added in click by click, from an endpoint to a midpoint to 
another midpoint, then to the final endpoint, at the bottom left.

A spline can also be offset using the standard Offset command, though be careful in areas 
where the spline takes a sharp turn. If the offset distance is too great and the spline cannot 
make a smooth turn after the offset, it breaks down into separate lines. The offset spline also 
has many more grip and control points than the original spline. A 3” spline offset, with all 
grips enabled, can be seen in Figure 11.16.

Examples of spline use are numerous. Already mentioned were contour lines (the Chapter 11 
opening image and Figure 11.17), electrical wiring, piping, network cables, landscape design 
(golf courses, curved driveways, and walkways), interior design (Jacuzzis, swimming pools, 
furniture), and much more.

11.6  Mline (multiline)
A multiline is a very useful tool that does pretty much what you would expect from the 
name; it is used to draw multiple lines all at once. This, in theory, should save you time when 
drawing everything from architectural walls to multilane highways. As we see soon, the basic 
mline is easy to draw but not too useful. The trick is to set it up for useful applications using 
additional tools.

Figure 11.17 
Splines used in contour lines.

Step 1. Start up the Mline command via any of the previous methods (no toolbar or Ribbon 
is available).

Step 2. m  AutoCAD says: Current settings: Justification = Top, Scale = 1.00,
Style = STANDARD
Specify start point or [Justification/Scale/STyle]:

Step 3. A generic mline appears. Click again.
m  AutoCAD says: Specify next point or [Undo]:

Step 4. m  Another click and AutoCAD says: Specify next point or [Close/Undo]:
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You can continue in this manner until finished.

The default distance between the lines is 1.0, and of course if the mline is too small or 
too large, you can zoom in or out. Figure 11.18 shows what you should see after properly 
executing the previous steps.

Modifying the Mline
While simple, the preceding was not too useful. Specifically, you may want to change one or 
more of the following properties:

l	 Number of lines making up the mline.
l	 Distances between those lines.
l	 Linetypes making up the lines.
l	 Colors of the lines.
l	 Fills, end caps, and other details.

All these and more can be input and modified, thereby making the mline more useful and 
sophisticated. The key command for setting up mlines is Mlstyle.

Mlstyle (Multiline Style)
The Multiline Style command offers a dialog box that allows you to set all of the preceding 
parameters. Type in mlstyle and press Enter or Format→Multiline from the cascading 
menu. The box in Figure 11.19 appears.

Figure 11.18 
Basic mline.

Figure 11.19 
Mline Style box.
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Let’s create a new style. Press New; give it a name (no spaces allowed in the name), and press 
Continue. You then see the main dialog box in Figure 11.20.

We can now go through the essential changes to the mline. Our goal is to create a typical 
wall used in construction (see Figure 11.21), shown often in cross section in architectural 
elevations. For simplicity, it is 6” wide and features a 1” drywall panel on either side, with 
insulation in between, and room for a wooden stud (not shown here).

This mline, once set up, can be used to draw building walls faster and easier than offsetting 
and changing properties one line at a time. The process to do this follows.

Step 1. Determine the
m  Number of lines making up the mline.
m  Distances between those lines.
Both of these can be set using the Elements part of the Modify Multiline Style dialog 
box with the Add button and the Offset field shown in Figure 11.22.

You need to now add more line elements and enter an offset distance for each highlighted 
element. Before you do so, however, you need to decide what is the origin of the offset.  
The two choices are positioning zero all the way on the leftmost line element (then all values 
are positive) or in the middle element (then half the values are negative). With choice 1,  
the outer walls are at 0 and 6, and with choice 2, they are at –3 and 3, as shown graphically 
in Figure 11.23.

Figure 11.20 
Mline Style, main box.

Figure 11.21 
Mline modified for a typical wall.



level 2  
Chapters 11–20

242

We choose method 1 and set the walls to 0, 1, 3, 5, and 6 inch positions (there are 
no feet units in Mline; you use decimal inches throughout).

Step 2. m  Linetypes making up the lines.
m  Colors of the lines.
Both of these can be set using the Color: drop-down menu, and the Linetype… button 
as shown in Figure 11.24. Simply highlight the line element you wish to change and 
change it. Remember that you may not have the linetypes loaded yet, so you may need 
to do this (refer back to Chapter 3 for a reminder, if needed).

In the Figure 11.21 example, the outer wall color was selected to be blue and the inner walls 
are red with a hidden linetype. The centerline is a special linetype, often used for insulation, 

Figure 11.22 
Elements.

Figure 11.23 
Offset origin.

Figure 11.24 
Color and Linetypes.
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called BATTING. Feel free to choose your own colors and linetypes (Figure 11.24); these are 
just for illustration, but they are a good starting point.

Step 3. m  Fills, end caps, and other details.
End caps and even a fill can be added to your mline, as shown in Figure 11.25. They 
are not added in this example, but feel free to experiment.

After your new mline has been created, go ahead and click on OK; you will be taken back 
to the dialog box of Figure 11.19, with your new mline previewing in the window at the 
bottom. The other choice should be Standard, the default mline you created by just typing in 
mline and seen in Figure 11.18. Set your new mline as the current one (Set Current button), 
and click on OK. Now go ahead and type in mline and draw part of a rectangle, as seen in 
Figure 11.26.

The linetypes may not look right in this example. This is due to a low linetype scale being set. 
If you recall from Chapter 3, the way to fix this is to type in ltscale and enter a new, more 
appropriate value. The value used was 4.8. The result is shown in Figure 11.27.

Figure 11.25 
Caps and Fill.

Figure 11.26 
The new mline.
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Mledit (Multiline Edit)
Multiline Edit is a dialog box that deals with the practical applications of Mline, such as how 
to trim intersecting mlines and how to deal with joints, cuts, and vertexes. To try out some of 
the features, draw two intersecting mlines, as shown in Figure 11.28.

Now go ahead and type in mledit, press Enter (or Modify→Object→Multiline from the 
cascading menus), and the dialog box in Figure 11.29 appears.

Select Closed Cross (upper left). The dialog box disappears and you are asked to select the 
first mline (click on it), then the second mline (click that, too). After the second click,  
Figure 11.30 appears. As you can see, the mline’s intersection has been modified.

In the same manner, try out all the features of Mledit at your own pace; they are all relatively 
straightforward and self-explanatory. A cut will cut the line; a vertex will add a “kink” in the 
mline. Close, Open, and Merge deal with intersections and so on.

Figure 11.27 
The new mline with an ltscale of 4.8.

Figure 11.28 
Intersecting mlines.
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Other Mline Properties

l	 Grips: All mlines have grip points at either the top or bottom of the overall line (this is 
set using Justification when first creating the mline). Feel free to use these grips to stretch 
the line around as needed.

l	 Exploding the mline: Mlines can be exploded, which separates them into the individual 
component lines. This may not necessarily be a bad thing. An architectural floor plan may 
be quite complex and you may not be successful in getting an mline to do exactly what you 
want all the time. If the mline is exploded, then you can use Fillet, Trim, and Extend to coax 
it into the shape you want. Much time has already been saved by using an mline in the first 
place, so exploding it may be the right solution to finish off the floor plan linework.

Figure 11.29 
Multilines Edit Tools.

Figure 11.30 
Multilines edited.
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l	 Trim and Extend: Mlines can be trimmed and extended without exploding them 
(filleting, however, is not possible). However, an option that pops up is
Enter mline junction option [Closed/Open/Merged] <Open>:

	 The Closed, Open, and Merged options have to do with the intersections, so you need to 
pick one option to continue the Trim or Extend. Go through them all as practice.

l	 Modification of mlines: Once created, a new mline style cannot be modified once you 
start using it (but can be beforehand). If you wish to change an mline after you have a 
few drawn, you need to create a new style that incorporates your desired change.

11.7  Sketch
This is perhaps one of the most unusual tools in AutoCAD. It allows you to draw objects in 
freehand. This may seem counterproductive and unnecessary. After all, you spent so much 
time learning precision and accuracy; but Sketch actually finds a wide array of applications, 
as we soon see.

To truly sketch in freehand on a computer you need bitmap graphics (such as what 
Photoshop® does). Then, the maximum resolution is determined by the pixels. In almost 
all cases, the pixels are so small that it truly seems like you are drawing smooth (and 
continuous) freehand lines and shapes. You would have to zoom in pretty close up to see 
what is called pixilation or the breakdown of smooth lines into the little squares (pixels) that 
make up the drawn geometry.

This is all fine and would be useful for AutoCAD if not for one problem. AutoCAD is a 
“vector program,” meaning it does not use pixels. Instead, all the geometry is represented by 
mathematical formulas, which completely describe the shape, size, and location of everything 
seen on the screen. This approach is necessary for many reasons, not the least of which is to 
ensure the integrity of the geometry when zoomed in close. So then, how would you sketch in 
freehand? The solution is simple; instead of pixels use very short lines, which look continuous if 
they are small enough and you are not too close to them. This is exactly how Sketch works. The 
command uses small lines, with their size determined by something called a record increment.

This is where the record increment setting comes in. We need to set it to a very small value 
(use 0.01). Let us try this out. Type in sketch and press Enter.

m	 AutoCAD says: Type = Lines Increment = 0.1000 Tolerance = 0.5000
Specify sketch or [Type/Increment/toLerance]:

Press i for Increment, press Enter, type in the value .01, and press Enter again.

m	 AutoCAD says: Specify sketch or [Type/Increment/toLerance]:

Click the mouse anywhere and begin drawing.

m	 AutoCAD says (and continues to say): Specify sketch:

You will see what is essentially a smooth line, green in color, and completely freehand 
generated. To “lift the pen,” you need to left-click once, and then click again to “put it down.” 
You can also click and hold the left mouse button to press down at will, which is more 
realistic for some. To “set” the drawing, press Enter; the lines will turn white (or some other 
color depending on the current layer). Be careful not to press Esc until you set the lines, as 
everything disappears. Figure 11.31 shows what you can get after a few strokes of the mouse.

Applications of Sketch
I hope that whatever you tried to draw was better than the odd-looking little man with a 
briefcase. It is not that easy to draw something well with a mouse; occasional erasing and 
fixing up is needed to get a good sketch. Sometimes a graphic design tablet and a pen-like 
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stylus may be used. Zoom in closely on whatever you created and you will notice the figure is 
made up of the small lines we talked about. In the close-up of the hand and briefcase handle 
in Figure 11.32, you can clearly see the individual line segments. Be careful making a dense 
drawing. All these lines increase the size of the file very quickly!

Sketch has many applications, such as:

l	 Architectural elevations featuring sketched people for comparative sizing.
l	 Sketched people for traffic sign design and civil engineering studies.
l	 Trees, shrubs, and other landscape design objects.
l	 Realistic drawings of small cables and wiring.
l	 Anytime an organic, non-rigid shape is needed.

A website mentioned in the appendix (www.cben.net) is a great source of free sketches, both 
in plan and in elevation. Figure 11.33 shows a few sketch examples from that website.

Figure 11.31 
Basic sketch.

Figure 11.32 
Line increments of the Sketch 
command.

Figure 11.33 
Creative use of the Sketch command.
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Level 2 Drawing project (1 of 10): Architectural  
floor plan
This drawing project is started now and completed, chapter by chapter, by the end of Level 2. 
It is an architectural layout, similar to the apartment you did in Level 1, but more in-depth. 
The project takes advantage of and has you put to use a lot of what you learned in each of 
the chapters (though maybe not right away). The house design is turned on its end to better 
fit the Portrait orientation of this textbook, but by the time we get to the Paper Space layouts, 
you will need to turn it 90° counterclockwise as that is how the house would best fit the 
Landscape orientation of a typical set of architectural prints.

Step 1. Open a new file and save it as House_Plan.dwg.
Step 2. Set up units as Architectural, and create the following initial layers. Use any color 

you see fit. The drawing is monochrome in this textbook for clarity on a white page.
m  A-Deck
m  A-Deck-Hatch
m  A-Dims
m  A-Walls-Exterior

Step 3. Draw the floor plan shown in Figure 11.34. The dimensions are not just for your 
reference anymore; you also need to draw them in. They serve as checks on your 
design. Use the proper layers and consistent colors.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 12.

l	 Pline (polyline)
m	 Creating a pline
m	 Pedit
m	 Setting constant width (thickness)
m	 Setting variable width (thickness)
m	 Changing lines into plines
m	 Adding spline curves and decurving
m	 Other pline options (length, arc, offset)
m	 Exploding a pline

l	 Xline (construction line)
m	 Creating a random xline
m	 Creating a Hor/Vert/Ang xline

l	 Ray
m	 Creating a random ray
m	 Creating a horizontal or vertical ray (with Ortho)

l	 Spline
m	 Creating a random spline
m	 Offsetting the spline
m	 Grips and modifying the spline

l	 Mline (multiline)
m	 Creating a generic mline
m	 Mlstyle
m	 Mledit
m	 Other mline properties

l	 Sketch
m	 How Sketch works
m	 Setting a record increment
m	 Applications of Sketch

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 11.

  1.	 What are the two major properties a pline has and a line does not?

  2.	 What is the key command to add thickness to a pline?

  3.	 What is the key command to create a pline out of regular lines?

  4.	 What option gives the pline curvature? What option undoes the curvature?

  5.	 What two major things happen when you explode a pline?

  6.	 What other options for pline were mentioned?

  7.	 Define an xline and list a unique property it has.

  8.	 How is a ray the same and how is it different from an xline?

  9.	 Describe a spline and list its advantages.

10.	 List some uses for a spline in a drawing situation.

11.	 What is an mline? List some uses.

12.	 What are some of the items likely to be changed using Mlstyle?

13.	 What are some of the uses of Mledit?

14.	 Describe the Sketch command. What is a record increment? What size is best?
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EXERCISES
1.	 Draw a pline with ten segments, each 2 units long and at right angles to each other. Give the pline 

a thickness of .2 units. Then spline the pline. The progression is shown in the following figure. Upon 
completion, decurve the pline and explode it. (Difficulty level: Easy; Time to completion: 1–2 minutes)

2.	 Using Xline, Circle, Trim, Copy, and Rotate, draw a tree symbol as seen in Figure 11.7, reproduced 
here. Repeat the same procedure using the Ray command. (Difficulty level: Easy; Time to completion: 
1–2 minutes)

3.	 Using the Spline, Break, and Text commands, draw contour lines as seen in Figure 11.13, reproduced 
here. (Difficulty level: Easy; Time to completion: 5–7 minutes)
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4.	 Using the Mline, Line, and Hatch commands, draw a representation of a divided highway, as follows. 
(Difficulty level: Intermediate; Time to completion: 5–7 minutes)
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CHAPTER

Advanced Layers

Learning objectives
In this chapter we introduce advanced layers and discuss the following:
l	 The need for automation
l	 Script Files
l	 Layer State Manager
l	 Layer Filters

By the end of the chapter you will learn how to use and apply these new types of layer tools 
and be able to incorporate them into future design work where a large number of layers are 
present in the file.

Estimated time for completion of chapter: 1–2 hours.

12
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12.1 I ntroduction to advanced layers
After the basic commands in Level 1, we introduced the Layers concept. This was just 
a primer, showing you how to create them and set a variety of items, such as color and 
linetype. Also, several methods of control were covered, such as freezing and locking. Here 
we look at additional powerful features that allow for unprecedented control over your 
layers. They are called Script Files, the Layer State Manager, and Layer Filtering.

Imagine the following scenario. You work at a large architecture or engineering consulting 
firm that specializes in complete commercial building and site design.

Among your staff there are a number of

l	 Architects and interior designers to lay out the overall exterior and interior of the 
building.

l	 Civil engineers to assist in structural design and site plans.
l	 Mechanical engineers to design the HVAC and mechanical systems.
l	 Fire protection and security engineers to design the electrical, sprinkler, and security 

systems.
l	 Landscape designers to integrate landscape design into the site plan.
l	 Additional design professionals as needed for specialized subsystems.

All these people contribute to the complete design in their own way. Generally all their work 
is based on (or ends up in) one main building design file. This common file then contains 
not only the architectural layout of the building but also the data from all these other 
disciplines. Each discipline has its own set of layers (usually following the AIA convention 
or another in-house layer naming method). Therefore, architects have their own set of layers 
starting with an A- (e.g., A-Demo-Wall, A-Bay-Window). Civil engineers have their own 
(C-Struct-Column, etc.), electrical engineers their own (E-Light-Switch), and so on.

You may already see where this is going as far as layers are concerned. As the project 
progresses, the layers grow in number. Toward the end, when everyone has added his or her 
respective design, the file may contain as many as 500 layers (something I have seen more 
than once in actual use). There needs to be a way to impose some order and control over 
them, so only the needed layers are visible to each discipline. This can certainly be done by 
manually freezing and thawing layers but is very time-consuming. If you guessed that some 
sort of simple automation is available to you for this purpose, then you are correct.

This in essence is advanced layer management, a process where the layers, once set, are saved 
under a descriptive name such as Arch_Layout or Elect_Layout, then recalled when necessary 
by simply clicking on the name. AutoCAD then freezes and thaws the layers automatically, 
exactly the way you initially told it to. This is what Script Files, the Layer State Manager, and 
Layer Filtering do. These tools allow sorting, classifying, and filtering of layers according to a 
variety of properties and are indispensable when working on a large project.

12.2  script files
A script (in most general terms) is simply a Text file with one command on each line. Its 
purpose is to automate a sequence of commands when executed. It is perhaps the simplest 
type of programming you can do. All you need is a text editor (such as Notepad). You next 
list the commands you want the script to go through, one per line. Then you save it under a 
name and an .scr extension (e.g., MyScript.scr), close the file, and run it from AutoCAD’s 
command line by typing in script and pressing Enter (alternatively via the Ribbon’s Manage 
tab→Run Script). The Script dialog box pops up, the script is double-clicked (executed) on, 
it does its thing, and if you got the command sequence correct, a short task is automatically 
performed.
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Scripts are generally not used as much now for purposes of layer control as they once were, 
but we briefly cover them because knowing how they perform gives you insight into the 
other remaining tools. It is also a good skill to have overall. You can automate a variety of 
AutoCAD routines. It may be worth your time to read up on further Script File details in the 
Help Files, as we do not go too in-depth here.

Here is a very simple example of a script file. It freezes all layers after first thawing them 
and setting 0 as the current layer. As scripts do not work with dialog boxes, everything has 
to be command line driven, such as this version of the Layer command (generally many 
commands that are preceded by a -go to the command line version). After the -layer is a 
set of answers to prompts: t is thaw, * means all, s is set, and f is freeze. This exactly 
answers everything AutoCAD asks for if you were to do this by hand at the command line. 
The last two keystrokes (→) are Enter and Enter.

–layer
t
*
s
0
f
*
→
→

This reads as Layer, Thaw, All, Set, 0, Freeze, All, Enter, Enter. Try this out with an AutoCAD 
file that has a bunch of layers. In a real application, you of course have to manually type in 
the layers deemed not relevant to the particular state (which therefore need to be frozen) in 
place of the last * and before the two Enters. The steps prior to that (t, *, s, 0) are necessary 
in case a layer that needs to be frozen is set to current (you cannot freeze the current layer), 
so the 0 layer is set as current.

This was a lengthy process and is the main reason why Script Files gradually fell out of favor, 
replaced by the Layer State Manager for layer control, as shown next. Keep in mind, however, 
that the Layer State Manager (LSM) works in pretty much the same way, except you select 
layers and do everything graphically through the Layers dialog box. Now that you have read 
through the underlying theory, we can rapidly go through the functions of the LSM.

12.3  Layer state manager
As described previously, the LSM is essentially a graphical version of Script Files. Since you 
should now have a basic understanding of what you need to do, let us just set up a collection 
of layers and go through the mechanics of how to set up several layer states. While our 
example is simple—we set up only three layer states, an Arch_Layout, Mech_Layout, and 
Elect_Layout—the theory can be easily extended to a large number of layers and states.

Open up a new AutoCAD file and set up the following layers:

A-Walls-Demo
A-Walls-New
A-Window-Bay
E-Outlet-Main
E-Switch-Main
E-Wiring-Main
M-Diffuser
M-Panel
M-Return_Air
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Assign color to these layers as shown in Figure 12.1. What we want to do now is create a layer 
state called Arch_Layout. This means only the A- layers are needed, with the Electrical and 
Mechanical layers frozen. So go ahead and freeze the six layers beginning with E- and M-, 
also as shown in Figure 12.1.

Now that the layers have been frozen, we need to save this “state” under the appropriate 
name. Click on the Layer State Manager button in the upper left of the Layer dialog box, 
as seen in Figure 12.2. The LSM then appears (Figure 12.3). It can be expanded (if it is not 
already) by pressing the arrow in the lower bottom right corner.

We now create a new layer state by clicking on New… and filling in the name and description 
(if desired), as shown in Figure 12.4, and clicking on OK. Once the layer state is entered, it 
appears in the LSM, as shown in Figure 12.5, and you can press Close to exit out of the LSM 
dialog box.

Figure 12.2 
LSM icon.

Figure 12.1 
Layers for LSM.
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In the same manner, go back to the Layers dialog box and create the other two states:  
Elect_Layout (only E- layers visible) by turning off the unneeded layers and activating the 
LSM and Mech_Layout (M- layers visible). The result is shown in Figure 12.6.

To activate these states when needed, you simply go to the Layers dialog box, click on the 
LSM icon, and when it appears double-click on the state name or highlight it with one click 
and press Restore. Instantly the correct layers are frozen or thawed (you can see this happen 
in real time in the Layers dialog box as you click on one state or another).

The purposes of the buttons found to the right of the main LSM window are as follows:

l	 New: Displays the New Layer State to Save dialog box, which we already used.
l	 Save: Saves the selected named layer state.

Figure 12.3 
LSM.

Figure 12.4 
New Layer State to Save.
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l	 Edit: Displays the Edit Layer State dialog box, where you can modify the layer state.
l	 Rename: Allows editing of the layer state name.
l	 Delete: Removes the selected layer state.
l	 Import: Layer states (*.las extension) can be imported from another file by means of 

this option, though this is not done often in practice.

Figure 12.6 
LSM with remaining layer states.

Figure 12.5 
LSM with new layer state.
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l	 Export: Layer states (*.las extension) can be exported to another file by means of this 
option, though this is also rarely done in practice.

Some additional options are available in the LSM dialog box, if you click on the small arrow 
in the extreme bottom right as previously mentioned (Figure 12.7).

Layer properties to restore is simply a listing of every property a layer typically has and you 
can check off if you want that particular property restored. If all are checked, as is more 
typical in practice, all the layer’s properties are affected.

12.4  Layer filtering
Layer Filtering is a tool that allows you to filter out (or selectively choose) layers that fall 
under a certain description. You can create filters of your own choosing and assign them 
names. For example, if for some reason you want only the red layers to show or ones that are 
assigned a hidden linetype, this can be done. Layer names can also be filtered. If you want 
only those layers that start with an A- to show, this can be arranged, though in this case you 
are essentially doing what was described previously with the LSM.

The key to layer filtering is to set up filter definitions. These can include full names or partial 
names (using the wildcard * character) and property definitions (color, linetype, etc.). The 
entire left side of the Layer dialog box, since AutoCAD 2005, is dedicated to filters. When 
used properly, these are very effective tools. We highlight some of the more important 
features essential to using them in this chapter. You are encouraged, as with many topics 
mentioned in Level 2, to explore them further on their own.

Two types of filters are available as icons on the top left of the Layers dialog box, as shown in 
Figure 12.8.

The New Property Filter is what you use to set up the definitions. If you press that icon, the 
box in Figure 12.9 appears, with the previously entered layers visible.

Figure 12.7 
Additional LSM options.
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The Layer Group Filter is a general filter that includes all the layers that are put into the 
Property filter when you define it, regardless of their names or properties. Selected layers 
can then be added from the layer list by dragging them into the filter. This type of filtering is 
generally not used but can be employed to make a new filter based on the layers of another 
filter. To begin, click on the icon, create a name, and click and drag layer names from the 
right side of the Layers box into the Group Filter.

Figure 12.9 
Layer Filters dialog box.

Figure 12.8 
Layer Filters.
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Remember an important point with filters: By themselves they do little except sort the layers. 
It is up to you to then do something useful with this, such as freeze or lock them as needed. 
Therefore, think of filtering as simply a way to get the layers in some sort of order for further 
action on them.

Here you first enter the name of your filter in the text field in the upper left. Then it is just 
a matter of careful selection of the properties or names (or both) of the layers you want to 
see. You may use the wild character * in conjunction with typed parts of the layer name to 
indicate to the filter to include anything before or after the specific letters. Any property can 
also be used as a filter; color and linetype are common ones.

Go through the filter at your own pace and experiment with the settings. Shown in  
Figure 12.10, as a simple example, are the layers that are green and have the letter w 
somewhere in the name.

Level 2 drawing project (2 of 10): architectural  
floor plan
Here we continue to add to the walls of the floor plan, with a lot of new work on the interior, 
as well as adding doors and windows. We can also now hatch the exterior and interior walls, 
as well as label some of the rooms. With this in mind, let’s add

l	 A-Door
l	 A-Text
l	 A-Wall-Hatch
l	 A-Wall-Interior
l	 A-Window

Feel free to use any colors you prefer, as the drawing remains monochrome in the text for 
clarity. When the layers are set up, go ahead and draw and position the doors and windows 
using the given dimensions. Be sure to use correct drafting techniques learned in Level 1 in 
regard to properly creating them. Finally, dimension the floor plan; this serves as your check. 
If any measured dimensions do not “add up,” go back and fix your design. The drawing is 
of course simplified from the original, but all the essential features are there. Blowups of the 
bedroom and bathroom as well as the garage and kitchen are shown in Figures 12.11 and 
12.12 for clarity, with the overall floor plan in Figure 12.13.

Figure 12.10 
Layer Filters dialog box.
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Figure 12.11 
Bedroom and bathroom.
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Figure 12.12 
Kitchen and garage.
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Figure 12.13 
Overall floor plan.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 13.

l	 Script Files
m	 Basic concept
m	 Writing a simple script file

l	 Layer State Manager (LSM)
m	 New
m	 Save
m	 Edit
m	 Rename
m	 Delete
m	 Import
m	 Export
m	 Restore
m	 Layer Properties

l	 Layer filters
m	 New Property filter
m	 Layer Group filter

Review questions
Answer the following based on what you learned in Chapter 12.

1.	 Describe what is meant by layer management. Why is it needed?

2.	 Describe the basic premise of a script.

3.	 What can a Script File do for layer management?

4.	 Describe what a Layer State Manager does.

5.	 What are the fundamental steps in using a Layer State Manager?

6.	 What is layer filtering? What are the two types?

Exercises
1.	 Create six layers as follows:

A-Walls_1
A-Walls_2
A-Walls_3
A-Walls_4
A-Walls_5
A-Walls_6

	 Color all odd layers green and all even layers red. Write a script file to thaw all layers; set layer 0 as 
current. Then freeze all and thaw just the even layers. (Difficulty level: Easy; Time to completion: 10 
minutes)

2.	 Using the same six layers, set up layer states Odd_Layer and Even_Layer and run them. (Difficulty 
level: Easy; Time to completion: 3 minutes)

3.	 Using the same six layers, create filters to sort and capture only the green layers. (Difficulty level: 
Easy; Time to completion: 2 minutes)
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CHAPTER

Advanced Dimensions

LEARNING OBJECTIVES
In this chapter we introduce advanced dimensions and discuss the following:
l	 The Lines tab
l	 The Symbols and Arrows tab
l	 Text tab
l	 Fit tab
l	 Primary Units tab
l	 Alternate Units tab
l	 Tolerance tab
l	 Geometric Constraints
l	 Dimensional Constraints

By the end of the chapter you will learn additional advanced features of the Dimension Style 
Manager dialog box and be capable of setting up complex dimensions. We also discuss two 
features that first appeared in AutoCAD 2010: Geometric and Dimensional Constraints.

Estimated time for completion of chapter: 2–3 hours.

13
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13.1  Introduction to advanced dimensions
This chapter is meant to complete your knowledge of AutoCAD’s dimensioning features. 
Specifically we look at the New Dimension Style dialog box and Parametrics. In Level 1 
we focused primarily on defining the types of available dimensions and how to properly 
dimension geometry. Little was mentioned of this dialog box except for the four essential 
features deemed most important: Arrowheads, Units, Fit, and Text Style (not needed as 
much anymore, as the better-looking Arial is the default font). Here we go through the entire 
Dimension Style dialog box and discuss other options and features, some more than others, 
according to their usefulness.

The reason you need this knowledge is because AutoCAD allows for a tremendous amount of 
power, flexibility, and variation with its dimensioning. As a regular user, you may not come 
to appreciate what is available, because much of it may already be “set up” for you. As a CAD 
manager and advanced user (for whom Level 2 is geared), you may be charged with doing 
this “setting up” and need to know what to do. We conclude the chapter with a new feature 
introduced last year in AutoCAD 2010, Parametric Dimensions, and the idea of Constraints. 
These are routinely found in advanced 3D software, but just recently appeared in AutoCAD.

13.2  Dimension style manager
To start off, let us take a closer look at the Dimension Style Manager. You saw it in Chapter 6, 
so as a reminder here is how we got it up on our screen.

Figure 13.1 
Create new dimension style.

Let us create a new style (by pressing the New button) and name it Sample Style (Figure 13.1). 
Click on Continue when done. You then see the New Dimension Style dialog box. We now take 
a much closer look at the seven tabs, titled Lines, Symbols and Arrows, Text, Fit, Primary Units, 
Alternate Units, and Tolerances.

An important point to remember here is that our goal is not to go through every possible 
button and menu in extreme detail, but rather give a basic overview of them, followed by a 
narrow focus on (and exact description of) the most useful features only, how they fit in with 
the design process, and how they benefit you as an AutoCAD user.

Let us take a look at the first tab all the way on the left of the New Dimension Style dialog 
box, called Lines (Figure 13.2). Throughout the process, carefully observe the preview 
window at the upper right to see the results of changing or adjusting whatever we discuss.
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This tab is the only one where you will likely not change anything of significance. There is a 
good reason for that. It focuses on dimension lines and extension lines and various sizing, 
linetype, color, and suppression options. However, as far as sizing is concerned, all these 
features can (and should) be adjusted all at once using the Fit tab’s overall scale feature (to 
be discussed shortly).

So what can we learn from this tab then? Well, it is actually quite instructive to see what exactly 
dimension and extension lines are and how you can change their colors (or linetypes). Much of 
what is shown here falls under the “just in case you may need it” definition. Just because we can, 
let us change the dimension lines to blue and the extension lines to red. Also try suppressing one 
or both of them to see the effect. We do not change the linetypes; it should be clear what that 
does. Most of this is rarely done in practice, and the dimensions are left as they are.

It is important to understand that things like the Extend beyond dim lines value (bottom 
right) really should not be touched (though you should know what they mean), and all 
of them should be changed up or down all at once, as discussed later under the Fit tab. 
If you try to set sizing one item at a time, you will end up with lopsided, oddly shaped 
dimensions—there are just too many items to change in correct proportion to guarantee you 
get it correct and too much effort for something unnecessary.

Except for the suggested color change, leave everything as it is—ByBlock. Your Dimension 
Style dialog box should look like Figure 13.2.

Symbols and Arrows Tab
Under this tab (Figure 13.3), in Chapter 6, you practiced modifying the arrowheads to 
architectural ticks. Go ahead and do this again, making a note of the other available choices. 
The leader is generally left as an arrow since its main purpose is to point at something.

Figure 13.2 
Lines tab.
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of a circle and what you want to see in the center of one when a diameter or radius dimension 
is added. Mark or Line is typically selected; let us go with Line. Notice how the preview 
window reflects both this and the arrowhead changes.

On the right, we have some relatively minor options. Arc length symbol concerns the 
placement of the symbol, and the Radius jog dimension has to do with the angle of the jog 
“wiggle.” Leave them, as well as the Linear jog dimension, as default all around.

What is most important in the Symbols and Arrows tab is how to set the arrowheads to other 
types by selecting them from the drop-down menu. Your Dimension Style dialog box should 
look like Figure 13.3.

Text Tab
Under this tab (Figure 13.4), you already practiced changing the text under Text style: (upper 
left). The goal was to make the dimension text the same as the rest of the text in the drawing 
(always the same font and usually the same size, too). In Chapter 6, when this was done, the 
text you selected on the floor plan was Arial 6. Here we make one from scratch by pressing 
the button to the right of the Text style field (with the three dots) and setting a font style 
called RomanS.25 (as outlined in Chapter 4, when we discussed the Style box). Review this if 
necessary. Moving down the Text appearance category we find:

l	 Text color: Usually not set separately, but we do it here, setting Magenta.
l	 Fill color: Creates a color highlight around the text. Try it out. To add a frame around the 

text, there is a check box for this further on down, which we check off.
l	 Text Height: Not adjusted here. Use the previously mentioned Style dialog box.
l	 Fraction height scale: Applies to the size of fractions. Those appear only when we set 

architectural units (coming soon).

Figure 13.3 
Symbols and Arrows tab.
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alignment on the right. The default values for Text placement (mainly the first two: Centered 
and Centered) are correct for most situations, but do try them all out to see the effect in the 
preview window. Offset from dim line is not to be changed.

With Text alignment, the common default is Horizontal because people generally do not 
want to tilt their heads to the side every time they check a dimension on a printout. Do 
check the other two options (aligned and ISO) to see what they do, though. Your Dimension 
Style dialog box should look like Figure 13.4.

Fit Tab
Under this tab (Figure 13.5), you already practiced changing the Use overall scale of: text 
field (on the right, underneath the preview window) to a value of 15 in Chapter 6. We really 
did not discuss why this value was chosen (we leave this for the Paper Space discussion in 
Chapter 18), but this field is by far the most important one in this tab. It is used to simply 
boost up the overall dimension size evenly and uniformly, as opposed to manually adjusting 
every possible value (under the Lines tab and a few other places). We see in later chapters 
how this value is tied in with the overall printing scale and viewports. The annotative option 
also is discussed. Change the value in the field to 5.0000 for now, as that corresponds well to 
the ½ height text we selected earlier.

The rest of the categories are quite straightforward. Fit options simply address what to stick 
outside the extension lines if there is not enough room. Best fit is usually the safe choice, 
as it lets AutoCAD decide how to best proceed. If you force a specific action, it may not be 
appropriate for every situation, so let AutoCAD handle it.

Text placement has some minor adjustment options, as stated in the choices (leave as 
default), as does Fine tuning, where you should leave both boxes unchecked. Placing the 

Figure 13.4 
Text tab.
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lines effectively crosses out the dimension value, a distracting feature.

What is most important under the Fit tab is adjusting the Use overall scale of: field under 
the Scale for dimension features category. As mentioned, use 5.0000 as a value for now. Your 
Dimension Style dialog box should look like Figure 13.5.

Primary Units Tab
Under this tab (Figure 13.6), you already practiced changing the Unit format to Architectural 
in Chapter 6. Generally the dimension units are the same as the drawing units. Here we 
leave the units as Decimal, not Architectural. Note in both cases the precision available to 
you. This closely parallels what you saw in the Units dialog box from Chapter 2. Proceeding 
further down the Linear dimensions category, we have

l	 Fraction format: Various ways to represent fractions with Architectural dimensions; 
grayed out when Decimal is selected. The choices are Horizontal, Diagonal, and Not 
Stacked. Try them out.

l	 Decimal Separator: Various ways to represent Decimal numbers; grayed out when 
Architectural is selected. The choices are Period, Comma, and Space and they simply 
represent different ways to show the same thing. Europeans, for example, sometimes use 
a space or decimal, not comma (e.g., 5 000 not 5,000).

l	 Round off: Rounds off dimension values; not necessary in common usage.
l	 Prefix/Suffix: A very useful feature allowing you to add text, symbols, or values before 

and after the dimension values. We add the inch symbol in the suffix as an example.
l	 Measurement scale: Scales dimension values; not necessary in common usage.
l	 Zero suppression: Another very useful feature allowing you to suppress zero values 

either before or after the main significant digits when using decimal units. For example, 
a 0.625 value becomes just .625 and a 1.250 becomes 1.25. This is used in conjunction 

Figure 13.5 
Fit tab.
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the Architectural units setting, the idea is the same but now 0 feet and 0 inches are 
suppressed.

Angular dimensions allow you to choose other degree measurement systems, but Decimal 
Degrees is sufficient for most users. Zero suppression for angles is the same concept as before 
but is rarely used in this case. Your Dimension Style dialog box should look like Figure 13.6.

Alternate Units Tab
This (Figure 13.7) is a tab we have not explored at all in Level 1. Alternate units are a 
secondary set of dimensions that reside inside parentheses attached to the main set of units. 
Their purpose is to present the main units in an alternate form such as Metric versus English 
(just one example). This is why you see a 25.4 value right away under Multiplier for alt 
units:. This is how many millimeters fit into 1 inch; more on this in just a moment.

Check off the top left box, Display alternate units. All the fields then become editable. Take a 
look at all of them; most should look familiar (such as Zero suppression and Prefix/Suffix), 
so we do not go over them again. Unit format:, Precision:, and Round distances to: have 
also been mentioned (reminder: do not round off without a good reason). The Placement 
category (bottom right) is also easy to understand, the choices being After or Below the 
primary value.

Understanding alternate units then boils down to fully grasping the Multiplier for alt units: 
concept. It is a powerful and simple idea. Instead of presenting a collection of “canned” 
multipliers, AutoCAD allows you to set your own. So if the main unit is 1 mile, to express 
this in feet (as an alternate unit), type in 5280 as a multiplier. You are in no way limited as 
to what sort of value you can enter (inches to miles or millimeters to yards, anyone?), but 
of course you have to know exactly what the multiplier is or else, as they say, “garbage in, 

Figure 13.6 
Primary Units tab.
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garbage out.” Therefore an incorrect multiplier gets you false alternate unit readings. Explore 
all the features of Alternate units and try entering several multipliers. For example, the 
number of yards equal to 1 mile (1760).

In our case here, let us go with the amount of centimeters in an inch (2.54) and enter that as 
the alternate unit. Also add cm in the suffix. Your Dimension Style dialog box should look 
like Figure 13.7.

Tolerances Tab
This final tab (Figure 13.8) also has not been looked at yet. Tolerances are relevant mostly to 
engineering and manufacturing and less so to architecture.

Tolerances are generally defined as deviations from an ideal stated value, as used in 
manufacturing specifications of engineering devices (there are of course other stated definitions). 
The underlying need for specifying tolerances hinges on the fact that in manufacturing closer 
tolerances may be costlier to achieve, while larger tolerances, although cheaper, may adversely 
affect performance of a part. Tolerances are a way of expressing just how much a part may be 
off the mark and still be acceptable, based on engineering need and cost analysis. Aerospace, 
automotive, and biomedical engineering tolerances are closer than most consumer products, 
for example.

Tolerances are a familiar topic to mechanical engineers and machinists. To them no further 
explanation is needed and AutoCAD’s tolerance choices are familiar: Symmetric, Deviation, 
Limits, and Basic. Other options under this tab should also look familiar to all, such as Zero 
suppression and placement options.

l	 Symmetric tolerances: These indicate the overall deviation, which is symmetric for upper 
and lower values; therefore you set only one (the upper value).

Figure 13.7 
Alternate Units tab.
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l	 Deviation tolerance: These indicate nonsymmetrical deviations in either direction with a 

stacked .
l	 Limits tolerance: These are similar in theory and indicate the acceptable limit in one or 

both sets of values, but no  is shown.
l	 Basic tolerance: These are the same as none, the first choice.

If you are not currently familiar with tolerances, chances are you do not need them in your 
work situation. While this is an interesting topic to discuss in further detail, tolerances 
already are familiar to those who need them and not relevant to those who do not. Feel free 
to set a Deviation tolerance as seen in Figure 13.8.

So what did we end up with after all these settings? Well, in the interest of trying out as much 
as possible, we did not really create a very realistic dimension. Let us take a look at it. Click 
on OK in the Dimension Style box; it will disappear and take you back to the Dimension 
Style Manager. Then press Set Current in the next box, followed by Close. Now draw a 10” by 
10” rectangle and dimension it using the basic Horizontal dimension. It should look similar 
to Figure 13.9.

Let us try another dimension style on a hypothetical section of roadway (go ahead and draw 
something similar to Figure 13.10, with the two vertical lines 3 units apart). Run through all the 
setup steps again, using the following data, and you should get a result similar to Figure 13.10:

l	 Architectural ticks.
l	 Arial font, .25, color: Red.
l	 Fit: 1.000.
l	 Primary units: Decimal. Watch the precision.
l	 Suffix added on both main units (miles) and alternate units (feet).
l	 Alternate units, use 5280 as the multiplier.
l	 No tolerances.

Figure 13.8 
Tolerances tab.
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13.3  Introduction to constraints
AutoCAD was always a top-notch 2D drafting software application, but one with a bit of 
an inferiority complex. Not in regards to any other 2D competitors but rather toward 3D 
solid modeling and design software. These sophisticated products were developed in their 
own world, apart from AutoCAD, via development firms that never competed against 
or had anything to do with Autodesk or architecture. These programs included CATIA, 
NX/Unigraphics, Pro-Engineer, and SolidWorks. Their developers created quite a few 
revolutionary concepts and methods that transformed the way engineering design is done. 
Autodesk eventually jumped on board with Inventor and later Revit; both of which are 
excellent 3D products (one for engineers and the other for architects).

That left the AutoCAD development team looking at how their software could be enhanced 
by incorporating some of these sophisticated 3D tools without fundamentally altering 
AutoCAD’s identity or formula for success. If you go on to study AutoCAD 3D, you will 
notice how many “borrowed” concepts found their way into the software as AutoCAD 
reached ever further into the high-end 3D world.

Some of these concepts also found their way into 2D, such as the ones we are about 
to discuss, namely Parametrics, which is really two topics: geometric constraints and 
dimensional constraints; the latter is also referred to as dimension driven design. If you are  
an engineer or an engineering school student who used the previously mentioned 3D 
software, you will quickly recognize these concepts. AutoCAD literally took a page out of  
that playbook. Inferiority complex no more. Let us discuss each concept separately.

13.4  Geometric constraints
The fundamental idea behind geometric constraints, regardless of what software we are 
dealing with, is to restrict (constrain) the possible movement of drawn geometry and also 
force that geometry into certain positions. Ortho was a horizontal and vertical constraint on 

Figure 13.9 
The new dimension style.

Figure 13.10 
Sample dimension.
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lines. So if you have two parallel or perpendicular lines, a constraint can be placed on them 
that forces them to always stay parallel or perpendicular as well as forces them to be that way 
in the first place. Expanding to more general terms, geometric constraints set “relationships” 
between geometries such as parallel, perpendicular, tangent, and coincident.

This overall concept is quite important in setting what is referred to as design intent. If a 
drilled hole in a bracket absolutely has to be concentric to the bracket’s corner fillet to fulfill 
the design intent, then that is the main driving factor in its design (concentric means the 
circles and arcs share the same center point). There may, however, be other aspects of the 
design, such as perhaps notches and other geometry on the bracket, which are less critical. 
The constraints then “hold” the critical geometry, while you design the rest around it.

This was of course a very simple example; with a bracket you can probably keep track of 
the critical relationships without any help. Geometric constraints really earn their keep 
with more complex designs, where many constraints are needed to preserve design intent. 
Without them it would be easy to forget one or two important relationships and discover 
later down the road that the part you are working on does not function properly because a 
tangency somewhere was not preserved.

Almost since the beginning of high-end 3D software, geometric constraints were an 
important part of the design approach, but they were not included in AutoCAD until now, 
and AutoCAD designers needed to keep track (and check over) their geometric relationships 
manually. With these new tools, use of AutoCAD for engineering design (and even 
architecture to some extent) is greatly enhanced.

Types of Geometric Constraints
Here are the constraints available to you. We do not go through every single one but cover 
only the more commonly used ones, leaving the rest for you to explore. The best way to 
set constraints is via the Geometric Constraints toolbar (Figure 13.11) or the Ribbon’s 
Parametric tab.

The critical constraints we will discuss are:

l	 Perpendicular: Constrains two lines or polylines to perpendicular 90° angles to each 
other.

l	 Parallel: Constrains two lines to the same angle.
l	 Horizontal: Constrains two lines to lie parallel to the X axis.
l	 Vertical: Constrains two lines to lie parallel to the Y axis.
l	 Concentric: Constrains circles, arcs, or ellipses to maintaining the same center point.
l	 Tangent: Constrains a tangency between curves and lines.
l	 Coincident: Constrains two points together (to be discussed along with dimensional 

constraints).

Adding Geometric Constraints
Adding geometric constraints involves simply picking the constraint you wish to add and 
selecting the first object (which serves as the reference point) followed by the second object. 
The constraint then appears next to the objects reminding you it is set. The constraint 
tool also forces the objects into that constraint, so if you draw two lines that are not quite 
parallel, once you set the constraint, they become parallel right away.

Figure 13.11 
Geometric Constraints toolbar.
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Having read this, you may be tempted to completely do away with Ortho and even OSNAP 
to create accurate geometry, allowing constraints to “fix” drawn shapes. This of course is not 
generally recommended, as sloppy drafting catches up to you sooner or later (though we try 
this in the next example). While geometric constraints are very useful new tools, use them 
when appropriate, without forgetting or throwing away basic accuracy habits.

Let us try this out with the first constraint on the above list: Perpendicular.

Figure 13.12 
Perpendicular geometric constraints.

Step 1. Draw two lines that are roughly perpendicular, as seen in Figure 13.12 (left).
Step 2. Select the perpendicular geometric constraint via any of the previous methods.
Step 3. m  AutoCAD says:

Enter constraint type
[Horizontal/Vertical/Perpendicular/PArallel/Tangent/
SMooth/ Coincident/CONcentric/COLlinear/Symmetric/Equal/Fix] 
<CONcentric>:_Perpendicular
Select first object:

Step 4. Select the first line (the vertical one).
m  AutoCAD says: Select second object:

Step 5. Select the second line.

Immediately after the selection of the second line, you see it snap to perpendicular and two 
sets of geometrical constraints are added next to each line, as seen in Figure 13.12 (right). 
Note that if you selected the bottom line first, then the vertical one would snap to it, not the 
other way around. Selection order matters.

Let’s try one more, the concentric one. We leave the rest as an in-class exercise.
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Step 1. Draw an arc and a circle, one above the other, as seen in Figure 13.13 (left).
Step 2. Select the concentric geometric constraint via any of the previous methods.
Step 3. m  AutoCAD says:

Enter constraint type
[Horizontal/Vertical/Perpendicular/PArallel/Tangent/
SMooth/ Coincident/CONcentric/COLlinear/Symmetric/Equal/Fix] 
<CONcentric>:_Concentric
Select first object:

Step 4. Select the circle.
m  AutoCAD says: Select second object:

Step 5. Select the arc.

Immediately after the selection of the arc, you see one or both snap to a concentric setting 
(their centers are the same) as seen in Figure 13.13 (right). Note that, if you selected the arc 
first, the circle would adjust to it, not the other way around. Selection order matters.

For the remaining geometric constraints, try them out on your own.

Hiding, Showing, and Deleting Geometric Constraints
There are two ways to access these options. You can either right-click on one of the constraints 
to reveal a small menu, as seen in Figure 13.14, or find these same options on the Ribbon, as 
seen in Figure 13.15, along with the rest of the constraints.

Figure 13.13 
Concentric geometric constraints.

Figure 13.14 
Geometric constraints options, right-click 
menu.
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The Constraint Settings dialog box (which can be accessed via the small drop-down arrow 
at the bottom right of the Geometric tab) is actually just for global settings, for which 
geometric constraints to show. Leave all the choices selected and the transparency at 50%,  
as seen in Figure 13.16. Finally Figure 13.17 shows all seven of the constraints mentioned,  
as you should see them on your screen after trying them.

13.5  Dimensional constraints
Since we already discussed the basic idea of constraints, this introductory section is shorter. 
The idea here is to move from constraining pieces of geometry (and their positions relative 
to each other) to constraining the actual dimensions of the drawn design. So if two circles, 
representing drilled holes, absolutely need to be 3 apart, then constraining that dimension 
ensures it does not change regardless of what other design work goes on around them.

Dimensional constraints are also a major part of 3D parametric design and can be easily 
transferred to 2D work, as was done here in AutoCAD. Also, because the geometry has 
to obey the constrained dimension, you can change the geometry by simply changing 

Figure 13.15 
Geometric constraints options, Ribbon.

Figure 13.16 
Constraint settings.
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the dimension value, which is quite a departure from the normal order of business with 
AutoCAD. This ability to change geometry by updating dimensions, called dimension driven 
design, is really the only way to change the size of an object (usually called a feature) when 
using the high-end 3D design software such as CATIA.

At this point, you may start to see why all the preceding is referred to as parametric design. We 
are designing by changing or assigning parameters to our geometry. The geometry itself is 
almost secondary to the relationships and data that drive its existence and creation. This type of 
philosophy and approach is one of several steps critical to assuring that what we have is a valid 
engineering design, not just a pretty picture. The data behind the design have to make sense.

Working with Dimensional Constraints
Learning the basics of dimensional constraints is straightforward. You can either add them in 
right away to your design or convert existing regular dimensions to constraints. Dimensional 
constraints have their own toolbar (Figure 13.18), or they can be accessed through the 
Ribbon (Figure 13.19).

Figure 13.17 
Geometric constraints.

Figure 13.18 
Dimensional Constraints toolbar.

Figure 13.19 
Dimensional constraints, Ribbon.



level 2  
Chapters 11–20

282

The available dimensional constraints mirror the regular dimensions closely:

l	 Horizontal
l	 Vertical
l	 Aligned
l	 Radius
l	 Diameter
l	 Angle

Draw the bracket seen in Figure 13.20, but do not dimension it; use only the values shown 
to create the geometry.

Let us add a horizontal dimensional constraint.

Figure 13.20 
Bracket with dimensional constraints, Ribbon.

Step 1. Start up the dimensional constraint via any of the previous methods.
Step 2. m  AutoCAD says: Specify first constraint point or [Object] <Object>:
Step 3. Pick one end of the bottom part of the bracket (a red circle with an X appears).
Step 4. m  AutoCAD says: Specify second constraint point:

Pick the other end of the bottom part of the bracket (a red circle with an X appears 
again).

Step 5. m  AutoCAD says: Specify dimension line location:
Locate the dimensional constraint some distance away from the part, similar to a 
regular dimension.

AutoCAD displays the value (d = 10.0000) with a graphic of a lock, as seen in Figure 13.21. 
Press Enter.

In a similar manner you can add additional dimensional constraints to the rest of the 
bracket or convert existing dimensions (if you had some) via the Convert button in the 
Parametric→Dimensional Ribbon tab. Notice the whole point behind this tool. The 
dimensional values are “locked in” as represented by the lock graphic and will not budge 
regardless of how other surrounding geometry may change.
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13.6  Dimension driven design
You can of course change the value of the dimensional constraint by just double-clicking on 
it and typing in something else (Figure 13.22).

The value forces the line to move to the right, leaving a gap, which is not quite what you 
intended. Try the same with a circle and diameter constraint (Figure 13.23).

This leads to much better results; the circle has changed its size. There is a very important point 
to understand here in order to take full advantage of these tools. With linework and angles, 
dimensional constraints need to work together with geometric constraints. Used just by themselves, 
dimensional constraints change only the dimension value and drag the lines along for a ride; 
but if you add a coincident geometric constraint, the lines are “glued” together so you can make 
entire sections of the design properly constrained. A coincident constraint asks you to select one 
of the lines, then the second, and create a point where they intersect. Try this out on our bracket’s 
bottom pieces, and try changing the bottom line’s size again, leading to quite a different effect.

A lot more can be written about constraints in general; it is a broad and important topic. You 
are encouraged to explore further and practice setting up dimensional constraints on critical 
parts of a design. It will take some getting used to, and applying dimensional constraints 
intelligently can be awkward at first. The key is to apply these constraints only to the critical 
geometry and not constrain every single line and circle on the screen. Fortunately, AutoCAD 
prevents you from doing this and issues a warning that you are overconstraining or there are 
conflicts, similar to high-end solid modeling applications.

Figure 13.21 
Dimensional constraint.

Figure 13.22 
Altering dimensional constraint.

Figure 13.23 
Altering diameter dimensional constraint.
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Level 2 drawing project (3 of 10): architectural  
floor plan
In our third round of floor plan design, all exterior work is now complete, and we focus on 
adding additional features to the interior, mainly furniture and kitchen appliances (Figures 
13.24 and 13.25). Be sure to create the appropriate layers, such as

l	 A-Appliances
l	 A-Fireplace
l	 A-Furniture

and any others you think you may need. Assign colors to the layers. Dimensions for the 
furniture and appliances are not specifically given (as they are for the fireplace), but draw in 
reasonable designs as seen in the layout. Feel free to add more than is shown; there is only 
minimal furniture in the apartment. The full plan is in Figure 13.26, while blowups of the 
two sides of the house (and fireplace) are shown here for clarity.

Figure 13.24 
Bedroom and kitchen with furniture and appliances.

Figure 13.25 
Fireplace (detail).
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Figure 13.26 
Full floor plan.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 14.

l	 Creating a new dim style (ddim)
l	 Lines tab

m	 No permanent settings, but know functions of all
l	 Symbols and Arrows tab

m	 Architectural tick setting; know functions of all others
l	 Text tab

m	 Text font and size settings; know functions of all others
l	 Fit tab

m	 Fit setting; know functions of all others
l	 Primary Units tab

m	 Units setting
m	 Precision setting
m	 Prefix setting
m	 Suffix setting
m	 Zero suppression settings; know functions of all others

l	 Alternate Units tab
m	 Multiplier settings; know functions of all others

l	 Tolerances tab
m	 Tolerance settings (if needed)

l	 Geometric Constraints
m	 Perpendicular
m	 Parallel
m	 Horizontal
m	 Vertical
m	 Concentric
m	 Tangent
m	 Coincident

l	 Dimensional Constraints

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 13.

  1.	 Describe the basic functions found under the Lines tab.

  2.	 Describe the basic functions found under the Symbols and Arrows tab.

  3.	 Describe the basic functions found under the Text tab.

  4.	 Describe the basic functions found under the Fit tab.

  5.	 Describe the basic functions found under the Primary Units tab.

  6.	 Describe the basic functions found under the Alternate Units tab.

  7.	 Describe the basic functions found under the Tolerances tab.

  8.	 Describe the purpose of Geometric Constraints.

  9.	 What seven geometric constraints are discussed?

10.	 Describe the purpose of Dimensional Constraints.
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2.	 Draw a rough parallelogram shape, with one side 20, as shown below on the left. Parallel constrain all four sides, filleting if 
necessary. Then, carefully, coincident constrain all four corners. Finally, dimension constrain one side, using a value of 30 as seen 
on the right. If everything is done right, the rectangle should increase in size uniformly. (Difficulty level: Easy; Time to completion: 

5 minutes)

EXERCISES
1.	 Draw the following shape and label it exactly as shown. Be sure to note all the modifications to the 

dimensions, including arrowheads and the presence of alternate units and tolerances. You may have 
to get creative with the leader. (Difficulty level: Intermediate; Time to completion: 10–15 minutes)
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Spotlight On:  
Interior Design

Interior design is a major branch of architecture that concerns itself with interior living 
spaces. The goal is to create a living (or office) space that is both functional and aesthetically 
attractive by the creative use of colors, lighting, and materials. Interior design is not to be 
confused with interior decorating. Interior designers are often well versed in the principles of 
architecture, engineering, and materials and must generally hold at least a four-year degree. 
They can be called upon to create challenging spaces that are tailored to certain ecological or 
handicapped-accessible needs. It is a creative profession, but one that still requires analytical 
skills.

Education for interior designers (in the United States) involves a four-year baccalaureate 
degree in interior design. Masters degrees (MS, MA, MFA, and recently the MID) in 
interior design are also available, although this advanced degree is less common than the 
baccalaureate degree. Many professionals pursue advanced degrees in related subjects, 
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such as industrial design, fine art, or education. Doctoral programs in interior design are 
increasing in number at various institutions of higher education. It is worth noting that a 
great many interior designers held no formal education.

Following formal training, graduates usually enter a one- to three-year apprenticeship to gain 
experience before taking a national licensing exam or joining a professional association. The 
National Council for Interior Design Qualification (NCIDQ) administers the licensing exam. 
To be eligible to take the exam, applicants must have at least six years of combined education 
and experience in interior design, of which at least two years constitute postsecondary 
education in design. Once candidates have passed the qualifying exam, they are granted the 
title of Certified, Registered, or Licensed Interior Designer, depending on the state. Some 
states require continuing education units to maintain the license.

Interior design earnings vary based on employer, number of years with experience, and the 
reputation of the individual. For residential projects, self-employed interior designers usually 
earn a per-hour fee plus a percentage of the total cost of furniture, lighting, artwork, and 
other design elements. For commercial projects, they may charge per-hour fees or a flat fee 
for the whole project. The median annual earnings for hourly and salaried interior designers, 
in 2009, was approximately $61,000, with the top 10% earning over $78,760.

So how do interior designers use AutoCAD and what can you expect? Very often, as far as 
AutoCAD goes, interior design is tied in with the general architecture design of the building. 
Therefore interior designers work side by side with architects on their CAD files. The layering 
convention often follows AIA standards. You will find layers such as A-Furniture, A-Carpeting, 
and the like. Designers also work with blocks and attributes, and make extensive use of 
custom hatch patterns and a wide array of colors (think Pantones).

Interior designers often work in 3D, as the whole idea is often to present and sell the design 
concept. In these cases, they have to master 3D AutoCAD as well as additional rendering 
software. With 3D work, AutoCAD is not the only choice; and one can find Rhino, Form Z,  
and other applications running side by side with AutoCAD or even bypassing CAD 
completely.

Shown in Figure 1 is a 2D plan view of a residential interior. It makes use of solid shading 
and custom hatch patterns to give the client a good idea of the final outcome of the design 
effort.

Shown in Figure 2 is a 3D photorealistic rendering of another design. Though AutoCAD can 
be used to easily create the underlying architecture, additional rendering tools are usually 
used for this level of sophistication and realism.
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Figure 1 
2D plan view of a residential interior.

Figure 2 
3D photorealistic rendering of another design.



This page intentionally left blank



293

Up and Running with AutoCAD 2011. DOI:

©  Elsevier Inc. All rights reserved.
10.1016/B978-0-12-375715-9.00014-6

2011

CHAPTER

Options, Shortcuts,  
CUI, Design Center,  
and Express Tools

LEARNING OBJECTIVES
In this chapter we introduce a variety of advanced tools and discuss the following:
l	 Options dialog box

m	 Files tab
m	 Display tab
m	 Open and Save tab
m	 Plot and Publish tab
m	 System tab

14
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By the end of the chapter you will learn how to significantly customize your environment 
and speed up your work via importing pre-drawn blocks and using shortcuts to accelerate 
command input.

Estimated time for completion of chapter: 2–3 hours.

14.1  Options
Our topics for this chapter are the Options dialog box, followed by the concept of shortcuts 
(the acad.pgp file), and the Customize User Interface (CUI). We then look at the Design 
Center and the Express Tools. These topics introduce you to basic customization, greatly 
enhance your efficiency, and ideally lessen any remaining frustration with using AutoCAD.

The Options dialog box is your access to basic AutoCAD customization, and through it 
you can change many essential settings to make AutoCAD behave as you want it to. Almost 
every user finds a few items worthy of changing, and knowing this dialog box is absolutely 
essential. Often while covering this topic, students remark how they have been annoyed by 
some feature (or lack of it) and now know how to turn it off (or on). This is exactly why we 
introduce this dialog box (or cover it in more detail if you have already seen it).

Note that our goal is not to go over every single item in Options; it is far too big for that, 
and it is unnecessary anyway. Instead, we outline the most important features and explain 
why they are necessary. There are instances (in many cases) where you will be advised 
against changing the default values of one item or another. If you want to know more, press 
F1 (Help Files) while in each of the tabs for a detailed outline of every single feature. Note, 
however, that you should first have a clear understanding of the selected items this chapter 
focuses on before going into more detail.

To access the Options dialog box, right-click anywhere in the drawing area or command line 
and a menu appears, as shown in Figure 14.1. Click on the last choice: Options

A sizable dialog box appears (Figure 14.2) with the following tabs: Files, Display, Open 
and Save, Plot and Publish, System, User Preferences, Drafting, 3D Modeling, Selection, 
and Profiles. With the exception of 3D Modeling (to be covered in another book), all the 
significant features of each tab are introduced, although with limited discussion in the case 
of several tabs. Click the very first tab (Files) and let us begin.

Files Tab
This first tab is the easiest to go over for the simple reason that we change nothing here. 
What are all these listings, you ask? When AutoCAD (or any software for that matter) installs 
in your computer, it spreads out all over a certain area of the disk drive (where you indicated 
it should go on installation) and drops off necessary files as it sees fit.

m	 User Preferences tab
m	 Drafting tab
m	 3D Modeling tab
m	 Selection tab
m	 Profiles tab

l	 Shortcuts and the acad.pgp file
l	 Customize User Interface (CUI)
l	 Design Center
l	 Express Tools
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What you are looking at in Figure 14.2 is a collection of paths (each of which you can observe 
and modify by clicking on the plus signs) for the locations of a variety of important AutoCAD 
functions: Help Files, automatic saves, and the like. You have choices as to where you want 
them to go if you do not like the default locations. Some of these you may recognize, some 
you may not.

Be careful though; default settings are a good thing in this case. If you change the end 
location of some file, often you (or sometimes AutoCAD) may not find it, and difficulties 
result, such as when you try to move the device driver files. It is strongly advised to leave 
all these as they are, as there really is no compelling reason to change the preset values. 
I have needed to change only a few of these paths in all my years of AutoCAD use and 

Figure 14.1 
Accessing Options.

Figure 14.2 
Files tab.
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management, and those had to do with log file locations and AutoSave, so the average user 
probably has little use for this advanced tab.

If you want a detailed description of what each path means, press F1 while you have the Files 
tab open.

Display Tab
This second tab (Figure 14.3) has a few items of interest, specifically Window Elements, 
Layout elements (on the left side of the box, top to bottom), and Crosshair size (on the 
right).

Under the category Window Elements, you do not need any of the boxes checked except 
the four related ToolTips boxes. The first few boxes feature color schemes, scroll bars, and 
outdated menus that just take up screen space and add nothing of value (though some 
visually impaired individuals can make use of the Large buttons for Toolbars). You may  
want to have ToolTips though, to explain the meaning of new toolbars and other items.

Colors… refers to the color of your screen background. Generally this is colored black (as 
preferred by most but not all users). Black is a good choice for the simple reason that the 
dark background throws less light at your eyes from the screen, and lessens fatigue. The only 
catch is that printed paper output is always white, and some people prefer seeing the design 
as it would appear in real life (on white paper, hence the white background). Obviously it is 
easy to get used to the black background and pretty much disregard the “paper” aspects of 
the output, and this is what most users do.

Other colors are available of course (actually all 16 million colors are available as a 
background), but as we joke in class, if you see someone using a bright neon green background, 
stay away—this is probably not a stable individual. A white background is of course used for 
screen shots throughout this textbook for clarity.

Figure 14.3 
Display tab.
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To change the color scheme for practice, press the Colors... button and the dialog box in 
Figure 14.4 appears.

Here you can select from the general Context: on the left (only the first choice, 2D model 
space, for now), and select some element in the Interface element area on the right (e.g., the 
Uniform background). Then pick the color you want this element to have. Figure 14.4 shows 
white being chosen. Note the sizable number of choices in both the left and right columns. 
AutoCAD allows for the color of just about anything to be changed; browse through all the 
choices to get familiar. If you change so much that you forget what you did, you can always 
press the Restore classic colors button seen in Figure 14.4. When done, press Apply & Close.

Fonts… refers to the font present on the command line text, not the font in the actual 
drawing, so unless you have an objection to the Courier New font (the default), do not 
change anything.

In Layout Elements, you can uncheck all the boxes except the top one: Display Layout and 
Model tabs. Generally all those options are distractions and unnecessary in Paper Space. We 
discuss this in Chapter 18.

The Crosshair Size setting is generally a personal preference. Many leave it as a “flyspeck” 
setting, which is 5, but increasing the size to a full 100 is recommended, as this makes life 
easier when you are in a Paper Space viewport or checking if a drawn line is straight (by 
comparing it to the straight-edge crosshairs). In the end, it is up to you, but all screen shots 
in the book feature the 100 setting.

We change nothing under Display resolution, Display performance, and Fade control. The 
default settings are fine. If you want a detailed description of what each selection means, 
press F1 while you have the Display tab open. Otherwise, check to see that your settings 
reflect what is in Figure 14.3 and let us move on.

Figure 14.4 
Drawing Window Colors with white selected.
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Open and Save Tab
The Open and Save tab (Figure 14.5) contains several important features worth discussing, 
all of them contained inside the two categories on the left-hand side: File Save and File Safety 
Precautions.

In File Save, let us take a look at the top option, labeled Save as:. This drop-down menu is 
very important, as it allows you to permanently save your files down to an older version of 
AutoCAD. The significance of this cannot be overstated because you simply cannot open a 
file created on a more recent version using an older release. AutoCAD is an often updated 
software, with new releases every year (since 2004), and you can rest assured that not everyone 
is running the same version. I have seen AutoCAD 14 (from the mid-1990s) running on a 
company PC as late as 2006. While that may have been an isolated case, AutoCAD 2002 and 
2004 are still in widespread use, and nothing is more frustrating to someone than getting a 
copy of your files for collaboration and not being able to work with them.

Autodesk of course realizes this and allows you to save files down on a case-by-case basis 
during the Save procedure. AutoCAD even automatically saves one release down anyway. But 
to be safe (if it is not already set this way), select the AutoCAD 2000/LT 2000 Drawing (*.dwg)  
choice, as seen in Figure 14.5; that way you are assured of the file being accessible by just about 
everyone else. We can skip over the rest of the options under the File Save category and move 
on down to File Safety Precautions.

The Automatic Save is about as close to controversial as something in AutoCAD gets. The 
suggestion is this: Do not use it. Others may say, why not, it is there. The argument against it 
is simple: As a computer user you need to save your work often, no matter what application 
you use. To rely on automatic saves is to invite trouble when you use a program that does not 
have an automatic save (or it is not turned on). As an AutoCAD user, you should be saving 
your work every 5 to 10 minutes, something students often do not do in class.

Figure 14.5 
Open and Save tab.
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There are also some practical difficulties with Automatic Save. For one thing, you need to exit 
a command to save a drawing. AutoSave does this for you, so even if you are in the middle of 
something, you are kicked out for AutoSave to run (except while in Block Editing mode). Other 
issues are where Automatic Save files go and what extension they have. You can set where they go 
using one of the paths under the File tab, but then all Automatic Save files go there regardless of 
what actual drawing is open and overwrite existing files. The extension of AutoSave files is .sv$.

In summary, while AutoSave can be set up, it is not advisable to rely on it; often you see 
veteran programmers and computer users ignore this feature in all computer use and save 
instinctively every few minutes. If you do wish to use AutoSave, simply turn it on by checking 
the box and setting a time threshold (Minutes between saves) just below that.

The Create backup file with each save setting can also be mildly controversial, as it seems 
like a good idea initially, yet does not stand up under scrutiny. Backup files (if the option is 
checked) are created every time you save a file. A backup file (.bak) is essentially a regular 
drawing file (.dwg) that is cloaked with an extension Windows does not recognize, but you 
do (see Appendix C for more information on all extensions). If the .dwg file is lost, then the 
.bak file can be renamed and, voila, the drawing is there again. So what is wrong with this? 
Well, in theory nothing, but in real-life use there are a few issues.

The main problem is that backup files actually double the size of your project folders; it is 
like having a copy of every drawing file next to the original, and they just are not necessary, 
due to the combination of cheap storage media and a heightened sense of risk in recent 
years that has prompted just about every company to do daily and weekly backups. Also, 
AutoCAD’s drawings rarely “go bad” to the point of being unrecoverable by the Audit and 
Recover commands. Finally backup files reside right next to the drawing files themselves, 
and if you lose the entire folder, they all go. Rarely do you lose just the drawing, and even 
then going to the previous night’s tape backups is enough to get them back. So, while some 
would argue that no harm is done by keeping the *.bak files, one could say: Why add the 
extra junk to your company’s server? Ultimately, the choice is up to you, though sometimes 
company policy may dictate the use of backup files, and this is beyond your control.

Most users will not need Full-time CRC validation. CRC stands for cyclic redundancy check.

Maintain a log file makes AutoCAD write the contents of the text window to a log file, also 
an unnecessary feature for most users.

Security Options… is a relatively new feature in AutoCAD that addresses the need to secure 
or authenticate the drawings. This is not an often used feature, as most AutoCAD drawings 
are not top secret in nature, but the idea is intriguing and worth a look. When you click on 
the button the box in Figure 14.6 appears.

Figure 14.6 
Security Options Tab.
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The first tab allows you to add a password to the drawing. Then the drawing can be opened 
only by someone who knows the password; though be careful—if the password is forgotten, the 
drawing is lost. The second tab has to do with a Digital Signature. This is in itself a lengthy topic 
and is sometimes used when collaborating with others. In short, a user installs a certificate from 
a digital security vendor (VeriSign® in this case), which allows for a “digital signature,” which in 
turn prevents changes to the drawing or keeps track of them. This is of course a very simplified 
version of the concept, but if your company already uses this, then no further explanation is 
necessary; if not, you will likely not care about this feature anyway.

We do not go over anything in the right-hand column of the Open and Save tab. File Open 
is self-explanatory, and the other settings under External References (Xrefs) and ObjectARX 
(AutoCAD runtime extension) applications are left as default. If you want a detailed description 
of what each selection means, press F1 while you have the Open and Save tab open. Otherwise 
check to see that your settings reflect what is in Figure 14.5 and let us move on.

Plot and Publish Tab
While there is nothing critically important under the Plot and Publish tab (Figure 14.7), a 
few features are worth a look. We run through everything with just general comments, while 
expanding on what proved to be useful over the years and why. Starting from the top left, 
moving down, we have the following options.

The Default plot settings for new drawings option selects the default plotter or adds a new 
one. However, this should not be done from here, but rather from the Windows control 
panel. When new plotters or printers are added, AutoCAD notices them, as well as what the 
chosen default is (though this is of little significance, as the printer settings for each drawing 
are set individually). Leave everything here as default.

In Plot to file a drawing can be plotted to a .plt (plot) file and saved in this location.  
While this is generally an outdated legacy command from the old days of .plt files being 

Figure 14.7 
Plot and Publish tab.
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sent (or physically carried on a floppy disk) to plotters, it has found some use today when 
taking drawings to a printing company (such as Kinkos). The company may not have 
AutoCAD (or anyone qualified to operate it), so instead it accepts the .plt files, which are 
nothing more than ready-to-print code that can be interpreted by any plotter.

Background processing options have to do with being able to plot in the background while 
working on a drawing (with the Plotting option unchecked, you must wait until the plotting 
is complete before continuing).

The Plot and publish log file is an option that creates (or turns off) the log feature, which 
is nothing more than a record of the Job name, Date and time started and completed, Full 
file path, Selected layout name, Page setup name, Device name, Paper size name, and a few 
others. It is recommended to disable (uncheck) this feature unless there is a specific reason 
to create a record of all this information.

Auto publish is an option that allows you to automatically create DWF files. DWF stands for 
design web format and is a topic all unto itself. The basic idea is to generate vector files that 
can be viewed by others who have the Autodesk Viewer, or if not, then through a browser.

General plot options is the only item of interest that has to do with the output quality of 
OLE (object linked embedded) items, a topic to be discussed in Chapter 16. The OLE plot 
quality drop-down choices can be adjusted depending on what is embedded.

Leave Specify plot offset relative to as default.

Plot Stamp Settings… is an item of interest. A plot stamp is simply a text string that appears 
on all output (when activated in the Plot dialog box). This text string has information on a 
variety of parameters, but the ones of most interest include the drawing name and the date 
and time. This can be useful for internal check plots (obviously not for final output), to 
show where the drawing is on the company server or to indicate which paper output is the 
latest based on the date and time. Use the Advanced button in the lower left (Figure 14.8) to 
further refine the Plot Stamp.

Leave Plot Style Table Settings… as default. These settings are addressed elsewhere.

If you want a detailed description of what each selection means, press F1 while you have the 
Plot and Publish tab open. Otherwise, check to see that your settings reflect what is in Figure 
14.7 and let us move on.

figure 14.8 
Plot stamp.
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System Tab
There will not be much to discuss here; all settings will basically remain as default (see  
Figure 14.9).

We do not discuss 3D Performance.

Current Pointing Device allows for digitizer operations, not relevant to most users.

Leave Layout Regen Options as default.

In dbConnect Options, the db refers to database connectivity, which is also not relevant to 
most users, but may be important in some high-end custom applications, where AutoCAD is 
linked to a database.

Leave everything in General Options as default. Here resides perhaps one of the most 
annoying features of AutoCAD: Beep on error in user input. This may push a student just 
starting out and making lots of errors over the edge—not recommended.

The Live Enabler Options tell AutoCAD to check for object enablers. They can be used to 
display and use custom objects in drawings when the ObjectARX application that created 
them is unavailable. This is not relevant to most users and may sometimes cause a program 
stall if the internet is not hooked up to the PC.

Help is a new section added in AutoCAD 2011 and is where you specify where AutoCAD 
goes to get its Help Files. See Chapter 1 on some commentary concerning this.

If you want a detailed description of what each selection means, press F1 while you have the 
Systems tab open. Otherwise check to see that your settings reflect what is in Figure 14.9 and 
let us move on.

Figure 14.9 
System tab.
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User Preferences Tab
This tab (Figure 14.10) has one very important setting under the Windows Standard 
Behavior category in the upper left. The rest of the categories are not relevant to most users, 
though we will briefly mention a few.

Windows Standard Behavior concerns speed, which is a topic near and dear to the hearts 
of most AutoCAD users. Since time equals money, whatever technique accelerates the 
drafting is always welcome. One of the more important ones (shortcuts) is discussed later in 
this chapter. Another important “trick” is to set your mouse buttons to the most likely and 
needed settings for fast drafting. As such, Right-click Customization… is very important. 
Click on that button and the dialog box in Figure 14.11 appears.

Figure 14.10 
User Preferences tab.

Figure 14.11 
Right-click customization.
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Your mouse settings should be as shown in Figure 14.11, with the last one, Command Mode, 
set to ENTER. This subtle but powerful setting speeds up your basic drafting by allowing you 
to instantly finish commands by using the right mouse button instead of having to press 
Enter. Also set Edit Mode to Repeat Last Command and Default Mode to Shortcut Menu. 
Nothing else needs to be adjusted. Press Apply & Close.

We briefly mention the other categories.

Insertion scale controls the scale for inserting blocks; leave the default values.

Fields sets fields preferences, which are not relevant to most users; leave as default.

Priority for Coordinate Data Entry controls how AutoCAD responds to coordinate data 
input, also not necessary to change for most users.

Leave Associative Dimensioning checked, since all dimensions should be associative 
(meaning, if the geometry changes, so do the dimensions associated with it).

Hyperlink controls settings of hyperlinks; leave this box checked. We cover hyperlinks in the 
next chapter.

Undo/Redo controls Undo and Redo for Zoom and Pan; leave both boxes checked off.

Below these settings are four bars that you can press to set preferences. They are described 
next.

Block Editor Settings… changes the environment of the Block Editor. You worked with the 
Editor when you first learned dynamic blocks.

Lineweight Settings displays the Lineweight Settings dialog box. These settings can be 
adjusted when setting up the .ctb files as described in Chapter 19; it is not needed here.

Edit Scale List displays the Edit Scale List dialog box. Additional scales are rarely needed 
but can be added here if necessary.

Initial Setup is an interesting set of options. When you first start up AutoCAD, known as out 
of the box, it allows you to set a variety of customization settings, depending on what you are 
working on: architecture, engineering, and so forth. If you skipped those steps, you have a 
chance to do it now as seen in Figures 12.12–12.14.

Figure 14.12 
Initial setup, select your industry.
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Each step of the way is explained by instructions and questions on the left. All these steps 
are completely optional and can be customized and set in other ways. If you cancel, you see 
Figure 14.15.

If you want a detailed description of what each selection in the User Preferences tab means, 
press F1 while you have the User Preferences tab open. Otherwise check to see that your 
settings reflect what is in Figure 14.10 and let us move on.

Drafting Tab
The entire left side of this tab (Figure 14.16) is devoted to snap point markers, those yellow 
colored geometric objects that represent endpoints, midpoints, and the like.

Leave AutoSnap Settings as default, including Colors, unless you prefer something different.

Leave AutoSnap Marker Size as default, unless you have trouble seeing them or find them 
too big.

Leave all Object Snap Options as default.

AutoTrack Settings have to do with AutoCAD’s tracking tool OTRACK, which is briefly 
looked at in Chapter 15 along with other miscellaneous topics. Leave these settings as default.

Leave Alignment Point Acquisition as default.

Figure 14.13 
Initial setup, optimize workspace.

Figure 14.14 
Initial setup, choose template.
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Aperture Size is perhaps the one item that may occasionally be adjusted to suit the user’s 
taste, but generally keep it the same size as the AutoSnap marker.

Drafting Tooltip Settings… feature minor nuanced adjustments to drafting tooltips (such as 
distance or angle displays) and their visibility to the users (the transparency). Leave all them 
as default.

Lights Glyph Settings… and Cameras Glyph Settings… are advanced settings that are not 
relevant at this point; leave them as default.

If you want a detailed description of what each selection means, press F1 while you have the 
Drafting tab open. Otherwise check to see that your settings reflect what is in Figure 14.16 
and let us move on.

3D Modeling Tab
Settings and adjustments under this tab are not discussed here.

Figure 14.16 
Drafting tab.

Figure 14.15 
Changes not saved.
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Selection Tab
This entire tab (Figure 14.17) is devoted to minor adjustments to your drafting environment, 
which may or may not be important depending on your personal tastes and style of drafting.

Pickbox Size is simply what the cursor becomes when you are in the process of picking 
something. Set it too small and you have trouble selecting the geometry. Set it too big  
and you select more than you wanted. Generally leave it at the default size shown in  
Figure 14.17.

Selection Preview is a relatively new feature that causes objects to “light up” when your 
mouse hovers over them. What exactly constitutes “light up” and a few other items is the 
business of the Visual Effect Settings button. When you press it, you see what is shown in 
Figure 14.18.

Here you can set whether you want the lighting up effect to be dashed linework or thicker 
lines (as if a highlighter magic marker went over them) or both. On the right is an interesting 
setting that has to do with the inside colors of the familiar Window/Crossing. You can 
change those colors as well as their intensities. You can eliminate them, as the colors are 
really unnecessary; what is important is whether the selection rectangle is dashed or solid.

Selection Modes is just more adjustments to object selection. Leave them all as default, as 
seen in Figure 14.17.

Ribbon options are some options regarding contextual tab states. Leave them as default.

Grip Size should be self-explanatory. Leave them the default size unless you prefer bigger or 
smaller grips.

Figure 14.17 
Selection tab.
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Grips are yet more grip settings for colors and other adjustments. There is really no reason to 
change grip color. Blue means cold (unselected), red means hot (selected), and hover can be 
any color (default green is just fine). Leave the other settings as default (you want the grips 
enabled usually but not inside blocks). Leave the maximum amount of grips that can be 
shown at 100 so as to not overwhelm the drawing if you select more.

Really most of these settings can be left alone. They are included for the benefit of the 
handful of people who may want to change something and feel that, with a $4000 software 
program, they ought to be able to alter anything. If you want a detailed description of what 
each selection means, press F1 while you have the Selection tab open. Otherwise check to see 
that your settings reflect what is in Figure 14.17 and let us move on.

Profiles Tab
This tab (Figure 14.19) is simply there to save your personal settings, so if someone 
else using your computer and AutoCAD prefers other settings (maybe that neon green 
background color), that person can set his or her own and save them as well. Simply press 
the Add to List button and enter a name for the profile, as seen in Figure 14.19, and press 
Apply & Close, as seen in Figure 14.20.

The profile is added to the list (as many as you want can be added) and can be restored 
by selecting it and pressing Set Current. Profiles can be exported (as ARG files), imported, 
renamed, and deleted as needed. Profiles were more relevant in the days when PCs were 
more expensive and each one in a company may have had a few users, but some people still 
use them to avoid office arguments about exactly how AutoCAD “should look” if one were 
to “borrow” a PC for the day, change AutoCAD to suit his or her taste, and forget to reset it to 
how the original owner or user likes it.

Figure 14.18 
Visual effects settings.
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14.2  Shortcuts
Recall that it was mentioned in the previous pages how important speed is to an AutoCAD 
designer. One of the tools to help you work faster was already mentioned, the mouse  
right-click settings under the User Preferences tab. Shortcuts, however, are another important 
way to accelerate your input. This is useful only if you type. If you are a die-hard Ribbon 
or toolbar user and abhor the keyboard, then you have no need for them. Many students, 
however, end up typing quite a lot, even if they also integrate some toolbar and Ribbon 
use. The reasons are quite simple; typing is a fast and very direct method to interact with 
AutoCAD and remains quite popular despite other methods. However, to take advantage of 
this, you need shortcuts, as typing out the full command defeats the speed advantage.

You may have already been using shortcuts all along. Instead of typing in arc, you may 
have just pressed the letter a, instead of move, the letter m. This is exactly what is meant by 

Figure 14.19 
Profile tab.

Figure 14.20 
Add profile.
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shortcuts; it is the process of shortening the typed commands so they can be entered faster. 
What we want to do here is put all this on solid footing and outline exactly how to set your 
own shortcuts to make best use of them.

PGP File
Here is a basic primer on shortcuts. They have been a part of AutoCAD since the very 
beginning, when typing commands was the best way to interact with the software. 
Abbreviating the commands was the logical next step. The abbreviations are stored in a 
file called acad.pgp, which resides in the Support folder of your AutoCAD installation. 
AutoCAD comes with a wide range of preinstalled shortcuts, but the file is easily found 
and meant to be modified to suit the user’s taste and habits. The key here is that you need 
to have your shortcuts memorized (or it makes no sense to use them in the first place) and 
of course you need to pick the most efficient abbreviations of the commands. To that end 
AutoCAD does not care what you use—it can be numbers or names of your relatives—but 
obviously you want to use something that makes sense to you and shortens the typing effort. 
Ultimately the first letter, first and second letters, or first and last letters are used for all but a 
few of the commands.

Here are some suggestions for the Modify commands:

Erase: e
Move: m
Copy: c
Rotate: ro
Scale: s
Trim: t
Extend: ed
Fillet: f
Offset: o
Mirror: mi

The idea here is to abbreviate the most often used commands in the shortest way possible 
(for example, when there is a conflict: circle is ci and copy is just c, because copy is generally 
used more often). Sometimes doubling up of letters is OK, such as with Array (aa), because 
a is taken by arc, and so on. Listed in Figure 14.21 is my acad.pgp file. It is presented here 
only for illustration purposes and may or may not match what you may want in yours, 
though it can be a good starting point to creating your own.

Altering the pgp File
So how do you find and alter the pgp file to suit your tastes? Prior to AutoCAD 2004, you 
had to look for it in the C:\Program Files\AutoCAD 2002\Support folder (for ACAD 2002 in 
this example). You no longer have to do this and can access the file automatically through 
the drop-down menus as follows: Tools→Customize→Edit Program Parameter (acad.
pgp). The pgp file then appears on your screen (opened as a Notepad file, which is just a 
simple ASCII text editor if you never used it before). Scroll down the file until you see the 
rather lengthy built-in listing of shortcuts. At this point you may do one of three things:

1.	 Leave the entire file as it is, and use it without modification.
2.	 Erase or change the shortcuts for commands that you either do not use or would like to 

modify.
3.	 Erase the entire list and start fresh, entering the shortcuts as you would like them to be, 

one by one. If this is the case, be sure to follow the format given where you enter the 
shortcut, then a comma, then a few spaces, and finally the command preceded by a *.
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When done save the acad.pgp file and close Notepad. At this point, for the changes to 
take effect, you can either restart AutoCAD or (if you are in the middle of a drawing and 
do not want to do that), type in reinit and press Enter. The dialog box in Figure 14.22 
pops up.

Check off the PGP File box and press OK. The pgp file is ready to go and you can use it right 
away. To add or subtract commands, just repeat the steps at the beginning of this section, 
save the pgp file, and reinitialize.

A,          *ARC

AA,        *ARRAY

B,           *BHATCH

BL,         *BLOCK

C,           *COPY

CI,          *CIRCLE

CH,        *PROPERTIES

D,           *DTEXT

DI,          *DIST

DDO,     *OSNAP

E,           *ERASE

EL,         *ELLIPSE

ED,        *EXTEND

EX,        *EXPLODE

F,           *FILLET

I,            *INSERT

ISO,       *LAYISO

L,           *LINE

LI,          *LIST

LA,        *LAYER

LF,         *LAYFRZ

M,          *MOVE

MI,         *MIRROR

MM,       *MATCHPROP

ML,        *MLINE

O,           *OFFSET

PP,         *PURGE

PL,         *PLINE

PE,         *PEDIT

Q,           *QSAVE

R,           *REGEN

RO,        *ROTATE

RE,        *RECTANG

S,           *SCALE

SP,         *SPLINE

T,           *TRIM

U,           *UNDO

UU,        *UCSICON

W,          *WBLOCK

X,           *EXTRUDE

XL,         *XLINE

Z,            *ZOOM

Figure 14.21 
Sample acad.pgp file.
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It is strongly recommended that you at least try to modify and use the pgp file. It is 
almost always faster to type the shortcuts than to click on icons. You can eventually learn 
to type quickly and without even glancing at the keyboard (similar to a good secretary 
or court reporter), assuming you do not already type fast, as many students do. Another 
advantage is that, by typing commands, you free up space on your screen where toolbars 
normally go.

14.3  Customize user interface
The Customize User Interface dialog box (referred to from here on as just the CUI) 
is the next item of interest in this chapter. The CUI has to do with changing the look 
and functionality of menus and toolbars (among other items) and as such can be of 
importance to a small set of users that may need to do this for aesthetic or functional 
reasons.

The CUI is an advanced and somewhat mysterious concept and is not taken advantage of by 
most users, as either they do not know much about it or do not wish to change their toolbars 
or menus. A few though find this customization ability of great interest and spend time 
customizing the look of AutoCAD to the point of almost having AutoCAD look like another 
program entirely.

We walk a middle ground here and present some CUI basics, demonstrating the creation of a 
new custom toolbar (something for which I have an occasional use) and leaving the student 
with some CUI ideas to pursue further if he or she is interested in doing so.

Let us introduce the basic CUI as it opens in default mode. Type in cui, press Enter (or 
alternatively use the Ribbon’s Manage tab→User Interface), and after a few seconds the 
dialog box in Figure 14.23 opens up. Press the expansion button (small arrow, bottom right) 
to make it full size if it does not do this automatically.

In general, the CUI is your window into customizing virtually anything in AutoCAD that 
you can push, select, or type in. The full list of candidates is in the upper left of the CUI box: 
Workspaces, Toolbars, Menus, Dashboard Panels, and all the other choices.

Just to get our feet wet, let us create a custom toolbar that has only the buttons you want and 
none of the ones you never use (great for 3D, where toolbar use is more of a necessity than 
in 2D).

1.	 In the upper left-hand corner find the Toolbars category and right-click, selecting New 
Toolbar. Once clicked, a Properties Palette appears on the right. Give your new toolbar a 
name in the name field (under General).

Figure 14.22 
Reinitialization of the pgp file.
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2.	 On the bottom left begin selecting the commands you want your new toolbar to have 
(you can filter the commands to find them easier), and drag them into the new toolbar 
name on the upper left. As soon as you begin doing this, a toolbar preview and Button 
Image category appear on the right-hand side, as seen in Figure 14.24, when “rectangle” 
was added as the first command.

Interestingly, you can even modify the image itself by pressing Edit in the Button Image 
category, which takes you to the dialog box shown in Figure 14.25, although this is not 
commonly done.

Finally, after adding a few more commands (Revcloud, Circle, and Spline) and pressing 
Apply and OK, the new toolbar is born, as shown in Figure 14.26; this is certainly a good 
trick if you like toolbars and want to see only what you use on yours.

Figure 14.23 
The CUI.
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Figure 14.25 
Button editor.

Figure 14.26 
The newborn toolbar.

Figure 14.24 
Toolbar modification.
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This is of course just the tip of the iceberg. You can modify all the rest of the choices. 
Shortcut Keys under the Keyboard Shortcuts are quite useful. This refers to shortcuts such 
as Ctrl  C for Copy Clip (also known as Accelerator keys). You can set up your keyboard to 
accelerate many commands. Just some of the preset ones are shown in Figure 14.27.

It may be worth your time to look through the Help Files and investigate the CUI further; it 
really is a bottomless pit of customization, though be careful not to change something just 
for the sake of change but only if you feel it may help your productivity.

14.4  Design center
You can probably guess at one of the purposes of the Design Center (DC) as soon as you 
open it by using the cascading menus Tools→Palettes→DesignCenter (also via typing in dc 
and pressing Enter, or Ctrl  2). Be sure to dock it to the left side of the screen and expand 
all the sections for good visibility, as shown in Figure 14.28.

What you see here (far left window) is basically the Windows Explorer that is used regularly 
to view files (such as when you click on My Computer). This is a big clue to the first of two 

Figure 14.27 
Accelerator keys.
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functions of the DC, which are to view the contents of one drawing on the left, and as we 
soon see, transfer parts of that drawing into the active drawing on the right. Let us give this  
a try using the process outlined next.

By default the DC opens the //Sample/DesignCenter file folder on the left, revealing a 
collection of sample drawings. You can of course browse for and choose an actual work 
drawing you created (that is the whole point, after all), but for our purposes right now, one 
of the sample drawings is just fine. Go ahead and pick, let us say, the HVAC one. Clicking 
on the plus sign next to the file name and expanding the folder reveals a collection of useful 
data, such as Blocks, Dimstyles, Layers, Layouts, and others. Now click on a category, such 
as Blocks. A collection of blocks present in this drawing are revealed in the middle window, 
next to the file tree. Click and drag any block from the choices given on the left into the 
drawing space on the right, as seen in Figure 14.29.

In the same manner you can transfer layers and anything else listed from one drawing into 
another. This is very useful when you need only a few items as opposed to everything and is 
a great visual alternative to the familiar Copy/Paste (Ctrl  C and Ctrl  P).

The next two tabs of the DC are not all that significant. Open Drawings simply looks at the 
content of the current active drawing, and History is exactly that, the history of all the open 
drawings thus far in the drawing session. There is however another function to the Design 
Center that we have yet to explore.

This function is the ability of the Design Center to present to you an extensive array of 
drawing blocks for you to use as generic items in your floor plan. New to this release of 
AutoCAD, you can access all this online, as opposed to clicking another tab that leads you  

Figure 14.28 
AutoCAD 2011 Design Center.
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to blocks built into AutoCAD and installed on your computer. This of course greatly expands 
the available library and allows Autodesk to update it in real time.

To access this feature, click on (assuming you have internet access on your computer) the 
Autodesk Seek content logo in the upper right of the Design Center (Figure 14.30).

After a moment or two, this leads you to Autodesk’s online database of product specs and 
design files. If you want to access the site without using the Design Center, here is the web 
address: http://seek.autodesk.com/. You then see the screen in Figure 14.31.

As you can see from inspecting the website, you have quite a lot of categories from which to 
choose. Pick one (let us say, refrigerators) to see what is available. You can then choose by 
generic or manufacturer. If you pick Manufacturer→Bosch & Siemens, you get the screen 
shown in Figure 14.32.

You can then choose a file type on the right (not just AutoCAD drawing, or DWGs), and  
then actually download the file. Explore this extensive website further; it is truly a great 
resource.

Figure 14.29 
Design center transfer of blocks (Ribbon and toolbars turned off).

Figure 14.30 
Autodesk Seek.
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14.5  Express tools
Express Tools are a set of commands grouped together under the Express drop-down 
menus. These commands add extra functionality to AutoCAD, and while some of them are 
redundant or not that useful, others became so indispensable that they were incorporated 
into regular AutoCAD menus and command sets. It really is a mixed bag, and our goal here 
is to highlight only the most useful ones, leaving the rest for you to explore if needed.

Figure 14.31 
Autodesk Seek online.

Figure 14.32 
First few choices in the refrigerator category.
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Express Tools were originally called Bonus Tools and got their start around Release 14 as a 
collection of useful routines and small programs. Where they originally came from is a 
matter of debate, but Autodesk likely acquired them from other third-party developers or 
possibly regular programming-savvy users who felt that AutoCAD just did not have that 
perfect command and developed their own as “plug-ins.”

However it happened, these tools found their way to Autodesk and the company began to 
offer them as an “extra” to AutoCAD (not technically part of the core software). Sometimes 
these tools were offered for sale, sometimes for free to VIP subscribers, and more recently for 
free to everyone, though they often still need to be installed in a separate and deliberate step 
while installing AutoCAD itself.

The first step in learning Express Tools is to check that you have them (you should with 
AutoCAD 2011), and we proceed from here on with the assumption that all is well and you 
are ready to go over them. Figure 14.33 shows what the topmost listing looks like when 
dropped down from the top cascading menu.

Although all these categories have a collection of commands, we do not cover them all, and 
you can refer to the Express Tools Help Files for detailed description of each. Often you may 
find the functionality of the Express Tool already a part of AutoCAD in some other way, 
shape, or form. Next is a rundown of the most useful Express Tools.

Blocks
The Copy Nested Objects command is useful for plucking out nested items, such as those 
embedded in Xrefs (a topic to be covered later) or Blocks. These objects are otherwise stuck 
inside and not easily accessible for copying. The command line equivalent for this is ncopy, 
and does the same thing.

When you explode regular attributes (a Chapter 19 topic), they do not turn into regular text; 
instead they take the shape of attribute definitions. This useful Explode Attributes to Text 
tool forces them to revert to ordinary text so you need not retype anything.

Nothing else from Blocks is covered.

Text
What you see is what you get with the Convert Text to Mtext command, which converts lines 
of text to a paragraph of Mtext. It is faster and more efficient than copying the text in one line 
at a time or redoing Mtext completely.

Figure 14.33 
Express Tools.
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The unique Arc-Aligned Text command is used to tackle a problem that has never been 
addressed by AutoCAD prior to Express Tools: how to enter text that stretches around an arc. 
The procedure is to draw an arc and select this tool (or just type in arctext), and then select 
the arc. The dialog box seen in Figure 14.36 appears.

Enter the actual text and adjust parameters such as fonts, size, and anything else you want 
(they all have explanatory tooltips if you float your mouse over them), and finally press OK 
when done. Your text should look similar to the text shown in Figure 14.37.

If the text is too squeezed or spread out, adjust the sizing. Note that the text can be over 
or under the arc. Also remember that you need to type in arctext to go back and edit it. 
Regular ddedit or double-clicking does not work here.

The interesting Enclose Text with Object command encloses your text with rectangles, slots, 
or circles. Run through the menu options, setting offsets, shapes, and sizes.

Nothing else from Text is covered.

Figure 14.34 
Express Tools (Blocks).

Figure 14.35 
Express Tools (Text).
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Layout Tools, Dimensions, and Selection Tools
Nothing from these Express tools categories is covered.

Modify
Flatten objects is a great tool for 3D work and flattens (converts) a 3D image into a 2D one. 
Nothing else from this Express Tool category is covered.

Draw
Students have found the Break-Line Symbol one of the most useful Express Tools, because 
everyone seems to hate drawing one from scratch. Here the process of making one is as easy 
as clicking two points and indicating a midpoint for the actual break line. Try it by selecting 
the command and specifying a first and second point along a line; then, using the MIDpoint 
OSNAP, place the break symbol in the middle.

Be careful with Super Hatch…, which creates hatch patterns out of ordinary images by 
basically copying them many times over to fill an area. This looks interesting but really slows 
down the computer, as graphics are copied over and over.

Figure 14.36 
Arc-aligned text.

Figure 14.37 
Arc-aligned text example.



level 2  
Chapters 11–20

322

File Tools, Web Tools, and Tools
Nothing from these Express Tools categories is covered.

Layer Express Tools
The Express Tools just covered are the most useful ones to the average designer and the ones 
I have used the most over many years of varied experience. However, you should still review 
the others at your own pace, just to know what is available. You will find a lot of overlap and 
redundancy between what is still in the Express Tools and what has been incorporated into 
regular AutoCAD. Autodesk does not like to throw much away.

The Express Tools are also missing something very important, perhaps the most important 
tools of all: the Layer Express tools. They were once part of the gang, but their importance 
has been acknowledged by an upgrade to permanent status within regular AutoCAD menus. 
Although there are a bunch of them (most are redundant), we focus on the primary three 
that are of significant importance:

l	 Layer Freeze (command line, layfrz).
l	 Layer Isolate (command line, layiso).
l	 Layer Walk (command line, laywalk).

Besides typing, these tools are also accessible via the drop-down menus under 
Format→Layer tools, as seen in Figure 14.39.

Layer freeze
In a complex drawing, layers may number in the dozens or even hundreds. Any tool that can 
simplify dealing with them is a welcome addition. Layer Freeze allows you to freeze a layer 
merely by selecting it. This bypasses the tedious process of finding out what layer an object 
is on (if not known), then freezing it manually via the LA dialog box or the toolbar. Simply 
type in layfrz or select Format→Layer tools→Layer Freeze.

m	 AutoCAD says: Select an object on the layer to be frozen or [Settings/Undo]:

Pick an object that represents the layer you want frozen and it disappears. This can be repeated 
as often as needed and is a good way to clear a lot of junk from a busy, dense drawing.

Figure 14.38 
Express Tools (Draw).
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Layer isolate
Layer Isolate allows you to isolate a layer merely by selecting it. The command turns off 
(not freezes in this case) all the other layers, leaving the selected one by itself. This bypasses 
the tedious process of doing it manually. Simply type in layiso or select Format→Layer 
tools→Layer Isolate.

m	 AutoCAD says:
Current setting: Hide layers, Viewports = Vpfreeze
Select objects on the layer(s) to be isolated or [Settings]:

Pick an object that represents the layer you want isolated, press Enter, and all the others 
disappear. It is another good way to clear a dense drawing.

Layer walk
This is perhaps the most interesting one of all the layer controls and a good way to shuffle 
through an entire drawing layer by layer. Layer Walk presents a list of layers and isolates one 
of them. Then you use the arrow keys on your keyboard to select your way up or down the 
list. AutoCAD turns layers on or off in succession, allowing you to inspect each layer, one at 
a time (walk through them). To try this, open up any file that has a number of layers. Then 
type in laywalk and press Enter or select Format→Layer tools→Layer Walk….

A dialog box appears, listing all the layers that are visible from layer 0 until the last one, as 
shown on a sample file in Figure 14.40. Click on layer 0; it highlights that layer and all the 
rest disappear. Use the arrow keys to cycle down through each layer, and notice how each 
one appears and disappears as its turn comes up in the listing.

This is a great tool to review all the layering on an unfamiliar drawing as well as one of your 
own to ensure accuracy. You will notice that along the way many AutoCAD designers let their 
layering accuracy slip as the project gains complexity, and by the end, layers are sloppy, with 
objects residing where they are not supposed to be.

Figure 14.39 
Layer Express Tools.
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After inspecting all the layers, you can either stop on any one of them for editing, or if the 
Restore on exit selection box is checked, then all the layers come back on when you press 
Close.

Most of the other layer commands are redundant, as you can already perform these functions 
in other familiar ways (via the LA dialog box or toolbar), so we do not discuss them further, 
but review them at your own pace.

Level 2 drawing project (4 of 10): architectural  
floor plan
Here we create a rudimentary electrical plan using outlets, lights, switches, and wiring. Create 
the appropriate layers, which should at a minimum include

l	 E-Switch
l	 E-Outlet
l	 E-Light
l	 E-Wiring
l	 E-Panel

Some of the symbols are shown in Figure 14.41, connected by a wire. They are reasonably 
close to the standard you may find in architectural design, but that of course can vary, 
especially in regard to how architects choose to represent lighting. Even with switches and 
outlets, there are numerous types (dimmer, three-way, duplex outlet, GFI, etc.), so this only 
scratches the surface. Be sure to follow the standard at your company. The plan is of course 
greatly simplified from the original and does not follow strict electrical guidelines; it is 
primarily an exercise for you to become familiar with electrical drafting.

Lay out the electrical devices as seen in the floor plan in Figures 14.42–14.44. Some of the 
wiring runs use spline.

Figure 14.40 
Layer Walk.
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Figure 14.43 
Floor plan, living room.

Figure 14.41 
Some electrical symbols.

Figure 14.42 
Floor plan, bedroom and bathroom.
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Summary
You should understand and know how to use the following concepts and commands before moving on to 
Chapter 15.

l	 Files tab
l	 Display tab
l	 Open and Save tab
l	 Plot and Publish tab
l	 System tab
l	 User Preferences tab
l	 Drafting tab
l	 3D Modeling tab
l	 Selection tab
l	 Profiles tab
l	 Shortcuts

m	 pgp file
l	 CUI
l	 Design Center
l	 Express Tools

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 14.

1.	 What is important under the Files tab?

2.	 What is important under the Display tab?

3.	 What is important under the Open and Save tab?

4.	 What is important under the Plot and Publish tab?

5.	 What is important under the System tab?

6.	 What is important under the User Preferences tab?

7.	 What is important under the Drafting tab?

8.	 What is important under the Selection tab?

9.	 What is important under the Profiles tab?

10.	 What is the pgp file? How do you access it?

Figure 14.44 
Floor plan, kitchen and garage.
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11.	 Describe the overall purpose of the CUI.

12.	 Describe the purpose of the Design Center.

13.	 Describe the important Express Tools that are covered.

EXERCISES
1.	 Based on what you learned about the Options dialog box, set up your own profile. Be sure to include 

or at least consider all the variables and settings discussed. Save the profile as Profile_1_Your_Name. 
(Difficulty level: Easy; Time to completion: 10 minutes)

2.	 Based on what you learned about the pgp file, create your own based on whatever abbreviations you 
prefer. Be sure to utilize the commands shown in Figure 14.21 as well as add any of your own that you 
may want included. (Difficulty level: Easy; Time to completion: 20 minutes)

3.	 Based on what you learned about CUI, create your own toolbar that features the following command 
icons:

Line
Circle
Rectangle
Move
Copy
Rotate
Offset

(Difficulty level: Easy; Time to completion: 15 minutes)

4.	 Review the Express Tools. Practice creating another arc-aligned text and break line. Open up any 

multilayer file and review the Layer tools: layfrz, layiso, and laywalk. (Difficulty level: Easy; 
Time to completion: 20 minutes)
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CHAPTER

Advanced Design and File 
Management Tools

LEARNING OBJECTIVES
In this chapter we continue to introduce a variety of advanced tools and discuss the 
following:
l	 Align command
l	 Audit and Recover commands
l	 Break and Join commands
l	 CAD Standards
l	 Calculator command
l	 Defpoints concept
l	 Divide and Point Style commands
l	 Donut command
l	 Draw Order command
l	 eTransmit command
l	 Filters

15



level 2  
Chapters 11–20

330
By the end of the chapter, you will have added significantly to your command repertoire.

Estimated time for completion of chapter: 3 hours.

15.1  Introduction to advanced design and file 
management tools
 This is easily the most diverse and unique chapter you will read in the book. This text 
was written from the start to simplify and isolate core topics and essential ideas, without 
cluttering the themes with additional AutoCAD commands and concepts. Several more 
“big ideas” are left, such as Xrefs and Attributes. Those are addressed in upcoming chapters. 
However, that leaves out a great deal of useful concepts and commands that did not quite 
fit in anywhere else. These bite-sized chunks of information form the basis of this chapter. 
Many of these topics are just random commands, standing alone, not part of any other major 
concept, some are part of a larger family, but all are useful to one extent or another and are 
necessary for a well rounded knowledge of AutoCAD.

In this chapter we really look into the nooks and crannies of AutoCAD and try to cover 
just about anything you may find browsing through the menus. Obviously this is not an 
exhaustive list, some items have been left out due to marginal usefulness or just space 
limitations, but for the most part the important ones are here. The list is in alphabetical 
order. Go through it at your own pace, noting how each concept or command can help you 
in your design work. There is much to discover.

15.2  Align
This command does exactly what it advertises, aligns one object to another. In Figure 15.1, 
we have a rectangle drawn and rotated to some random angle and below it a line. While one 
can always measure the angle of the rectangle and use the Rotate command, there is a much 
easier and accurate way to align the rectangle to the line (or vice versa).

l	 Hyperlinks
l	 Lengthen command
l	 Object snap tracking
l	 Overkill
l	 Point command
l	 Publish command
l	 Rasters
l	 Revcloud command
l	 Sheet sets
l	 Selection methods
l	 Stretch command
l	 System variables
l	 Tables
l	 Tool palette
l	 UCS and crosshair rotation
l	 Window tiling
l	 Wipeout command
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Type in align and press Enter. You can also use the cascading menus Modify→3D 
Operations→Align. There are no toolbar or Ribbon equivalents.

m	 AutoCAD says: Select objects:

Select the object to be moved into alignment (the rectangle). Press Enter.

m	 AutoCAD says: Specify first source point:

Pick the lower left corner of the rectangle using the endpoint OSNAP (point 1 in Figure 15.2).

m	 AutoCAD says: Specify first destination point:

Pick the left point of the line using the endpoint OSNAP (point 2 in Figure 15.2).

m	 AutoCAD says: Specify second source point:

Pick the lower right corner of the rectangle using the endpoint OSNAP (point 3 in  
Figure 15.2).

m	 AutoCAD says: Specify second destination point:

Pick the right point of the line using the endpoint OSNAP (point 4 in Figure 15.2).

Figure 15.1 
Alignment objects.

Figure 15.2 
Alignment, points.
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m	 AutoCAD says: Specify third source point or <continue>:

You have no need for a third set of points, so press Enter.

m	 AutoCAD says: Scale objects based on alignment points? [Yes/No] <N>:

There is something interesting you can do here. Not only can you align the rectangle to the line, 
but you can also scale it up to the line if needed by selecting Yes. We do not try this now but 
go back after learning the basic Align command and try this variation of it. For now just press 
Enter to accept the default No option. The rectangle is aligned to the line, as in Figure 15.3.

15.3  Audit and recover
Though rare, AutoCAD does lock up and crash (usually a hardware or memory issue but can 
also be software related). In the event of a crash, the drawing is automatically saved but may 
be corrupted when you try to open it up again. Sometimes also drawings just cause AutoCAD 
to behave oddly for no specific reason (i.e., commands do not work as expected or just fail). 
In either case, the drawing needs to be audited or recovered.

Auditing is the lower-level check. AutoCAD evaluates the integrity of the drawing and corrects 
some errors. You simply type in audit and press Enter; alternatively use the cascading menus 
Application menu→Drawing Utility→Audit. There is no toolbar or Ribbon equivalent. 
AutoCAD asks about fixing any detected errors (Yes), cycles through drawing entities, and 
in a few seconds generates a log similar to what you see next (assuming nothing wrong was 
found or fixed as seen here):

Auditing Header
Auditing Tables
Auditing Entities Pass 1
Pass 1 100 objects audited
Auditing Entities Pass 2
Pass 2 100 objects audited
Auditing Blocks
1 Blocks audited
Total errors found 0 fixed 0
Erased 0 objects

Of course if something is found, fixes are reported. Sometimes however audit is not enough 
and you must recover the drawing. This is not as drastic as it sounds. The Recover command 
is powerful and almost always brings the drawing back as a matter of routine. I can count 
on one hand the number of drawings that were lost forever due to corruption in 14 years 
of CAD design. And even in those cases, going to the previous night’s backups restored the 
drawing, minus a few hours of work.

To use this feature, open a blank drawing file, type in recover, and press Enter; alternatively 
use the cascading menus File→Drawing Utilities→Recover. There is no toolbar or Ribbon 

Figure 15.3 
Alignment, final results.
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equivalent. You are prompted to browse and find the unfortunate drawing. Once you select it 
and press Open, Recover runs and generates its own log, as seen here (assuming nothing was 
found, as I ran both Audit and Recover on clean files to generate these logs):

Drawing recovery.
Drawing recovery log.
Scanning completed.
Validating objects in the handle table.
Valid objects 755 Invalid objects 0
Validating objects completed.
Salvaged database from drawing.
Auditing Header
Auditing Tables
Auditing Entities Pass 1
Pass 1 900 objects audited
Auditing Entities Pass 2
Pass 2 900 objects audited
Auditing Blocks
19 Blocks audited
Total errors found 0 fixed 0
Erased 0 objects

Following the log, you see the message box shown in Figure 15.4.

However, if something is wrong, Recover should fix it and the drawing opens as normal. 
Immediately save it.

15.4  Break and join
The Break command can take a geometric object and put a break in it (remove a section, 
in other words) or, if applied at an intersection with another object, break that object at 
the intersection without actually removing any material. The Join command is the exact 
opposite. It adds material to close the break, but works only in certain circumstances. Let us 
examine each command closer.

Break, Method 1
Draw a line of any size or direction and start Break via any of the following methods.

Figure 15.4 
Recover message.



level 2  
Chapters 11–20

334

m	 AutoCAD says: Select object:

Go ahead and click to select the line at some random spot. It turns dashed.

m	 AutoCAD says: Specify second break point or [First point]:

Pick another nearby point on the line, and a section between these two points is removed 
(Figure 15.5).

In this method you have no control over the first point of the break. When you selected the 
line, the first point was chosen. However, as shown in the next method, you can select the 
line to be broken, then using the First point option, specify exactly where to start the break. 
We use this to our advantage to create four lines out of two, as seen next.

Break, Method 2
Draw a horizontal line of any size, followed by a perpendicular vertical one that is of equal 
size. They should cross perfectly in the middle. You will have a plus sign. One good trick to 
do this is to first draw a circle and just connect the four quadrant points with two lines, as 
seen in Figure 15.6.

Start the Break command via the previous methods.

m	 AutoCAD says: Select object:

Go ahead and click to select the horizontal line at some random spot. It turns dashed.

m	 AutoCAD says: Specify second break point or [First point]:

Type in f for First point.

m	 AutoCAD says: Specify first break point:

Using OSNAPs select the midpoint of the horizontal line.

m	 AutoCAD says: Specify second break point:

Once again, using OSNAPs, select the same midpoint of the line.

Figure 15.5 
Break command.

Figure 15.6 
Setup for Break, Method 2.
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Now repeat these steps with the vertical line. The result is four lines where there were only 
two just moments earlier, as seen in Figure 15.7, when the grips are revealed. All four are 
broken at their intersection.

Join
The Join command is included here because it is the exact opposite of Break. It closes the gap 
between two coplanar lines. Note the important disclaimer, however. The Join command does 
not unite two lines that are not on the same plane. This means that, if they are not pointing in 
the exact same direction and are not literally “one after the other,” then Join does not work.

Draw two coplanar lines (or use Break to put a gap in), as seen in Figure 15.8.

Figure 15.7 
Break, Method 2.

Figure 15.8 
Setup for Join.

Start the Join command via any of the previous methods.

m	 AutoCAD says: Select source object:

Select the first line.

m	 AutoCAD says: Select lines to join to source:

Select the second line.

m	 AutoCAD says: Select lines to join to source:

You are done with the two segments, so press Enter.

m	 AutoCAD says: 1 line joined to source

A solid line takes the place of the two segments.

15.5  Cad standards
This is a rather obscure procedure that may be valuable to a few organizations, and I have 
on occasion recommended it to prime contractors who often find their design files bouncing 
around from subcontractor to subcontractor. After all the respective additions to the drawings 
are finished, they are sent back to the main contractor. There it is found that the standards 
have deteriorated, as everyone did his or her own thing in regard to layers and text or dim 
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styles. A way to identify and clean up the mess would be useful, hence the existence of this 
tool.

The CAD Standards procedures can be a bit confusing, and the process does not guarantee 
effortless and perfect results. Depending on the damage, you may still need to do manual 
cleanup of layer properties, errant fonts, and the like. The best defense is to hold all others 
who may work on your drawings to a high standard from the start and outline what is 
acceptable and what is not. Obviously this can be challenging in just one office, never mind 
implementing it for designers at other remote locations.

Here is the basic idea. Come up with one file that is in great shape. This can be a regular 
job that is singled out for its perfect or near perfect use of company standards and is of 
the highest quality and integrity. Then do a Save As for this job under a .dws (drawing 
standards) extension. This is your standards file. All others are compared to it as they come 
in from subcontractors or just other designers.

To implement it, open up a job that just came in and is of questionable CAD quality. 
Type in standards and press Enter; alternatively use the cascading menu Tools→CAD 
Standards→Check…. There is no toolbar or Ribbon equivalent. The Configure Standards 
dialog box appears, as seen in Figure 15.9.

Next use the plus () sign to open up the saved dws file. The file appears in the window on 
the left with some descriptions on the right. The Check Standards button (lower left) also 
lights up, at which point you press it to execute the check. The Check Standards dialog box 
appears as seen in Figure 15.10.

Next you need to run through the fixes, item by item. Continue pressing the Fix button as 
AutoCAD runs through the fixes and matches up text, layers, and other items. When done, 
the Checking Complete notice in Figure 15.11 displays.

15.6  Calculator
The calculator is a surprisingly powerful and versatile tool within AutoCAD, and one that is 
often ignored by users. The function’s power and versatility should come as no surprise, as 

Figure 15.9 
Configure standards.
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AutoCAD itself is highly mathematical software, a calculator in itself, performing complex 
operations “under the hood” as you draw, copy, and rotate objects.

The calculator function can perform all regular and scientific calculations you would expect 
from a handheld device, but, in addition, can assist you in the construction of geometry and 
even allows you to use AutoLISP, a programming language. We do not go in-depth here by 
any means but provide one example of construction assistance using the transparent line 
command calculator and one example of the actual graphic calculator tool (QuickCalc) 
to do unit conversions. You are encouraged to read the Help Files for a wealth of additional 
information.

First a brief overview of the Cal command. This was the original version of the calculator.  
It is a command line tool enabled by typing in cal and pressing Enter. AutoCAD then  
says: >> Expression:, at which point you can enter some math function using the familiar 
characters such as , , *, and /. Pressing Enter again yields an answer.

Not too long ago the limit of the calculator was 32,767 and 32,768 as the largest displayable 
final integer, but that restriction was lifted somewhere around the AutoCAD 2005 release, and 
you can now work with integer numbers between 2,147,483,647 and 2,147,483,648 (that is 
2 to the 15th and 31st powers, respectively, if you really wanted to know where those seemingly 
random numbers came from).

Let us use the previously described Cal command to assist in design, because crunching 
numbers alone can be done by your handheld or Windows calculator. Suppose you need 

Figure 15.10 
Check standards.

Figure 15.11 
Check complete.
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to offset a line one half of some number, but you do not know what that value is (say one 
half of 17.625”, for example). Instead of reaching for that calculator, let AutoCAD do both: 
calculate what one half of 17.625 is as well as offset the line, all in one command. To do this:

1.	 Draw a line of any reasonable size.
2.	 Start the Offset command via any method.
3.	 You do not know the offset distance so let us use the Calculator.
4.	 Type in ‘cal (the apostrophe makes Cal, or any command, temporarily transparent, 

meaning you can enter it without exiting out of another, in-progress command, which in 
this case is Offset). Press Enter.

5.	 The >>>> Expression: prompt asks for the expression. Enter 17.625/2 and press Enter.
6.	 Your answer (8.8125) appears, and you may resume the Offset command.
7.	 Continuing as usual, select the line and pick a direction to complete the Offset and Esc to exit.

This was a very simple case of how the Calculator assists in design tasks. It can do a lot more 
in that regard and you are encouraged to examine the Help Files for additional examples. We 
now however move on to briefly introduce the QuickCal.

The Calculator function is not command line limited but also now comes in a graphic 
version.

Figure 15.12 
QuickCalc.

Figure 15.12 shows what you see.

The Number Pad and Scientific keypads are self-explanatory. If you ever used a handheld 
calculator, you should be right at home with this one. Variables, at the bottom, are not 
covered, but Units Conversion deserves a special mention. It is a very useful tool for 
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converting between a wide variety of Length, Area, Volume, and Angular values. Simply select 
from the fields on the right (drop-down arrows appear) and enter the values to convert just 
below that. A converted value appears according to what you requested.

15.7  Defpoints concept
Defpoints is not a command, but rather a concept that pops up often and bears a short mention. 
Defpoints stands for Definition Points, and they appear in the drawing (and mysteriously in 
the Layers dialog box, where most users first notice them) as soon as you add any dimension 
to your drawing. What are they exactly? They are the tiny points where a dimension attaches 
itself to the object being dimensioned. The Defpoints layer does not go away easily and usually 
prompts questions from students as to its nature and intent. The layer fortunately does not plot, 
and you can pretty much disregard its existence if you choose. One benefit of it not plotting is 
that you can put any objects that you do not want to see on paper on it (such as viewports, as is 
discussed in Chapter 10). In fact that is exactly what many users do, though a dedicated VP layer 
is recommended instead. In conclusion, do not worry about Defpoints and continue on.

15.8  Divide and point style
Divide does exactly what it advertises; it divides an object into equally spaced intervals. 
Note however that the object is not actually broken into those segments (that is for a Break 
command to do) but rather just divided by equally spaced points. Then you can use these 
points as guides for further work. Let us give this a try. Draw a horizontal line of any size.

Type in divide and press Enter; alternatively use the cascading menu 
Draw→Point→Divide. There is no toolbar or Ribbon equivalent.

m	 AutoCAD says: Select object to divide:

Select the line.

m	 AutoCAD says: Enter the number of segments or [Block]:

Enter some value, 8 for example, and press Enter.

The line looks the same, with no apparent divisions. It seems as though the command has 
not worked. It actually worked just fine, and the line is divided into the eight segments using 
seven points, as expected. The problem is that you cannot see the points; they are obscured 
by the line, and we need to change the point style to something more visible. Using the 
cascading menu, select Format→Point Style. You see what is shown in Figure 15.13.

Figure 15.13 
Point style.
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Select a point style that is not too complex; the X format in the top row is a popular one. 
Press OK and the divided line appears as you were expecting it, divided into the eight visible 
segments (Figure 15.14).

15.9  Donut
While this command may not be used all that often, it is still worth a mention. It creates 
exactly what it advertises: a donut of varying size. Broken down into its components, a donut 
is two circles of different size, one inside the other, and a fill. You have control over the sizes 
of both circles and, as a result, the size of the donut.

Figure 15.14 
Divided line.

Figure 15.15 
Donut.

Start the Donut command via any of the previous methods.

m	 AutoCAD says: Specify inside diameter of donut <0.5000>:

You can accept this value by pressing Enter or type in another (we accept the 0.5 here).

m	 AutoCAD says: Specify outside diameter of donut <1.0000>:

Once again you can accept this value or type in your own (we accept the 1.0 here).

m	 AutoCAD says: Specify center of donut or <exit>:

Click anywhere on the screen and the donut appears, as seen in Figure 15.15.

15.10  Draw order
Draw Order refers to the stacking order of objects that are positioned one on top of another. 
This feature is commonly used in most graphic design programs and has an occasional use 
in AutoCAD as well. The stacking order is usually not of major concern in day-to-day basic 
drafting. If items intersect, the one drawn last is on top; and in cases of two intersecting lines, 
the intersection point is one pixel in size, hardly worth mentioning. Sometimes, however, 
such as when two or more hatch patterns are stacked, the order is critical. We use this feature 
later in this chapter to great effect when we discuss Wipeout. For now just know where the 



CHAPTER 15  
Advanced Design and File Management Tools

341

Draw Order command is. It is found in the cascading menu under Tools→Draw Order, with 
options for Objects, Text, and Dimensions.

Bring to Front and Send to Back send objects strictly to and from the top and bottom of the 
order, while Bring Above Objects and Bring Below Objects are more selective, moving items 
one step at a time. With these four tools you can arrange any amount of objects in any order.

15.11  eTransmit
The purpose of this command is to assist with emailing drawings. The problem is that, when 
drawings are sent out, items can be inadvertently omitted. These omissions may include 
something major, like associated Xrefs, or something secondary, such as fonts and styles. As 
a project grows more complex it is easy to forget to send Xrefs and even easier to forget about 
the unique fonts, styles, and ctb files that have been generated over time. The recipient of the 
email may have only some of these, and what he or she downloads and reconstructs on that 
end may not be quite what you intended to be seen.

eTransmit is a “go-getter” of sorts. It sniffs out every associated file and everything else 
that may be relevant to recreate the file(s) in a new location as originally intended. Then it 
packages everything together in a folder and sends it out. While veteran users have remarked 
that an experienced and aware designer needs to always have a clear idea of what to send 
(eTransmit is a recent invention, after all), it is still a valuable tool for novice and expert alike.

So what is (and is not) included in the eTransmit transmittal? Here is a partial list of what is 
included. You should know of most of these files. If not refer to Appendix C.

*.dwg: Root drawing file and any attached external references.
*.dwf: Design web format files that are attached externally to the root drawing or Xrefs.
*.xls: Microsoft Excel spreadsheet files that are linked to data extraction tables.
*.ctb: Color-dependent plot style files used to control the appearance of the objects in 
the drawings of the transmittal set when plotting.
*.dwt: Drawing template file associated with a sheet set.
*.dst: Sheet Set file.
*.dws: Drawing standards file associated to a drawing for standards checking.

Here is a partial list of what is not included. Do not worry if you do not recognize all these 
formats. You will know most of them by the end of Level 2.

*.arx, *.dbx, *.lsp, *.vlx, *.dvb, *.dll: Custom application files (ObjectARX, 
ObjectDBX, AutoLISP, Visual LISP, VBA, and .NET).
*.pat: Hatch pattern files.
*.lin: Linetype definition files.
*.mln: Multiline definition files.

To use eTransmit, save your work but keep the file open. Type in etransmit and press Enter; 
alternatively use the cascading menu File→eTransmit…. There is no toolbar or Ribbon 
alternative. You are asked to save the file if it has not been saved yet. Then, the dialog box in 
Figure 15.16 appears.

The procedure is highly automated, but you do have to select a few parameters. The current 
drawing that is open is the one that is packaged together. Some of the included items are shown 
in the file tree. Expanding the  signs shows specific files (which you can deselect if desired). You 
also add more drawings to the transmittal using the Add File button. If you are fine with just the 
current drawing then press the Transmittal Setups button. You see the dialog box in Figure 15.17.

Let us create a new setup as an exercise. Press the New button and the dialog box in  
Figure 15.18 appears. Give the transmittal a name and press Continue. The dialog box in 
Figure 15.19 then appears.
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All you really have to do here is visually check all the settings. Looking at the fields from top 
to bottom, we see the Zip option for actually sending the files (recommended), followed 
by a variety of information related to formats, names, and locations. Finally, below that, 
we have a number of checked-off options. You should keep the files in one folder and 
include everything listed in the first four options. The last four options, in contrast, may be 
unnecessary. Use your best judgment.

Figure 15.16 
Create transmittal.

Figure 15.17 
Transmittal setups.

Figure 15.18 
New transmittal setup.
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When done press OK, then Close in the next dialog box (Figure 15.17), and finally OK in 
the main setup box (Figure 15.16). You are asked where to put the Zip file and for any last-
minute name changes. Pressing Save drops the file into its place, and it is ready for emailing.

15.12  Filters
Filters were briefly discussed in the context of layers (Chapter 12). While the idea is roughly 
similar, the application is slightly different, so let us review them from the beginning.

Filters are nothing more than a method to isolate and select objects using their features or 
properties. So, for example, you can isolate and select all the circles by virtue of them being 
circles, and find green objects because they all have green in common. You can also add 
together properties and create requests like: “find me circles that are red only” and so on. 
This is a good tool for quickly finding stuff in a complex drawing.

To experiment with filters, let us first create a simple drawing that is just a collection of 
shapes. Draw the set of circles, rectangles, and arcs in Figure 15.20. Then change the shapes’ 
colors to blue or red.

Type in filter and press Enter. There is no cascading menu, toolbar, or Ribbon equivalent. 
Object Selection Filters appears, as shown in Figure 15.21. The procedure here is to first select 
the filter, then add it to the list, and finally apply it.

Select Arc from the Select Filter drop-down menu on the left. Then press the Add to List: 
button just below that. For good measure let us also add the color red. Select color from the 
same Select Filter menu. Notice at that point the Select button lights up. Go ahead and select 
the color red. Then press Add to List:. Your Filter should look like Figure 15.22.

Figure 15.19 
Modify transmittal setup.
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Now press the Apply button. AutoCAD asks you to select objects. Select everything by typing 
in all. Every red arc in the drawing becomes dashed after the first Enter. Press Enter again 
and the grips come on, as seen in Figure 15.23. Now type in Erase and press Enter. Because 
they are selected, all the red arcs disappear. Filters can be saved for future use via the Save As: 
button and the listing can be modified or deleted via the Edit Item, Delete, and Clear List 
buttons.

15.13  Hyperlinks
The Hyperlink command attaches a hyperlink to either an object or text. During this process, 
you are asked to specify what this hyperlink opens when activated. It can be a website (usually) 
or a document (sometimes). In either case, it is a great command to quickly access additional 

Figure 15.20 
Basic shapes for filter.

Figure 15.21 
Object selection filters.

Figure 15.22 
Object and color selected.
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useful information. Someone, for example, can see a drawing of a product and follow the link 
to a website of the manufacturer or call up an Excel file that lists all the specs of a design.

To try out the Hyperlink features, draw a symbol for a chair and a regular text website 
address, as seen in Figure 15.24. Make a block out of the chair.

We would like to link the chair (an object) to a furniture website (IKEA®, for example) and 
link the Google text (a text string) to the Google website. Type in hyperlink and press Enter; 
alternatively use the cascading menu Insert→Hyperlink. There is no toolbar or Ribbon 
equivalent. AutoCAD asks you to select objects. Go ahead and pick the chair block. The 
dialog box in Figure 15.25 then appears.

Enter the name of the desired website in the appropriate field. That is where it says Type the 
file or Web page name not the Text to display. Not much else needs to be done, so press OK. 
Repeat the process for the Google text.

Figure 15.23 
Red arcs selected by filter.

Figure 15.24 
A shape and text for the hyperlink.

Figure 15.25 
Insert hyperlink.
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Hover your mouse over the chair and the Google text and notice something new. A hyperlink 
symbol appears with text prompting you to hold down the Ctrl key and click to follow the 
link (Figure 15.26). If your computer is currently connected to the internet, go ahead and do 
that in both cases (chair and Google) to bring up the respective websites.

There is an interesting variation to this, as mentioned earlier. You need not attach a website 
to the link. You can also attach a regular document, so it is called up when the hyperlink 
is clicked on, as before. Pretty much anything can be attached if it can be found and the 
computer can run the application; Word, Excel, PowerPoint documents, pictures, videos—
you name it.

To do this, follow the same steps as before, but this time select the File button under the 
Browse for: header on the right side of the dialog box. Find the file of interest, double-click 
on it, and OK the Hyperlink dialog box. That is it; the document is now attached to your 
object or text and supersedes any other links you may have.

15.14  Lengthen
The Lengthen command is quite a lot like Extend in its effect, but goes about doing it 
differently. It is worth adding to your AutoCAD vocabulary. The command works by 
lengthening nonclosed objects, such as lines or arcs (circles and rectangles do not qualify). 
You can lengthen the objects by change in size [DElta], by percentage added or subtracted 
[Percent], by total final size [Total], or dynamically “on the fly” [Dynamic]. All this 
applies to angles (of arcs) as well. To try it out, draw an arc and a line (Figure 15.27).

Type in lengthen and press Enter. Alternatively use the cascading menu Modify→Lengthen. 
There is no toolbar or Ribbon equivalent.

m	 AutoCAD says: Select an object or [DElta/Percent/Total/DYnamic]:

Pick the Percent choice by typing in p and pressing Enter.

m	 AutoCAD says: Enter percentage length <100.0000>:

Enter a value such as 150 and press Enter.

m	 AutoCAD says: Select an object to change or [Undo]:

Pick the line and it lengthens 150%. Press Esc to exit the command.

The process is essentially the same with the arc and other lengthening options. Repeat the 
command several times and run through each option.

Figure 15.26 
Hyperlink.
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15.15  Object snap tracking
Object snap tracking is a drawing aide that allows you to find various OSNAP points of an 
object and connect to them without actually drawing anything that touches that object, a 
sort of remote OSNAP. This function can be activated when the OTRACK button is pressed 
in at the bottom of the AutoCAD screen and is deactivated when the button is pressed back 
out. The best way to see the purpose and function of this command is to try it. Draw a series 
of rectangles or squares spaced some distance apart, as shown in Figure 15.28. You need not 
number them; that is only for identifying purposes.

What we want to do is connect a series of lines from (and to) the midpoints of each of these 
shapes via right angles (not directly). An example of this may be a cable diagram or an 
electrical schematic. One way would be to start a line from the midpoint of the right side of 
shape 1, stop somewhere randomly, and repeat the process from the top of shape 2. Then you 
can use Trim, Extend, or Fillet to connect the lines. This, however, is cumbersome and slow.

A better way is to begin the line from the right side midpoint of shape 1 as before (turn on 
ORTHO also), but then activate OTRACK, and without clicking, position the mouse over the 
midpoint of the top of shape 2. A straight dashed vertical line appears. Follow that dashed 
line back up until the mouse meets the straight horizontal dashed line. Then and only then, 
click once and continue to draw the line to shape 2. This is shown in Figure 15.29. Notice 
what OTRACK does. It senses where that midpoint of shape 2 is and gives you a position to 
confirm and click before proceeding. Complete similar lines from the bottom of shape 2 to 
the top of shape 3 and then 4.

15.16  Overkill
This interesting command is technically part of the Express Tools under Modify→Delete 
duplicate objects, but it is more entertaining to type in its rather dramatic other name. What 
Overkill does though is quite useful. It deletes duplicate objects that overlap each other. In 
the 2D flat world of AutoCAD, it can be quite challenging and time consuming to find these 

Figure 15.27 
Arc and line for lengthen.

Figure 15.28 
Shapes for OTRACK.
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overlaps, especially if similar shapes and colors are involved. With Overkill, you simply select 
the offending objects and AutoCAD figures out which to keep and which to delete, effectively 
merging them all into one.

To try it out, draw five lines, one on top of another. Although it may not be obvious to 
a novice, an experienced user notices these lines are a bit darker and “fuzzy,” indicating 
the presence of an overlap; it is subtle but there. Now type in overkill and press Enter. 
AutoCAD asks you to select objects. Select all five lines using a Window or Crossing (not  
one at a time) and press Enter when done. The dialog box in Figure 15.30 appears.

You can leave all the defaults as they are, pressing OK to have all the lines merge into one 
line. This is probably the simplest application of the Overkill command. However, what if 
the lines are on different layers?

In this case, you have to check off Ignore LAYERS and the command merges the layers into one. 
Numeric fuzz works by comparing the distances between nearly overlapping objects and acts 
on them if the distance falls inside the fuzz value. Overkill has other useful features as well, so 
go through the command, referring to the Express Tools Help File for more information.

15.17  Point
You have already seen and used points when we discussed the Divide command. In that 
case, points were created as a means to divide an object. To see them clearly, you needed to 

Figure 15.29 
OTRACK in progress.

Figure 15.30 
Overkill.
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modify the form of the point, from a dot to something more visible, using Format→Point 
Style…. The Point command can be used to create points from scratch, as described next.

Figure 15.31 
Publish command.

Start the Point command via any of the previous methods.

m	 AutoCAD says: Current point modes: PDMODE = 3 PDSIZE = 0.0000
Specify a point:

Click anywhere and a point appears.

15.18  Publish
The Publish command is a convenient way to print multiple sheets (Layouts) all at once. 
This command depends on knowing the basics of Paper Space, so you may want to review 
Chapter 10. Assuming, however, that you have done so, the idea here is quite simple. When 
a file with multiple Layouts is opened, the Publish command sees them and allows you to 
print them all at once, as opposed to clicking on each tab one at a time and using the Plot 
command. In Figure 15.31, I opened a file called Alta Elevation (a recent job that features 
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a design spread out over two Layouts: a Plan View and an Elevation View), then started the 
Publish command, which can be done via any of the following methods.

The dialog box in Figure 15.31 then appears. Note that it can be expanded, if it is not, by 
pressing the Show details button on the lower left.

The dialog box features some options to fine-tune publishing, such as adding additional 
sheets, plot stamp, deciding how many copies, and a few others. All you have to do at this 
point is just press the Publish button on the bottom and AutoCAD will print out one copy 
of every single Layout the file contains. It is quick and easy and saves time. Go ahead and 
explore this very useful command on your own for additional features.

15.19  Raster
Raster is a term you may hear of in AutoCAD circles, and it is not so much a command as 
a concept in graphic design. A raster graphic is nothing more than a bitmap, which in turn 
is a grid of pixels viewable on any display medium, such as paper or a computer monitor. 
This method of presenting graphics stands in marked contrast to vector graphics, which are 
based on underlying mathematical formulas. Vectors can be scaled up or down with no loss 
of clarity, while bitmaps cannot. So raster images are basically pictures. These can easily be 
inserted into AutoCAD as covered in a previous chapter.

Raster graphics hold a unique place in AutoCAD history. They were needed to implement a 
massive worldwide conversion from paper-based hand-drawn designs to CAD files. When it 
became obvious that computer-aided design was the future, millions upon millions of  
hand-drawn documents, spanning decades of design work, were scanned into the computer, 
became backgrounds, and were patiently redrawn. Government and private industries around 
the industrial world collectively spent large sums of money and many work hours to transform 
these archives into viable CAD files for future use. Most of this work was done during a ten-year 
span (1988–1998), though some of it was started prior and some work is still ongoing. I recall 
putting in some significant screen time doing these conversions early in my career, and for a 
new AutoCAD user this was excellent, if boring, practice: scan, draw, print, check, and repeat.

Raster scanning software can be quite sophisticated. At the time, we used regular large sheet 
scanners that simply pulled up the graphic on the screen. We then tugged at it until it was 
the right size (by comparing a drawn line to a scanned known dimension). Later we acquired 
more sophisticated software that actually recognized shapes and attempted recreating these 
pieces of geometry to somewhat mixed results. Any smudges, imperfections, or odd shapes 
could confuse the system. Noise level (sensitivity) settings were used to control how much 
was picked up, and it was usually better to set it lower, so you could add what was missing 
rather than constantly erase accidentally picked up junk. As an AutoCAD user today, you may 
never need these tools, but it is good to know what they are just in case.

15.20  Revcloud
This is a command that thousands of architects were screaming for. Revision clouds, or 
revclouds for short, are used to indicate changes on a drawing. You can draw an ellipse, 
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rectangle, or circle just as well, but the unmistakable cloud shape is noticed most easily. To 
draw one of these using the Arc command is certainly quite tedious. Let us give it a try the 
right way.

Figure 15.32 
Revcloud.

Start up the Revcloud command via any of the previous methods.

m	 AutoCAD says:
Minimum arc length: 0.5000 Maximum arc length: 0.5000
Style: Normal
Specify start point or [Arc length/Object/Style]
<Object>:

Click anywhere once.

m	 AutoCAD says: Guide crosshairs along cloud path...

Draw a circular shaped revcloud connecting the last arc to the first one (no extra clicking 
needed).

m	 AutoCAD says: Revision cloud finished.

Your result is should look somewhat similar to Figure 15.32 (you may have to zoom in or 
out to see the revcloud).

The command has several options. For example, if you do not connect the last arc to the first 
and instead just right-click, AutoCAD asks you: Reverse direction [Yes/No] <No>:. 
Here you can actually turn the revcloud “inside out,” though this is rarely done. You can 
also change the size of the cloud’s arcs by selecting the Arc length option, and even turn 
objects (like circle and rectangles) into revclouds using the Object option. Take the time to 
experiment with all of these.

15.21  Sheet sets
Like many new features in AutoCAD, these are not revolutions, rather but evolutions of 
previous ideas. This tool, introduced in AutoCAD 2005, was meant to combine some aspects 
of Paper Space Layouts and the Publish command with a few new twists, to create an “all under 
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one roof” method of setting up the printing of a project. The idea is to set up sheet sets (1 
Layout  1 Sheet) that define exactly what is needed to plot out the entire job correctly. These 
sheets can come from different drawings and even different jobs and are grouped together by 
their respective categories. The idea is that they are now easier to handle and organize.

While I have seen some reluctance in the industry to using a tool that somewhat duplicates 
existing functionality (even if new features are added), a few organizations, not surprisingly 
ones that produce jobs that span dozens of pages, took to this idea. We provide a very brief 
overview, and you can then decide if you want to pursue this further.

To create a sheet set, you need to set it up. Go to File→New Sheet Set… and you see what is 
shown in Figure 15.33. Select the first choice, an example sheet set, and press Next . What 
you see in Figure 15.34 appears. Select the appropriate sheet set, Architectural Imperial for 
example, and press Next . What you see in Figure 15.35 appears. Here you can give the set 
a name and location. Press Next  and what you see in Figure 15.36 appears. The various 

Figure 15.33 
Create sheet set, begin.

Figure 15.34 
Create sheet set, sheet set example.
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sheet sets sorted by category are visible. Press Finish and the Sheet Set manager appears, as 
seen in Figure 15.37.

This was all just to set up the basic sheets (placeholders). They are still blank and need 
drawings associated with them. Right-click on the Architectural folder and select Import 
Layouts as Sheet. What you see in Figure 15.38 appears.

You now have to browse for the right drawing associated with the Architectural layout. 
Continue down the categories until all are filled. This is just the basic idea of sheets sets. It 
is an extensive tool that can span many more pages of descriptions, and you should explore 
some of it on your own.

15.22  Selection methods
What we outline here are a few other methods of selecting items that you may have not yet 
seen: the Fence (F), Window polygon (WP), and the Crossing polygon (CP). All these are 

Figure 15.35 
Create sheet set, sheet set details.

Figure 15.36 
Create sheet set, confirm.
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applicable when selecting objects for a number of operations such as Erase, Move, Copy, 
Trim, and others.

To try out Window and Crossing polygons, draw a set of circles, as seen in Figure 15.39, and 
execute the Erase command. Then, when it is time to select objects, type in wp for Window 
polygon and press Enter.

Figure 15.37 
Sheet set manager.

Figure 15.38 
Import layouts as sheets.
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m	 AutoCAD says: First polygon point:

Click anywhere.

m	 AutoCAD says: Specify endpoint of line or [Undo]:

Continue to “stitch” your way around the circles you wish to select, and right-click when done. 
Notice the difference here between the standard window selection tool (strictly rectangular in 
nature) and the flexible “any shape you want it” Window polygon (Figure 15.39). Its action of 
course is similar; everything it encloses is selected.

The Crossing polygon (Figure 15.40) works the same exact way, except anything it touches 
gets selected, much like how the regular Crossing operates.

The Fence option works by having a drawn line be the cutting tool during a Trim command, 
and selects multiple lines to be trimmed. Draw a bunch of vertical lines, and one horizontal 
line, as seen in Figure 15.41. Then execute the Trim command, but when it is time to select 
the lines to be trimmed, type in f for fence, then click twice to draw a line across the lines to 
be trimmed, and press Enter to make them disappear.

In case you discovered it on your own, yes, you can accomplish the exact same thing using  
a regular Crossing to eliminate the lines once a cutting edge is selected. However, the  
Fence command comes in handy when going around corners, as the flexible line-based 
approach can bend around any shape, while the rigid rectangular shaped Crossing cannot.

Figure 15.39 
Window polygon.

Figure 15.40 
Crossing polygon.
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This is an easy command to learn and use, and it can work wonders for quick shape 
modifications. The Stretch command uses the Crossing tool to literally stretch shapes.  
Create two rectangles, as seen in Figure 15.42.

We want to stretch the right sides of both rectangles some distance. Start the Stretch 
command via any if the following methods.

Figure 15.41 
Fence command and the results.

Figure 15.42 
Rectangles for stretch.

Using a Crossing (this does not work with the Window selector), select the first quarter or so 
of the rectangles, as seen in Figure 15.43.

They become dashed. Press Enter and click anywhere to begin stretching them, as seen in 
Figure 15.44. You need to have Ortho on and all OSNAPs off.

Finally click elsewhere and the rectangles have a new length. You did not have to explode 
and redraw them or use grips. You can use the Displacement option to key in specific X, Y,  
or Z distances or stretch to another OSNAP point. Note that stretch does not work on 
partially selected circles and it moves, not stretches, fully selected ones.
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15.24  System variables
There is not much to say about system variables except to make you aware of what they are, 
so if they come up in reading of other texts or the AutoCAD Help Files, you know what you 
are dealing with. System variables are Yes/No, On/Off, or 0, 1, 2, 3 types of commands used 
to indicate a preference or a setting. AutoCAD has over 500 of them for every conceivable 
variable (something that changes) in the software, and listing them all is futile, though if 
you wish to see them all, type in setvar, press Enter, then type in ?, and press Enter twice. 
Many system variables are set graphically via a dialog box, and users may not even be aware 
or know it is a system variable they are changing. Perusing the Help Files and AutoCAD 
literature, especially on an advanced level, you will find many references to these. Knowing 
system variables is important for those wishing to learn advanced customization (such as 
AutoLISP).

Here is a useful example that is typed in on the command line. Suppose you were mirroring 
text and the new set is backwards, as seen in Figure 15.45.

That is not quite right, as you want text to be readable even after mirroring, so some sort 
of system variable (SV) needs to be set. The responsible SV is called mirrtext, and it is of the 
On/Off variety represented by 0 and 1. Somehow it got set to 1, and needs to be 0. Type 
in mirrtext, press Enter, type in the new value of 0, and press Enter again. Try the Mirror 
command again—it should work fine now.

As mentioned before, this is just one example; there are hundreds of others. Keep an eye out 
for them. After years of using AutoCAD you will amass a formidable collection of useful  
SVs that can resolve some thorny problems for less experienced designers.

Figure 15.43 
Stretch in progress, 1.

Figure 15.44 
Stretch in progress, 2.
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15.25  Tables
If you have not yet used tables, here is a quick primer on them. They are pretty much what 
you expect, a bunch of rows and columns, with a header on top, ready for you to enter 
information. You can specify the number of rows and columns and add or take them away 
at a later time as well. Tables are quite reminiscent of low-tech Excel spreadsheets and can be 
useful in certain situations (like when you need data displayed in a hurry).

We cover some basics here and let you explore more on your own. Start the Table command 
via any of the following methods.

Figure 15.45 
Mirrtext.

Figure 15.46 
Insert table.

You then see Figure 15.46.

Under the Column & row settings: set your columns and rows as well as their respective 
widths and heights (we do a 10  10 here). When done press OK and you are asked to click 
where you want the table to go. When you position it, you see what is shown in Figure 15.47.



CHAPTER 15  
Advanced Design and File Management Tools

359

Here you are asked to set up the header. Type in Sample Data Table and press OK. You see 
the completed table in Figure 15.48. You can now fill in the table with data by clicking in 
each individual cell and typing in values, as seen in Figure 15.49.

There is more to this command, such as sizing and modification of the table, as well as some 
ability to link up with Excel spreadsheets, so go ahead and explore it further. You can also set 
up styles of tables by first using the Tablestyle command, which gives you the dialog box for 
“designing” a table (Figure 15.50).

Press New and give your style a name. You then get the New Table Style dialog box  
(Figure 15.51). Here you can work with the general properties, text, and borders of the new 
table, similar to an Excel spreadsheet, and design a custom style that fits your needs.

Figure 15.47 
Insert header.

Figure 15.48 
Fill in header.

Figure 15.49 
Fill in individual cells.
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15.26  Tool palette
This useful palette, shown in Figure 15.52, can be accessed by typing in toolpalettes; 
alternatively via cascading menu Tools→Palettes→Tool Palettes; or by pressing Ctrl  3. 
It may also be on your screen already, but hidden away off to the side. To see it, you have to 
hover the mouse over the palette’s spine and it reveals itself. This “auto-hide” feature can be 
disabled via a right-click (on the spine) menu, seen in Figure 15.53.

The tool palette represents a collection of commonly used commands and predefined blocks. 
What you actually see when the palette comes up may be different from Figure 15.52, as it 
depends completely on what menu is pulled up or what tab is clicked. In all cases, to use this 

Figure 15.50 
Table style.

Figure 15.51 
New table style.
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Figure 15.52 
Tool palettes, all palettes.

Figure 15.53 
Tool palettes, spine menu.
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palette, just click on a command (or click and drag) and it is executed as though you typed 
or selected a toolbar icon. To access more menus, simply right-click on the gray “spine.” The 
menu in Figure 15.53 appears.

Even more tabs are available in this palette. Go to the bottom left of the tabs (where it looks 
like several tabs are bunched together) and click. Another extensive menu appears, as shown 
in Figure 15.54.

Take the time to go through each of the menu choices. The amount of available blocks is 
quite extensive. Although we do not go into this further, you may also customize what tabs 
you have available by creating your own and adding custom commands and blocks to it. 
This is similar to creating new toolbars using the CUI, as covered in Chapter 14. You can 
also modify existing commands in the tabs; and finally the entire palette can be hidden, 
docked, and even made transparent, so it is always there but you can see what you are doing 
underneath it, a neat, if distracting, trick. Explore all the options; most are easy to figure out 
and self-explanatory.

15.27 Ucs  and crosshair rotation
Rotating the crosshairs or the UCS icon is a very useful trick for working with tilted shapes. 
Not everything you work on will be perfectly horizontal and vertical; some designs will be 
rotated at some angle and it would be nice to align the crosshairs to them. This allows for 
easier drawing and better orientation for the designer. Commands such as Ortho can now be 
implemented at the new tilted angle.

Rotating the UCS icon is not the same as rotating just the crosshairs, but we do not split hairs 
(so to speak) over the conceptual differences, and we go over both methods as if they are the 
same. To rotate the UCS icon, which by default rotates the crosshairs, simply type in ucs, 

Figure 15.54 
Tool palettes, tabs menu.
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press Enter, and type in ob for the OBject option. Then, assuming you are working with a 
rotated design, click a line that best represents the angle of the design’s rotation and the UCS 
icon aligns itself (or the crosshairs align themselves) to that line, as seen in Figure 15.55.

To revert back to normal, retype ucs, press Enter, type in w for world, and press Enter. The 
UCS icon or crosshairs return to normal.

If you just want to rotate the crosshairs and not touch the UCS icon, then do this:

1.	 Type in snap and press Enter.
2.	 Type in ro and press Enter.
3.	 For base point, type in 0,0.
4.	 For angle of rotation type in per for perpendicular.
5.	 Select an angled line.
6.	 Turn off the SNAP command.

To get back to normal, repeat all six steps, except type in 0 at step 4.

15.28 Windo w tiling
This is just a simple tool for allowing viewing of two drawings side by side in a convenient 
manner. Open up two drawings in one session of AutoCAD and press one of the drawing’s 
Restore Down (middle button) at the upper right, so they are tiled one on top of another. 
You see something similar to Figure 15.56. Then select Window→Tile Vertically from  
the drop-down menu as seen in Figure 15.57. After the button is clicked on, you see what is 
shown in Figure 15.58. The active drawing is highlighted.

Both drawings are lined up neatly on the screen. You can now click in and out of each and 
use Copy and Paste commands to transfer items if necessary. The same thing can of course be 
done for a horizontal tiling.

15.29 Wipeo ut
For reasons that may not be immediately apparent but are explained in detail, this command 
is one of the most important in 2D in producing drawings that not only possess extraordinary 
clarity but are easy to work with and modify. When used properly, Wipeout is truly an 
“insider’s” secret, not known by beginner students, and one of the reasons why drawings 
done by AutoCAD experts have that intangible “something” that sets them apart from those 
done by less experienced designers.

First let us define what Wipeout is. It is simply a tool that creates a mask (or screen) that 
blocks out the viewer’s ability to see other drawn geometry covered by the wipeout. To use 
it, draw a shape of some sort. Then type in wipeout, press Enter, and click your way around 

Figure 15.55 
UCS icon or crosshairs rotation.



level 2  
Chapters 11–20

364

Figure 15.58 
Window tiling, end.

Figure 15.56 
Window tiling, start.

Figure 15.57 
Window tiling, drop-down menu.
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all or part of the shape. When you press Enter or right-click, the shape disappears behind the 
wipeout, as seen in Figure 15.59.

Notice the wipeout itself is still visible (something addressed later), but the double circle 
shape has been partially blocked as expected. Practice using this command a few times just to 
become familiar with it.

Remember that a wipeout itself is an object. It can be moved, erased, copied, rotated, scaled, 
and just about anything else you can do to a regular geometric object. You can also click on 
the wipeout (click on the lines, not the blank center) to activate its grips. Then the grips can 
be used to reshape it into any shape whatsoever (as in Figure 15.60).

So, what is so important about Wipeout that qualified it for such commentary as seen a few 
paragraphs ago? Well, this command allows us to do something very special in 2D work. We 
can give our designs depth.

When you look around you in the real world, objects are generally not transparent. So if 
you are looking at a bus in front of a building, part of the building is obscured by the bus. If 
another car were to park between you and the bus, it would obscure part of the bus, and so 
forth. In 3D, this is no problem at all. All objects are solid, and while they can be viewed in 
transparent wireframe form, a click of the button gives you rendered models that create an 
instant illusion of depth. This is important, as it matches our everyday experience and we quickly 
identify what we are looking at. In the image in Figure 15.61, the chair and the computer 
monitor both block a part of the computer desk. It is easy to tell what is in front of what in the 
rendered image on the left, but not as easy with the wireframe image on the right.

Let us try the same thing with the bus and car, as seen in Figure 15.62. Which is in front of 
which in Figure 15.62? You really cannot tell without shading the image, as in Figure 15.63.

Figure 15.59 
Creating wipeout and the result.

Figure 15.60 
Wipeout grips.
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In 2D, though, we have a problem: We cannot shade in the conventional sense. Everything 
is drawn using lines and nothing is solid, even though it may be in real life. In a plan view 
of an architectural floor plan, this is not an issue, as we are looking straight down, but what 
about in elevation view, such as the previous images? A section through a room in elevation 
view may feature furniture obscuring walls and walls obscuring other items behind them. 
Or in electrical engineering, we have equipment on a rack obscuring mounting holes. To 
provide realism and a sense of depth, we need to somehow obscure our view of items not 
seen. Of course you can trim linework behind the object, but what if the object moves? You 
now have a gaping hole. We need a way to temporarily obscure and hide geometry that is 
tied directly to the object doing the hiding, so if it moves, the linework reappears. Wipeout 
to the rescue.

In Figure 15.64, notice how the equipment bolted to the rack obscures part of the rack. Now 
if the equipment is moved, such as in Figure 15.65 (notice the numbers to the left change), 

Figure 15.62 
Bus, building, and car, wireframe.

Figure 15.63 
Bus, building, and car, solid.

Figure 15.61 
Solid and wireframe images.
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the wipeout moves with it and it acts like a solid object. The move is successfully done with 
no trimming necessary.

Now what if you did not have a wipeout? Such is the case in Figure 15.66. Notice that the 
rack is visible underneath the equipment, giving no indication of depth. You would have to 
trim lines to achieve this.

So, in summary, when a wipeout is attached to an object, it prevents anything behind it from 
being seen, exactly as in real life. So a bookshelf with a wipeout attached blocks the wall 
behind it and electrical equipment blocks the mounting holes to which it is attached. Move 
the object and the wipeout moves, also blocking out whatever you happen to be blocking. 
This is the technique that the pros use to give drawings a uniquely realistic look in 2D design,  
and you should learn this as well. Let us go through some details.

The essential steps of making this technique work include the following:

Step 1. Create the drawing of what you are designing, such as the equipment rack in  
Figure 15.67.

Figure 15.64 
A router on a rack with a wipeout.

Figure 15.65 
Equipment relocated.

Figure 15.66 
Same equipment with no wipeout.
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Step 2. Using Wipeout, click to trace the outline of the drawing point by point (just the four 

corners in this case).
Step 3. Using Tools→Draw Order→Send to Back put the wipeout behind the design.
Step 4. Make a block out of the design and wipeout.

The object is now “solidified” and can be placed in front of other objects. If you create more 
objects in this manner, you can simply use the Draw Order tool to shuffle them around top 
to bottom as needed (as long as all of them are blocks). In this manner, you can create a 
rather impressive sense of depth and clarity to an otherwise busy drawing.

Take a close look at Figure 15.68. It is a larger section of the same cabinet shown in the 
previous figures. It could not have been done this way without extensive use of the Wipeout 
command. Notice how it is easy to tell which equipment is in front and which is behind the 
rack. There are in fact several layers of objects: the equipment bolted to the front of the rack, 
then the rack itself and then the equipment in the back of the rack.

The final item to mention with wipeouts is that they themselves can be hidden (while their 
ability to hide objects remains in effect). To do this, simply type in wipeout, press Enter, and 
select f for Frames in the submenu. AutoCAD then says: Enter mode [ON/OFF] <ON>:. If 
you type in off, AutoCAD turns off all wipeouts on the screen, while preserving their effect 
on other objects.

Level 2 drawing project (5 of 10): architectural  
floor plan
Here we first add some landscaping using advanced lines learned in Chapter 11. Use Spline, 
Xline, and a variety of hatches to create shrubbery, trees, a driveway, and two walkways, as 
seen in Figure 15.69. Create the appropriate layers before starting the design (L-Driveway, 
L-Tree, etc.).

Figure 15.68 
Equipment with wipeout.

Figure 15.67 
Wipeout, step 1.
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Figure 15.69 
Floor plan with shrubbery, trees, driveway, and walkways.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 16.

l	 Align command
l	 Audit and Recover commands
l	 Break and Join commands
l	 CAD Standards
l	 Calculator command
l	 Defpoints concept
l	 Divide and Point Style commands
l	 Donut command
l	 Draw Order command
l	 eTransmit command
l	 Filters
l	 Hyperlinks
l	 Lengthen command
l	 Object snap tracking
l	 Overkill
l	 Point command
l	 Publish command
l	 Rasters
l	 Revcloud command
l	 Sheet sets
l	 Selection methods
l	 Stretch command
l	 System variables
l	 Tables
l	 Tool palette
l	 UCS and crosshair rotation
l	 Window tiling
l	 Wipeout command

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 15.

  1.	 What are the purposes of the Audit and Recover commands? What is the difference?

  2.	 For Join to work, lines have to be what?

  3.	 The Defpoints layer appears when you create what?

  4.	 Does the Divide command actually cut an object into pieces?

  5.	 What is the idea behind eTransmit?

  6.	 To what can you attach a hyperlink? What can you call up using a hyperlink? How do you activate a 
hyperlink?

  7.	 What is the idea behind overkill?

  8.	 Can you make a revcloud out of a rectangle? A circle?

  9.	 What three new selection methods are discussed?

10.	 Do you use a Crossing or a Window with the Stretch command?

11.	 Name two or three system variables.

12.	 Explain the importance of the Wipeout command. What does it add to the drawing?



CHAPTER 15  
Advanced Design and File Management Tools

371

EXERCISES
1.	 Draw the following two rectangles according to the dimensions given. Pedit the width to 0.250 and 

shade each separately with a solid hatch, with color 9. Then use align to place the 100 box on top of 
the 10 box. (Difficulty level: Easy; Time to completion: 5 minutes)

2.	 Draw the following set of lines and Chamfer them to the dimensions shown. Then Pedit the result to a 
thickness of 0.250. (Difficulty level: Easy; Time to completion: 5 minutes)

3.	 Draw the following line and divide it into seven sections using six points of the style shown. Then 
Pedit the line to a thickness of 0.250 and break it using the Break command (First point option) at each 
of the points. Finally offset each alternate section 0.50 up and 0.50 down as shown. (Difficulty level: 
Easy; Time to completion: 5 minutes)
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4.	 Draw the following rectangle, circle, and triangle according to the dimensions shown. Then use 
Revcloud and the Object option to turn each into a revcloud. Finally Pedit the new shapes to a 
thickness of 0.250. (Difficulty level: Easy; Time to completion: 5 minutes)
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CHAPTER

Importing and Exporting 
Data

LEARNING OBJECTIVES
In this chapter we learn how AutoCAD interacts with other software you are likely to use 
in the course of design work. We cover the following topics:
l	 AutoCAD and MS Word
l	 AutoCAD and MS Excel
l	 AutoCAD and MS PowerPoint
l	 AutoCAD and jpgs
l	 AutoCAD, pdfs, and screen shots
l	 AutoCAD and other CAD software
l	 Exporting and Save As
l	 Importing and OLE

By the end of the chapter you will smoothly import and export data among a variety of 
common office and design applications.

Estimated time for completion of chapter: 2 hours.

16.1  Introduction to importing and exporting data
AutoCAD and the designers who use it usually do not work in a “software vacuum.” They 
typically interact with not only AutoCAD but a number of other applications, some of them 
generic and used by many other professions, others unique to their own field. As such, 
there is often a need to either import data into or export data out of AutoCAD. Examples 
are numerous, such as an architect who wishes to transfer notes typed in MS Word into his 

16
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project details page in AutoCAD or an engineer who needs to drop in an Excel spreadsheet. 
Just as often, AutoCAD drawings may need to be inserted into MS Word reports, PowerPoint 
presentations, and other applications. You may then need to create pdfs of your drawing or 
insert a pdf or an image into one.

Swapping files among the various software applications has in the past been occasionally 
tricky business. Software companies are under no obligation to make such tasks flow 
smoothly, as it is not their business what else you may have on your PC (which may include 
programs from a direct competitor). Of course, such thinking scores no points with the 
customer, therefore as a rule developers try hard to make sure there are as few compatibility 
issues as possible. Today such tasks flow much smoother but still require knowledge of 
procedures that can be unique to each application.

The sheer quantity of software on the market is staggering, so we limit the discussion to

l	 Software or files that are used or encountered by virtually everyone who uses a computer 
(Word, Excel, PowerPoint, jpg, and pdf).

l	 Software that has special relevance to AutoCAD users (such as other CAD programs).

We focus on two distinct tasks, how to import files from these applications and how to export 
AutoCAD files into them (analyzing each software pairing bidirectionally, if you will), and 
then conclude with a brief overview of the Export and Insert feature and OLE.

16.2  Importing and exporting to and from  
MS Office applications
We begin with MS Word, Excel, and PowerPoint, as those are probably the ones most 
important and relevant to the majority of users. Throughout, unless noted otherwise, we 
make extensive use of Copy and Paste. These Copy/Paste to clipboard tools are some of the 
most useful in computing, allowing you to shift around just about anything from one spot 
to another. The keyboard shortcuts are Ctrl  C for copy and Ctrl  V for paste, or you can 
just right-click and select copy and paste.

Be aware that the “copy” is not AutoCAD’s standard Copy command, so do not use that. 
Yes, some students mix these up, so let us be clear from the start. Open up Word, Excel, and 
PowerPoint and keep them handy as we go through each one.

Word into AutoCAD
Example of use
You would like to bring in extensive typed construction notes onto one of the pages of the 
AutoCAD layout.

Procedure
Go ahead and click-drag to highlight the text in Word first and right-click or Ctrl  C to copy 
to the clipboard. Go to the AutoCAD screen, but do not right-click and paste the text in. If 
you do this, it will appear as an embedded object, with a white background (seen in the 
top line of Figure 16.1) and not be editable. Instead, create an Mtext field of an appropriate 
size, and paste the copied text into it. The result is easily editable text that can be further 
formatted, as seen in the bottom line of Figure 16.1.

Figure 16.1 
Insertion of word text.
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AutoCAD into Word
Example of use
You are preparing a report and would like to include some of the graphics spread out among 
the text to enhance clarity or support documentation.

Procedure
This is a direct application of the Copy/Paste function or the PrtScn (print screen) key. With 
Copy/Paste you no longer have to change the background color of AutoCAD before insertion 
(developers finally conceded to the fact that, yes, most paper is white and the black AutoCAD 
background just does not look right—an automatic color change is performed), but be 
careful with older AutoCAD releases.

Once inserted, some cropping is necessary to get rid of excess white space. Often the Print 
Screen button followed by pasting in is easier, and the newer 2007 Word brings the cropping 
tool up right away when you click the pasted-in screen shot. Indeed, this was the initial 
method for importing screen shots throughout this textbook.

A typical view of this procedure is shown in Figure 16.2.

Excel into AutoCAD
Example of use
You would like to bring a spreadsheet into your electrical engineering drawing that details 
the type of connections and wiring used in a design.

Procedure
Once again, you use Copy/Paste. In Excel, create a small group of cells, number them 
(adding borders if desired), then highlight all, right-click Copy, go into AutoCAD, and  
right-click Paste. As soon as you do this, the dialog box in Figure 16.3 appears.

Figure 16.2 
Insertion of an AutoCAD design into Word.
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This is the OLE (object linked embedded) Text Size dialog box, which allows you to alter the 
text height of your inserted spreadsheet. The exact size is not too important for now (you can 
easily scale objects up or down anytime after insertion), but the concept of OLE is important 
and is discussed again soon. For now, press OK, and you see what is shown in Figure 16.4 
(zoom in if needed).

This is your basic Excel insertion. The cells are regular objects (very much like blocks), and 
you can erase, copy, and move them as needed. You can also scale them by clicking once and 
moving around the resulting grip points. You cannot mirror or rotate the cells, however.

A major question usually arises at this point from students. Are the inserted Excel cells linked 
to Excel, allowing for changes and updates? They are not in the true sense of the word. What 
you can do is double-click on these inserted cells and Excel is called up temporarily for editing 
purposes, but any changes made to the original file after accessing it from Excel (not AutoCAD) 
are not reflected in AutoCAD.

Having truly linked files is a very useful idea. I worked with some fancy Excel/AutoCAD 
interfaces where extensive Excel data was used to generate corresponding AutoCAD drawings, 
but this trick requires additional programming and extensive customization and is beyond 
the scope of this book.

AutoCAD into Excel
This action basically pastes an image into Excel with the same Copy/Paste procedure as for 
Word. This, however, is rarely done, as Excel is primarily for spreadsheet data; and unless you 
need a supporting drawing, there is just no overwhelming reason to do this.

Figure 16.3 
OLE text size.

Figure 16.4 
Embedded Excel cells.
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PowerPoint into AutoCAD
This action is not very common, as PowerPoint is almost always the destination for text 
and graphics, not an intermediate step to be inserted into something else. However, if it is 
needed, you can insert slides into AutoCAD via regular Copy/Paste.

AutoCAD into PowerPoint
This makes a lot more sense, as you may sometimes want to insert a drawing into a 
PowerPoint presentation. Fortunately PowerPoint behaves very much like Word in this 
particular case, and one Copy/Paste followed by some cropping is all it takes to insert an 
AutoCAD design, and no new techniques need to be learned.

16.3  Screen shots
Screen shot or screen capture refers to capturing a snapshot of everything on your screen as 
seen by you, the user, and sent to memory, to be inserted somewhere. This is done by simply 
pressing the Print Screen button, which on most computers is called PrtScn or SysRq or 
sometimes just F12. You can capture what is on your screen this way and insert it into Word 
or PowerPoint, then crop out what you do not need to see. While many computer users may 
know of the Print Screen function to actually print something, they may overlook this useful 
trick for inserting data into other applications.

16.4  JPGs
This file compression format (used most often with photographs) can be inserted directly 
into AutoCAD and is a great idea if you would like a picture of what you drafted next to 
the drawing. Examples include an aerial photo of a site plan for architectural and civil 
applications and a photo of an engineering design after manufacture for as-built or record 
drawings.

Inserting jpgs is very easy. Click on a file you want to insert and right-click and copy it. Then 
simply right-click and paste it into AutoCAD. A few things happen at this point:

m	 AutoCAD asks for an insertion point:
Specify insertion point <0,0>:

Click anywhere you like.

m	 AutoCAD then asks for the image size:
Base image size: Width: 0.00, Height: 0.00 Inches
Specify scale factor or [Unit] <1>:

Scale the jpg by moving the mouse to any size you wish (or type in a value).

m	 AutoCAD then asks for the rotation angle:
Specify rotation angle <0>:

If you want the image rotated, enter a degree value; otherwise, press Enter.

The result of a jpg insertion is shown in Figure 16.5. It has also been selected (one click), 
revealing the Ribbon’s Image Editor.

The image can be erased, copied, moved, rotated, mirrored, and just about anything else you 
can do to an element. You can also do some very basic image adjusting via the Ribbon or by 
double-clicking on the picture. The dialog box shown in Figure 16.6 appears, allowing you to 
adjust Brightness, Contrast, and Fade, as well as reset everything. Any changes apply only to 
that jpg, not copies of it (if other copies exist).
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16.5  PDFs
The portable document format (pdf) is of course Adobe’s popular format for document 
exchange. AutoCAD drawings can be easily converted to pdf by simply printing to them (in 
other words, selecting pdf as the printer, assuming Acrobat is installed). The print function 
executes, and AutoCAD asks you where you want the file saved. Select the destination and 
your pdf file is created.

Figure 16.5 
Embedded jpg.

Figure 16.6 
Image Adjust.
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Another way to generate a pdf, especially if you need to customize the output, is via the Ribbon’s 
Output tab→Export option. If you select the pdf option a Save As PDF dialog box appears and 
allows some tinkering with options and output to finesse the results, as seen in Figure 16.7.

As of the previous release of AutoCAD, you can now bring in a pdf file as an underlay. This means 
it will come into AutoCAD as a background, which you can see but not edit. This is not unlike 
raster images (mentioned in the previous chapter) and is quite useful if all you have of a design 
is a pdf. After insertion you can draw over it or use it as a supporting image, such as a key plan. 
To bring in the pdf use the cascading menu Insert→PDF Underlay…. You then are prompted to 
look for the file you want to insert, and upon selection you see the dialog box in Figure 16.8.

Once you press OK, the pdf inserts into the AutoCAD file and the box prompts you for an 
insertion point and scale factor. Once the image is embedded, you can click on it and the 
Ribbon changes to show you some of the image editing options, as seen in Figure 16.9, with 
Change to Monochrome and some Fade and Contrast adjustments among the more useful 
tools.

Figure 16.7 
Save as pdf.

Figure 16.8 
Attach pdf Underlay.
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16.6  Other CAD software
Initially, as AutoCAD gained market dominance, it did not really attempt, nor had any 
incentive, to “play nice” with other CAD software on the market. Being the 2D industry 
leader allowed AutoCAD to get away with not accepting any other files in their native format. 
It was the company’s way or the highway, but that slowly changed. One major concession 
in regards to importing and exporting was with MicroStation, AutoCAD’s nemesis and only 
serious competitor. MicroStation always opened and generated AutoCAD files easily but not 
the other way around.

Finally, in recent releases, AutoCAD listed the dgn file format as something you can import. 
You were then able to bring in MicroStation files, more or less intact. In AutoCAD 2009, 
the settings box was expanded and that was carried over to 2010 and 2011, as seen in Figure 
16.10. You can now compare layers and other features side by side and make adjustments so 
the target file is similar to the original.

To access this, use the cascading menu File→Import… and search for the MicroStation 
dgn file you are interested in importing. Another way around all of this is just to have the 
MicroStation user generate the AutoCAD file. You can also export dwg files directly to dgn 
as well by using the cascading menu File→Export… and selecting dgn as the target file. You 
then see the same Settings dialog box as in Figure 16.10. Of course MicroStation accepts the 
AutoCAD file with no problem, so this may not be necessary. If you would like to learn a bit 
more about MicroStation in general, see Appendix B.

Let us expand the discussion to other CAD software. What should someone do who is using 
another CAD program and needs to exchange files with an AutoCAD user? The dxf file is the 
solution, as it is a format agreed upon by most CAD vendors as the go-between that can be 

Figure 16.9 
PDF Underlay Ribbon menu.
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understood by all applications for easy file sharing. AutoCAD easily opens a dxf or generates 
its own dxf files for any drawing. This is discussed momentarily.

A few observations on sharing files: Among architects, the issue is not much of a problem, as 
AutoCAD is the main application in this profession and competitors such as ArchiCAD easily 
open AutoCAD’s files and send a dxf right back if needed. In engineering, however, AutoCAD 
has a lesser presence. While some electrical and civil engineers use AutoCAD, many others, 
especially mechanical, industrial, aerospace, automotive, and naval engineers, must instead 
use 3D modeling and analysis software such as CATIA, NX, Pro/Engineer, or SolidWorks.

These applications do not interact well with AutoCAD. Their “kernel” (the software’s core 
architecture) is significantly different in design and intent from AutoCAD’s ACIS 3D kernel. 
They generate native files for internal use and unfamiliar (to AutoCAD users) files such as 
IGES and STEP for sharing and analysis or manufacturing purposes. Some of the previously 
mentioned software can generate dxf files, but those files are “flattened” and what you get is a 
2D snapshot of what used to be a 3D model. It is better than nothing but not terribly useful 
for further work in AutoCAD. These are two different worlds indeed. AutoCAD can also now 
import images from CATIA and SolidWorks using the OLE command (to be discussed soon), 
but once again they are also just flattened images.

All this can admittedly be a somewhat confusing scenario. Because so many different CAD 
packages are on the market, AutoCAD designers need to be aware and up to date on what 
others in their industry are using and think on their feet when it comes time to exchange 
files, as there usually is a way. Let us now take a look at the specifics of exporting, importing, 
and the OLE command to explore the available options.

16.7  Exporting and the save as feature
As just mentioned with a MicroStation example, exporting data can be done by selecting 
File→Export… from the cascading menu. What you see is the dialog box in Figure 16.11.

Figure 16.10 
Import DGN Settings.
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Your drawing can be exported to the following formats:

l	 3D dwf: This is to convert the drawing to web format for use on viewers.
l	 Metafile: This is to convert the drawing to a Windows Meta File, a Microsoft graphics 

format for use with both vectors and bitmaps.
l	 ACIS: ACIS is the 3D solid modeling kernel of AutoCAD as well as a format to which a 

drawing can be exported. Few other software currently use the ACIS kernel (SolidEdge 
comes to mind), as Parasolid is the industry standard, so this is a rarely used export format.

l	 Lithography: STereoLithography files (*.stl) are the industry standard for rapid 
prototyping and can be exported from most 3D CAD applications including AutoCAD. 
Basically, it is a file that uses a mesh of triangles to form the shell of your solid object, 
where each triangle shares common sides and vertices.

l	 Encapsulated Post Script: EPS is a standard format for importing and exporting PostScript 
language files in all environments, allowing a drawing to be embedded as an illustration.

l	 DXX Extract: DXX stands for drawing interchange attribute, and is a dxf file with only 
block and attributes information, and is not relevant to most users.

l	 Bitmap: This converts the drawing from vector form to bitmap form, with the resulting 
pixilation of the linework; it is not recommended.

l	 Block: This is another way to create the familiar block covered in Level 1.
l	 V8 dgn: MicroStation Version 8, as described previously.

The Save As dialog box can be accessed anytime you select File→Save or File→Save As…
from the drop-down cascading menus. You can also type in saveas. In either case, you get 
the dialog box shown in Figure 16.12.

The extensions presented here are described in detail in Appendix C, but in summary you 
can save your drawing as an older version of AutoCAD (an important step that is automated 
via a setting in Options, as covered in Chapter 14) or as a dxf as described earlier. Note that 

Figure 16.11 
Export data.
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the dxf files can also be created going back in time, all the way to Release 12 (that was a 
mostly DOS-based AutoCAD). The other extensions, dws and dwt, are used less often and 
are also mentioned in Appendix C.

16.8  Inserting and OLE
The final discussion of this chapter features the Insert menu option in general and the OLE 
concept or command in specific. The Insert cascading menu is shown in Figure 16.13.

You may already be familiar with most of what is featured in this drop-down menu, or it will 
be covered soon as a separate topic:

l	 Block insertion is the same as typing in insert (from Level 1).
l	 Hyperlinks and raster images are covered in Chapter 15.
l	 External references is all of Chapter 17.
l	 Layouts is a Paper Space topic from Chapter 10.

Other items we do not cover (and you rarely need) are:

l	 Fields
l	 3D Studio, ACIS, Drawing Exchange Binary, and the like

Let us then focus on OLE (object linked embedded). OLE is a way to embed (insert) 
non-native files into AutoCAD on a provisional basis, meaning these files are not part of 
AutoCAD (they cannot be anyway, as they are of non-AutoCAD formats), but they are merely 
dropped in and are visually present. In principle you can drop in just about anything, with 
just about any results. Some files sit nicely, others do not appear, and still others may even 
cause a crash. Let us take a look at the dialog box.

Figure 16.12 
Save As dialog box.
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Select OLE Object from the Insert menu and the dialog box in Figure 16.14 appears.

These, in theory, are the various software file items that can be inserted into AutoCAD. 
Looking through it, top to bottom, you can see that a wide variety of Adobe, Microsoft, 
and even Dassault (they own CATIA and SolidWorks) files can be inserted. You can also, in 
principle, insert video and audio clips (one can envision music files playing upon the opening 
of an AutoCAD drawing) and even Flash animations. Simply pick what you want to insert and 
select Create from File. Some of the more useful OLE insertions are related to the Microsoft 
products listed, but much of that topic has already been covered earlier in this chapter. To 
insert a file, select Create from File and browse for the file in which you are interested.

Figure 16.14 
Insert object.

Figure 16.13 
Insert menu.
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Level 2 drawing project (6 of 10): architectural  
floor plan
Here we add a variety of hatch patterns to the rooms. Create a carpeting layer, A-Carpet, for 
those hatches. Note how all the doors, but not the appliances or furniture, are frozen to allow 
for the carpeting hatches. Some of the hatch patterns used include those shown in Figure 16.15:

l	 AR-HBONE
l	 NET
l	 HOUND

Figure 16.15 
Floor plan with hatch patterns.
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Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 17.

l	 Data transfer from Word to AutoCAD
l	 Data transfer from AutoCAD to Word
l	 Data transfer from Excel to AutoCAD
l	 Data transfer from AutoCAD to PowerPoint
l	 Screen shots, jpgs, and pdfs
l	 Interaction with other CAD software
l	 Exporting and Save As features
l	 Inserting and OLE

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 16.

1.	 What is the correct way to bring Word text into AutoCAD?

2.	 What is the procedure for bringing AutoCAD drawings into Word?

3.	 What is the correct way to bring Excel data into AutoCAD?

4.	 What is the procedure for bringing AutoCAD drawings into PowerPoint?

5.	 What is the procedure for importing jpgs and generating pdfs?

6.	 Describe the basic ideas of interacting with other CAD software.

7.	 What are Exporting and Save As?

8.	 What is OLE?

EXERCISE
1.	 At your own pace, review everything presented in this chapter and do the following:

•	 Type any short paragraph in MS Word and then import it into AutoCAD correctly, using Copy and 
Paste.

•	 Type in several columns of data in MS Excel then import them into AutoCAD. Adjust it by scaling it 
up and down.

•	 Import any image from AutoCAD into MS Word using:

i.	 Print Screen function

ii.	 Copy and Paste

•	 Export any drawing to a dxf format.

•	 Bring in any jpg (picture) using Copy and Paste. Adjust it in AutoCAD.

(Difficulty level: Easy; Time to completion: 15 minutes)
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CHAPTER

External References 
(XREFs)

LEARNING OBJECTIVES
In this chapter we introduce and thoroughly cover the concept of external references 
(Xrefs). We specifically introduce
l	 The primary reasons for using Xrefs
l	 Loading Xrefs
l	 Unloading Xrefs
l	 Binding Xrefs
l	 Updating and editing Xrefs
l	 Layers in Xrefs
l	 Multiple Xrefs
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By the end of the chapter you will be well versed in applying this critical concept to your 
design work.

Estimated time for completion of chapter: 1–2 hours.

17.1  Introduction to xrefs
External reference, or Xref for short, is a critically important topic for architectural AutoCAD 
users and very useful knowledge for all others. Along with Paper Space (next chapter), Xref 
forms the core of Level 2 and is considered an advanced application of the software. Like 
many advanced topics, you need to understand fundamentally what it is and when to use 
it. The “button pushing” or the mechanics of how to make it work is the easy part. In this 
introduction, let us explain what an Xref is and why there is a need for this rather clever 
concept, which has existed since AutoCAD’s early days.

WHAT IS AN XREF?
As defined, an Xref is a file that is electronically attached (referenced) to another file. It then 
appears in that file as a fully visible background against which you can position new design 
work. This Xref is not really part of the file, it is merely “paper clipped” to it and cannot be 
modified in a traditional way; it merely serves as a background. The word Xref is also an 
action verb, as in “I need to Xref that file in.”

WHY DO WE NEED AN XREF? WHAT IS THE BENEFIT?
The preceding paragraph was just a strict definition and may not have yet illuminated 
the real reason for Xref. To see why we have this concept in AutoCAD let us propose the 
following scenario.

You are designing a tall office building. It is boxy in shape (similar to the former World Trade 
Center towers), and as such, the exterior does not change from floor to floor. The interior, 
however, does. The first floor is a lobby, the second is a restaurant, the third is storage, and 
floors 4 through 30 are office space. In short, for a designer, once the exterior is done, the rest 
is all interior-space work. Therefore, going from floor to floor, the exterior design file can be 
Xref ’d in and just “hang out,” providing a background for placement of interior walls and 
other items. This dramatically reduces the size of each file as a copy of the exterior is merely 
referenced and never part of the interior files. Got 100 floors to do? No problem, one Xref file 
of the exterior is all that is needed.

l	 Xref benefit 1: Reduce file size by attaching a core drawing to multiple files.

If this were all there was, Xref would be a neat trick and would have surely fallen out of favor 
as computer speed, power, and disk storage space increased over the years. However, the 
preceding was just a warm-up. The main reason for the Xref concept is design changes. If you 
need to change the shape of the exterior walls, you need to do it only once, and the change 
propagates through all files using that Xref. Think about the implications for a moment. In 
the old hand-drafting days, each floor had to be drawn separately. Imagine now a last-minute 
change to the exterior design. Hundreds of sheets would have been updated by hand. Score 
one for AutoCAD.

l	 Xref benefit 2: Automated design change updates to core drawings.

Need another benefit? How about security. The Xref file can be placed in a folder that is 
accessible only to the structural engineer and lead architect, not the interior designer or 
electrical engineer. Granted, this “need to know” basis for access may not be necessary, but it 
is good to have a way of keeping someone from shifting structural walls to accommodate the 
carpeting.



CHAPTER 17  
External References (XREFs)

389

l	 Xref benefit 3: Critical file security.

Ideally you are now sold on the benefits of an Xref. So how is this actually done in practice? 
The Xref is typically not just the exterior walls but also columns and the interior core (elevators 
and stairs), as those also tend to not change from floor to floor. The designer creates these files, 
naming them something descriptive such as ExteriorWallsRef or ColumnsCore. Next the Xrefs 
are attached together and then to the first floor file (or to the first floor file individually; more 
on that later).

The first floor file is the active file of course and is named Floor_One_Arch. At first it is 
blank, showing just the Xref. Then the interior design is completed. Then the designer opens 
another blank file, attaches the same Xref or set of Xrefs and names this file Floor_Two_Arch 
and so on. Xrefs can be attached, detached, refreshed, and bound to the main drawing 
file. We cover all these shortly. We also cover some Xref related topics such as layering and 
methods to edit Xrefs in place.

17.2 Using  xrefs
To demonstrate the features of the Xref command, we first need to have a building exterior 
file with which to work. You can select one of your own or one assigned by your instructor 
if taking a class. Alternatively (and for good practice), draw the floor plan in Exercise 1 at 
end the end of the chapter. We use that floor plan for the rest of the Xref discussion. In 
Figure 17.1, the plan is rotated horizontally and the left corner moved to point 0,0. All the 
dimensions are frozen and the file is saved as ExteriorWalls.dwg.

As of now, nothing is special about this file. We still need to Xref it to the working file.

Figure 17.1 
The Xref file.
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Open up a blank file and save it as Floor_One_Layout.dwg. Then type in xref and press Enter. 
Alternatively you can use the cascading menu Insert→External References…. The palette in 
Figure 17.2 then appears.

At the upper left is a white rectangle with a paper clip (hence the earlier paper clip reference). 
That is the Attach drawing button. You can click on the down arrow to reveal further attachment 
options (Image, dwf, dgn), but we do not need those. Simply click on the Paper icon and the 
Select Reference File browsing window opens. Browse to find the Xref file (ExteriorWalls.dwg) and 
click on Open. The External Reference insertion box appears as shown in Figure 17.3.

Figure 17.3 
External Reference.

Figure 17.2 
The Xref palette.



CHAPTER 17  
External References (XREFs)

391

Examine what is featured here, most of which you should be familiar with (such as Insertion 
Point, Scale, and Rotation). Uncheck Insertion Point; the fields turn from gray to white. We 
want the Xref to insert at 0,0,0. Finally press OK.

The Xref appears with its lower left corner at 0,0,0. Zoom out to see the entire drawing if not 
apparently visible. Notice the new addition to the Xref palette, as seen in Figure 17.4. The 
ExteriorWalls file is visible and indicated as Loaded with the appropriate date, time, and path.

You can now proceed to add new design work to the file, as the Xref procedure is complete. 
Let us skip ahead and explore some of the other available options, now that the Xref is 
loaded. By right-clicking on the ExteriorWalls paper icon, you get access to the important 
menu in Figure 17.5.

l	 Open: This option allows you to open the original Xref if you wish to make changes.
l	 Attach…: This option allows you to attach another Xref to your working file with the 

same procedure as outlined earlier in the chapter.
l	 Unload: This option removes the Xref from your working file but preserves the last 

known path, so if you wish to bring the Xref back you need not browse for it again but 
just click on Reload.

l	 Reload: The option just referred to for bringing back an unloaded Xref.
l	 Detach: This option is more permanent and removes the Xref from the working file, 

requiring you to browse and find it if reattachment is called for again.
l	 Bind: This option allows you to attach a permanent copy of the Xref to your working file 

and severs all ties with the original. The Xref then becomes a block; and if it is exploded, 
it completely fuses together with the working file. This action is potentially dangerous 
and is rarely used, as you are now stuck with the Xref permanently. Two possible uses 
include permanent drawing archiving and emailing the drawing set (so as to not forget 
the Xrefs), though eTransmit can take care of that.

Figure 17.4 
Xref loaded.

Figure 17.5 
Xref menu.
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17.3  Layers in xrefs
A very logical problem creeps up when using Xrefs. The Xref file itself has layers, often many 
of them. There may also be several Xrefs in one active drawing. And of course the drawing 
itself may have numerous layers of its own. It is almost guaranteed that, on a job of even 
medium complexity, layer names can and will be duplicated. This of course is not allowed in 
AutoCAD, and some method is needed to separate layers in the Xref from mixing and being 
confused with layers in other Xrefs or the main design drawing. The solution is quite simple. 
In the same manner that people have first and last names to tell them apart (especially 
helpful if the first names are the same), so do layers when Xrefs are involved.

All layers that are part of a certain Xref have that Xref’s name preceding the layer name with a small 
vertical bar (and no spaces) between them. All layers that are native to the working file of course 
have no such prefix.

This simple method ensures no direct duplication by having the Xref file name act as the 
“first name” and the layer name as the “last name.” An example is shown in Figure 17.6. New 
layers have been added in the host file. Notice the small vertical bar in the Xref layer name 
and the inclusion of the Xref file name.

When an Xref is bound to the drawing, the layer’s vertical bar changes to a $0$ set of symbols, 
indicating they are now bound and part of the working drawing, as seen in Figure 17.7. You 
should be familiar with this if you ever examine a bound set.

Figure 17.6 
Xref layering.

Figure 17.7 
Xref bound layering.
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17.4  Editing and reloading xrefs
At one time Xrefs could not be changed in place. This means you had to open the original 
Xref file to edit it and could not do this from the main working file. This made sense, as you 
generally want to limit access to the original Xref so it cannot be casually edited.

All things (and software) change, and a number of releases ago AutoCAD started allowing 
Xrefs to be edited in place using a technique similar to editing blocks (somewhat diminishing 
the security benefit of Xrefs, as mentioned earlier). Let us give it a try. Double-click on any of 
the lines making up the Xref while in the main file. The Reference Edit box appears, as seen 
in Figure 17.8.

The Xref you clicked on is listed under Reference name. Press OK and you are taken into 
Reference Edit mode. You may notice a few new features or items of interest:

l	 The Xref has remained brightly lit up while everything that is on the main drawing 
file has faded down. This is a feature of Ref Edit. You can now clearly tell apart 
the Xref geometry from the rest. The intensity of the fade can be adjusted under 
Options→Display→Reference Edit fading intensity.

l	 The Xref can now be edited in place; go ahead and change a few items around.
l	 A new toolbar appears, called Refedit (shown in Figure 17.9).

When you finish editing the Xref, press the last button all the way to the right, Save 
References Edits. A warning icon pops up; press OK and you are done. The Xref has been 
edited in place.

Figure 17.8 
Xref bound layering, editing box.

Figure 17.9 
Refedit.
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Just as a reminder, this procedure is only for editing the Xref while you have the main 
working file open, and what you just did can be also done in a far simpler manner by just 
opening the Xref as its own file (though with Ref Edit you have the advantage of seeing the 
internal design while editing). In fact, when changes are extensive, the designer may just 
open the Xref itself and work on it all day, without resorting to Ref Edit. Every time the 
designer saves his or her work, the changes become permanent and accessible to any other 
designers who may be working on a job that uses that Xref.

A good question may come up at this point. How do other designers know that the Xref is 
changed so they can adjust their interior work accordingly? Many releases ago, the only way 
to know was for the person working on the Xref file to simply tell others via a visit to their 
cubicle or office, phone, or email. The other users would then press Reload All References, as 
seen in Figure 17.10.

Of course you can still do this, and designers often refresh every few minutes on their own if 
they know someone is actively working on the Xref. However, a new tool appeared recently. 
It is simply a “blurb” announcement that appears in the lower right corner of AutoCAD’s 
screen, as shown in Figure 17.11. Press the reload exterior walls link and the Xref reloads and 
refreshes automatically.

One final brief topic in this chapter concerns how to chain together Xrefs if there are more 
than one of them. Some methods are suggested next.

17.5  Multiple xrefs
As mentioned earlier in the chapter, many complex drawings use more than one Xref. 
Typically you may find the exterior walls, columns, and the core as three separate Xrefs. The 
ceiling grid (RCP) can also be Xref ’d in for extensive ceiling work, as can the demolition plan 
and many other combinations.

There are essentially two options. Let us say you have five Xrefs total to work with. You can 
attach them one to another and then to a master working file (daisy chain) or one at a time 
as shown in Figures 17.12 and 17.13.

Figure 17.10 
Reload Xref.

Figure 17.11 
Reload Xref announcement.
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Which method you use is up to you (there may be company policy or a convention in use at 
your job). Each method has minor pros and cons, and you should expect both to be used in 
the industry.

One final word on when not to Xref, as this feature gets abused occasionally. Xref ’ing  
of title blocks, furniture, and text is not what Xref is for. It is intended for major pieces  
of infrastructure not secondary objects. The logic behind Xref in the first place is to 
attach objects that are not likely to change and can serve as the backdrop. Use the  
tool wisely.

17.6  Ribbon and xrefs
Some Xref functions can be accessed via the Ribbon, and we discuss them separately in this 
section. You can find them under the Insert, Reference tab, as seen in Figure 17.14.

One important control is the Xref fading slider you see toward the bottom of the tab. This 
controls the darkness of the Xref. Some users prefer the Xref to be dark, similar to the 
surrounding design, while some prefer it very light, so they clearly know what is an Xref and 
what is the design.

Finally the Ribbon switches to a dedicated Xref tab if you click on the Xref, as seen in 
Figure 17.15, though there is much duplication of the previous tab’s commands.

Figure 17.12 
Multiple Xref attachment, Method 1.

Figure 17.13 
Multiple Xref attachment, Method 2.
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Level 2 drawing project (7 of 10): architectural  
floor plan
Here we add some mechanical work in the form of diffusers and return air ducts, all 
embedded in a reflected ceiling plan. This is not necessarily how an architect would 
choose to do it, but the point here is CAD practice, not adherence to strict design protocol. 
Moreover, a residential home would not necessarily have such an air circulating system, 
which is more typical of an office space. Consider this practice in all types of architectural 
design rolled into one drawing. We need additional layers such as M-Diffuser, M-Return-Air,  
A-RCP, and others as you see fit. Note that all interior work except for walls is frozen for 
this exercise, and we work strictly with the structure of the building only. Use the following 
dimensions for the mechanical features:

l	 RCP, 2  2 grid.
l	 Diffuser and return air ducts, both 2  2, as seen in Figure 17.16.

Figure 17.15 
External References via Ribbon, 2.

Figure 17.16 
Diffuser and return air ducts.

Figure 17.14 
External References via Ribbon, 1.
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Figure 17.17 
Floor plan with RCP and mechanicals.
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The best way to create the RCP is to draw a pline around the border of each room and  
begin the plan either from the center or more commonly from one edge and offset out at  
2 intervals. You can also use the NET hatch pattern. When this is done, place the diffusers 
and return air ducts as shown in Figure 17.17.

Summary
You should understand and know how to use the following concepts and commands before 
moving on to Chapter 18.

l	 Xref command
m	 Inserting
m	 Detaching
m	 Unloading
m	 Reloading
m	 Binding

l	 Layers in Xref
l	 Nesting Xrefs

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 17.

1.	 What are several benefits of Xref?

2.	 How is an Xref different from a block?

3.	 How do you attach an Xref?

4.	 How do you detach, reload, and bind an Xref?

5.	 What do layers in an Xref’d drawing look like?

6.	 What do layers look like once you bind the Xref?

7.	 What are some nesting options for Xref?
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EXERCISE
1.	 Draw the following floor plan in order to practice the Xref command. (Difficulty level: Easy–Moderate; 

Time to completion: 45–60 minutes)
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Electrical engineering is a branch of engineering that deals with electricity and its 
applications. This can be on a large scale, such as power generation and transmission, or 
small scale, such as design of chips and consumer electronics (sometimes referred to as 
electronics engineering). The profession appeared in the mid-1800s as major advancements 
in the understanding of electrical phenomena were put forward by Ohm, Tesla, Faraday, 
Maxwell, and others. Today electrical engineering is a wide-ranging profession vital to our 
society. Few human-made objects have no electrical components, and electrical engineering 
figures prominently in virtually every product or device you see before you.

Just some of electrical engineering’s specialties include power, controls, electronics, 
microelectronics, signal processing, telecommunication, and computer engineering. 
Electrical engineers need a mastery of a wide variety of engineering sciences, such as basic 
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and advanced circuit theory, electromagnetics, embedded systems, signal processing, 
controls, solid state physics, and computer science and programming, among others.

Education for electrical engineers starts out similar to the other engineering disciplines. In 
the Unites States, all engineers typically have to attend a four-year ABET accredited school 
for their entry level degree, a Bachelor of Science. While there, all students go through a 
somewhat similar program in their first two years, regardless of future specialization. Classes 
taken include extensive math, physics, and some chemistry courses, followed by statics, 
dynamics, mechanics, thermodynamics, fluid dynamics, and material science. In their final 
two years, engineers specialize by taking courses relevant to their chosen field. For electrical 
engineering, this includes courses in most or all of the sciences just listed.

Upon graduation, electrical engineers can immediately enter the workforce or go on to 
graduate school. Though not required, some engineers choose to pursue a Professional 
Engineer (P.E.) license. The process first involves passing a Fundamentals of Engineering 
(F.E.) exam, followed by several years of work experience under a registered P.E., and finally 
sitting for the P.E. exam itself.

Electrical engineers can generally expect starting salaries (with a bachelor’s degree) in the 
$55,000–$60,000/year range, which is toward the higher end among engineering specialties. 
This of course depends highly on market demand and location. A master’s degree is highly 
desirable and required for many management spots. The job outlook for electrical engineers 
is excellent, as the profession is extremely diversified, and by selecting a specialization 
carefully, an engineer can join one of many growing fields, such as controls, nano-
engineering, robotics, and other such career paths.

So how do electrical engineers use AutoCAD and what can you expect? Industry-wide, 
AutoCAD enjoys significant amount of use for the simple reason that most electrical work is 
2D in nature and plays into AutoCAD’s strength. AutoCAD layering is far simpler in electrical 
engineering than in architecture. There is no AIA standard to follow, only an internal company 
standard, so there is room to improvise. As always the layer names should be clear as to what 
they contain.

In electrical engineering, you will not likely need advanced concepts such as Paper Space and 
Xref, but often you need to build attributes that will hold information on connectors and 
wires. You also need to have a library of standard electrical symbols handy, so nothing needs 
to be drawn from scratch every time. The key in electrical engineering drafting is accuracy 
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(lines straight and connected), as the actual CAD work is quite simple. A related field, 
network engineering, is similar. Here you may use plines or splines that indicate cables going 
into routers and switches. Shown in Figure 1 is an example of an electrical schematic. Notice 
the extensive use of symbols for capacitors, diodes, transformers, and switches.

Figure 2 is an example of some racked equipment in a network/electrical engineering 
drawing. There is nothing complex in this image, just careful drafting. You saw this example 
earlier when Wipeout was discussed.

Figure 1 
Electrical schematic.

Figure 2 
Racked equipment.
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CHAPTER

Attributes

LEARNING OBJECTIVES
In this chapter we introduce and thoroughly cover the concept of Attributes.  
We specifically discuss
l	 The purpose of attributes
l	 Defining attributes
l	 Editing attributes and properties
l	 Extracting data from attributes
l	 Invisible attributes

By the end of the chapter you will be well versed in applying this critical concept to your 
design work.

Estimated time for completion of chapter: 1–2 hours.

18.1  Introduction to attributes
Attributes is an important advanced topic. An attribute is defined in AutoCAD as information 
inside a block. The key words here are information and block. You can have a block without 
information—you have done this many times before; it is called a regular block or Wblock but 
not an attribute. You can also have information in the form of text sitting in your drawing. 
That is just text or Mtext but also not an attribute. However, put the two concepts together 

18
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and you have what we are now about to explore: essentially an “intelligent” block, one that 
has useful embedded information.

What is the reason for creating attributes in the first place? Why would you want information 
inside of blocks, and what can you do with this information? The information itself can be 
anything of value to the designer or client. For an office chair in a corporate floor plan, one 
may want to know its make, model, color, and catalog number. Then, if there are a variety of 
chair types for this office, the designer can keep track of all of them. Another example is a list of 
connections going into an electrical panel. It would be nice to know what and how many. All 
this information can be entered into the attribute and displayed on the drawing if you wish.

However, this is only half the story and displaying information is not the main reason for 
creating attributes. As a matter of fact, this information is often completely hidden so as not 
to clutter up the drawing. So, what is the main reason? The key is that this information can 
be extracted out of the attributes and sent to a spreadsheet (among other destinations). Now 
you have a truly useful system in place, where extensive information is hidden unobtrusively 
in the drawing, yet can be accessed if needed at the touch of a few buttons, and put into 
an Excel file or other very useful form for cost analysis or just plain old keeping track and 
organizational purposes.

You may have already heard of these tools in use or envisioned a need for them in 
architecture with such items as doors and windows schedules. The software keeps track 
of each door and window in the drawing and links the information to a database that is 
updated as you add or remove the objects from your design. While basic AutoCAD does 
not do this automatically, other add-on software does. Underneath it all is the concept of 
embedded attributes, similar to what we discuss here.

You should have a good understanding of the preceding few paragraphs. As always, the 
button pushing is far easier once the concept is crystal clear. We now go ahead and do the 
following:

l	 Create a simple design.
l	 Create a basic attribute definition.
l	 Make a block out of the simple design and the attribute definition.
l	 Extract information out of our new attribute.

The information is extracted via a multistep process to two locations, an Excel spreadsheet 
and a table. In both cases, the information is in an organized tabular form and, while not 
linked bidirectionally, is an exact reflection of drawing conditions. Let us give it a try.

18.2  Creating the design
We need nothing complicated drawn to learn the basics of attributes. Go ahead and draw a 
simple chair made up of several rectangles and rounded corners, as shown in Figure 18.1. 
Make the chair 30  30 and approximate the rest of the dimension relative to those.

Figure 18.1 
Basic chair design.
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We would like to embed the following information in it—manufacturer, color, and catalog 
number—and put these three items just above the chair. Let us first add some text, a header 
of sorts, indicating what the three categories are, as seen in Figure 18.2. Use regular text of 
any appropriate size, font, and color (blue in this case).

This is not yet the attribute definition, merely the name of the categories, so we know 
what we are looking at. You do not have to do this, but it helps clarify things initially, as 
the attributes are just plain Xs. You now have a simple design and the start of some useful 
information. We are now ready to make an attribute definition.

18.3  Creating the attribute definitions
Here we define the new attributes that contain the actual information. The idea for now is to 
simply assign them all a value of X and change the X to meaningful data later in the process; 
so we are creating generic definitions, which allow us to create multiple sets of data from one 
template.

Figure 18.2 
Basic chair design with text.

Start the attribute definition via any of the previous methods. The dialog box in Figure 18.3 
pops up.

We are interested in only the upper right of the dialog box for now. Under the Attribute 
category, let us focus on Tag:, Prompt:, and Default:. For

l	 Tag, type in Mfg for Manufacturer (this is the actual category).
l	 Prompt, type in Please enter manufacturer (this is just a reminder for the user).
l	 Default, type in X (this is the generic placeholder) as seen in Figure 18.4.

The rest of the information in the dialog box can be left as is for now, though we discuss a 
feature under Mode (upper left) later in the chapter. One thing you can adjust however is the 
text height, matching up the attribute size to the size of the text added in Figure 18.2. The 
text is 4 in height, so you can enter that value into the field.

Press OK and your attribute definition appears attached to your crosshairs. Go ahead and 
place it next to the Mfg: text. Note that it is in capital letters by default. Go ahead and go 
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through the same procedure for the remaining two categories, changing the Tag value and 
slightly modifying the Prompt. The default will remain as X. Note also that you cannot have 
blank spaces in the tag, hence the CATALOG_# underscore. The final results are shown in 
Figure 18.5.

We are almost done creating the attribute definitions. Note the differences between the text 
and the attribute. Double-click on the regular (original) text, and you get the standard text 
editing field. Double-click on the attribute definition to the right and you get a different, Edit 
Attribute Definition, field, as shown in Figure 18.6.

Figure 18.4 
Attribute fields.

Figure 18.5 
Attribute fields completed.

Figure 18.3 
Attribute Definition.
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At this point, it may not be obvious why we have two identical sets of categories next to each 
other or why we entered the X. After this next step, what we are doing should become much 
clearer.

18.4  Creating the attribute block
This next step should be familiar; create a regular block named Sample Chair via any method 
you prefer. Give it a name, select the objects (both the chair and all the text), and pick an 
insertion point. Finally click on OK, and the dialog box shown in Figure 18.7 shows up.

This Edit Attributes dialog box allows you to enter specific values for those placeholders 
(marked as X), but we do not do that at this point. Simply press OK and your new attribute is 
officially born (Figure 18.8). Notice all the previous categories are now just X and ready for 
customization. This is the process for creating a generic attribute. In the example of the office 
chairs, you create several copies (the different types of chairs) and customize the information 
for each. Then copy and distribute the types as needed on the floor plan, as we do next.

Figure 18.6 
Attribute editing fields.

Figure 18.7 
Edit Attributes dialog box.
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18.5  Attribute properties and editing
Now that you have a block with attributes, you need to learn how to edit its fields to add or 
delete information from the attribute as well as change its color, font, and just about any 
other property. Some of these techniques overlap each other and duplicate effort, so we need 
to clearly state what is used for what.

First of all, if you want to change only the content of the attribute (in other words, what it 
says), you need to get back to the dialog box shown in Figure 18.7. It is basic and simple, but 
does not change fonts and colors. Also, the only way to get to it is by typing. The command, 
attedit, takes care of the content. Indeed this is the way you should “populate,” or fill in, 
the fields once we start copying the chair. Try it right now and edit the chair to say Sears for 
the manufacturer, Brown for color, and S-1234 for catalog number.

Now, what if you wanted to change an attribute’s properties, as discussed earlier? Well, 
the method here changes slightly, as you need to deal with the Enhanced Attribute Editor. 
Although a full command matrix is shown next, the easiest way to get to it is just to double-
click on the attribute.

Figure 18.8 
Completed attribute.

What you get after either double-clicking or using the previous methods is Figure 18.9. Here 
you can do quite a lot. This Editor not only allows you to fill in the fields but also a variety 
of properties (colors, layers, fonts, etc.). Click through the three tabs, Attribute, Text Options, 
and Properties, to explore all the options. Here are some additional pointers on attributes.

EXPLODING ATTRIBUTES
Attributes can be easily exploded, but this action destroys the blocks and turns them into 
what you see in Figure 18.6, where you have just generic placeholders unattached to a 
physical design. You can change a few fields and reassemble the block, which is a perfectly 
valid technique, especially if the attribute is giving you a hard time. Be careful though; 
exploding complex attributes can suddenly fill your screen with an enormous amount of 
data, so keep one finger on that Undo button.

INSERTING ATTRIBUTES
As you learned in this chapter, attributes are blocks; therefore you can insert them as needed, 
as an alternative to copying them. When you insert a block that contains an attribute, you are 
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prompted to fill in the X placeholders at the command line. Indeed this is how title blocks 
are often filled out when a generic template block is inserted into a specific job file.

I hope everything makes sense now that you see the big picture of what was done. Review the 
chapter up to now if not. Our next step is to learn how to extract the useful information. For 
this you need to duplicate the attribute to simulate having a number of them in a real drawing. 
Then go ahead and change some of the values. The final result is shown in Figure 18.10.

18.6  Attribute extraction
Extracting the information is a multistep process, necessarily so because of the number of 
options offered along the way. Our target extraction is both an Excel spreadsheet and a table 
embedded in AutoCAD. Remember of course that this is a basic generic extraction and more 
complex spreadsheets and tables can be created to hold such data, which is left to you to 
explore.

Figure 18.9 
Enhanced Attribute Editor.

Figure 18.10 
Varied attributes.



level 2  
Chapters 11–20

412

Figure 18.11 
Data Extraction, page 1.

Figure 18.12 
Define Data Source, 
page 2.

Step (Page) 1. Begin.

Start up the data extraction process via any of the previous methods. The Data Extraction –  
Begin (Page 1 of 8) dialog box shown in Figure 18.11 appears.

You are going to create a new data extraction, so leave the default top choice but uncheck the 
Use previous box. Then Press Next and you are taken to a File→Save Data Extraction As 
dialog box. Save your file as Sample.dxe anywhere you will find it easily on your drive. You 
are then taken to the next page.

Step (Page) 2. Define Data Source (Figure 18.12). Here we are interested in the data source, 
or location of the file to be looked at. Leave the default choice with the Include 
current drawing box checked off. Press Next .
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Figure 18.13 
Select Objects, page 3.

Figure 18.14 
Select Properties, page 4.

Step (Page) 3. Select Objects (Figure 18.13). Here we are interested in selecting from what 
we want to extract data. In our case, there is only one choice, the sample chair, as it is 
the only available block (as seen under the type column). You can also click on, 
Display blocks only, under the Display options, to isolate the chair. In either case, 
select it and press Next .

Step (Page) 4. Select Properties (Figure 18.14). Here you initially see many property 
choices. Use the category filter on the right to uncheck all the choices except 
Attribute. You then easily see the three properties on the left that we created earlier. 
Check off all three and press Next .
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Step (Page) 5. Refine Data (Figure 18.15). This step is for you to refine the data if needed. It 
contains some interesting features, such as Link External Data (to tie in this output 
to another Excel file) as well as some tools for adjusting and tweaking the columns. 
Much of this and more can be done in Excel itself after extraction is completed, but 
it can be useful to adjust the look and content of the table extractions, as tables are 
less flexible. If you want to change nothing, press Next  for the final few steps.

Figure 18.15 
Refine Data, page 5.

Figure 18.16 
Choose Output, page 6.

Step (Page) 6. Choose Output (Figure 18.16). Here we are interested in our destination 
output. Although the Excel spreadsheet is the one that gets all the attention, you can 
also extract to a table that will be inserted into the drawing itself. Tables were first 
introduced in Chapter 15, so review that section if necessary. Check off both boxes if 
you have not done so yet and finally select the location of the Excel file by using the 
three dot browse button. When ready, press Next .
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Step (Page) 7. Table Style (Figure 18.17). We do not do anything to the table, leaving it as 
is, but you should review the options available and press Next  when done.

Figure 18.17 
Table Style, page 7.

Figure 18.18 
Finish, page 8.

Figure 18.19 
Table insertion (AutoCAD).

Step (Page) 8. Finish (Figure 18.18). On the final page, there is little to do except read what 
AutoCAD is telling you and press Finish. You are asked for an insertion point and 
notice the table attached to the mouse. You may have to zoom in to see it better. 
Finally, when you can see it, click to place the table. The table is inserted into your 
drawing, as shown in Figure 18.19.
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It is not fancy but it gets the information across. The main output, however, is the Excel file. 
Look for it wherever you may have dropped it off and double-click on it to start Excel. Then, 
after some cleanup (cell borders, column width, fonts, colors, etc.), select the cells and Copy 
and Paste them into AutoCAD, as you did in Chapter 16. It looks like Figure 18.20.

This in essence is Attribute Data Extraction. You should recognize the value in what you did 
and the potential it holds for easy data access and accounting.

There are other uses for attributes. One common use is formatting a full title sheet and  
block with generic attributes and saving it as a company standard. In this case, the text is  
the fixed permanent categories, such as Date, Sheet, Drawn by, and other fields, and the 
attribute definitions are the variables, such as the actual date, sheet number, and the initials 
of whoever created the drawing. Then everything is blocked out and saved for future use, 
with the Xs representing to-be-filled-in variables. Then, as the need comes up for a new title 
block, it is inserted as a block into the design’s Paper Space with the variables filled out on 
the spot.

We conclude the attributes chapter by briefly going over an important option in the attdef 
command dialog box.

18.7  Invisible attributes
This option appears as the first check-off box in the upper left of the attdef dialog box and 
is the most important of all the ones in that column. It is used to make attributes invisible 
upon creation.

Now, why would you do this? As mentioned at the beginning of this chapter, this is a 
relatively common way of creating attributes for the simple reason that you do not need 
to see the text and the attribute information. If you know what you created, then there is 
no need to clutter up the drawing with that list over and over again. This is especially true 
if there is a great deal of information (electrical termination panels come to mind) and 
revealing all would create a dense blanket of text on the drawing, obscuring everything else.

To use the invisible option simply start the attribute creation process with attdef, check off 
the Invisible option, then proceed as outlined previously. The attribute of course remains 
visible until the block is created and disappears afterward. To see what you have, there is no 
problem: Simply double-click on the block or type in attedit as outlined previously.

As you can see, being invisible for an attribute is no problem at all, as you can easily access 
it for editing if needed, and it is unobtrusively out of the way until then, the best of both 
worlds. The only downside of course is that you do not know that the attribute is there if 
you were not the one who set it up. It is always a good habit to double-click on blocks just 
to see what pops up on an unfamiliar drawing, and indeed this is a standard investigative 
procedure in these cases.

Figure 18.21 shows the Invisible option checked off in the attdef dialog box.

Figure 18.20 
Table insertion (Excel).

Figure 18.21 
Invisible option.
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Level 2 drawing project (8 of 10): architectural  
floor plan
We continue the main project here by applying attributes to create an intelligent title block. 
This was mentioned in the main text of this chapter, but the working example employed was 
the chair, as that was valuable to demonstrate extraction.

Using attributes to create a company title block, however, is no less important an application, 
and many design firms create a generic set of title block “templates” and insert them into 
the Paper Space layouts of new jobs. The multitude of information can then be filled out 
quickly and easily. Note, however, that this information is generally not extracted, rather it 
is a convenient way to simply fill out the needed information quickly. The title block also 
remains a block not individual lines of information.

You can use a modified version of the title block first created in Chapter 10 (Paper Space). 
Start out with that basic template and add some extra lines to the lower right part of the 
title block (Figure 18.22). Then, following what you learned in this chapter, add text for the 
following categories, followed by the attributes themselves:

l	 Drawn by
l	 Checked by
l	 Approved by
l	 Date
l	 Name of drawing
l	 Sheet number
l	 Number of drawing

The basic Architectural Layout title block would look like Figure 18.22 after the initial setup 
using attdef. Next, you would of course make a block out of it, and the entered attributes 
turn to Xs. Then you can either fill them out right away or insert the title block into Paper 
Space (after deleting the old one) and fill in the data as you go. Create just one for now. In 
the next chapter, we set up multiple ones.

Figure 18.22 
Modified title block.
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Summary
You should understand and know how to use the following concepts before moving on to 
Chapter 19.

l	 Attribute definitions
l	 Attribute blocks
l	 Editing fields and properties
l	 Attribute extraction
l	 Invisible attributes

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 18.

1.	 What is an attribute and how do you create one?

2.	 How do you edit attributes?

3.	 How do you extract data from attributes? Into what form?

4.	 How do you create an invisible attribute? Why can this be important?

EXERCISE
Exercise 1
a.	 Draw the following doors:
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b.	 Next add text attributes to each, as shown by the sample that follows:
	 1  12 accordion
	 Type: Accordion Double
	 Size: 1  12
	 Color: Natural Wood
	 Mfg: XYZ Door Company
	 Stock #: 654-A-1x12
	 Create realistic attribute data for the remaining four doors. Vary the colors and the stock numbers.
c.	� Make a block out of each one and fill in the attribute information. Copy the entire set once for a total 

of ten doors.
d.	 Extract the data to Excel.
	 (Difficulty level: Intermediate; Time to completion: 30 minutes)
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CHAPTER

Advanced Output and  
Pen Settings

LEARNING OBJECTIVES
In this chapter we introduce and thoroughly cover the concept of advanced output, 
which includes the concept of the ctb pen settings file. We specifically discuss
l	 ctb files and their purpose
l	 Editing lineweights
l	 Screening
l	 The LWT option

19

By the end of the chapter you will be well versed in applying this critical concept to your 
design work.

Estimated time for completion of chapter: 1 hour.
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19.1  Introduction to advanced output and pen settings
This chapter is the last of three that talk about some aspect of printing and output. Although 
general and advanced printing was already explored in Chapters 9 and 10, a crucial piece of 
information was omitted. This information concerns pen settings and other advanced output 
techniques, essential knowledge for professional-looking output. The reasons we are doing 
this are outlined next.

Most designs are rather complex when everything has been added to the drawing. Lines cross 
other lines and text is everywhere. The eye needs to be able to quickly and easily focus on 
what is essential; for example, the outlines of the walls of a floor plan or the outline of the 
mechanical part among the many other elements in the design.

This is analogous to a mix of a rock song. Not every instrument can be the loudest, 
something has to give, and a balance needs to be found so the nuances and color of the 
music can stand out. Usually when the singer sings, other instruments have to be turned 
down a bit, but when a guitar solos, its volume gets turned up, and so on. Otherwise it 
would be a loud, obnoxious mess with all sounds competing for attention.

Such is the situation with a pencil and paper drawing. All lines cannot be the same thickness 
and darkness. Such a monochrome mess would be confusing to look at. Draftspersons have 
known this for as long as the profession has been around and, as a result, have numerous 
pencils at their disposal ranging from lightest (hard lead) to darkest (soft lead) and everything 
in between. They use the darkest for the primary design and the lighter leads for all else.

AutoCAD has a similar philosophy. Lines must have differences in thickness for some to 
stand out more than others. But how do we show these differences, now that we no longer 
use pencil leads? The answer is to use color. Colors are then assigned line thicknesses, and 
assuming of course a consistent and intelligent pattern of use on the part of the designer, 
differences in line thickness can easily be incorporated into the design by assigning certain 
colors to the primary geometry. As you can see, colors play a dual role. They allow you to tell 
geometries apart not only on the screen but also on paper. The challenge then is to set up a 
table that assigns colors to certain line thicknesses, and most important, stick to using these 
colors properly and consistently.

19.2  Setting standards
The thing you need to determine before anything gets touched in AutoCAD is what colors will 
be used to represent the most important geometry. You actually did this back in Chapter 3, 
when layers were introduced. This of course is something done once by the CAD manager and 
usually is applied to all drawings. All we are really doing is establishing a “pecking order,” so 
to speak, for colors. This order corresponds from the most important (hence thickest) to the 
least important (the thinnest) pen setting. There are no hard rules here as far as what colors to 
use; it is more or less arbitrary, though convention favors some colors over others.

Let us say (based on what I have seen over the years and what was shown in Chapter 3), 
that green is the A-Wall layer color in our architecture plan and is assigned the thickest line 
weight. The Windows layer is typically red and the Door layer yellow. Both those objects are 
almost as important as the walls but can be set a bit thinner. The Furniture and Appliance 
layer is magenta and thinner still. Text and Dim layers are cyan and thinner yet; finally in  
our hypothetical example is hatch. Those dense patterns really need to be light, so as not  
to overwhelm the drawing, so we assign them a gray color and the thinnest line weight of all.

Though this is just an arbitrary example, it is also exactly the thought process you need to go 
through to have a rough idea of how things will look. Once this is generally documented, 
you can move on to the actual settings.
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19.3  The ctb file
The ctb file is the file that needs to be modified to set the pen settings. It is where you assign 
pen thickness to a color and where we spend our time for the remainder of the chapter. We 
open the ctb file, give it a name, modify settings, and save. Then, as you set up plots, you 
assign the ctb file to those plots, which is a permanent, “do only once” action.

There are two ways to set up the ctb file; either by accessing it in the Page Setup Manager or 
as a separate action, which is what we do. Select Tools→Wizards→Add Plot Style Table… 
from the drop-down menu. The dialog box in Figure 19.1 appears.

Figure 19.1 
Add Plot Style Table.

Press Next  and you are taken to the next page of this dialog box (Figure 19.2), where you 
select the first Start from scratch option. This begins a new line setting procedure from the 
default base values.

Figure 19.2 
Add Plot Style Table, Begin.
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Press Next and you are taken to the next page of this dialog box (Figure 19.3); select the 
Color-Dependent Plot Style Table choice. This is the only choice we look at; the named plot 
styles are not covered and are rarely used.

Figure 19.3 
Add Plot Style Table, Pick Plot Style Table.

Figure 19.4 
Add Plot Style Table, File name.

Press Next and you are taken to the next page of this dialog box (Figure 19.4). Give the 
new ctb file a descriptive name, like StandardCTB, ColorCTB, or anything else that will be 
recognized.

Press Next for the final step (Figure 19.5). Here we are interested in the Plot Style Table 
Editor to actually set the lineweights. Press that button and you are taken to our final 
destination, the actual Editor, shown in Figure 19.6.
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It is here that we set the colors, weights, and a few other tricks. Stay in the default Form 
View (referring to the tabs on top), as we do not need the information in any other format. 
Familiarize yourself with the Editor. On the left is the palette of the available 255 colors, and 
on the right is a variety of effects and settings you can impart on whatever color or colors you 
select from the palette. All the tools are there; you just need to proceed carefully.

Figure 19.5 
Add Plot Style Table, Finish.

Figure 19.6 
Plot Style Table Editor for the sample ctb file.
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STEP 1
The first thing you need to do is to set all the colors in the color palette to black. As the default 
settings are now, each color is interpreted literally, which means that if you are sending your 
design to a color plotter, all the linework will come out in color, exactly as seen on the screen. 
This is a very desirable outcome in certain situations but not in most (we talk about this more 
later on). For now, we need to monochrome everything so we can work on line thicknesses.

l	 Select all the colors (1–255) in the palette by clicking your mouse in the empty white area 
just to the right of the colors, holding down the button, and sweeping top to bottom. 
Holding down the Shift key and clicking the first and last entry accomplishes the same 
thing.

l	 Then, as all the colors are highlighted blue, select the very first drop-down choice in 
Properties, called Color:, and select Black (Figure 19.7). All colors are assigned black ink.

Figure 19.7 
Selecting black for all colors.

l	 Clear the palette choices by clicking randomly anywhere in the white empty area of the 
left side of the palette, and test out your changes by clicking random colors. They should 
all be black.

STEP 2
Next we need to set the actual thicknesses. This is done in the Lineweight: drop-down menu, 
about half way down the list on the right. Currently it says Use object lineweight, which 
simply means nothing is set specifically and all lineweights are the same (the default value is 
0.1900 mm).

Here, we need to discuss a major point you must understand in working with this feature. The 
actual line sizes are of secondary importance to the relative differences between the sizes. This 
means that you need not worry too much about how big 0.2 mm or 0.15 mm is—though that 
is the range of sizes that happen to look just right on paper. What is more important is that 
there is a large enough difference between the choices (0.2 mm vs. 0.15 mm as opposed to 
0.2 mm vs. 0.18 mm), so the eye can notice this difference. You can just as easily use 0.25 mm 
and 0.3 mm, but as you get up in the higher numbers, all lines end up being overly thick so it is 
best to stick to the range of 0.25 mm on the upper end and 0.05 mm on the lower end.
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Let us put this all to use and set some values:

l	 Click on and select color 3 (green); set Lineweight to 0.2500 mm.
l	 Click on and select color 1 (red); set Lineweight to 0.1900 mm.
l	 Click on and select color 2 (yellow); set Lineweight to 0.1900 mm.
l	 Click on and select color 4 (cyan); set Lineweight to 0.1500 mm.
l	 Click on and select color 6 (magenta); set Lineweight to 0.1500 mm.
l	 Click on and select color 9 (gray); set Lineweight to 0.1000 mm.

Now to put it all together, recall the Level 1 apartment drawing. The A-Walls layer was colored 
green and appears darkest (0.2500 mm) as required. The A-Doors and A-Windows layers were 
yellow and red, respectively, and are slightly lighter (0.1900 mm), followed by the A-Text and 
the A-Appliances (or A-Furniture) layers, colored cyan and magenta, respectively, lighter still 
(0.1500 mm). Last were the gray colored hatch patterns coming in at (0.1000 mm).

So, will these particular lineweight choices look good? The drawing will certainly look more 
professional and features will stand apart from each other. The exact values and colors will 
all be determined by the architect, engineer, or designer as this person inspects the results 
and tweaks lineweights as needed. This is an extensive trial and error procedure and not all 
individuals select the same settings; however, in any professional office, these techniques 
must be used regardless of exactly what specific settings are set. Nothing screams amateur 
more than a monochrome drawing with equal lineweights.

STEP 3
To complete the procedure, press Save & Close and Finish in the Add Plot Style Table – 
Finish dialog box. Then open a drawing, such as the Level 1 floor plan, if available. Type in 
Plot and set the drawing up for plotting or printing as outlined in Chapter 10, being sure 
this time to select Sample.ctb instead of monochrome.ctb in the appropriate field.

19.4  Additional ctb file features
We briefly cover two other useful features about which you should know. The first one 
was already alluded to earlier. When you selected all the colors and turned them to black, 
you could have left a few out. These colors would then have been plotted in color. So this 
action is certainly not an “all color” or “all black” deal. You can mix and match, and what is 
typically done in a piping or electrical plan (for example) is that the entire floor or site plan 
is monochrome, but the pipes or cables and wiring are left in vivid red, blue, or green (yellow 
and cyan do not show up well on white paper). The intent of the design is much clearer. It is a 
great effect, though it can obviously be derailed by not having a color capable printer or plotter.

The second feature has to do with the screening effect. What this does is lighten any color 
of your choosing so less ink is put on the paper during printing. It is literally “faded out” 
and is a very useful trick, as we will see with an example. The color most often chosen to be 
screened is color 9 (gray), as it is a natural for this effect and already looks faded, although 
any color can be used.

To screen a color, select it in the Editor as outlined just previously, and go to the Screening 
field (as seen in Figure 19.8). Then use the arrows or type in a value. Typically the screening 
effect is most useful around 30–40%. Then proceed as before with saving and plotting.

Figure 19.8 
35% screening of Color 9.
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So, what is the effect like? Figure 19.9 shows two solid fills on the same solid white color: 
one with no screening (left), meaning it is 100%; and one with the 35% screening (right) as 
viewed through the plot preview window.

It is a great trick to use. Here are some ideas where you can do this:

l	 In a key plan, where the area of work is grayed out and screened, yet the underlying 
architecture is still visible.

l	 In an area of work on a demolition plan, where the area to be demolished for a redesign 
is grayed out, with all the features still visible.

l	 As a rendering tool, to create contrasting shading.
l	 As a rendering tool to give a sense of depth or solidness to exterior elevations.

and many more applications

19.5  The lwt option
An additional Lineweight (LWT) option is available to you, and it is one that is often noticed 
first because of its visibility (found all the way on the right among your bottom push-in 
menu choices), as shown in Figure 19.10.

Figure 19.9 
Plot preview without and with 35% screening.

Figure 19.10 
LWT (Lineweight) option.

This is not the same thing as what we covered earlier in this chapter. The ctb file and setting 
the lineweights in that manner gets you only plotted results. This means that onscreen all the 
lines remain the same size, regardless of the settings. The results can be seen on paper.

In contrast the LWT option allows you to set line thickness that is actually visible onscreen. 
It is a rather interesting effect. Once set, the lines remain at that thickness regardless of how 
much you zoom in or out. Opinions on this effect vary between AutoCAD users. Some think 
it is very useful and accurately reflects what will be printed, while others (me included) see it 
as a distraction and are perfectly fine remembering what colors are set to what line thickness 
via the ctb method.



CHAPTER 19  
Advanced Output and Pen Settings 

429
It is up to you to experiment and see where you stand. To set the line thickness using this 
option, you need to go to the Layer dialog box, create a new layer (usually with a color), and 
set the value under the Lineweight header as seen in Figure 19.11 (with 0.50 mm used for 
clarity). The result is seen in Figure 19.12.

After setting this layer as current, draw something. Notice that the line is thin, as if nothing 
happened. Now press in the LWT button; the line suddenly turns thicker, as seen in Figure 
19.13. This is exactly how it will print. Note however that ctb settings supersede the LWT 
settings, and you would leave the ctb settings as default if you were inclined to use this LWT 
feature instead.

Level 2 drawing project (9 of 10): architectural  
floor plan
Here you finally put everything together and produce the five plans you have been working 
on using your Paper Space knowledge from Chapter 10. You need to

1.	 Create five tabs and label them Architectural Layout, Electrical Layout, Mechanical Layout, 
Carpeting Layout, and Landscaping Layout.

2.	 Use your new title block, inserting it into each Paper Space layout. Modify it as needed.
3.	 Create an Mview window for each layout, centering and zooming each layout to the 

proper scale. Do not forget to reorient your design to landscape view. You need to do this 
with all layers visible or only some of the drawn geometry rotates.

4.	 Going back to the Paper Space viewports, freeze all layers that are not necessary for each 
view.

Your output for the Architectural Layout should look similar to Figure 19.14. The rest of the 
layouts are similar, with their respective layers showing.

Figure 19.11 
Lineweight setting.

Figure 19.12 
Lineweight set to 0.50 mm.

Figure 19.13 
Line drawn with the 
0.50 mm LWT setting.
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Summary
You should understand and know how to use the following concepts before moving on to 
Chapter 20.

l	 ctb file
l	 Editing lineweights
l	 Screening
l	 LWT

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 19.

1.	 What is the ctb file?

2.	 Describe the process of setting up a ctb file.

3.	 What is screening?

4.	 What is LWT?

Figure 19.14 
Floor plan, Architectural Layout.



CHAPTER 19  
Advanced Output and Pen Settings 

431

EXERCISE
Exercise 1
a.	 Create a brand-new ctb file. Call it Ch_19_Sample_File.
b.	 Monochrome all colors.
c.	 Assign the following thicknesses to the listed colors:
	 Color 1, red, 0.2500
	 Color 2, yellow, 0.1900
	 Color 3, green, 0.1500
	 Color 4, cyan, 0.3000
	 Color 5, blue, Use object lineweight
	 Color 6, magenta, 0.0900
	 Color 7, white, 0.1000
	 Color 9, gray, Use object lineweight
d.	 Screen color 9 to 30%.
(Difficulty level: Easy; Time to completion: 10 minutes)
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CHAPTER

Isometric Drawing

LEARNING OBJECTIVES
In this chapter we introduce isometric perspective and how to use it.
l	 What isometric perspective is
l	 When to use it
l	 When not to use it
l	 Setting isometric perspective
l	 Changing planes (F5)
l	 Ellipses in isometric
l	 Text in isometric

20
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In the course of the chapter, you will create several isometric designs including a computer 
desk and mechanical devices.

Estimated time for completion of chapter: 1 hour.

20.1  Introduction to isometric perspective
By strict definition, isometric perspective means representing a three-dimensional object in 
two dimensions. As applied to AutoCAD, it means we draw a 3D object without resorting to 
the complexities of 3D space, sort of “faking it” in 2D, by angling horizontal lines 30° (the 
accepted isometric drafting standard, though there is also Axonometric, which is 45°). This 
creates the illusion of 3D and is good enough to get an idea across; indeed, that is how it 
is done with paper and pencil. In our case, we sometimes leave the horizontal lines flat (as 
with the box in Figure 20.1) and sometimes angle all of them 30° (as with the computer 
table exercise at the end of the chapter).

Why use isometric perspective instead of 3D?
There are a few reasons. One is that it is much easier to learn isometric drawing as opposed to 
developing proficiency in real 3D. So, for someone who only needs a quick 3D sketch once in 
a while just to accent an otherwise excellent 2D presentation, this perfectly fits the bill. Another 
reason is that 3D takes up more time and computing resources, something that is not always 
available, and there is also some difficulty in combining 2D and 3D drawings on one sheet. 
Many students do not go on to take AutoCAD 3D right away (nor should they), and isometric 
fills that temporary void quite well. For those who do go on, isometric drawing serves as an 
excellent introduction to 3D and should be reviewed before starting 3D instruction.

When not to use isometric perspective
Isometric drawing is inappropriate when precision 3D drawings are required for design, 
testing, and manufacture. Remember, isometric perspective is only for visualization. These 
are not true 3D objects and have no real depth, only the illusion of depth. As a result, true 
measurements and the use of the Offset command are not possible in the traditional sense.

20.2  Basic technique
Nothing is inherently special about drawing in isometric mode. Draw a straight (Ortho) 
horizontal line, then rotate it 30° counterclockwise. Next attach a perfectly straight line 
to one of the tips using ENDpoint. Copy the original horizontal line from where it meets 
the vertical to the other end (using ENDpoint as well). You are on your way to drawing an 
isometric box. It is the same as taking a T-square in hand-drafting and putting a 30°-60°-90° 
triangle on it, as illustrated in Figure 20.1.

Figure 20.1 
T-square and triangle.
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That was not hard, but it was tedious. There is of course a way to have AutoCAD preset the 
crosshairs so you are always drawing in isometric mode. To explain it, we need to introduce 
the idea of planes, so here is a short introduction to the plane concept.

In isometric drawing, you are always drawing in one of three available planes: top, right, 
or left (see Figure 20.2). Because you are using a 2D pointing device (a mouse), which 
exists only in a 2D world, you need to be able to easily move from one plane to the other 
to be able to draw on it. To toggle between planes, press the F5 key. Your crosshairs line up 
accordingly, and now you just draw using the Line command. Here is one final rule: You 
almost always have Ortho on while in isometric mode, otherwise the lines are not straight 
and rotating them 30° is meaningless. Let us put it all together and draw an isometric box. 
After you are able to do this, more advanced isometric drawings are surprisingly easy.

Step 1. Open a blank file.
Step 2. From the cascading menu select: Tools→ Drafting Settings and the dialog box 

seen in Figure 20.3 appears.

Figure 20.2 
Isometric planes.

Figure 20.3 
Drafting Settings, Snap type, Isometric snap.
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Step 3. Pick the Snap and Grid tab, go to Snap type (lower left), pick Isometric snap, and 
finally press on OK. Figure 20.3 is a screen shot of the Drafting Settings dialog box 
with Isometric snap selected.

Step 4. Make sure Ortho is activated and the crosshairs are set at 100% for easier visualization 
of planes. Notice also how the crosshairs are positioned now that you are in isometric 
mode.

Step 5. Draw straight lines (as they should be with Ortho) of any size and continue drawing 
until you have the front face of a box.

Step 6. Very important: Do not try to connect the final line to the first line; you will never get 
it exactly right. Instead overshoot and click after passing it by, as shown in Figure 20.4.

Figure 20.5 
Step 7.

Figure 20.6 
Step 9.

Figure 20.4 
Steps 5 and 6.

Step 7. Now use the Fillet command to fillet the line between Clicks 4 and 5 and Clicks 1 
and 2. What is shown in Figure 20.5 is the result.
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  Step 8. Now press F5. The crosshairs shift to another plane and you can draw another surface.
  Step 9. �You can press F5 again for the final surface or use the Copy command. Be sure to 

use the ENDpoint OSNAP to cleanly connect lines. Figure 20.6 shows what you get 
after a few lines.

Figure 20.7 
Step 10.

Figure 20.8 
Basic ellipse.

Step 10. And the final result after a few more lines is seen in Figure 20.7.

What makes isometric drawing easy is that the techniques do not change for more complex 
objects. There may be more lines but it is the same thing over and over.

Here are some additional pointers:

l	 To draw circles in isometric perspective use Ellipses. This command was introduced in 
Chapter 2 and was used to make the bathtub in the apartment drawing at the end of 
Chapter 4. We say a few more words about using ellipses in isometric design here.

l	 Always stay in Ortho mode unless you need to deliberately angle a line at some odd 
angle. You see an example of this with the back of the monitor in the upcoming computer 
desk drawing.

l	 Text can be angled up or down by 30° to align with the isoplanes. We discuss this shortly.
l	 Have fun with this. Isometric drawing is a semi-artistic endeavor and not as rigid as 

drafting. Eyeball distances but try to make the drawing look good. Do not be afraid to 
throw in some hatch patterns, as is done on the computer desk drawing. Remember 
though, if you need more precision you have to go to the real 3D.

20.3  Ellipses in isometric drawing
A circle angled away from you is an ellipse, and these shapes find wide application in 
isometric drawing. You need ellipses for the base of the monitor in the upcoming computer 
desk drawing as well as the power button and extensive end-of-chapter exercises.
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There is no surefire way to create the perfect ellipse; it always requires a bit of adjusting to get 
right and a bit of a creative eye to do so. Reproducing what was first shown in Chapter 2, we 
have Figure 20.8.

Once the ellipse is positioned and is the right size, you can rotate it until it looks correct and 
in the same plane as the rest of the isometric geometry. Figure 20.9 is an example of some 
ellipses in an isometric box.

20.4  Text and dimensions in isometric drawing
Text can easily be aligned with isoplanes by rotating it plus or minus 30° (or other values 
such as 200°), depending on the plane, as shown in Figure 20.10.

Although not ideal, you can dimension in isometric drawing, using Dimension→Aligned 
and vertical dimensions, as seen in Figure 20.11.

Figure 20.9 
Isometric box with ellipses.

Figure 20.10 
Text in isometric drawing.



CHAPTER 20  
Isometric Drawing

439

Level 2 drawing project (10 of 10): architectural  
floor plan
The final step of the Level 2 project is the easiest. Your task is to set up the lineweights for the 
floor plan. Assume the standard we have been following, and make green the darkest line, 
followed by yellow and red, then all the others. Print out and compare the drawing versus 
just using monochrome.ctb.

Summary
You should understand and know how to use the following concepts at the conclusion of 
this chapter.

l	 Isometric drawing
m	 What is it?
m	 When to use it
m	 When not to use it
m	 Isometric settings

l	 Planes
m	 What are the three planes?
m	 Switching between them (F5)

l	 Ellipses in isometric drawing
l	 Text and dimensions in isometric drawing

REVIEW QUESTIONS
Answer the following based on what you learned in Chapter 20.

1.	 List some instances when isometric drawing is appropriate.

2.	 List some instances where 3D would be better than isometric drawing.

3.	 Name the three planes that exist in isometric perspective.

4.	 In what dialog box is Isometric snap found?

5.	 What F key switches the cursor from plane to plane?

6.	 What is almost always on when drawing in isometric?

7.	 What is the equivalent of a circle in isometric drawing?

Figure 20.11 
Dimensions in isometric drawing.
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EXERCISES
1.	 Draw the following computer desk. You need your basic isometric drawing knowledge and construction 

techniques developed in this chapter. Also make use of the Ellipse command and hatch the desk itself. 
All sizes are approximate and may be estimated. (Difficulty level: Easy/Moderate; Time to completion: 
20–30 minutes)
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2.	 Draw the following mechanical device. You need your basic isometric knowledge and construction 
techniques developed in this chapter. Also make extensive use of the Ellipse command. All sizes are 
approximate and may be estimated. (Difficulty level: Moderate; Time to completion: 30 minutes)



level 2  
Chapters 11–20

442

3.	 Draw the following architectural detail. All sizes are approximate and may be estimated. (Difficulty 
level: Easy; Time to completion: 10–15 minutes)

4.	 Draw the following architectural detail. All sizes are approximate and may be estimated. (Difficulty 
level: Easy; Time to completion: 15–20 minutes)
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Additional information on 
AutoCAD

Who makes autocad?
As you may already know, AutoCAD is designed and marketed by Autodesk®, Inc. (NASDAQ: 
ADSK), a software giant headquartered in San Rafael, California. Its website (a good resource 
center) is www.autodesk.com. The company was founded in 1982 by programmer John Walker 
and his associates and went public in 1985 (see the history). Walker was one of AutoCAD’s 
early developers, building on original source code purchased from another programmer, 
Michael Riddle. Autodesk today is headed by president and CEO Carl Bass, has over 7300 
employees (down after some layoffs in early 2009), and posted revenues of $2.315 billion 
in FY 2009. Although the company now has more than 90 software applications, AutoCAD 
remains its flagship product and biggest source of revenue.

The installed base of AutoCAD (the number of software copies purchased) worldwide (as 
of 2007) is 3.9 million of AutoCAD and 3 million of AutoCAD LT. Due to piracy, the actual 
installed base is probably significantly higher. Also, the number of seats can vary depending 
on how you count educational versions and vertical software purchases. Either way though, 
these numbers indicate that AutoCAD is indisputably the world’s number 1 drafting software 
with a market share often estimated to be somewhere in the 55%–60% range.

What is autocad lt?
Contrary to popular belief, LT does not stand for “lite” (or as we joke in class, “AutoCAD 
with less calories”). Instead it means “laptop” and was originally meant for slower and 
weaker early laptop computers, a sort of portable AutoCAD, if you will. Today laptops 
are just as powerful as desktops and LT exists to compete in the lower-end CAD market 
with similarly priced software. It is essentially stripped-down AutoCAD. What is missing 
is detailed exhaustively on the Autodesk website, but it essentially boils down to no 3D 
ability, no advanced customization, and no network licensing. In addition to these, some 
other minor missing features are scattered throughout the software, but the differences are 
not that great, and aside from the lack of 3D, it takes a trained eye to spot LT. It really looks 
and acts like AutoCAD, and with good reason. It was created by taking regular AutoCAD 
and “commenting out” (and thereby deactivating) portions of the C code that Autodesk 
wanted to reserve for its pricier main product.

Having said this, however, AutoCAD LT is an excellent product and is recommended for 
companies that do not have ambitious CAD requirements. The simple truth (and something 
Autodesk does not promote) is that some users never need the full power of AutoCAD and 
do just fine with LT, while paying a fraction of the cost of full AutoCAD. Electrical engineers 
especially need nothing more than LT for basic linework and diagrams, as do architects and 
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mechanical engineers who deal with schematics. The size of the files you anticipate working 
on, by the way, is of no consequence. LT lacks certain features, not the ability to work with 
multistory skyscraper layouts if needed. It truly is a hidden secret in CAD. Autodesk must 
have been taken by surprise with the strong LT sales since 2002 and tried to dramatically raise 
prices on the software from $700 to $1200 in 2008 and 2009 but, as of the 2010 release, had 
a change of heart (or a dose of economic reality), and the price has dropped down to $880.

How is autocad purchased and how much does it cost?
A number of years ago, you could not have purchased AutoCAD at a retail store or from 
Autodesk itself. You had to contact an authorized dealer (or reseller) and the sale was then 
usually arranged by phone, paid for with a credit card, and AutoCAD was shipped via 
registered mail. You can still do this, and some customers continue to, however since Release 
2000, Autodesk’s website was configured for direct purchase. Look under Products, then 
AutoCAD, then How to Buy in the main section of the site. AutoCAD is still not available 
at retail outlets, although AutoCAD LT always has been, and continues to be, sold in some 
retail computer stores.

How much AutoCAD costs is a trickier question. If purchasing from a dealer, called an 
authorized reseller, prices may vary but are generally the lower “street prices.” If purchasing 
from the Autodesk site, however, the prices are fixed. Currently AutoCAD 2011, the latest 
release, is shipping for $3995. A download is $3975 (you don’t have to pay for shipping and 
the cardboard box). An upgrade from 2010 is $1995 and higher from older versions (prior to 
AutoCAD 2008). This is an incentive, and not a well-liked one, to force customers to upgrade 
now for fear of paying more later on. AutoCAD LT, as mentioned, is now $880 retail. In 
general, use these prices only as guidelines; they may be lower with dealers, and of course 
this is all subject to change.

There are also variations in cost if you are buying only AutoCAD versus buying AutoCAD 
with vertical add-ons. The cost also varies depending on how many copies you are buying 
(for large volume purchases). With a dealer, the purchase may come bundled with a 
telephone or an on-site support contract for any anticipated problems or training needs. 
Sometimes these are sold separately. Autodesk in general, like other software firms, 
has moved toward a subscription model where you pay a yearly fee to own AutoCAD 
but upgrades are free. The subscription price for AutoCAD 2010 is $4445, shipped or 
downloaded. This makes more sense to larger firms that anticipate upgrading often. If you 
are tasked with purchasing AutoCAD for your company, explore all your options and shop 
around. You also need not upgrade as often as Autodesk suggests.

Are there significant differences between autocad 
releases?
This is a common question at the start of training sessions. Many schools are authorized 
training centers and, as such, have the latest version of AutoCAD installed. That may or may 
not be the case with the students and their respective companies. No issue seems to cause 
as much confusion and anxiety as this one. To put your fears to rest, if you are learning 
AutoCAD 2011 (this book) and have 2010, 2009, 2008, 2007, or earlier versions at home or 
at work, do not worry. The differences, while real, are for the most part relatively minor and 
cosmetic (such as the introduction of the Ribbon in 2009). While AutoCAD has certainly 
been modernized, it has not fundamentally changed since it moved to Windows and away 
from DOS over 16 years ago and finally stabilized with R14 in 1997. If you were to open up 
that release, you would feel right at home with 90% of the features. Purists and AutoCAD 
fanatics may scoff, but although there have been many great enhancements, the fact remains 
that the vast majority of what is truly important has already been added to AutoCAD and 
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new features are incremental improvements. Most of what you learn in one version is 
applicable to several versions backward and forward, especially at a beginner’s level.

A brief history of autodesk and autocad
The father of Autodesk and AutoCAD is John Walker. A programmer by training, he formed 
Marinchip Systems in 1977 and, by 1982, seeing an opportunity with the emergence of 
the personal computer, decided to create a new “software only” company with business 
partner Dan Drake. The plan was to market a variety of software, including a simple drafting 
application they acquired earlier. Based on code written in 1981 by Mike Riddle and called 
MicroCAD (later on changed briefly to Interact), the software would sell for under $1000 
and would run on an IBM PC. It was just what they were looking for to add to their other 
products.

Curiously, the still unnamed company did not see anything special in the future of 
only MicroCAD and focused its energy on developing and improving other products as 
well. Among them were Optical (a spreadsheet), Window (a screen editor), and another 
application called Autodesk or Automated Desktop, which was an office automation and 
filing system meant to compete with a popular, at the time, application called Visidex. This 
Automated Desktop was seen as the most promising product; and when it came time to 
finally incorporate and select a name, Walker and company (after rejecting such gems as 
Coders of the Lost Spark) settled on Autodesk Inc. as the official and legal name.

Written originally in SPL, MicroCAD was ported by Walker onto an IBM machine and 
recoded in C. As it was practically a new product now, it was renamed AutoCAD, which 
stood for automated computer aided design. AutoCAD-80 made its formal debut in 
November 1982 at the Las Vegas COMDEX show. As it was new and had little competition at 
the time, the new application drew much attention. The development team knew a potential 
hit was on their hands and a major corner was turned in AutoCAD’s future. AutoCAD 
began to be shipped to customers, slowly at first, then increasing dramatically. A wish list 
of features given to the development team by customers was actively incorporated into each 
succeeding version—they were not yet called releases.

In June 1985 Autodesk went public and was valued at $70 million, in 1989 it was at $500 
million, and in 1991 at $1.4 billion. With each release, milestones, large and small, such as 
introduction of 3D in Version 2.1 and porting to Windows with Releases 12 and 13, were 
achieved. In a story not unlike Microsoft, Autodesk, through persistence, innovation, firm 
belief in the future of personal computers, and a little bit of luck, came to dominate the CAD 
industry.

Figure A.1 shows perhaps the most famous AutoCAD drawing of all, a nozzle drawn in 1984 
by customer Don Strimbu on a very early AutoCAD version. This was the most complex 

Figure A.1 
A nozzle drawn in 1984 by Don Strimbu on very early AutoCAD.
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drawing on AutoCAD up to that point, used by the development team as a timing test for 
machines, and featured on the covers of many publications, including Scientific American in 
September 1984.

Autocad releases
Autodesk first released AutoCAD in December 1982, with Version 1.0 (Release 1) on DOS, 
and continued a trend of releasing a new version sporadically every one to three years until 
R2004, when they switched to a more regular once a year schedule. A major change occurred 
with R12 and R13, when AutoCAD was ported to Windows and support for UNIX, DOS, and 
Macintoshes was dropped. R12 and R13 were actually transitional versions (R13 is better 
left forgotten), with both DOS and Windows platforms supported. It was not until R14 
that AutoCAD regained its footing as sales dramatically increased. Figure A.2 is AutoCAD’s 
timeline. A release history follows:

Version 1.0 (Release 1), December 1982
Version 1.2 (Release 2), April 1983
Version 1.3 (Release 3), August 1983
Version 1.4 (Release 4), October 1983
Version 2.0 (Release 5), October 1984
Version 2.1 (Release 6), May 1985
Version 2.5 (Release 7), June 1986
Version 2.6 (Release 8), April 1987
Release 9, September 1987
Release 10, October 1988
Release 11, October 1990
Release 12, June 1992 (last release for Apple Macintosh)
Release 13, November 1994 (last release for UNIX, MS-DOS, and Windows 3.11)  
Release 14, February 1997
AutoCAD 2000 (R15.0), March 1999
AutoCAD 2000i (R15.1), July 2000
AutoCAD 2002 (R15.6), June 2001
AutoCAD 2004 (R16.0), March 2003
AutoCAD 2005 (R16.1), March 2004
AutoCAD 2006 (R16.2), March 2005

Figure A.2 
AutoCAD timeline.
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AutoCAD 2007 (R17.0), March 2006
AutoCAD 2008 (R17.1), March 2007
AutoCAD 2009 (R17.2), March 2008
AutoCAD 2010 (R17.3), March 2009
AutoCAD 2011 (R17.4), March 2010
AutoCAD 2012 (R17.5), March 2011 (anticipated)

Major autodesk products
Autodesk markets more than 90 software products, some major and some obscure. Only 
one application sold today is the company’s original product, that is AutoCAD. The rest have 
been developed in-house from scratch over the years, purchased outright from the original 
developers, or as is often the case, acquired in takeovers and mergers. Many products are 
designed to “hitch a ride” on the back of AutoCAD and extend its power to serve a niche 
market with additional functionality and menus not found in the base product. Those 
are often homegrown applications and are referred to as verticals. In other cases Autodesk 
markets radically different software, such as one used for high-end animations and cartoons. 
Those have been acquired to extend the company’s reach into new markets.

The following lists Autodesk’s flagship products that you should know about, as you may 
come across them in the industry; also listed are the popular add-on products purchased 
with AutoCAD:

Flagship products

l	 AutoCAD: Autodesk’s best-selling and biggest product for computer aided design.
l	 AutoCAD LT: A limited functionality version of AutoCAD for an entry-level market.
l	 3ds Max: A powerful high-end rendering and animation software product.
l	 Autodesk AliasStudio: A high-end surface modeling, sketching, and illustration product.
l	 Inventor: A mid-range parametric solid modeling and design package for engineering.
l	 Revit: A high-end parametric software for architectural and building design.
l	 Maya: Very high-end animation, effects, and rendering software.

Add-ons to AutoCAD (verticals)

l	 AutoCAD Architecture: Additional functionality for architecture design applications.
l	 AutoCAD Civil: Additional functionality for civil engineering applications.
l	 AutoCAD Electrical: Additional functionality for electrical engineering applications.
l	 AutoCAD Land Desktop: Additional functionality for land, civil, and environmental 

design.
l	 AutoCAD Mechanical: Additional functionality for mechanical engineering.
l	 AutoCAD P&ID: Additional functionality for creating piping and instrumentation 

diagrams.

These are just some of the major software applications in Autodesk’s inventory. A significant 
number of products, including all the less known or obscure ones, have been omitted. 
A full and comprehensive list of all of them can be found on the Autodesk website. You 
are encouraged to look them over to stay ahead of the curve and know what other design 
professionals may be using.

Autocad related websites
Next is a listing of important and valuable websites for AutoCAD and general CAD related 
information. Online content has grown from occasionally useful to indispensable, and 
experienced AutoCAD users must have at least the following at their fingertips when the need 
arises. Note that link fidelity is not guaranteed, and except for the few major ones at the start 
of the list, the sites may and do change.
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Autodesk Inc. (www.autodesk.com). Mentioned previously, it is home base for the makers 
of AutoCAD. Here you find locations of AutoCAD dealers and training centers as well as 
endless information on AutoCAD and other software products and services. Well worth 
visiting occasionally.
Autodesk User Group International (www.augi.com). The Holy Grail for all things related 
to AutoCAD. This site is the officially sanctioned user community for Autodesk and 
its products. AUGI puts out numerous publications and runs conferences and training 
seminars all over the United States and worldwide. Its website is packed full of tips, tricks, 
articles, and forums where you can ask the community your hardest AutoCAD questions. 
Claiming over 100,000 members, AUGI has the distinction of being the only organization 
that can officially submit “wish lists” directly to Autodesk, meaning that if you are a 
member and have an idea for a new feature or how to improve AutoCAD, the company 
just may listen to you.
Cadalyst magazine (www.cadalyst.com). A great magazine dedicated to all things 
CAD, including solid modeling and rendering, but with a large amount of coverage 
dedicated specifically to AutoCAD. A must read for AutoCAD managers, the magazine 
features informative articles on all aspects of the job, including programming, industry 
trends, and advanced topics. Subscription is free and can be applied for online; highly 
recommended. In 2009 the magazine went “all digital” pending further notice, so check 
the website for the latest.
CAD Block Exchange Network (http://cben.net). Many sites post helpful articles; this site 
posts actual AutoCAD files. Blocks, blocks, and more blocks. If you need it and really 
do not want to draw it, check here first. Great resource for people, trees, and vehicle 
blocks for civil and landscape engineering, in plan, elevation, and 3D, though just about 
everything else can be found there, too.
AutoCAD blocks resource site (www.autocadblock.com). With lots of free, and for 
purchase, blocks in every category, this is a useful and growing site, if a bit too 
commercial. However, if you are looking to spend some money on entire libraries of 
blocks, this is the place to go.
Lynn Allen’s blog (http://lynn.blogs.com). You may have never heard of Lynn Allen if you 
are just starting out with AutoCAD, but hang around long enough and you probably will. 
She is what the AutoCAD community refers to as an Autodesk Technical Evangelist, or an 
expert on all things AutoCAD. Though certainly many experts are around, what sets Lynn 
apart is that she actually works for Autodesk and gets to learn AutoCAD directly from the 
developers. Her blog is the place to go to when a new release is about to hit the market. 
She will likely have already analyzed it and written a book by then. Lynn is also a prolific 
speaker, appearing at just about every AutoCAD conference, and has been a columnist 
for Cadalyst for many years as well. She writes and speaks well and employs humor in her 
approach to thorny technical issues.
AutoCAD Lessons on the Web (www.cadtutor.net). A well organized and extensive site for 
learning AutoCAD that includes some tutorials on 3ds max, VIZ, Photoshop, and web 
design.
The Business of CAD, Part I (www.upfrontezine.com). The website describes itself thus: 
“Launched in 1995, the upFront.eZine e-newsletter is your prime independent source of 
weekly business news and opinion for the computer-aided design (CAD) industry.” The 
site is a no-nonsense, cut through the hype source for CAD (mostly AutoCAD but others, 
too) information, latest releases, and analysis of Autodesk business decisions; a great 
resource for a CAD manager.
The Business of CAD, Part II (http://worldcadaccess.typepad.com). A spin-off blog from the 
preceding site, it also addresses news in the media about all things CAD and how it will 
affect you; recommended for the serious CAD manager or user.
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John Walker’s site (www.fourmilab.ch). This site, while not essential AutoCAD reading, 
is still interesting, fun, and often quite informative. As co creator of AutoCAD, former 
programmer John Walker has put together the definitive early history of how it all began. 
Fascinating reading from a fascinating man who is now “retired” in Switzerland and 
pursuing artificial intelligence research. His site is chock full of readings on numerous 
subjects as you would expect from a restless and inquisitive mind; truly someone who 
changed computing history in a significant way.

As with many topics in this brief appendix, what is listed here only scratches the surface. 
Remember that you are not the only one out there using AutoCAD, so feel free to reach out 
and see what else is out there if you have questions or would just like to learn more. At a 
minimum, it is recommended to join AUGI and get a subscription to Cadalyst.
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Other CAD Software and 
Design and Analysis Tools 
and Concepts

While it is true AutoCAD is the market leader for drafting software, it certainly does not 
operate in a vacuum and is not the only game in town. The list that follows summarizes 
other major players in the drafting field. The reason you should know about them is because 
you may run into them in use and may have to exchange files if collaborating. Saying “I’ve 
never heard of that” is usually not a good way to start a technical conversation in your area 
of expertise, so take note of the following products. 

MicroStation (www.Bentley.com)
A major (and really the only serious) competitor to AutoCAD is produced and marketed by 
Bentley Systems. For historical reasons, the software is widely used in government agencies 
and in the civil engineering community. It comes in full and PowerDraft variations (akin to 
AutoCAD and LT). The current version is MicroStation V8 XM, and its file extension is dgn. 
AutoCAD does not open these files directly, though that may soon change. MicroStation, on 
the other hand, does open AutoCAD’s dwg files. Of course many techniques and even third 
party software are available to quickly and easily convert one file format to another.

MicroStation is more icon driven but otherwise similar to AutoCAD in many ways. Its 3D 
capabilities are considered excellent, but its interface can be a bit cumbersome to use for a 
novice. Its main disadvantage is that it is not an industry standard; it is otherwise excellent 
software, and its ability to handle Xrefs (multiple external file attachments) is unparalleled. 
Its users are a sometimes fanatical bunch, promoting its virtues against AutoCAD at every 
opportunity. An objective view of both applications yields an opinion that both have their 
pros and cons, and those who disparage one over the other usually do not know what they 
are talking about.

ArchiCAD (www.graphisoft.com)
This is a popular application among architects, geared toward the Macintosh but also available 
for Windows. Developed by a Hungarian firm, Graphisoft, at around the same time as 
AutoCAD, ArchiCAD took a different approach, allowing for a parametric relationship between 
objects, as well as easier transitions to 3D, as all objects are created inherently with depth. 
The software has a loyal installed user base of about 100,000 architects worldwide and can 
interoperate fully with AutoCAD files. The current release is ArchiCAD 11.
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APPENDIX B  

454

TurboCAD (www.turbocad.com)
This is a mid-range 2D/3D drafting software, first developed and marketed in South Africa 
in 1985 and brought to the United States the following year. It was marketed as an entry 
level basic drafting tool (once sold for as low as $49), but with constant upgrading and 
development TurboCAD has grown over the years to a $1200–$1500 software product for 
the architectural and mechanical engineering community. It operates on both Windows and 
Macintosh. The current release is TurboCAD 15.

Some other notable CAD applications include RealCAD, VectorWorks (formerly MiniCad), 
IntelliCAD, Form Z, and Rhino, though the last two are often used only for modeling and 
visualization. This list is not exhaustive by any means, as literally hundreds of other CAD 
programs are available.

Many of my students are interested in other aspects of design, and questions often come up 
as to how AutoCAD fits into the “big picture” of a much larger engineering or design world. 
To address some of these questions, the following information, culled from a chapter written 
in 2007 as part of an undergraduate machine design theory workbook, is included. AutoCAD 
students, especially engineers, may find this informative. The subject matter is extensive and 
this brief overview only scratches the surface. Ideally, if the reader was not aware of these 
concepts and the engineering design and analysis software described, this serves as a good 
introduction and a jumping off point to further inquiry.

l	 CAD (computer aided design). It is a broad generic term for using a computer to 
design something. It can also be used in reference to a family of software that allows 
you to design, engineer, and test a product on the computer prior to manufacturing it. 
CAD software can be used for primarily 2D drafting (such as with AutoCAD) or full 
3D parametric solid modeling. The latter is the software that aerospace, mechanical, 
automotive, and naval engineers commonly use. Examples include CATIA, NX,  
Pro-Engineer, IronCAD, and SolidWorks, among others. Included under the broad 
category of CAD is testing and analysis software.

l	 FEA (finite element analysis). This is used for structural and stress analysis, testing 
thermal properties, and much more as related to frames, beams, columns, and other 
structural components. Examples of FEA software include NASTRAN, ALGOR, and 
ANSYS.

l	 CFD (computational fluid dynamics). This is software used to model fluid flow around 
and through objects to predict aerodynamic and hydrodynamic performance. Examples 
of CFD software include Fluent and Flow 3-D.

l	 CAM (computer aided manufacturing). The basic idea is this: OK we designed and 
optimized our product, now what? How do we get it from the computer to the machine 
shop to build a prototype? The solution is to use a CAM software package that takes your 
design (or parts that make up your design) and converts all geometry to information 
useable by the manufacturing machines, so the drills, lathes, and routing tools can get to 
work and create the part out of a chunk of metal. Examples of dedicated CAM software 
include Mastercam and FastCAM.

l	 CAE (computer aided engineering). Strictly defined, CAE is the “use of information 
technology for supporting engineers in tasks such as analysis, simulation, design, manu-
facture, planning, diagnosis, and repair.” We use this term to define an ability to do this 
all from one platform, as explained next.

As you read the CAD and CAM descriptions you may be wondering why CAD companies 
have not provided a complete solution to design, test, and manufacture a product using 
one software package. They have, to varying degrees of success. For a number of years an 
engineering team designing an aircraft, for example, had to typically create the design  
(and subsystems) in a 3D program like CATIA, then import the airframe for FEA testing into 
NASTRAN, followed by airflow testing in CFD software (and a wind tunnel), and finally 
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send each component through CAM software like Mastercam to manufacture it (a greatly 
simplified version of events of course).

Obviously data could be lost or corrupted in the export/import process, and a lot of 
effort was expended in making sure the design transitioned smoothly from one software 
application to another. While the final product was technically a result of CAE, software 
companies had something better in mind: “one stop shopping.” As a result, CAE today 
means one source for most design and manufacturing needs. CATIA for example has 
“workbenches” for FEA analysis and CAM. Code generated by CATIA is imported into the 
CNC machines that (typically after corrections and editing) produce virtually anything you 
can design (with some limitations of course).

As you may imagine, not everything is rosy with this picture. As the specialized companies 
got better and better at their respective specialties (CAM, FEA, or CFD), it became harder 
and harder for the CAD companies to catch up and offer equally good solutions embedded 
in their respective products. Mastercam is still the undisputed leader in CAM worldwide, 
and NASTRAN is still the king of FEA. CATIA’s version of these has gotten better but is still a 
notch behind. The situation is the same with Pro/E, NX, and other CAD software.

These high-end 3D packages are also referred to as product lifecycle management (PLM) 
software, a term you will hear a lot of in the engineering community. As described already, 
these software tools aim to follow a product from design and conception all the way through 
testing and manufacturing in one integrated package.

l	 CNC/G-Code (computer numerical code). This is the language (referred to as G-Code) 
created by the CAM software and read by the CNC machines. G-Code existed for decades. 
It was originally written by skilled machinists based on the geometry of the component 
to be manufactured (and sound manufacturing practices). This code can still be written 
by hand. It is not hard to understand. Most lines start with G, hence its name; and they 
all describe some function that the CNC machine does as related to the process. After 
some practice the lines start to make sense and you can roughly visualize what is being 
manufactured, just by reading them.

Here are some more specific details on the CAD software mentioned in the preceding section. 
You may run into many of these throughout your engineering career. It is well worth being 
familiar with these products. The information is up to date as of press time.

CATIA (www.3ds.com)
Computer aided three-dimensional interactive application (CATIA) is the world’s leading 
CAD/CAM/CAE software. Originally developed in France by Dassault for its Mirage fighter 
jet project (though originally based on Lockheed’s CADAM software), it is now a well-known 
staple at Boeing and many automotive, aerospace, and naval design companies. It has even 
been famously adopted by architect Frank Geary for certain projects. CATIA has grown into 
a full PLM solution and is considered the industry standard, though complex and with a not 
always user friendly reputation. The current version is CATIA V6 R2010.

NX (www.ugs.com)
Another major CAD/CAM/CAE PLM software solution is from a company formerly called 
UGS. This package is a blend of the company’s Unigraphics software and SDRC’s popular 
I-DEAS software, which UGS purchased and took over. Siemens AG now owns UGS and the 
NX software. It is used by GM, Rolls Royce, Pratt & Whitney, and many others. The current 
version is NX 6.

Pro/Engineer (www.ptc.com)
The third major high-end CAD/CAM/CAE PLM software package, Pro/E is historically 
significant. It originally caused a major change in the CAD industry when first released 
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(in 1988) by introducing the concept of parametric modeling. Rather than models being 
constructed like a mound of clay with pieces being added or removed to make changes, the 
user constructs the model as a list of features, which are stored by the program and can be 
used to change the model by modifying, reordering, or removing them. CATIA and NX also 
now work this way. The current version is Pro/E Wildfire 5.0.

SolidWorks (www.solidworks.com)
Solidworks is a mid-range CAD/CAM/CAE product from Dassault, the makers of CATIA. 
Marketed as a lower-cost competitor to major CAD packages, the software still has extensive 
capabilities and caught on quickly in smaller design companies. The current version is 
SolidWorks 2008.

Inventor (www.autodesk.com)
This is another mid-range product, from the makers of AutoCAD, for solid modeling and 
design. Considered a low- to mid-range product when first introduced, Inventor matured 
to become a major competitor to SolidWorks and even Pro/Engineer. The current version is 
Inventor 2010.

IronCAD (www.ironcad.com)
This is another vendor in the mid-range market. The software gained ground in recent years 
due to a user-friendly reputation and a more intuitive approach to 3D design. The current 
version is IronCAD 10.

Solid Edge (www.solidedge.com)
This is also a mid-range product from UGS (now owned by Siemens AG), the same 
company that makes the high-end NX package. It is comparable to SolidWorks in cost and 
functionality. The current release is Solid Edge V20.

Listed next are some of the major software products in FEA and CFD, as mentioned earlier.

NASTRAN (www.NEiNastran.com)
Originally developed for NASA as open source code for the aerospace community to 
perform structural analysis, NASA structural analysis, or NASTRAN, was acquired by several 
corporations and marketed in numerous versions. NEiNastran is just one (commonly used) 
flavor of it. NASTRAN in its pure form is a solver for finite element analysis and cannot 
create its own models or meshes. Developers, however, have added pre- and postprocessors 
to allow for this. The current release for NEiNastran is V9, though other companies have 
different designations for their products.

ANSYS (www.ansys.com)
This is a major FEA product for structural, thermal, CFD, acoustic, and electromagnetic 
simulations.

ALGOR (www.algor.com)
This is another major FEA product for structural, thermal, CFD, acoustic, and 
electromagnetic simulations.

Fluent (www.Fluent.com)
This is the industry standard for CFD software, holding about 40% of the market. It imports 
geometry, creates meshes (using GAMBIT software) and boundary conditions, and solves for 
a variety of fluid flows, using the Navier-Stokes equations as theoretical underpinnings. The 
company was recently acquired by ANSYS. The current release is Fluent 6.3.
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File Extensions

File extensions are the bane of the computer user’s existence. They number in the many 
hundreds (AutoCAD alone claims nearly 200) and even if you pare the list down to a useful 
few, it is still quite a collection. Here we focus on those extensions that are important to an 
AutoCAD user, as chances are you will encounter most, if not all, of them while learning the 
software top to bottom. They are listed alphabetically (with explanations and descriptions) 
but grouped in categories to bring some order to the chaos and set priorities for what you 
really need to know and what you can just glance over. Following AutoCAD’s list is a further 
listing of extensions from other popular, often-used software, which you may find useful if 
you are not already familiar with most of them.

Autocad primary extensions
l	 .bak (backup file). A bak is an AutoCAD backup file created and updated every time you 

save a drawing, provided that setting is turned on in the Options dialog box. The bak file 
has the same name as the main dwg file, generally sits right next to it, and can be easily 
renamed to a valid dwg if the original dwg is lost.

l	 .dwf (design web format file). The dwf is a format for viewing drawings online or with a 
dwf viewer. The idea here is to share files with others who do not have AutoCAD in a way 
that enables them to look but not modify. If this sounds like Adobe pdf, you are correct; 
dwf is a competing format.

l	 .dwg (drawing file format). The dwg is AutoCAD’s famous file extension for all drawing 
files. This format can be read by many of Autodesk’s other software products as well as by 
some competitors. The format itself changes somewhat from release to release, but these 
are internal programming changes and invisible to most users.

l	 .dwt (drawing template). The dwt is AutoCAD’s template format and is essentially a dwg 
file. The idea is to not repeat setup steps from project to project but use this template. It is 
equivalent to just saving a completed project as a new job and erasing the contents.

l	 .dxf (drawing exchange format). The dxf is a universal file format developed to allow 
for smooth data exchange between competing CAD packages. If an AutoCAD drawing is 
saved to a dxf file, it can be read by most other design software (in theory anyway). This 
of course is not always the case, and some CAD packages open dwg files anyway without 
this step, but the dxf remains an important tool for collaboration. The dxf is similar in 
principle and intent to IGES and STEP for those readers who may have worked with solid 
modeling software and understand what those acronyms mean.

Autocad secondary extensions
l	 .ac$  A temporary file generated if AutoCAD crashes; it can be deleted if AutoCAD is not 

running.
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l	 .ctb  This color table file is created when pen settings and thickness are set (Chapter 19 
topic).

l	 .cui  This customizable user interface file is for changes to menus and toolbars (Chapter 
14 topic).

l	 .err  This error file is generated upon an AutoCAD crash. You can delete it.
l	 .las  This layer states file can be imported and exported (Chapter 12 topic).
l	 .lin  This linetype definition file can be modified and expanded (see Appendix D).
l	 .lsp  This LISP file is a relatively simple language used to modify, customize, and 

automate AutoCAD to effectively expand its abilities (see Appendix F).
l	 .pat  This hatch definition file can be modified and expanded (see Appendix D).
l	 .pgp  This program parameters file contains the customizable command shortcuts 

(Chapter 14 topic).
l	 .scr  This script file is used for automation (mentioned in Chapter 12).
l	 .sv$  This is another temporary file for the Auto Save feature. It appears if Auto Save is on 

and remains in the event of a crash. It can be then renamed to dwg or deleted.

Miscellaneous software extensions
These extensions are for software and formats likely to be encountered daily or at least 
occasionally by AutoCAD users and are always good to know. Some extensions can be found 
in AutoCAD as export/import choices.

l	 .ai  Adobe Illustrator files.
l	 .bmp  Bitmap, a type of image file format that, like jpg, uses pixels.
l	 .dgn  The MicroStation file extension. This competitor to AutoCAD can open native dwg 

files. Appendix C discusses this software.
l	 .doc  MS Word files (also WordPerfect and WordStar).
l	 .eps  Encapsulated PostScript file.
l	 .jpg  The jpeg (joint photographic experts group) is a commonly used method 

(algorithm) of compression for photographic images. It is also a file format. The jpgs are 
discussed in Chapter 16.

l	 .pdf  The famous Adobe Acrobat file extension. You can print any AutoCAD drawing to a 
pdf assuming Acrobat is installed.

l	 .ppt  MS PowerPoint file extension.
l	 .psd  The famous Photoshop file extension.
l	 .vsd  MS Visio drawing file extension. Visio is a simple and popular “drag and drop 

style” CAD package for electrical engineering schematics and flowcharts among other 
applications. It accepts AutoCAD files.

l	 .xls  MS Excel file extension.

This list is by no means complete, but covers many of the applications discussed in  
Chapter 16.
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Custom Linetypes and 
Hatch Patterns

This appendix outlines the basic procedures for creating custom linetypes and hatch patterns 
if you need something that is not found in AutoCAD itself or with any third party vendor. All 
linetypes and hatch patterns were originally “coded” by hand and there is nothing inherently 
special or magical about making them; they just take some time and patience to create. 
Though it is admittedly rare for a designer to need something that is not already available, 
creating these entities is a good skill to acquire. We just present the basics here and you can 
certainly do additional research and come up with some fancy designs and patterns.

Linetype definitions (basic)
All linetypes in AutoCAD (about 38 standard ones, to be precise) reside in the acad.lin or 
the acadiso.lin file. These are linetype definition files that AutoCAD accesses when you tell it 
to load linetypes into a drawing. In AutoCAD 2011, these files can be found in the Program 
Files\AutoCAD 2011\backup folder. Anything you do to these files, including adding to them, 
immediately shows up the next time you use linetypes. Our goal here is to open up the acad.
lin file, analyze how linetypes are defined, and then make our own.

Locate and open (usually with Notepad) the acad.lin file and take a look at it closely. Here is 
a reproduction of the first six linetype definitions: Border (Standard, 2, and X2) and Center 
(Standard, 2, and X2).

*BORDER, Border __ __ . __ __ . __ __ . __ __ . __ __ .
A,.5,.25,.5,.25,0,.25
*BORDER2,Border (.5x) __.__.__.__.__.__.__.__.__.__.__.
A,.25,.125,.25,.125,0,.125
*BORDERX2,Border (2x) ____ ____ . ____ ____ . ___
A,1.0,.5,1.0,.5,0,.5
*CENTER,Center ____ _ ____ _ ____ _ ____ _ ____ _ ____
A,1.25,.25,.25,.25
*CENTER2,Center (.5x) ___ _ ___ _ ___ _ ___ _ ___ _ ___
A,.75,.125,.125,.125
*CENTERX2,Center (2x) ________ __ ________ __ _____
A,2.5,.5,.5,.5

Let us take just one linetype and look at it closer. Here is the standard size center line:

*CENTER,Center ____ _ ____ _ ____ _ ____ _ ____ _ ____
A,1.25,.25,.25,.25
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The two lines that you see are the header line and the pattern line; both are needed to 
properly define a linetype. The header line consists of an asterisk, followed by the name of 
the linetype (CENTER), then a comma, and finally the description of the linetype (Center). 
In this case they are the same.

The pattern line is where the linetype is actually described, and the cryptic-looking 
“numerical code” (A,1.25,.25,.25,.25) is the method used to describe it and needs to 
be discussed for it to make sense.

The A is the alignment field specification and is of little concern (AutoCAD accepts only this 
type so you will always see A). Next are the linetype specification numbers, and they actually 
describe the linetype using dashes, dots, and spaces. Let us go over them as really this is the 
key concept.

The basic elements are

l	 Dash (Pen down, positive length specified, such as 0.5).
l	 Dot (Pen down, length of 0).
l	 Space (Pen up, negative length specified, such as –0.25).

Now you just have to mix and match and arrange these in the order you want them to be in 
to define a linetype that you envisioned.

What would this look like?

(A,.75,.25,0, .25, .75)

Well you know that dashes are positive, so everywhere you see.75, there will be a dash of 
that length. Spaces are negative, so everywhere you see .25, there will be a space of that 
length, and finally a 0 is a dot. This is the result:

___ . ___

These are the essentials of creating basic linetypes. AutoCAD, however, also allows for two 
other types to be created, and they are part of the complex linetype family: string complex 
and shape complex.

Linetypes (string complex and shape complex)
The problem with the previously mentioned linetypes is obvious; you have only dashes, dots, 
and spaces with which to work. While this is actually enough for many applications, you 
may occasionally (especially in civil engineering and architecture) need to draw boundary 
or utility lines that features text (Fence line, Gas line, etc.) or you may want to put small 
symbols between the dashes. It is here that strings and shapes come in.

String complex linetypes allow you to insert text into the line. Here is a gas line example:

*GAS_LINE,Gas line ----GAS----GAS----GAS----GAS----GAS----GAS--
A,.5,.2,[“GAS”,STANDARD,S=.1,R=0.0,X=0.1,Y=.05],.25

The header line is as discussed before, and the pattern line still starts with an A. After the 
A, we see a dash of length .5 followed by a space of length .2; so far it is familiar. Next is 
information inside a set of brackets, defined as follows:

[“String”, Text Style, Text Height (S), Rotation (R), X-Offset (X), 
Y-Offset (Y)].

Finally there is a .25 space and the string repeats.

The meaning of the information inside the brackets is as follows:

l	 String: This is the actual text, in quotation marks (GAS in our example).
l	 Text Style: The predefined text style (STANDARD in our example).
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l	 Text Height: The actual text height (.1 in our example).
l	 Rotation: The rotation of the text relative to the line (0.0 in our example).
l	 X-Offset: The distance between the end of the dash and the beginning of the text as well 

as the end of the text and the beginning of the dash (a space of .1 in our example).
l	 Y-Offset: The distance between the bottom of the text and the line itself. This function 

centers the text on the line.

With these tools you can create any text string linetype.

Shape complex linetypes are basically similar, aside from one difference; instead of a text string, 
we have a shape definition inserted. Shape definitions are a separate topic in their own right 
and are not covered in detail in this textbook. Briefly, however, shape files are descriptions of 
geometric shapes (such as rectangles or circles but can be more complex) and are written using 
a Text Editor and compiled using the Compile command. They are saved under the *.shp 
extension. AutoCAD accesses these when it reads the linetype definitions. If you are familiar with 
shapes, then you can proceed in defining shape complex linetypes as with string complex ones.

Hatch pattern definitions (basic)
Knowing the basics of linetype definitions puts you on familiar ground when learning hatch 
pattern definitions. Though they are more complex, the basics and styles of description are similar.

Hatch pattern definitions are found in the acad.pat and acadiso.pat files, and they reside in 
the same folder as the .lin files. Open the acad.pat file and take a look at a few definitions. 
Some of them can get long and involved due to the complexity of the pattern (Gravel, for 
example), but Figure D.1 shows a simpler one to use as a first example: Honeycomb.

The pattern definition file that describes it looks like this:

*HONEY, Honeycomb pattern
0, 0,0, .1875,.108253175, .125,.25
120, 0,0, .1875,.108253175, .125,.25
60, 0,0, .1875,.108253175, .25,.125

The first line (header line) is as discussed previously with linetypes. The next three lines are 
the hatch descriptors, and they have somewhat different definitions as shown next:

Angle, X-Origin, Y-Origin, D1, D2, Dash Length

where (in this particular example),

l	 Angle: Angle of the pattern’s first hatch line from the X-axis (0° in our example).
l	 X-Origin: X coordinate of hatch line (0,0 in our example).
l	 Y-Origin: Y coordinate of hatch line (.1875 in our example).
l	 D1: The displacement of second line (.1083 in our example).
l	 D2: The distance between adjoining lines (.125 in our example).
l	 Length: Length of dashes or spaces.

The pattern is repeated two more times to form the overall shape and repeated many more 
times in the overall hatch pattern.

Figure D.1 
Honeycomb pattern.
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Principles of CAD 
Management

So you have been hired on as a CAD manager or promoted to this role or more likely forced 
into it due to your substantial AutoCAD skills (or was it because no one else wanted the 
job?). Either way, you are now the top dog, head honcho—no, wait. You are just an architect 
or engineer and someone had to take the bull by the horns (many bulls actually, that run 
around and draft whatever way they please just to get the job out). Then again, maybe you 
are none of these and instead simply a student finishing Level 2. The bottom line is that you 
could use some ideas and a short discussion on this elusive science of CAD management. 
Well, you came to the right appendix.

All jokes aside, this is an important topic. You must take everything you learned in  
Levels 1 and 2 and apply it, while keeping others in line. You must be the keeper and 
the enforcer of standards and the technical expert who can resolve any issue. A true CAD 
manager who does nothing else is not all that common. You may have to multitask and do 
your own work while doing the management, especially in smaller companies.

Here are a few rules, ideas, and thoughts gathered from my 14 years of experience as a CAD 
consultant, educator, and CAD manager. They outline just some of the challenges and issues 
(and provide some possible answers) to those in charge of the software that is used to design 
a lot of what is around us.

PART 1: Know the seven golden rules of autocad
1.	 Always draw one-to-one (1:1).
2.	 Never draw the same item twice.
3.	 Avoid drawing standard items.
4.	 Use layers correctly.
5.	 Do not explode anything.
6.	 Use accuracy: Ortho and OSNAPs.
7.	 Save often.

Notice that most of those rules were discussed in some way in the first few chapters of  
Level 1. It is the basics people screw up, not some fancy new feature. Let us briefly go over 
these one by one; they bear repeating.

1.	 Always draw one-to-one (1:1). This is the most important one. Always draw items to 
real life sizes. Endless problems arise if users decide to scale items as they draw them. 
Leave scales and scaling to the pencil-and-paper folks. A drawing must pass a simple test. 
Measure anything that is known to be a certain value (for example, a door opening that is 
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3 feet wide) by using the list command. AutoCAD should tell you its value as 36 inches  
or 3 feet, and nothing else. You must enforce this as a CAD manager.

2.	 Never draw the same item twice. In hand-drafting, just about everything needed to be 
drawn one item at a time. Some inexperienced CAD users do the same in AutoCAD. That 
is not correct. AutoCAD and computer drafting in general require a different mindset, 
philosophy, and approach. If you have already drawn something once, then copy it, do 
not create it again. While this one may be obvious, another overlooked tool is the Block 
or Wblock command. If you anticipate using the new item again (even if there is a small 
chance), then make a block out of it. As a CAD manager, you need to sometimes remind 
users of this. Remember: “Time  $$.”

3.	 Avoid drawing standard items. This, like the preceding rule, aims to prevent duplicate 
effort. Before starting a project, as a CAD manager, you need to see to it that any standard 
parts (meaning ones that are not unique but constantly reused in the industry) are available 
for use and are not drawn and redrawn. Chances are good that you either already have these 
parts or can get the “cads.” as they say, from the part supplier. Another resource is the web. 
Sites such as www.cben.net and many others have pre-drawn blocks available for use. Buy 
them, borrow them, or download them, but do not redraw items that someone already has 
done before. Again, “Time  $$.”

4.	 Use layers correctly. Layers are there to make life easier, and they are your friend. While 
overdoing it is always a danger (500 layers is pushing reason), you need to use layers 
and place items on the appropriate ones. As a CAD manager, you need to develop a 
layering standard (more on that later) and enforce it. Users in a hurry do not always 
appreciate what having all items organized in layers does (“it all comes out the same on 
paper!” they may say), so you must stand firm and enforce the standard. And do not use 
layer zero. It cannot be renamed with a descriptive name, so why use it?

5.	 Do not explode anything. How do you destroy an AutoCAD drawing and render weeks 
of work and thousands of dollars in work-hours useless? Why, explode everything, of 
course. Short of deleting the files, this is the best way to ruin them. While this is generally 
a far-fetched scenario, remind users to not ruin a drawing in small ways, like once in a 
while exploding an Mtext, dimension, or hatch pattern. They are liable to do so, if these 
items do not behave as they are supposed to and users explode them to manually force 
them into submission. Not a good idea; lack of skill is not an excuse. Remind them 
to ask you for help if a dimension just does not look right. There is always a way to fix 
something. Leave the exploding for the occasional block or polygon.

6.	 Use accuracy: Ortho and OSNAPs. Drawing without accuracy is not drafting, it is 
doodling. Most users learn the basics, such as how to draw straight lines and connect 
them, but you may still see the occasional project manager (who gets to draft on average 
only once a month) fix a designer’s linework and forget to turn on OSNAPs. When 
zoomed out, the lines look OK and print just fine (reason enough to throw accuracy out 
the window for the occasional user), but a closer inspection reveals they are not joined 
together, causing a world of problems for a variety of functions (Hatch, Area, Distance, 
and other commands). Besides, it is just plain sloppy. How accurate is AutoCAD? Enough 
to zoom from a scale model of the earth to a grapefruit (more on that later), so be sure to 
use all the available accuracy.

7.	 Save often. Let us state the obvious. There is no crash proof software. AutoCAD does and 
will eventually lock up, get the equivalent of a stroke, and crash. Remind users to save 
often, and do daily and weekly file backups. But you already knew this, right?

PART 2: Know the capabilities and limitations of 
autocad
As a CAD manager you have to know what you have to work with. All computer aided design 
software including AutoCAD has an operating range for which the software is designed and 
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optimized. Some tasks it excels at, and you need to leverage that advantage; and some tasks 
are outside the bounds of expectation. AutoCAD cannot be all things to all people (though 
you would be hard-pressed to tell based on its marketing). What follows is a short discussion 
on the capabilities and limitations and how you need to best take advantage of what  
you have.

Capabilities
Often, as a CAD manager, you are asked to provide an estimate on how long it will take to 
complete the drafting portion of a job or just recreate something in CAD. Sometimes these 
requests come from individuals (senior management) who have had extensive experience in 
hand-drafting, and they expect an answer in the form of a significantly smaller time frame. 
AutoCAD has an aura of magic about it, as if a few buttons just need to be pushed and out 
pops the design. Where is that “Finish Project” icon?

The surprising truth is that a professional hand-drafter can give an average AutoCAD designer 
a run for their money if the request is a simple (small) floor plan. After all, the drafter is 
not burdened with setting up layers, styles, dims, and other CAD prep work. But this is not 
where AutoCAD’s power lies. Once you begin to repeat patterns and objects, AutoCAD takes 
a commanding lead. A layout that took one hour to draft by hand or via computer can be 
copied in seconds on the computer but adds another hour to the hand-drafter’s task.

Do not be surprised by the seeming obviousness of this. I have met many users and students 
who do not always see where exactly CAD excels; they think work is always faster on a 
computer. It may not be and may lead to erroneous job estimates. But in all cases with 
patterns, copying, and use of stored libraries, CAD is much quicker.

So when estimating a job, look for

l	 Instances where the Offset command can be used.
l	 Instances where there are identical objects.
l	 Minimal cases of unique, uneven, and non-repetitive linework.
l	 Minimal cases of abstract curves.
l	 Abundance of standard items.

Knowing what to look for enables you to make more accurate estimates. Remember, the 
more repetition, the greater the CAD advantage.

This of course is just one example. Other advantages include accuracy (discussed next) and 
ease of collaboration. Another interesting advantage noticed by me is that non-artistic people 
or ones who would never have been able to draft with pencil, paper, and T-square often excel 
at CAD, and skills such as neatness and a steady hand become less critical.

In support of Golden Rule 6, a brief discussion on accuracy follows. This is one often 
brought up in class. Search the web for a drawing called SOLAR.DWG. Download and 
open the file. It is a drawing of the solar system created in the early days of AutoCAD by 
founder John Walker and has become quite legendary over the years (Figure E.1). You see, 
the drawing is to scale. This means that the orbits of all the planets are drawn to full size 
as well as correct relative to each other. Zoom in to find the earth. Then zoom in to see the 
moon around the earth. Zoom in further and find the lunar landing module on the moon. 
Zoom in again and find a small plaque on one of the legs of the landing module. On it is a 
statement from humankind to anyone else who may read it. What does it say? And what is 
the date?

Think about what you just witnessed. You have zoomed in from the orbit of Pluto to look at 
a 5”  4” plaque. That is quite an amazing magnification. To put things into perspective, this 
is the equivalent of looking at the earth and then at a grapefruit, or looking at a grapefruit, 
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then an atom. Can you design microchips in AutoCAD? Safe to say, yes. Can you connect 
walls together in a floor plan? Absolutely.

Limitations
One of the chief limitations of AutoCAD is its 3D capabilities. Not that they are shabby, 
but sometimes they are pushed to do what they were not created for. The essence is 
that AutoCAD is not modeling and analysis software, rather, it is visualization software 
when it comes to 3D. It was not designed to compete with CATIA, NX, Pro/Engineer, 
and SolidWorks. Parametric design, dimension driven design, FEA, and CFD analysis are 
not what AutoCAD is about. These packages are dedicated engineering tools. AutoCAD 
was intended to be powerful 2D software with tools for presenting a design in 3D when 
necessary. As such, it is good at pretty pictures, to sell or present an idea.

Another limitation of the software, an obvious one about which a CAD manager needs to 
be aware, is that AutoCAD does not do the thinking for you. It contains little to no error 
checking, interference checking, or design fidelity tools. Garbage in definitely means garbage 
out. Be aware as a CAD manager that AutoCAD lets users do almost anything, and the word 
anything can swing in either a positive or a terribly negative direction. And finally understand 
the learning curve of this software. It will take a few months for a novice user to get up to 
speed. Keep an eye on that person until then.

PART 3: Maintain an office cad standard
A standard is a necessity for a smooth-running office, especially for one with more than a 
few AutoCAD users. A standard ensures uniformity and a professional look to the company’s 
output, minimizes CAD errors, and makes it easy for new users to get up to speed. A manual 
needs to be created, published, and given to all users who may come in contact with 
AutoCAD. This manual should have, at a minimum,

l	 The exact location of all key files and the overall office computer file structure, indicating 
the naming convention for all jobs and the locations of libraries, templates, and standard 
symbol folders.

l	 A listing of the office layering convention. This may follow the AIA standard in an 
architecture office or just an accepted internal company standard.

l	 A listing of acceptable fonts, dimension styles, and hatch patterns.
l	 A listing of print and plot procedures, including *.ctb files.

Figure E.1 
The solar system.
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l	 A listing of proper X-ref naming procedures.
l	 A description of how Paper Space is implemented. List title blocks, logos, and necessary 

title block information.
l	 A policy on purging files, deleting backup files, and Auto Save.

Keep the manual as short as possible while including all the necessary information. Do 
not attempt to cover every scenario that could possibly be encountered, as the longer the 
manual, the less likely it will be looked at cover to cover.

PART 4: Be an effective teacher and hiring manager
Part of being a CAD manager is sometimes explaining the finer points of AutoCAD to new 
hires or updating the occasional user as well as promotion of better techniques and habits. If 
you studied the Level 1 and 2 books cover to cover, you may have noticed a concerted effort 
to simplify as much as possible. You should do the same with any potential students. While 
this is not meant to be a teaching guide (I may publish a full essay on this topic in future 
editions of this text), some basic points apply. If you are tasked with training new hires, then 
try to observe the following:

l	 Cover basic theory first: creating, editing, and viewing objects.
l	 Cover accuracy next, such as Ortho and OSNAP.
l	 Move on to the fundamental topics in the order of layers, text, hatch, blocks, arrays, 

dimensions, and print and plot, similar to Level 1.
l	 If advanced training is needed, cover advanced linework, followed by Xref, attributes, and 

Paper Space, in that order. The rest of Level 2 can wait, as some of it is geared mainly to 
CAD managers anyway.

l	 Stress to users the secrets to speed: the pgp file, right-click customization, and intense 
practice of the basics; remember the 95%/5% rule from Level 1.

l	 Accurately assess the skill level of users and do not assign advanced tasks to those not yet 
ready, unless the drawings are not critical for a particular project. I have personally seen 
the subtle damage to a drawing that can be caused by an inexperienced drafter.

Also, be ready to test potential hires with an AutoCAD test. This test does not have to 
be long; 45 minutes to an hour should be the absolute maximum, although truthfully, 
an experienced user can tell if another person knows AutoCAD within three minutes of 
watching him or her draft. The trick is to maximize every minute and squeeze the most 
amount of demonstrated skill out of a potential recruit, which means do not have that 
person engage in lengthy drawing of basic geometry but rather perform broad tasks.

For example, the floor plan of Level 1 is a good test for an architectural drafting recruit (the 
drawing can be simplified further if necessary by eliminating one of the closets or even a 
room). It should take an experienced user about 15 minutes total to set up a brand-new 
drawing (fonts, layers, etc.) and draft the basic floor layout (most students can do it in an 
hour after graduating Level 1—not too bad). Then it should take another 15 minutes to 
add text, dims, and maybe some furniture, followed by another 5–10 minutes of hatch and 
touchups, followed by printing. So it is roughly a 45-minute test and runs the recruit through 
just about every needed drafting skill. When looking over the drawing, note the layers 
chosen, accuracy demonstrated, and how much was completed in what time frame.

Note the following. It is not critical if a new hire does not know Xrefs or Paper Space. These 
can be explained in a few minutes and learned to perfection “on the job.” However, nothing 
but “hard time” spent drafting teaches someone how to draft quickly and efficiently with 
minimal errors. This is a requirement, and do not hire anyone who does not have that, as 
it will take time climbing that learning curve. Exceptions should be granted, of course, for 
individuals hired for other skills, with AutoCAD being of only secondary importance.
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The bottom line (in my hiring experience) is that a fast, accurate drafter is far more desirable 
than a more knowledgeable one with a sloppy, slow manner of drafting. Be very careful of 
recent AutoCAD drafting class graduates. Extensive knowledge is no substitute for experience, 
and while many drafters are fine workers and can come in and be productive on an entry 
level, be sure you understand what you are getting. I have for a long time encouraged 
constant practice in class, even at the cost of occasionally not covering an advanced topic or 
two, knowing full well what these students will face in a saturated market full of experienced 
AutoCAD professionals.

As a final word, be sure the AutoCAD test is fair but challenging. Leave units in decimal form 
as the student needs to demonstrate a grasp of nuances and situational awareness and the 
ability to change units to architectural if the foot/inch input does not work. Include in  
the test

l	 Basic linework to be drawn.
l	 A handful of layers to set (colors, linetypes, etc.).
l	 Some text to write (set fonts, sizes, etc.).
l	 Some hatches to create.
l	 Some arrays to create.
l	 Some blocks to create.
l	 Some dimensions to put in.
l	 Plot of output.

PART 5: Stay current and competent
While we are on the subject of technical competency, you, as a recent advanced class graduate 
or CAD manager, are not off the hook for continuing to add to your skill set. It is much too 
easy to settle into a comfortable routine of drafting or designing and not learn anything 
outside the comfort zone (and not just with AutoCAD either). Some thoughts on this topic 
follow.

First of all, realize that it is virtually impossible for one individual to know everything about 
AutoCAD (many claim to come close). It is truly an outrageous piece of software, developed 
and updated constantly by hundreds of software programmers and designers. This statement 
should make you realize that there is always more to learn (not throw your hands up in 
despair, however), and you will not run out of new, easier, and creative ways to do a task. The 
main trait shared by all successful AutoCAD experts is that they are genuinely interested in 
the software and in the concept of computer aided design in general.

To maintain your skills or advance further, look through the following list and determine 
what applies to you, then take the steps needed to acquire that knowledge. Some of this you 
will learn as part of studying all three books in the series; others you have to initiate on your 
own:

l	 Learn the 3D features. Many users do not know 3D well, and it is a good way to stand out 
from the crowd. It is fun to learn and is an important side of AutoCAD.

l	 Learn basic AutoLISP. This relatively simple programming language allows you to 
customize AutoCAD and write automation routines, among other uses.

l	 Explore AutoCAD’s advanced features that are sometimes overlooked, such as Sheet Sets, 
Dynamic Blocks, eTransmit, Security, Dashboard, CUI, and much more. Keep notes of key 
features and effects (a “cookbook” in software lingo).

l	 Read up on the latest and greatest from AutoCAD, new tips and tricks, and what the 
industry is talking about. Cadalyst.com and Augi.com are two good sites for this. You 
should also get a Cadalyst subscription (it is free).
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l	 Do not work in isolation; talk to others in your field and see how they do things. Also be 
sure to take an AutoCAD update class if upgrading to a new release.

l	 Be curious about other design software including AutoCAD add-on programs (verticals) 
such as AutoCAD Mechanical, Electrical, Civil, and MEP. Be knowledgeable about as 
much software as possible. In the world of CAD, Revit and SolidWorks are two software 
packages to keep an eye on in the future.

l	 Enjoy what you are doing. If you’re not, you should seek other work duties in your 
profession. AutoCAD is very miserable to deal with if you hate it. Occasionally you may 
think it is just one big software virus out to get you; just do not let it be a daily thought.
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AutoLISP Basics and 
Advanced Customization 
Tools

You may have heard of AutoLISP, Visual LISP, VBA, .NET Framework, Active X, and ObjectARX. 
What exactly are they? These are all programming languages, environments, and tools used to, 
among other things, customize and automate AutoCAD beyond what can be done by simpler 
methods like shortcuts, macros, and the CUI, all explored earlier in this book.

To properly discuss all these methods would take up quite a few volumes of text, and indeed 
much has been written concerning all of them. Our goal here is to introduce the very basics 
of AutoLISP and only gloss over the rest, so you at least have an idea of what they are. If 
advanced customization or software development work interests you, you can pursue it 
much further with other widely available publications.

Overview I: AutoLISP
This is really the very beginning of the discussion. AutoLISP is a built-in programming 
language that comes with AutoCAD and is itself a dialect of a family of historic programming 
languages collectively referred to as LISP (list processing language). LISP was invented by 
an MIT student in 1958 and found wide acceptance in artificial intelligence among other 
research circles. The language and its developer, J. McCarthy, pioneered many expressions 
and concepts now found in modern programming.

AutoLISP is a somewhat scaled back version of LISP and is uniquely geared toward AutoCAD. 
It allows for interaction between the user and the software, and indeed one of the primary 
uses of AutoLISP is to automate routines or complex processes. Once the code is written, it 
is saved and recalled as needed. The code is then executed as a script (no compiling needed) 
and performs its operation.

One of the advantages of AutoLISP over other methods (discussed shortly) is that it requires 
no special training, except some familiarity with syntax, and is thus quite well suited for 
nonprogrammers. While it is not a compiled, object oriented language like C or Java 
(therefore not suitable for writing actual software applications), it also does not need to be 
for its intended use.

Overview II: Visual LISP
AutoLISP has, over the years, morphed into a significantly more enhanced version, called 
Visual LISP. More specifically, Visual LISP was purchased by Autodesk from another 
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developer and became part of AutoCAD since release 2000. It is a major improvement and 
features a graphical interface and a debugger. Visual LISP also has Active X functionality 
(more on that later). However, Visual LISP still reads and uses regular AutoLISP, and that is 
still where a beginner needs to start before moving up. We briefly touch upon Visual LISP 
and its interface (the Vlide command) later on. The subject is an entire book all in itself.

Overview III: VBA, .NET, Active X, and ObjectARX
There is evidence to suggest Autodesk is moving away from using Visual LISP toward other, 
more advanced tools for customization and programming.

VBA (Visual Basic for Applications) is a language based on Visual BASIC, a proprietary 
Microsoft product. VBA allows you to write routines that can run in a host application 
(AutoCAD), but not as standalone programs. It has some additional power and functionality 
over Visual LISP.

.NET Framework is another Microsoft software technology that was intended as a 
replacement for VBA. It features pre-coded solutions to common programming problems 
and a virtual machine to execute the programs.

Active X, also developed by Microsoft, is used to create software components that perform 
particular functions, many of which are found in Windows applications. Active X controls 
are small program building blocks and are often used on the internet, such as for animations 
and unfortunately also for some viruses and spyware applications.

ObjectARX is the highest level of customization and programming you can do with 
AutoCAD, short of working on developing AutoCAD itself. Unlike the scripting-type 
languages and methods discussed so far, ObjectARX (ARX stands for AutoCAD runtime 
extension) is an application programming interface (API). Using C, programmers 
can create Windows DLLs (data link libraries) that interact directly with AutoCAD itself. 
Everything needed to do this is part of the ObjectARX Software Development Kit, freely 
distributed by Autodesk. This is not easy to master, as you would expect from professional-
level software coding tools. Typical users are third party developers who need a way to 
write complex software that interacts seamlessly with AutoCAD. ObjectARX is specific to 
each release of AutoCAD and even requires the use of the same compiler Autodesk uses for 
AutoCAD itself.

Ideally this discussion gave you some insight into what is out there for AutoCAD 
customization. This is of course only a cursory overview, and you can pursue these topics 
much further. Any journey to learn advanced AutoCAD customization, however, begins 
with AutoLISP, and this is where we go next to introduce some basics of this programming 
language.

AutoLISP Fundamentals
As mentioned before, despite the proliferation of new tools, AutoLISP is still very much in 
use, and thousands of chunks of code are still being written and easily found online for 
just about any desired function. The main reason for AutoLISP’s popularity remains the fact 
that AutoCAD designers are not programmers and AutoLISP is accessible enough for almost 
anyone to jump in and learn. The value it adds to your skill set is substantial. Let us cover 
some basics and get you writing some code.

AutoLISP code can be implemented in two distinct ways:

l	 You can type and execute a few lines of code right on the command line of AutoCAD. 
This is good for a simple routine that is useful only in that drawing.

l	 You can load saved AutoLISP code and execute it, usually the case with more complex and 
often-used routines.
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We generally use the second method of writing and saving our routines. At this stage, it is 
helpful to know how (and where) to save AutoLISP code, and by extension how to load what 
is written.

All AutoLISP code is saved under the *.lsp extension. Once the code is written, it can 
theoretically be stored just about anywhere (AutoCAD 2008’s Express folder contains a 
sizable number of built-in routines). To load the code, go to Tools→Load Application… 
or Tools→AutoLISP→Load Application... (or just type in appload) and the dialog box in 
Figure F.1 appears.

Then you just browse around, find the AutoLISP code you are interested in, and press Load. 
Once loaded, you can close the dialog box; the code is ready to execute with a command 
input. There is a way to automatically load all existing code upon starting AutoCAD by 
adding it to the Startup Suite (lower right corner, the briefcase icon).

Now that you know how to save new code and where to find it, we should try writing a 
simple example that illustrates some AutoLISP basics. Here are two critical points that need 
to be understood before you begin:

l	 AutoLISP is closely tied to AutoCAD commands, so to write something useful, you need 
to know the commands well. If you do not know how to do it in AutoCAD manually, 
AutoLISP is of no use.

l	 Approach AutoLISP for an answer to a specific problem. State what it is you want to solve 
or automate, then write out the steps to do it manually. Only then, using proper syntax, 
write and test the AutoLISP code.

Figure F.1 
Load/Unload Applications.
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Following this philosophy, let us state a problem we would like to solve. We would like to 
modify the Zoom to Extents command by having it zoom to only 90% of the screen, not 
100%. That way we can see everything and nothing gets lost at the edges of the screen. How 
do we do this by hand, first of all?

You of course type in zoom, press Enter, select e for Extents, and press Enter again. The 
drawing is zoomed all the way. To bring it back a bit, you repeat the Zoom command but 
type in .90x instead of e. The drawing then zooms in a bit to fill only 90% of the screen.

Let us now automate these steps so all you have to do is type in zz (a random choice for a 
command name; you could pick anything), instead of the two-step process just described.

We need to

1.	 Open up the Notepad editor (we use the built-in Visual LISP editor later).
2.	 Save the blank file as ZoomSample.lsp in any folder you wish.
3.	 Define the function zz by typing in exactly the following:

(defun C:zz ()
4.	 List the relevant commands in order by typing in exactly the following:

(command “zoom” “e” “zoom” “.90x”)
5.	 Finally add (princ) and close the expression with another ).

So, here is the final result:

(defun C:zz ()
(command “zoom” “e” “zoom” “.90x”)
(princ))

Save the file again and let us run it. Open up any drawing, load the AutoLISP routine using 
appload or the drop-down menu and run it by typing in zz and pressing Enter. The drawing 
should zoom out to 90% as expected.

This simple routine has some essential ingredients of all AutoLISP code:

l	 It starts out with a parenthesis, indicating that a function follows.
l	 The defun or define function (an AutoLISP expression) is next followed by C, indicating it 

is an AutoCAD command, and finally the actual command, zz.
l	 The set of openning closing parenthesis can hold arguments or variables.
l	 The next line features “command”, an AutoLISP expression meaning AutoCAD commands 

(in quotations, meaning it is a string) follow.
l	 The (princ) function is added so the routine does not constantly return a “nil” value.
l	 Finally another matching parenthesis closes out the program.

Here are two simple routines that I use often to rotate the UCS crosshairs to align them to 
some geometry (this general task was covered in Chapter 15).

The first routine does the rotation and is called perp:

(defun C:perp ()
(command “snap” “ro” “” “per” pause “snap” “off”)
(princ))

The second one brings the crosshairs back to normal and is called flat:

(defun C:flat ()
(command “snap” “ro” “” “0” pause “snap” “off”)
(princ))

The perp and flat AutoLISP routines feature two new concepts. The first one is the pause 
function, which allows for user input. In this case, it is for the user to select the line to which 
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the crosshairs are to be aligned. Then the function resumes and turns off snap. The other 
concept is the two quotation marks back to back with nothing between them. They simply 
force an Enter.

Study these three examples closely. While they are simple, many AutoLISP routines are, as 
that is all that is needed to get the job done. Here is what we learned so far:

l	 String: Anything that appears in quotes (often an AutoCAD command).
l	 Expression: AutoLISP built-in commands such as defun.
l	 Functions: Can be user defined (perp, flat) or built-in (pause, princ, command).
l	 Functions are sometimes followed by arguments in parentheses.

VARIABLES AND COMMENTS
Let us now move on to other concepts. To take a step up in sophistication from what we 
did so far, we need to introduce program variables. Variables can be numbers, letters, or just 
about anything else that can change. The reason they are needed is because they allow for 
user interaction. Because user input is not known when the code is first written, a variable is 
used. When that information is acquired, the program proceeds accordingly. Variables are a 
fundamental concept in all programming.

Variables in AutoLISP can be global (defined once for the entire routine) or local (defined 
as needed for one-time use). Local is usually how variables get defined in AutoLISP. The 
function that creates variables is setq. To set a variable equal to whatever the user inputs 
(such as the radius of a circle), you write: setq RadCircle. The next logical step with 
variables is to pick up on whatever the user inputs. For this we need the getstring function 
that returns anything the user types in.

Here is how these concepts look in practice, with the \n simply meaning that a new line is 
started.

(setq RadCircle (getstring “\nCircle Radius: “))

In addition to getstring are many other get functions, such as getfiled (asks user to select 
a file using a dialog box), getangle, and getdist.

As in any programming language, you are allowed to comment on your work, so you or 
someone else can understand your intent when examining the code at a later time. In 
AutoLISP comments are preceded by a semicolon. You can of course add more than one 
semicolon to indicate sections or headers:

;This is a comment
;;So is this

ADVANCED FEATURES AND THE VLIDE COMMAND
We have only scratched the surface of AutoLISP, and if you enjoyed writing and running 
these simple routines, then consider taking a full class on this subject or reading specialized 
books. There is much more to learn. For example,

l	 The IF→THEN statements. This is a common feature in all of programming. If certain 
conditions are met, then the program does something; if not, it does something else.

l	 The WHILE function. Another important concept in programming. This function 
continues to do something until a condition is met.

Finally we come to the Vlide command. This brings up the Visual LISP Editor as shown in 
Figure F.2.

Everything you typed earlier into Notepad can be typed into the Visual LISP Editor, which 
has many additional useful features, such as debugging, error tracing, and checks for closed 
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quotations and parenthesis (formatting tools). Everything you type is also color coded for 
easy identification.

In-depth coverage of Visual LISP is beyond the scope of the book, but you are encouraged to 
pick up a specialized textbook and try to progress with this invaluable skill.

Figure F.2 
Visual LISP Editor.
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PC Hardware, Printers, 
Plotters, and Networks

This is another collection of topics that can easily span volumes, and indeed much has been 
written about all of them. We try to focus on hardware from an AutoCAD user’s point of 
view exclusively, which may be a less covered topic (if only slightly).

Hardware, in my opinion, goes hand in hand with the software. And, while computers, like 
cars, have become so reliable that a “hands off” approach works fine, remember that CAD 
in general and AutoCAD specifically, is not ordinary software. It is a high-end, powerful 
application that places heavy demands on the associated hardware and does not run at its 
peak on a clunky PC. Much like the case that the owner of a Porsche is more likely to be 
interested in (and look under the hood of) the car versus the owner of a Toyota, so should 
AutoCAD designers express interest in what is “under the hood” of their computer. After all, 
they are manipulating and creating multimegabyte sophisticated drawings or 3D models, not 
merely typing up a memo on Word, and it is in their best interest to use a PC that meets or 
exceeds AutoCAD’s demands.

PC hardware
By its nature, AutoCAD is not as fussy as some other CAD software out there (3D solid 
modeling applications come to mind), but it does need a high-end PC to operate optimally. 
Here is a rundown of a recommended setup with comments.

Processor: The “brain” of the computer, also referred to as a chip, is where all the 
calculations and operations are performed. Intel and AMD are the major players in 
the PC market. Which is better is a moot point; while Intel was once the only game in 
town, these days the two companies constantly one-up each other with performance 
benchmarks. At this point, both manufacturers produce high-quality products, and the 
Intel versus AMD comparison is essentially meaningless to the average user. The latest 
Intel chipset (as of this writing) is the Intel Core 2 Extreme with a 3.33 GHz clock speed. 
AMD has a similar Opteron series chip. Autodesk recommends a much tamer 2.2 GHz 
Pentium 4 as a minimum, so you have plenty of room to shop on price between these 
two extremes.
RAM: Random access memory is the next consideration, and the more the merrier. RAM 
has a direct effect on performance as it is there that software resides while in operation. 
More available RAM allows for more functions to execute faster. Autodesk recommends 
1 GB, but 2 GB is better.
Hard drive: Also known as storage disk, main drive, and the like, it needs to be at least 
750 MB to install AutoCAD. Fortunately this is rarely a problem, as most machines have 
disks on the order of 50–100 GB.
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Video graphics card: Perhaps the most overlooked part of the PC, the video or graphics 
card is similar to a processor but is specially designed to control the screen images or 
graphics. It needs to be beefed up to deliver the kind of graphics AutoCAD is capable of 
producing (essential in 3D rendering). Autodesk makes no recommendations, but get the 
best one possible under the allowed budget. High-quality graphic cards are not cheap; a 
high-end card tops out at over $2000. One in the $600–$900 range should be just fine.
OS: Operating systems that AutoCAD can run on number in the single digits (actually 
precisely one, Windows). AutoCAD does not run on UNIX, Linux, or a Mac. Windows 
XP (with Service Pack 2), Vista, and Windows 7 are the only accepted operating systems. 
Though AutoCAD is officially certified for Vista, students have reported sporadic 
operational problems. Maybe as of this writing things have improved; if not, Windows 7 
is finally here.
Other PC components: These include the motherboard (must be picked according to 
processor requirements), the sound card and speakers (if needed), the CD/DVD, power, 
cooling, and wiring systems. The DVD capability is needed as AutoCAD now comes on 
DVD when you buy it (unless you chose the download option of course).
Monitor: Get the best and largest flat screen monitor you can afford; your eyes will thank 
you many times over.
Mouse and Keyboard: Get a laser precision mouse (forget roller ball) and the best soft-
touch keyboard you can find. Do not try to cut corners here as you will be in physical 
contact and using these devices constantly while working on the PC, so get the good stuff.

Whether building your own PC or ordering an assembled one, take the PC purchase seriously 
and try to set realistic budget expectations. CAD workstations are in the same family as 
gaming stations (in fact I hand-built what amounts to a gaming machine, even though no 
games are on it) and you need to budget $2000–$3000 (or more) for a serious machine, not 
including the monitor. Some well known vendors include Dell, but if you are inclined to 
assemble your own, check out online stores such as TigerDirect.com or OutledPC.com.

A typical CAD station may consist of the following pieces (as built by me in 2006). Today, in 
mid-2010, you can easily exceed these specs for a lot less money.

l	 AMD Athlon 6400 processor
l	 2 GB RAM
l	 Asus motherboard
l	 ATI FireGL series video card
l	 Creative Labs X-FI sound card
l	 160 GB disk drive
l	 CD-R/DVD

Printers and plotters
There are essentially two ways to output something from AutoCAD, a printer or a plotter. 
Printers are generally Inkjet or LaserJet and black and white or color capable. Prices can range 
from a $49 desktop Inkjet to a “sky’s the limit” corporate high-speed color LaserJet. Which 
to get depends entirely on budget and desired level of quality for output, as AutoCAD does 
not care. Once AutoCAD is installed, it automatically senses any printer attached to the PC 
(assuming it works and has drivers in the first place). Be aware that most small desktop 
printers cannot handle 11  17 paper, but larger LaserJet printers can. The 11  17 format 
is very important in AutoCAD, as many jobs are handed in on this size paper, so be sure your 
printer can handle it.

Plotters (Figure G.1) are a familiar sight in architecture or engineering offices. Anything 
sized above an 11  17 sheet of paper needs to be routed to a plotter, all the way up to a 
48  36 or larger in some cases. Plotters as a rule are more expensive than printers, and 
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buying one should be a carefully researched decision. Many plotters are color capable and 
accept almost any type of paper, although bond or vellum is the norm. Hewlett-Packard 
(HP) is the premier manufacturer of plotters (some models on sale are well over $20,000, 
though their 500, 800, and 1055 series plotters are much more affordable), with other 
companies such OCE, Canon, and Encad rounding out the field. The typical average cost 
of a plotter as encountered by me hovers around $6000. Do your research carefully when 
selecting one, and be aware of recurring costs such as ink and paper.

Networks
This topic of course is an entire profession all to itself. A computer network is defined as a 
group of interconnected computers. Networks can range from local area network (LAN) to city, 
country, or worldwide (WAN, or wide area network). Networks allow for collaboration and 
sharing of information from computer to computer and have their own set of hardware familiar 
to any network engineer, such as routers, hubs, switches, repeaters, and other gear. Networks 
are operated via a protocol or set of instructions, such as the IEEE 802.3 protocol running on 
Ethernet technology for a typical LAN. The medium of data transfer between computers is usually 
a standard Cat5e cable but can be wireless or fiber optic for larger networks.

As an AutoCAD designer, you will likely encounter a local area network consisting of a server 
(host) with some other computers (clients) connected to it at your company. All the data are 
stored on the server, and once you log on to the network, your computer can access what it needs.

In regard to networks, AutoCAD can be installed on a per seat or network license method. 
Per seat is cost effective to a certain limit (usually ten seats). If your company requires more, 
a site license is purchased, which is cheaper and allows more computers to run the software, 
which now resides on the server only.

Figure G.1 
A Typical Plotter.
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AutoCAD  
Certification Exams

It seems like there is an exam or certification for just about every profession or occupation. 
Although AutoCAD and drafting in general are not really part of the greater information 
technology world, where certification exams are the benchmarks of competence and almost 
as valuable as college degrees, there still exists a series of exams for AutoCAD designers to 
take if they wish to “formalize” their knowledge and hang up a piece of paper in their office.

These exams have changed somewhat over the years and have varied in the number of 
questions, difficulty level, and the amount of time given to complete them. The typical 
method of delivery has been online, with users logging in and taking the exam in a timed 
fashion (although in years past there have been exams with no time limit). You are able to 
use the Help Files and any manuals or texts you can find.

Are these exams important? This question does not have an easy answer. The overriding 
belief among established AutoCAD professionals is that the exams are not well organized 
and test for trivial knowledge while not accurately assessing an individual’s true mastery of 
the software, which can really be tested only by having the person draw a complex design. It 
is partially Autodesk’s fault for not developing these exams into the powerhouse institutions 
that Microsoft, Cisco, Novell, and others have done with theirs.

Then again, however, there was little demand for the exams in the past. As AutoCAD 
was exploding in popularity, anyone who was reasonably good was hired and allowed 
to mature on the job. In recent years, as supply of knowledgeable AutoCAD designers 
finally caught up with demand, employers wanted ready-made experts and needed a way 
to separate the “wheat from the chaff.” This would explain the resurgence in popularity 
of testing for AutoCAD competence and the renewed interest from students as to how to 
study for and pass these exams. So, yes, these exams may be important to get a foot in the 
door with certain companies, but having passed the exam does not necessarily guarantee a 
knowledgeable AutoCAD expert; and I never used them as the sole reason to hire someone. 
Let us go over the exams as they exist now for AutoCAD 2011. There are two exams:

1.	 AutoCAD Certified Associate Exam
2.	 AutoCAD Certified Professional Exam

The Certified Associate Exam (CAE), which is taken first, consists of 30 questions, with the 
following breakdown by topic:

l	 Introduction to AutoCAD, one question
l	 Creating drawings, four questions
l	 Manipulating objects, six questions
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l	 Drawing Organization and Inquiry commands, three questions
l	 Altering objects, two questions
l	 Working with layouts, one question
l	 Annotating the drawing, three questions
l	 Dimensioning, two questions
l	 Hatching objects, two questions
l	 Working with reusable content, three questions
l	 Creating additional drawing objects, two questions
l	 Plotting, one question

The passing score is 70% and you have a 60-minute time limit.

The Certified Professional Exam (CPE), which is taken second, consists of 20 questions, with 
the following breakdown by topic:

l	 Manipulating objects, five questions
l	 Drawing Organization and Inquiry commands, one question
l	 Altering objects, two questions
l	 Working with layouts, one question
l	 Annotating the drawing, three questions
l	 Dimensioning, three questions
l	 Hatching objects, one question
l	 Working with reusable content, one question
l	 Creating additional drawing objects, two questions
l	 Plotting, one question

The passing score is 80% and you have a 90-minute time limit.

The CAE focuses more on multiple choice and matching questions and basic knowledge, 
while the CPE is more performance based and focuses on drawing (you need to download, 
open, and work on actual AutoCAD files while taking the exam; you then are asked to draw 
something and answer a question based on this drawing).

The intent here is to have an individual take the CAE shortly after completing a training 
course, and then the CPE a few months later after some practical drawing skills are gained.

Practice sample tests are available, and it is highly recommended to go over these to at least 
see what types of questions to expect. The cost for taking these exams is $50 per exam, but 
that is of course subject to change, so check the latest information on the Autodesk website.
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AutoCAD Employment

AutoCAD students vary widely in their backgrounds. Some are already in mid-career and 
are registered architects or engineers looking to pick up new skills. Others are recent college 
graduates entering the job market with architecture or engineering degrees. These students 
need AutoCAD as a small part of their job, or maybe even the main part of their job, but are 
ultimately hired for their engineering or design knowledge and may draft in only the first few 
years of their career as they learn the ropes.

Another very large group of students, however, are attracted to CAD drafting in and of itself 
and attend one of the many programs at local community colleges or tech/vocational schools 
that ultimately lead to a certificate or even a two-year associate’s degree in architectural or 
engineering drafting. These students intend to enter the workforce as professional AutoCAD 
drafters, a career track in itself. This can lead to CAD management positions as well as serve 
as a springboard for a career in engineering or architecture if the students decide to return 
to school to complete the bachelor’s or master’s degree. Even if they do not, a professional 
draftsperson is a well paid professional who is a valuable asset and, as CAD software 
increases in sophistication, is needed more than ever. So the question is then, how do you 
get your “foot in the door” and begin and AutoCAD career?

Once you graduate and are ready to look for work, there are a number of things to consider. 
First of all, decide if you would like to concentrate on architectural, mechanical, electrical, 
or some other drafting field. Though I moved around a lot in my early days of consulting 
work, this approach does not work in today’s saturated market. It is easier to succeed if you 
focus your interests instead of jumping around from company to company and field to field. 
What you ultimately decide to pursue should be something you are interested in (houses 
vs. mechanical devices, for example) as well as something you are good at. Generally, while 
learning AutoCAD in school, you are drawn to one type of work over another; go with your 
gut feeling.

Then consider your options to actually find work. Two major sets of resources are presented 
next:

Staffing firms: This is one of the best ways to find a CAD job, though sometimes staffing 
firms prefer experienced CAD designers, as those command higher salaries and therefore 
higher commissions and fees for the staffing agencies. These staffing firms can either place 
you outright with a client (collecting a onetime finder’s fee) or place you on an hourly 
rate as one of their own workers “on loan” to a client (collecting a premium over your 
pay). It may or may not matter which route you go, although being hired on directly with 
benefits may be more desirable, even if the initial salary is lower. Search for staffing firms 
(also informally called job shops) on the internet in your area. Some well known, large, 
nationwide firms include Kelly Staffing, Manpower Technical, and Aerotek.
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Job boards: These include Monster.com, Dice.com, and Craigslist.com, among others. 
Often these sites are populated with postings from staffing firms (see the preceding), but 
independent companies can be found as well. Simply enter AutoCAD and your city or 
town into the search engine and listings will appear. Of special note is Craigslist.com. You 
may have already used it for everything from apartment hunting to selling something, 
and their job boards are excellent and very informal and direct. The only downside is that 
Craigslist is most utilized by residents and companies in large metropolitan centers, and 
if you live in a small town far from major cities, you may have slim pickings (even if the 
actual job scene is pretty good).

Other places to look include your school’s employment office and classified newspaper ads 
(yes, those still exist, though disappearing fast). Also never forget the value of word of mouth 
and personal contacts. Let everyone know you are looking for AutoCAD work, and just 
maybe someone’s cousin’s friend knows something.
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AutoCAD Humor, Oddities, 
Quirks, and Easter Eggs

Real AutoCAD users

l	 Have been doing AutoCAD for six or more years.
l	 Never bother to keep .bak files.
l	 Do not do drawings on a dot matrix printer.
l	 Have a graphics card that can support two monitors.
l	 Have two SVGA monitors.
l	 Have games on their system.
l	 Get real pissed when someone else uses their machine just to “look around.”
l	 Know AutoLISP.
l	 Know how to edit an AutoLISP file.
l	 Wonder why Autodesk gives you so much worthless stuff with a software upgrade.
l	 Wonder why Autodesk charges so much for an upgrade, then AutoCAD gets pirated.
l	 Maintain at least three older versions of AutoCAD on their system.
l	 Never ask for the newest copy of AutoCAD—they already have it.
l	 Have a free subscription to Cadalyst.
l	 Do not really bother to read Cadalyst.
l	 Could write an article that could go in Cadalyst.
l	 Do not run AutoCAD on a Mac.
l	 Do not have friends that run AutoCAD on a Mac.
l	 Despise Macs.
l	 Are not concerned with losing a drawing.
l	 Use the Purge command about 60 times in a drawing.
l	 Use the spacebar, not return.
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l	 Have either drawn a picture of
m	 Their car.
m	 Their house.
m	 Their dream house.
m	 Or their dream house with their dream car parked in the drive.

l	 Like to waste time, such as like typing ZOOM E twice in a large drawing.
l	 Can talk on the phone and draw at the same time.
l	 Drink lots of liquid while drawing.
l	 Go to the bathroom a lot.
l	 Get some exercise while at work.
l	 Are not afraid to eat while drawing.
l	 Can leave the room while plotting.
l	 Do not care that the work system is on 24 hours a day; it is not their machine.
l	 Do not really like the system they run AutoCAD on; they are sure there is a better one.
l	 Would be damn lucky if they got the system they have at work, for their home.
l	 Always complain that AutoCAD on their system is too slow.
l	 Work in the dark with their AutoCAD screen color set as black.
l	 Get pissed when someone turns on the light.
l	 Get real pissed when people say, “How can you work in the dark like this?”
l	 Listen to free downloaded mp3s while working. 
l	 Are reading these while they should be working.

The AutoCAD monkey joke That never goes away
A tourist walked into a pet shop and was looking at the animals on display. While he was 
there, another customer walked in and said to the shopkeeper, “I’ll have an AutoCAD 
monkey, please.” The shopkeeper nodded, went over to a cage at the side of the shop and 
took out a monkey. He fitted a collar and leash, handed it to the customer, saying, “That’ll be 
$5000.” The customer paid and walked out with his monkey.

Startled, the tourist went over to the shopkeeper and said, “That was a very expensive 
monkey. Most of them are only a few hundred dollars. Why did that one cost so much?”

The shopkeeper answered, “Ah, that monkey can draw in AutoCAD—very fast, clear layouts, 
no mistakes, well worth the money.”

The tourist looked at a monkey in another cage. “That one’s even more expensive! $10,000! 
What does it do?”

“Oh, that one’s a design monkey; it can design systems, layout projects, mark-up drawings, 
write specifications, some even calculate. All the really useful stuff,” said the shopkeeper.

The tourist looked around for a little longer and saw a third monkey in its own cage. The 
price tag around its neck read $50,000. He gasped to the shopkeeper, “That one costs more 
than all the others put together! What on earth does it do?” The shopkeeper replied, “Well, I 
haven’t actually seen it do anything, but it says it’s an engineer.”

Oddities and quirks
l	 AutoCAD has an Oops command; try it to see what it does.
l	 AutoCAD had an End command. It used to shut down your drawing, even if you meant 

that as an OSNAP command and just forgot to type in line and press Enter first. End has 
been permanently discontinued for obvious reasons.

l	 AutoCAD has a Battman command. It has nothing to do with the caped crusader and 
everything to do with the block attribute manager (similar to the enhanced attribute 
manager of Chapter 18).
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Easter eggs
Easter eggs are surprises that one can find in software, hence the analogy to the Easter egg 
hunt. These surprises can be anything from a silly message to an entire video game buried 
in the code. To find and activate Easter eggs you really just have to be told how, as the 
complex combination of keys that need to be pressed in correct sequence is just too much 
for a random guess. Why are they in there? Just for fun is the simple answer. Also because 
programmers can get away with it; even a medium size application has millions of lines of 
code in which to hide the much smaller Easter eggs. AutoCAD has its own share of them that 
are well documented.

Here is a known AutoCAD 2008 Easter egg, which reveals a credit roll of the design team’s 
names:

1.	 On the AutoCAD command line start the Sun Properties by typing in sunproperties.
2.	 Click on the magnifying glass in Sky Properties.
3.	 Change the date to 3/23/2007 (the date AutoCAD 2008 was released) via the pop-up 

calendar. Press Enter to set it.
4.	 Click on the time.
5.	 Press the Home key on your keyboard (this sets you to midnight).
6.	 With the Ctrl key down, press the down arrow twice on your keyboard.
7.	 Now you should see the credits roll with music.

There are other Easter eggs in virtually all releases of AutoCAD. The more you look, the more 
you find.
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INDEX

A
Align, 330
Annotation, 222
Arc, 15, 60
Area, 48
Array

Polar, 176
Rectangular, 178

Attdef, 416
Attributes, 405
Audit, 332

B
Block, 157
Break, 333

C
CAD Standards, 335
Calculator, 336
Cartesian coordinate system, 43
Chamfer, 55
Character Map, 101, 102
Circle, 14
Circumscribed, 53
Color, 70
Color Books, 71
Command line, 7, 9
Copy, 22
Crosshairs, 8, 362
CTB Files, 423, 427

D
Ddedit, 97, 99
ddim, 148
Defpoints, 339
Design Center, 315
Dimensional constraints, 280, 283
Dimensions, 131

Aligned, 134
Angular, 137
Arc Length, 145
Baseline, 139
Continuous, 138
Diameter, 135
Jogged, 145, 146
Linear, 133
Ordinate, 145
Radius, 136

Donut, 340
Drafting Settings, 33, 435
Draw Order, 340
Dynamic Block, 164
Dynamic input, 45, 46, 47

E
Ellipse, 54
Erase, 21
Esc key, 12, 20
eTransmit, 341
Explode, 52
Export, 373, 379
Express Tools, 318
Extend, 25

F
Fillet, 29
Filter, 343
Floating Model Space, 208
Freeze VP, 216

G
Gap Tolerance, 122
Geometric constraints, 276
Gradient, 123
Grid, 42
Grips, 40, 41, 245, 308

H
Hatch, 113, 461
Help Files, 58
Hyperlink, 344

I
ID, 51
Index Color, 70
Inscribed, 53
Insert, 161
Invisible attributes, 416
Isometric, 433
Isoplanes, 437, 438

J
Join, 335
JPG, 377

L
Layer

Freeze, 72, 322
Lock, 72
Off, 72
On, 72
Thaw, 72
Unlock, 72

Layer Filter, 259
Layer State Manager, 255
Layouts, 201
Leader, 141
Lengthen, 346

Limits, 56
Line, 9, 13
Linetype, 72, 459, 460
List, 50
Lock VP, 215
LTscale, 74, 107
LWT, 428

M
Match Properties, 75
Mirror, 28
MLedit, 244
Mline, 239
MLstyle, 240
Model Space, 201, 207, 217
Move, 21
Mtext, 98
Multileader, 142
Mview, 207

O
Object snap tracking, 347
Offset, 27
OLE, 376, 383
Options, 294
Ortho, 30
OSNAP, 31

CENter, 31
ENDpoint, 31
INTersection, 32
MIDpoint, 31
PERPendicular, 32
QUADrant, 32

Overkill, 347

P
Page Setup Manager, 195
Pan, 19
Paper

A-size, 189
B-size, 189
C-size, 189
D-size, 189
E-size, 189

Paper Space, 199
PDF, 378
Pedit, 231
PGP file, 310
Pline, 230
Plot

Display, 190
Extents, 189
Limits, 190
Window, 190
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Plotter, 478
Point, 348
Point style, 339
Polygon, 52
Printer, 478
Properties, 74
Publish, 349
Purge, 162

R
Raster, 350
Ray, 236
Record increment, 246
Rectangle, 16
Redo, 20
Regen, 19
Revcloud, 350
Ribbon, 6, 8, 11, 12, 395
Rotate, 23

S
Save, 57
SaveAs, 58, 382
Scale, 23, 40
Screen Shots, 377
Screening, 427
Script Files, 254

Selection methods
Crossing, 30
Window, 30

Sheet Set, 351
Sketch, 246
Snap, 42
Solid fill, 123
Spell, 104
Spline, 237
Stretch, 234, 356
Style, 103
System variable, 357

T
Table, 358
Templates, 56
Text, 96, 217
Tool palette, 8, 360
Toolbar, 8, 10
Trim, 24
True Color, 71

U
UCSicon, 108
Undo, 20
Units, 40

V
Viewport, 207
Viewport scale, 210, 217

W
Wblock, 164
Window tiling, 363
Wipeout, 363
Workspace, 6

X
Xline, 235
Xref, 387

Attach, 391
Bind, 391
Detach, 391
Open, 391
Reload, 391
Unload, 391

Z
Zoom, 19, 20
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